
CircuitMaker 
 

1. Введение 
CircuitMaker – мощная система в своём классе, простая при вводе описания электрических схем и моде-

лировании. Система объединяет возможности качественного программного обеспечения при малой его стои-
мости. Используя передовые возможности CircuitMaker, можно разрабатывать электронные схемы и выводить 
таблицу соединений для TraxMaker и других систем проектирования печатных плат и авто трассировщиков. 
Система даёт возможность выполнять быстрое, точное моделирование цифровых, аналоговых и смешанных 
аналого-цифровых цепей, используя от Беркли SPICE3F5 и XSpice имитаторы. 

 
Требования к пользователю 
Используя необходимый минимум теоретических знаний электроники и электронных приборов, пользо-

ватель можете успешно использовать CircuitMaker для разработки и моделирования электрических цепей. Для 
новичков CircuitMaker совершенно необходимая вещь с целью изучения и экспериментирования с электрони-
кой и электронными приборами. Для профессиональных пользователей, мощные исследовательские возмож-
ности CircuitMaker обеспечивают сложную среду для тестирования и отработки всех " а если " сценариев в 
проекте. Лучше всего то, что  это можно выполнить гораздо быстрее, чем традиционными методами макети-
рования. 

 
Требуемые аппаратные и программные средства  

 Компьютер 486 или выше. 
 Математический сопроцессор, рекомендуется для моделирования. 
 32МБ оперативной памяти, 40МБ доступного пространства на жестком диске. 
 Микрософт Windows 95, 98, NT 4.0 или выше. 
 Дисковод CD ROM для установки. 
 Мышь или другое устройство управления позицией курсора. 
 VGA или SVGA цветной монитор. 

 

2. Основы CircuitMaker  
Эта глава даёт краткий обзор окна рабочей области CircuitMaker, принятых соглашений, пользователь-

ских установок, сокращений и комбинаций "hot key". Пользователь всегда нуждается в некотором руководстве 
перед использованием CircuitMaker, чтобы правильно рисовать, редактировать, проверять и моделировать 
электронные схемы. 

 
Окно рабочей области CircuitMaker 
При запуске CircuitMaker появляется пустое окно создания схемы. Окно схемы это область, где разме-

щаются элементы, которые представляют собой реальные компоненты типа резисторов, транзисторов, источ-
ников питания, и т.д. Окно рабочей области CircuitMaker также включает инструментальную панель, строку 
меню, строку состояния, панель и окно анализа. 

После размещения элементов необходимо соединить их между собой. Для этого рисуются линии связи 
между элементами, которые затем позволяют моделировать, проверять работу  схемы, используя для этого 
мощный имитатор CircuitMaker.  

 
Возможность соединения  
Важная особенность CircuitMaker это разводка электрических соединений между элементами в проекте. 

Концепция обеспечения связей это ключ к использованию CircuitMaker для рисования и моделирования элек-
тронных схем. Программа хранит информацию о соединениях для моделирования, создания и экспорта табли-
цы соединений в TraxMaker или другие программы разработки печатных плат. 

 
Об окнах CircuitMaker  
Окно CircuitMaker имеет три отдельных раздела: окно схем, окно анализа и панель. Окно схем это об-

ласть, где рисуются схемные решения. Только один файл схемы может быть открыт в этом окне. Окно анализа 
это то место, где отображаются результаты моделирования. Это окно может содержать множество диаграмм, 



которые выбираются нажатием на вкладки внизу окна. Одна вкладка доступна для каждого выбранного типа 
анализа. 

Панель также имеет вкладки, которые используются, чтобы выбрать средство управления, которое явля-
ется доступным в выбранном окне. На панели находится браузер элементов для их поиска, средство управле-
ния аналоговыми графиками и параметрами цифрового логического режима. Окна отделены разделительными 
полосами, которые позволяют при необходимости изменять их размеры. 

 
Файлы CircuitMaker  
CircuitMaker включает ряд специальных файлов. Следующая таблица по расширениям перечисляет раз-

личные типы файлов, которые будут использоваться: 
.CKT   файлы схем  
.DAT   файлы данных 
.LIB   файлы библиотеки элементов 
.MOD   файлы моделей  
.SUB   файлы макромоделей 
.SDF   файлы установки отображения графиков  
 

Доступ к инструментальным средствам и их особенности 
Этот раздел показывает имеющиеся фундаментальные инструментальные средства и метод их использо-

вания для черчения схем. 
 
Краткий обзор задач 
Использование CircuitMaker включает шесть базовых процедур:  

1. Размещение элементов типа резисторов, транзисторов, источников питания, заземления и т.д. в 
рабочей области схемы;  

2. Перемещение элементов;  
3. Редактирование параметров элементов;  
4. Удаление элементов в случае необходимости;  
5. Соединение элементов в схему;  
6. Моделирование и испытание схемы. 
 

Использование инструментальной панели 
Можно исполнять множество задач, используя кнопки на инструментальной панели, которая удобно рас-

положена вверху экрана. Таблица расположенная ниже кратко описывает каждую кнопку и инструмент на ин-
струментальной панели. Вообще, инструмент позволяет применять определенное действие, а кнопка вызывает 
даннуюфункцию.  
 

Инструмент или 
кнопка 

Действие 

Panel   Показывает/скрывает Panel. Освобождает место для рисования, моде-
лирования. 

New   Создает новую схему. 

Open   Открывает существующую схему. 

Save   Сохраняет текущее схемное решение. 

Print   Печать схемы. 

Arrow Tool   Выбирает, передвигает и редактирует элементы, провода и текст. Так-
же используется для размещения соединительных проводов (когда от-
мечена опция Arrow/Wire). 

Wire Tool   Размещает соединительные провода, чтобы соединять элементы в схе-



му, +Shift, чтобы размещать шины. 

Text Tool   Добавляет текст на схему. 

Delete Tool   Удаляет элементы, провода и текст. Щелчёк правой кнопкой мыши, 
удаляет сегменты провода, а +Shift разрезает провод. 

Probe Tool   Для наблюдения/планирования сбора данных в любой точке схемы. 

Zoom Tool   Увеличивает и уменьшает схему, +Shift чтобы уменьшить. 

Fit to Window   Изменяет масштаб, чтобы полностью поместить схему в окне. 

Rotate   Вращает один или более выбранных элементов. 

Mirror   Зеркально отражает один или более выбранных элементов. 

TraxMaker   Автоматически создает таблицу соединений ПП и запускает TraxMaker. 

Help   Отображает информацию из Help файла о выбранном элементе. 

Reset   Прекращает аналоговое или цифровое моделирование. 

Analyses Setup   Открывает диалоговое окно Analyses Setup. Только для режима моде-
лирования Analog/mixed.  

Run Analog   Запуск и останов режима моделирования Analog/mixed. При нажатии 
изменяется на значок Stop. 

Trace Digital   В интерактивном режиме отображает логическое состояние во всех уз-
лах в режиме моделирования Digital. 

Run Digital   Запуск и останов, при нажатии изменяется на значок Pause. 

Step Digital   Пошаговое выполнение режима моделирования Digital. Установка раз-
мера шага в Digital Panel. 

Tile Windows   Расположение схемы и окна анализа в четырёх вариантах. 

 
Использование мыши 
Как в других прикладных программах Windows, CircuitMaker использует мышь для щелчка, выбора и пе-

ремещения. При перемещении мыши, соответствующий выбранный инструмент или курсор приходит в дви-
жение на экране. Знакомый указатель Arrow Tool используется для стандартных операций Windows, типа вы-
бора из меню и диалоговых окон. Можно возвратиться к стандартному указателю Arrow Tool в любое время, 
выбирая инструмент из инструментальной панели, или щёлкая правой кнопкой мыши на фоне схемы и выби-
рая Arrow средство. 

 
Меню по щелчку правой кнопкой мыши 
Можно щёлкая правой кнопкой мыши в различных областях рабочего пространства CircuitMaker, откры-

вать различные всплывающие меню. Пункты, перечисленные во всплывающем меню, изменяются в зависимо-
сти от того, где произведён щелчок правой кнопкой мыши: 

 Фону схемы 
 Элементу 
 Проводу 
 Тексту, созданному с помощью Text Tool 
 Группе элементов, всплывающее меню зависит от типа выделенных элементов 
 Метке графика 
 Где-нибудь еще в окне анализа 
 
 
 



HotKeys 
Для быстрого и простого размещения элементов, CircuitMaker предлагает до шестидесяти определяемых 

пользователем Hotkeys, которые позволяют размещать часто используемые элементы одним  нажатием кла-
виши. Например, нажатие клавиши r разместит на схеме резистор 1k или нажатие клавиши b разместит на 
схеме батарею 10V. Эти назначения могут быть изменены и настроены в соответствии с элементами, которы-
ми часто пользуются.  

 
Клавиши Shortcut 
Эти клавиши позволяют непосредственно выбирать команды меню. Следующая таблица перечисляет 

доступные в CircuitMaker клавиши  Shortcut. 
 

Нажатие клавиши Что это делает 
Ctrl+A Select All 
Ctrl+C Copy 
Ctrl+D Duplicate 
Ctrl+E Expand Macro 
Ctrl+F Find and Select 
Ctrl+H New Macro 
Ctrl+K Device Display Data 
Ctrl+L Schematic Display Data 
Ctrl+M Mirror 
Ctrl+N New 
Ctrl+O Open 
Ctrl+P Print Schematic 
Ctrl+Q Reset Simulation 
Ctrl+R Rotate 
Ctrl+S Save 
Ctrl+U Macro Utilities 
Ctrl+V Paste 
Ctrl+X Cut 
Ctrl+Z Undo 
  
Alt+A Arrow Tool 
Alt+D Delete Tool 
Alt+P Probe Tool 
Alt+T Text Tool 
Alt+W Wire Tool 
Alt+Z Zoom Tool 
  
F1 Context Sensitive Help 
F2 Display Scale 
F3 Normal Size/Position 
F4 Zoom to Fit 
F5 Schematic Options 
F6 Collapse Device Tree 
F7 Refresh Screen 
F8 Analyses Setup 
F9 Step Logic Simulation 
F10 Run/Stop Simulation 
F11 Trace Logic Simulation 



  
End Refreshes the screen. 
Esc Aborts the current operation. 
Page Up Enlarges the display (zooms in). 
Page Down Reduces the display (zooms out). 
Delete Deletes the current selection. 
Home Centers the screen around the cursor 
Arrow Keys Nudges a selected device (by pressing the Left, Right, Up, or Down Ar-

row keys). 
  
Shift+Insert Moves the currently selected group of items. 

 
Сохранение параметров схемы  
CircuitMaker хранит множество параметров настроек, типа значений по умолчанию для схемы и про-

граммы. Можно определять свои собственные привилегированные параметры настройки, используя диалого-
вое окно Schematic Options выбором Options > Schematic. Чтобы сохранить параметры настройки как значе-
ния по умолчанию: 

1. Выбрать пункт Options > Schematic. 
2. Сделать желаемые изменения. 
3. Отметить пункт Save current settings as defaults, затем выбрать OK. 

Примечание: Некоторые из этих параметров сохраняются с каждой схемой. В этих случаях значения по 
умолчанию применяются только тогда, когда создаётся новая схема. 

 
Основы управления файлами .CKT 
Этот раздел объясняет базовые процедуры управления файлами CircuitMaker. 
 

Запуск, сохранение и закрытие .CKT файлов 
Наиболее часто будут использоваться New, Save и Save As пункты меню: 

1. Выбрать пункт File > New, чтобы запустить новый файл. 
2. Выбрать пункт File > Save, если имя файла уже установлено. 

или 
           Выбрать пункт File > Save As, чтобы дать файлу имя. Это способ копирования  .CKT файлов. 

1. Выбрать пункт File > Close > Yes, чтобы сохранить и закрыть  .CKT файл без выхода из 
CircuitMaker. 

или 
             Выбрать пункт File > Exit > Yes, чтобы сохранить файл и выйти из CircuitMaker. 
 

Открытие и повторное открытие .CKT файла 
1. Выбрать пункт File > Open. 
2. Выбрать файл с расширением .CKT, который необходимо открыть, затем выбрать Open. 

Можно открывать любые из последних  восьми .CKT файлов, которые открывались ранее. 
1. Выбрать пункт File > Reopen. 
2. Выбрать файл, который необходимо открыть повторно. 
 

Возвращение к предварительно сохраненному файлу 
Если были сделаны изменения в файле .CKT, которые не желательно сохранять, можно возвратиться к 

исходному .CKT файлу, выбором File > Revert. 
 
3. Обучающие программы 
Эта глава охватывает процессы в том порядке, в котором обычно исполнял бы их пользователь. Приве-

денные примеры дают понимание того, как работает CircuitMaker, и иллюстрируют это несколькими путями 
выполнения задачи. 



1: Рисование схемы 
Эта обучающая программа охватывает следующие разделы: 

 Использование вкладки Browse в Panel. 
 Выбор транзистора. 
 Выбор резисторов. 
 Выбор +V и элемента заземления. 
 Изменение номинальных значений резисторов и транзисторов. 
 Соединение схемы. 
 

Использование вкладки Browse в Panel 
Рисование схемы рассматривается на простом примере: 

1. Начать с запуска программы CircuitMaker и, в случае необходимости, очистить рабочее про-
странство выбором File > New или щёлкнув кнопку New инструментальной панели. 

2. Выбрать вкладку Browse в Panel, чтобы отобразить дерево выбора элементов. 
 Примечание: В этой обучающей программе, расположение элементов в дереве выбора элементов и их по 

умолчанию Hotkey обозначены с использованием формата: 
 [Major device class/minor device class/device symbol] (Hotkey) 

Например, батарея находится в [.General/Sources/Battery] (b). Просто нажимая символ b в этом примере 
можно быстро выбрать и вставить элемент в схему. 

 
Размещение транзистора 
Начать рисовать схему нужно с выбора транзистора 2N2222A: 

1. Выбрать General / BJTs / NPN Trans:C в дереве Browse. Выбрать транзистор 2N2222A в ниж-
нем списке Model. 

2. Щёлкнуть Place, чтобы выбрать элемент из библиотеки.  
3. Можно также щёлкнуть вкладку Search и набрать 2n2222a, щёлкнуть Find, чтобы быстро найти 

элемент. 
4. Установить транзистор в середине экрана и затем один раз щёлкнуть левой кнопкой мыши. 

Транзистор размещается в рабочее пространство и больше не следует за мышью. 
 

Размещение резисторов 
Следующая процедура включает размещение двух резисторов: 

1. Выбрать резистор [Passive Components/Resistors/Resistor] (r), нажимая символ r на клавиатуре. 
При этом резистор ориентируется горизонтально и перемещается по экрану мышью. 

2. Нажать снова клавишу r или щёлкнуть правой кнопкой мыши, чтобы вращать элемент на 90°. 
3. Переместить резистор выше и налево от транзистора и щёлкнуть левой кнопкой мыши для раз-

мещения. 
4. Это будет резистор R1. Не нужно волноваться о значении его сопротивления. 
5. Установить второй резистор несколько выше транзистора, это будет резистор R2. 
 

Размещение элементов +V и Ground 
Теперь необходимо установить источник напряжения и изменить его параметры: 

1. Выбрать источник  [.General/Sources / + V] (1), нажимая 1 разместить его выше резистора R2. 
2. Выбрать символ земли [.General/Sources/Ground] (0), нажимая 0 разместить его ниже транзи-

стора. 
3. Дважды щёлкнуть по элементу +V, используя левую кнопку мыши, чтобы открыть диалоговое 

окно Device Properties. 
4. Изменить значение в поле Label-Value на +15V. 
5. Щёлкнуть один раз на самом верхнем переключателе Visible. Это скрывает обозначение +V на 

схеме. 
6. Щёлкнуть один раз на третьем сверху переключателе Visible. Это скрывает обозначение V1 на 

схеме. Щёлкнуть OK. 



Изменение номиналов резисторов 
Теперь провести процедуру редактирования на резисторах: 

1. Дважды щёлкнуть по резистору R1. 
2. Изменить значение в поле Label-Value на 220k, затем щёлкнуть OK. 
3. Дважды щёлкните по резистору R2. 
4. Изменить значение в поле Label-Value на 870k, затем щёлкнуть OK. 
5. В случае необходимости, переместить этикетки вокруг элементов с помощью мыши, чтобы раз-

местить их в удобные положения. 
 

Соединение элементов в схеме 
Теперь пришло время соединить эти элементы в единую схему: 

1. Выбрать средство Wire Tool из инструментальной панели. 
2. Установить курсор на вывод эмиттера транзистора. Когда курсор попадает близко к выводу 

транзистора, на выводе появляется маленький прямоугольник. 
3. Щёлкнуть на выводе и протянуть провод к выводу символа Ground. 
4. Отпустить кнопку мыши, чтобы сделать соединение. 
5. Установить курсор на нижнем выводе R2, затем нажать и удерживать левую кнопку мыши для 

протягивания нового провода. 
6. Протянуть конец провода к выводу коллектора транзистора и отпустить кнопку мыши. 
7. Подключить аналогично провод от верхнего вывода R2 к источнику +15V. 
8. Подключить другой провод от нижнего вывода R1 к базе транзистора. 
9. Наконец, подключить провод от верхнего вывода R1 к середине провода, который соединяет 

+15V с R2.  
  Можно перемещать элементы и соединительные проводники, с помощью Arrow Tool. 
 
2: Цифровое логическое моделирование  
Лучший способ видеть, как работает цифровое моделирование это загрузить пример схемы и опробовать 

некоторые команды.  
1. Щёлкнуть кнопку Open на инструментальной панели. 
2. Выбрать файл SIM.CKT из списка доступных схем. 
3. Схема SIM.CKT содержит несколько микросхем и полезна для демонстрации особенностей циф-

рового моделирования CircuitMaker. 
4. Щёлкнуть кнопкой Run в инструментальной панели, чтобы запустить моделирование. 
5. С началом моделирования отобразится шестнадцатеричный дисплей, показывающий счет после-

довательности чисел. 
6. Выбрать Probe Tool из инструментальной панели и коснуться его наконечником провода слева 

от метки " Probe Wire to the Left". Символ L будет отображен в Probe Tool. 
7. Переместить наконечник Probe Tool на переключатель, помеченный как "Toggle Switch" и щёл-

кнуть около его центра. Логический дисплей, связанный с выходом этой микросхемы начнет то-
гда быстро переключаться. 

8. Щёлкнуть кнопку Horizontal Split в инструментальной панели, чтобы открыть цифровое окно 
Waveforms. Каждый узел в схеме, к которому прикреплён элемент SCOPE будет просматривать-
ся в этом окне. 

9. Выбрать пункт Simulation > Active Probe, затем выполнить моделирование снова. 
10. Новый график по имени Probe отображается в окне Waveforms. Можно понаблюдать, что слу-

чается с этим графиком, когда перемещается Probe Tool по схеме. 
11. Щёлкнуть кнопку Trace в инструментальной панели, чтобы видеть состояние каждого провода в 

схеме. Красный цвет провода указывает на высокий уровень, синий цвет провода указывает на 
низкий уровень. 

12. Щёлкнуть кнопку Pause в инструментальной панели, чтобы остановить моделирование. 
 

3: Аналоговое моделирование 
Лучший способ ознакомления с аналоговым моделированием CircuitMaker состоит в том, чтобы постро-

ить несколько простых схем, выбрать типы исследований и выполнить моделирование. Это и рассмотрено в 
обучающей программе:  



 Анализ простой схемы. 
 Моделирование простой схемы переменного тока. 
 Моделирование более сложной схемы. 
 Выбор исследований. 
 Выполнение моделирования. 
 Моделирование смешанного сигнала. 
 

Моделирование простой схемы 
Необходимо начать с простой схемы постоянного тока: 

1. Щёлкнуть кнопку New в инструментальной панели для создания нового окна схемы. 
2. Нажать кнопку F6, если необходимо сократить дерево выбора элементов. 
3. Убедиться что в меню Simulation разрешено Analog Mode, а не Digital Mode. 
4. Начертить схему, как показано на рисунке, используя следующие элементы: 

 1 батарея [.General/Sources/Battery] (b) 
 1 символ земли [.General/Sources/Ground] (0) 
 2 резистора [.General/Resistors/Resistor] (r) 
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  Примечание: Каждая аналоговая схема должна иметь соединение с Ground, и каждый узел в схеме 

должен иметь путь утечки по постоянному току на землю. 
5. Используя средство Wire Tool соединить элементы схемы. 
6. Щёлкнуть кнопку Analyses Setup в инструментальной панели, затем кнопкой Analog Options 

отобразить диалоговое окно. 
7. В групповом блоке Collect Data For, выбрать третью опцию: Node Voltage, Supply Current, 

Device Current and Power и щёлкнуть OK, чтобы выйти из Analog Options. 
Эта опция позволяет с помощью Probe Tool измерять напряжение, ток и мощность. 

8. Щёлкнуть кнопку Run Analyses, чтобы запустить моделирование. 
или 

        Щёлкнуть Exit и затем щёлкнуть кнопку Run на инструментальной панели. 
Окно CircuitMaker разбивается на две части, помещая окно Schematic в верхней половине, окно Analysis 

в нижней половине. Вкладка Operating Point отображает смещение постоянной составляющей DC Bias, сред-
нее значение постоянной составляющей DC Average и среднеквадратичное действующее значение перемен-
ной составляющей AC RMS для каждой точки, которая исследуется на схеме. 

9. Щёлкнуть наконечником Probe Tool по проводу, связанному с выводом + батареи. Можно заме-
тить, что появляется указывающий на измерение напряжения символ V на Probe Tool, когда пе-
ремещается его наконечник поверх провода. 

Напряжение постоянного тока в том узле 10.00 V появляется на вкладке Operating Point под DC Bias. 
Все измерения напряжения указываются относительно земли. Среднее значение постоянной составляющей и 
среднеквадратичное действующее значение переменной составляющей не определено, потому что не разре-
шено Transient Analysis. Значения DC Bias это результат анализа Operating Point. Этот простой анализ пред-
полагает, что все катушки индуктивности будут замкнуты, а все конденсаторы отключены. Это идеально для 
моделирования схемы только по постоянному току, когда не должны показываться любые переходные про-
цессы. 

10. Удерживая клавишу SHIFT нажать в провод между двумя резисторами. 
Напряжение DC Bias в этом узле 5.000 V появляется на вкладке Operating Point. 

11. Удерживая клавишу SHIFT, нажать на вывод резистора R1. На Probe Tool появляется символ I, 
указывающий на измерение тока, когда наконечник Probe Tool  на выводе элемента. 



Электрический ток через тот элемент 5.000mA появляется на вкладке Operating Point. 
12. Удерживая клавишу SHIFT, нажать непосредственно на резистор R1. На Probe Tool появляется 

символ P, указывающий на измерение мощности. 
Мощность, рассеиваемая этим резистором 25.00mW, появляется на вкладке Operating Point. 

13. Нажать кнопку Stop на инструментальной панели, чтобы остановить моделирование и возвра-
титься к режиму редактирования. 

 
Создание простой RC схемы 
Теперь необходимо заменить один из резисторов конденсатором, чтобы создать простую RC схему, где 

можно увидеть процесс заряда конденсатора. Анализ переходных процессов Transient Analysis начинает его 
моделирование в установившемся состоянии по постоянному току, когда конденсаторы уже заряжены. При 
необходимости увидеть процесс заряда конденсатора от нулевого времени, нужно установить начальное со-
стояние конденсатора в 0V. 

1. Используя Delete Tool на инструментальной панели, удалить R2. 
2. Выбрать конденсатор [.General/Capacitors/Capacitor] (c) и подключить его на место резистора. 
3. Выбрать .IC элемент [Analog/SPICE Controls] (I) и подключить его к проводу между резисто-

ром и конденсатором. 
Это установит при запуске анализа начальное состояние  на конденсаторе 0V. Схема должна выглядеть 

как изображенный ниже рисунок. 
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1. Выполнить моделирование снова, щёлкнув кнопку Run на инструментальной панели. 
  На сей раз диаграмма переходного процесса, подобная экрану осциллографа появится на вкладке 

Transient Analysis в окне анализа. 
2. Нажать вкладку Transient Analysis для ее выбора, затем нажать наконечником Probe Tool меж-

ду резистором и конденсатором. 
  Диагональная линия на вкладке Transient Analysis отобразит фактическое начало кривой заряда кон-

денсатора. Обзор кривой графика ограничен временем запуска и останова анализа, которые были выбраны по 
умолчанию. Необходимо увеличить размер отрезка времени, который можно обозревать. Можно так же 
уменьшать номиналы компонентов, чтобы конденсатор зарядился быстрее. 

1. Остановить моделирование, щёлкнув кнопку Stop. 
2. Дважды щелкнуть по резистору R1, чтобы отобразить диалоговое окно Edit Device Data. 
3. Изменить номинал R1 с 1k на 500, затем нажать OK. 
4. Дважды щёлкнуть по конденсатору C1 и изменить его номинал с 1uF на .001uF, затем нажать 

OK.  
5. Выполнить моделирование снова. 

  На сей раз, будет отображаться полная кривая заряда конденсатора.  
 

Моделирование простой схемы переменного тока 
Теперь необходимо создать простую схему переменного тока, используя генератор сигналов и два рези-

стора: 
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1. Нажать кнопку New на инструментальной панели. 
2. Начертить схему, как показано на рисунке: 

 1 сигнальный генератор [.General/Instruments/Signal Gen] (g) 
 1 символ земли [.General/Sources/Ground] (0) 
 2 резистора [.General/Resistors/Resistor] (r) 

1. Используя средство Wire Tool соединить схему. 
2. Убедиться, что выбран режим моделирования Analog, затем выполнить моделирование. 
3. Нажать средством Probe Tool на провод, связанный с выводом Signal Generator. Появится сину-

соидальный график. 
4. Удерживая клавишу SHIFT нажать в провод, связывающий два резистора. Появится второй гра-

фик.  
5. Остановить моделирование. 
 

4: Моделирование сложной схемы 
Следующий пример демонстрирует, как проводить исследования и как делать простые измерения, ис-

пользуя курсоры в окнах анализа. Для этого необходимо создать схему усилителя с коэффициентом усиления 
по напряжению 10, используя операционный усилитель A741, как показано на рисунке. 

 

 

1. Выбрать пункт File > New. 
2. Выбрать пункт Simulation > Analog Mode. 
3. Нажать F6, если необходимо сократить дерево выбора элементов. 
4. Разместить следующие элементы в область создания схемы: 

 1 сигнальный генератор [.General/Instruments/Signal Gen] (g) как Vin на схеме 
 2 +V устройства  [.General/Sources/+V] (1) как Vcc и Vee 
 2 символа земли [.General/Sources/Ground] (0) 
 3 резистора [.General/Resistors/Resistor] (r) как RI, RF и RL 
 1 ОУ [Linear ICs/OPAMPs/Op-Amp5] (o) как U1 

5. Выбрать кнопку Rotate на инструментальной панели, и вращением RL и источника питания -
12V установить в нужные позиции. 

6. Используя средство Wire Tool соединить схему. 
7. Используя Arrow Tool переместить элементы, провода и метки в удобные позиции. 
8. Дважды щёлкнуть на Op Amp. 
9. Выбрать uA741 из нижнего списка микросхем  и нажать кнопку Select. 
10. Нажать кнопку Exit. 
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11. Дважды щелкнуть по верхнему элементу +V. 
12. Установить в поле Label-Value значение +12V и разрешить visible. Установить в поле 

Designation значение Vcc и разрешить visible, запретить visible в поле Device и нажать OK. 
13. Дважды щёлкнуть по нижнему элементу +V. 
14. Установить в поле Label-Value значение -12V и разрешить visible. Установить в поле 

Designation значение Vee и разрешить visible, запретить visible в поле Device и нажать OK. 
15. Нажать и перетащить метки в удобные позиции, как показано на рисунке схеме. 
16. Дважды щелкнуть по каждому резистору, чтобы изменить их номиналы, обозначения и сделать 

их видимыми: 
  Резистор   Номинал  Обозначение 
  Входной  10k  RI 
  Обратной связи 100k  RF 
  Нагрузочный  25k  RL 
 

17. Дважды щёлкнуть в Signal Generator. 
18. Установить Peak Amplitude 0.1V и Frequency 10kHz. 
19. Нажать кнопку Wave в Signal Generator. 
20. Разрешить переключателем Source AC Analysis, установить в поле Magnitude 1V, в поле Phase  

0, затем нажать OK.  
Теперь можно использовать Signal Generator как эталонный генератор сигнала для AC analysis. 

21. Нажать кнопку Properties. 
22. Установить в поле Designation значение Vin и разрешить visible, затем нажать OK. 

Примечание: поле Label-Value содержит -1/1V, который представляет минимум и максимум напряже-
ния. Нажать OK, чтобы возвратиться к схеме. 

23. Выбрать пункт Edit > Place Net Label, появится небольшой прямоугольник, который следует за 
мышью. Когда нижний левый угол прямоугольника касается провода, появляется прямоуголь-
ник подключения. Переместить метку узла так, чтобы она соединилось с проводом, который 
связан с верхним выводом резистора RL, затем нажать левую кнопку мыши для размещения. 
При запросе ввести имя Vout, поскольку узел маркируется текстом. 

 
Установки анализа 
Теперь, когда схема создана, можно проводить исследования. При выполнении моделирования резуль-

таты основаны на состояниях, которые были установлены пользователем. 
1. Щёлкнуть кнопку Analyses Setup на инструментальной панели. 
2. Запретить опцию Always set defaults for transient and Op analyses, очистив прямоугольник с 

галочкой. 
 Запрещая эту опцию можно обращаться к установкам анализа Transient/Fourier и Operating Point. 

Когда эта опция отмечена, для моделирования используются значения по умолчанию. 
3. Нажать кнопку Transient/Fourier. 
4. В разделе Default Timing, установить Number of Cycles 5 и Points Per Cycle 100. Нажать кноп-

ку Set Default Timing для выбора установок по умолчанию для Transient Analysis и нажать OK. 
  Это обеспечивает моделирование для 5 периодов входного сигнала с общим количеством точек расчё-

та данных до 500. Для большей надежности, Max Step должен быть того же размер как Step Time. Большее 
количество точек с расчетом данных требует более длительного времени моделирования. 

5. Разрешить анализ Operating Point, чтобы использовать вкладку Operating Point. 
6. Нажать кнопку DC.... 
7. Выбрать параметры Enabled и Enable Secondary в диалоговом окне DC Analysis Setup. При 

окончании ввода следующих параметров настройки в соответствующие поля, нажать OK. 
    Primary Secondary 
 Source Name  Vin  Vcc 
 Start   -1.5V  10V 
 Stop   -.7V  14V 
 Step   0.01V  1V 

  Эта установка позволяет изменять напряжение Vin в указанном диапазоне в каждом из 5 различных 
значений Vcc. 

8. Нажать кнопку AC.... 



9. Выбрать опцию Enabled в AC диалоговом окне Analysis Setup и ввести следующие параметры 
настройки в соответствующие поля: 

 Start Frequency 1 Hz  
 Stop Frequency 1MegHz  
 Test Points  10 
 Sweep   Decade 

   Это установки измерения частотной характеристики схемы. Нажать OK, чтобы сохранить параметры 
настройки. Нажать Exit, чтобы возвратиться к схеме. 

10. Выбрать пункт File > Save As и сохранить схему как Myamp.ckt, установки для анализа сохра-
няются со схемой. 

 
Выполнение моделирования 
Заранее размещая контрольные точки Run-Time Test Points в схеме, можно визуально контролировать 

результаты моделирования. Время необходимое для выполнения анализа определяется типом и числом наме-
ченных анализов, количеством данных, сложностью схемы и быстродействием компьютера. 

1. Выбрать Probe Tool на инструментальной панели. 
2. Использованием левой кнопки мыши, нажать наконечником Probe Tool на провод Vout. 

CircuitMaker размещает контрольную точку в этот узел. 
3. Нажать кнопку Run на инструментальной панели, чтобы запустить моделирование. 

  Значок кнопки Run в инструментальной панели в течение времени моделирования меняется на квад-
ратный значок Stop. Можно нажать на этот значок, чтобы прервать моделирование и рассматривать данные, 
который были собраны до этого момента. Когда моделирование закончено, квадратный значок Stop заменяет-
ся круглым значком Stop. При нажатии на этот значок произойдёт возврат в режим редактирования. Можно 
исследовать схему в любое время в течение моделирования или после возврата в режим редактирования. 

4. При необходимости нажать на кнопку Zoom Schematic to fit на инструментальной панели, что-
бы сделать схему полностью видимой. 

5. Нажать вкладку Operating Point в окне анализа. 
6. Щёлкнуть наконечником Probe Tool на проводе связанном с выводом Signal Generator.  

DC Bias, DC Average и AC RMS напряжения относительно земли в этом узле будут отображены на 
вкладке Operating Point. Значение AC RMS должно быть приблизительно 70.7mV, это 100mV в пике. 

7. Удерживая клавишу SHIFT нажать на провод Vout. Напряжения в этом узле добавляются на 
вкладку Operating Point. Значение AC RMS должно быть приблизительно 707mV, что соответ-
ствует коэффициенту усиления 10 по входному напряжению. 

8. Удерживая клавишу SHIFT нажать на вывод +12V электропитания. Электрический ток через тот 
источник питания добавляется на вкладку Operating Point. 

  Можно также измерять электрический ток и мощность на других элементах, но только если разреше-
ны соответствующие Test Points. 

  Примечание: Spice видит электрический ток, втекающий в положительный вывод элемента как поло-
жительный ток.  

9. Нажать вкладку Transient Analysis в окне анализа, затем нажать наконечником Probe Tool на 
провод, связанный с выводом Signal Generator. 

График сигнала появляется на вкладке Transient Analysis, подобно виду на осциллографе. Убедиться, 
что кнопка AutoY на Panel нажата. 

10. Удерживая клавишу SHIFT нажать наконечником Probe Tool на провод Vout. 
  Второй график появится на вкладке Transient Analysis. Быстрое сравнение этих графиков подтвер-

ждает, что амплитуда на выходе усилителя намного больше, чем амплитуда на входе. 
11. В Panel, выбрать график Vout для measurement cursor 1. Курсор 1 отображается на вкладке 

Transient Analysis. Нажать на курсор и перетащить его к первой нарастающей части синусоиды 
в точке Vout, где эпюра пересекает 0V. При перемещении курсора его значения X и Y отобра-
жаются в Panel, изменяясь вместе с изменением позиции курсора на графике. Чтобы медленно 
перемещать курсор, один раз щёлкнуть по нему, чтобы выбрать его, затем нажимать клавиши 
курсора стрелка “вправо” или “влево” на клавиатуре. Для точного перемещения удерживать кла-
вишу SHIFT при нажатии на клавиши. 

12. Выбрать Vout график для measurement cursor 2. Курсор 2 отображается на вкладке Transient 
Analysis. Нажать на курсор и перетащить его до второй нарастающей части синусоиды графика в 
точке Vout, где график пересекает 0V. 

13. В Panel установить курсоры измерения, чтобы измерить Frequency 1.. 2. 



14. Начертить прямоугольник выбора вокруг интересующей части графика в окне Transient 
Analysis. Для этого щёлкнув мышью и удерживая кнопку мыши чертить блок. При отпускании 
кнопки мыши раскрывается часть выбранного в блок графика. 

15. Чтобы восстановить первоначальный вид выбрать пункт Wave > Fit Waveforms. 
или 
       В Panel нажать Fit X и Fit Y или Auto Y кнопки. 
16. Выбрать вкладку DC SWEEP в окне анализа, затем нажать на любой провод в схеме. 

График анализа DC SWEEP отображается на диаграмме. 
17. Выбрать вкладку AC Analysis в окне анализа, затем нажать в провод Vout. График АЧХ отобра-

жается на диаграмме.  
18. Щелкнув правой кнопкой мыши в окне с графиком, выбрать пункт Scaling... 
19. Установить Log10 в поле X Scale. Установить Magnitude IN Decibels в поле Y Axis Primary, за-

тем нажать OK. 
График теперь отображает АЧХ схемы в Db логарифмической шкале частот. Это подобно тому, что бы-

ло бы отображено в измерителе АЧХ. Используя курсоры произвести измерения графиков.  
20. Снова щелкнуть правой кнопкой мыши в окне с графиком, выбирать пункт Scaling... 
21. Установить Phase IN Degrees в поле Y Axis Secondary, затем нажать OK. 

Теперь в окне два отдельных графика. Верхний график отображает АЧХ в децибелах, а нижний отобра-
жает ФЧХ в градусах. Черная стрелка слева от сетки указывает, который график выбран. Любые измерения, 
выполняемые курсорами, проводятся на выбранном графике. Щелчок левой кнопкой на другом графике, по-
зволяет его выбрать для измерений. 

22. Нажать кнопку Stop на инструментальной панели, чтобы возвратиться к режиму редактирова-
ния. 

 
Пример моделирования смешанных схем 
Следующая схема двоично-десятичного счетчика демонстрирует, как цифровые SimCode элементы мо-

гут использоваться в аналоговом режиме моделирования. 

Preset
Data

Terminal
Count

Up/Down

Clock

Count
Enables

Parallel Load8
7
6
5
4
3
2
1

CP1
CP2

Data
Seq

1234

74LS168A
CEP
CET
CP

D3
D2
D1
D0

PE
U/D

TC
Q3
Q2
Q1
Q0

 
1. Выбрать пункт File > New. 
2. Убедиться, что выбран режим моделирования Analog. 
3. Начертить схему, показанную на рисунке. 

 Data Sequencer [.General/Instruments/Data Seq] 
 74LS168A  [Digital by Number/741xx/74168/74LS168A] 
 +V [.General/Sources/+V] (1) 
 Ground [.General/Sources/Ground] (0) 
 Logic Switch [Switches/Digital/Logic Switch] (s) 
 Logic Display [Displays/Digital/Logic Display] (9) 
 Hex Display [Displays/Digital/Hex Display] (h). 

4. Дважды щёлкнуть +V и ввести DVCC, включая точку с запятой в поле Bus Data, чтобы подклю-
чить этот элемент к выводу Vcc 74LS168A. Нажать OK. 

5. Дважды щёлкнуть в Data Sequencer. 
6. Нажать кнопку Pattern. 
7. Выбрать Count Up и нажать OK. 



8. Ввести 20 в поле Stop Address и ввести 10 в поле Tick Increment, затем нажать OK. 
9. Щёлкнуть кнопку Analyses Setup в инструментальной панели и удостоверится, что отмечен пе-

реключатель Always Set Defaults, затем нажать кнопку Run analyses, чтобы запустить модели-
рование. 

10. Нажать на вывод Data Sequencer наконечником Probe Tool, чтобы просмотреть сигнал синхро-
низации на вкладке Transient Analysis. 

11. Наверху Panel, выбрать All Cells. Диаграмма Transient Analysis изменяется на представление 
All Cells. 

12. Удерживая клавишу SHIFT, нажать на вывод Q0 74LS168A. Этот график появляется на той же 
самой диаграмме, но в отдельной системе координат. 

13. Повторить эту процедуру для каждого вывода 74LS168A и просмотреть результаты. 
Можно моделировать эту же самую схему в режиме моделирования Digital Logic. Для этого остановить 

моделирование, переключиться на цифровое моделирование и выполните его. В режиме моделирования 
Digital Logic, все средства отображения будут анимированы. 

 

4. Создание и редактирование схем 
Используя набор инструментальных средств черчения и редактирования CircuitMaker, можно легко и 

быстро создавать простые и сложные схемы. Эта глава охватывает инструментальные средства рисования и 
редактирования и их характеристики. 

 
Инструментальные средства черчения и редактирования 
Эта секция описывает кнопки инструментария, которые можно использовать при размещении и соеди-

нении компонентов. 
 
Arrow Tool 
Средство Arrow Tool используется для выбора и перемещения пунктов, перебрасывания ключей, выбо-

ра средств из инструментария, и т.п. Двойным щелчком можно выполнять множество функций, например, ре-
дактирование специфических устройств. Можно также активизировать Arrow Tool правым щелчком мыши на 
фоне схемы и выбором средства из управляющего меню. Если выбрана в установках опция Arrow/Wire, мож-
но использовать Arrow Tool для разводки проводников, щёлкая на выводе устройства. 

 
Wire Tool 
Средство Wire Tool используется для разводки проводов в рабочей области. Разводка шин производится 

аналогично,  придерживая клавишу SHIFT. Пунктирная линия создается, если придерживать клавишу Alt при 
чертеже провода. Пунктирные линии действуют подобно регулярным проводам, но если они не подключены к 
чему-нибудь, они не будут включаться в список цепей. Можно также активизировать Wire Tool правым щелч-
ком мыши на фоне схеме и выбором средства из управляющего меню. 

 
Text Tool  
Средство Text Tool используется для установки текста в схеме. Выбрать средство, нажать в рабочей об-

ласти и набрать текст. Выбрать Edit > Font, чтобы определить стиль текста или выбрать View > Colors для 
назначения другого цвета в текст, можно также изменять размер и форму текстовой области. Средство Text 
Tool  можно выбрать, нажимая сочетание Alt+T или выбором пункта Text в меню правой кнопки мыши. 

 
Delete Tool 
Средство Delete Tool используется для удаления выбранных пунктов. Выбрать средство Delete Tool, 

нажать в пункт, который необходимо удалить и пункт немедленно удаляется, за исключением проводов. Если 
нажать и придержать на проводе с Delete Tool, провод выделяется, но не удаляется, пока не будет отпущена 
кнопка мыши. Если средство при нажатой кнопке смещено с провода,  то провод не удаляется. Это позволяет 
видеть полную протяженность провода перед удалением. Чтобы удалить сегмент провода, нажать правой 
кнопкой в провод с Delete Tool и выбрать средство Delete Wire Segment. Можно также выбрать средство 
Delete Tool сочетанием Alt+D или выбором пункта Delete из меню правой кнопки мыши. Или выбрать пункт и 
нажать Delete на клавиатуре, чтобы удалить пункт. Для разделения провода на два придержать Shift клавишу 
и нажать в провод с Delete Tool, провод разделяется в контактной точке. 



Zoom Tool 
Средство Zoom Tool используется для изменения размера окна схемы. Для увеличения размера окна, 

выбрать средство Zoom Tool и позиционировать в область расширения, нажатие левой кнопки мыши, увели-
чивает схему на выбранный Scale Step размер. Для уменьшения размера выбрать средство Zoom Tool, и пози-
ционировать в область уменьшения. Придержать Shift клавишу и нажать левую кнопку мыши, чтобы умень-
шить схему на выбранный Scale Step размер. Средство можно также выбрать сочетанием Alt+Z или выбором 
Zoom из меню правой кнопки мыши. Другой метод нажать Page Up или Page Down клавиши, не используя 
Zoom Tool. В этом случае изменение масштаба происходит в позиции курсора мыши. 

 
Rotate 
Средство Rotate используется для вращения выбранных устройств на 90°. При выборе из библиотеки 

можно также вращать устройство, нажимая r клавишу или правую кнопку мыши прежде, чем установить уст-
ройство на схеме. Можно также выбрать Rotate из меню Edit > Rotate или сочетанием клавиш Alt+R.  

Примечание: При вращении устройств имена выводов и величины остаются в удобочитаемом положе-
нии. 

 
Mirror 
Средство Mirror используется для зеркального отображения устройства по горизонтали. Для зеркально-

го отображения устройств выбираемых из библиотеки нажимается m клавиша до установки устройства на 
схеме. Средство можно выбрать из меню Edit > Mirror или сочетанием клавиш Alt+M. 

 

Сетка, границы и титульный блок 
Система CircuitMaker дает возможность облегчать и делать более точным размещение компонентов на 

схеме. 
 
Grid 
Средство Grid используется для выравнивания устройств по сетке, отображение может быть включено  

или отключено. Использование Snap To Grid фиксирует устройства согласно определенной сетке при уста-
новке и перемещении. Один пункт определения сетки составляет 0.254 мм. 

Примечание: При установке устройств точно в сетке, они всегда остаются в сетке независимо от пози-
ции. Тем не менее, Snap To Grid не гарантирует выравнивание компонентных выводов.  

Выбрать Options > Schematic, чтобы иметь доступ к Grid диалоговому разделу. 
 
Title Block 
Выбор Title Block используется для добавления окна названия к правому нижнему углу страницы схе-

мы. Блок названия содержит следующие области: Name, Title, Revision, ID, Date и Page. Области Name и 
Title расширяются по высоте, чтобы вмещать весь необходимый текст. Если Name или Title области не ис-
пользуются, CircuitMaker исключает их из блока названия.  

Блок названия также расширяется в ширину согласно суммарно вводимому тексту. Можно напечатать 
блок названия на первой странице, на последней странице, или на всех страницах. К тому же, можно напеча-
тать полный блок названия на первой странице и сокращенный блок названия без Name и Title областей на 
последующих страницах. Выбор Options > Schematic даёт доступ к опции установки Title Block. 

 
Borders 
Этот выбор используется для быстрого поиска расположения устройств по координатной сетке вокруг 

схемы. Чтобы добавить границу к схеме: 
 Выбор Options > Border отображает Border диалоговое окно. 
 Выбор Display Border On Screen отображает границу допустимой области схемы. 
 Выбрать Do Not Print для запрета вывода границ на печать. Выбор Print Around Entire 

Schematic позволяет напечатать одну границу вокруг всех схем. Выбор Print Around Each Page 
напечатает границы для каждой страницы схемы. 

 
Поиск и размещение устройств 



Система CircuitMaker в своих библиотеках содержит несколько тысяч устройств. Можно устанавливать 
устройства из библиотеки, используя Browse и Search закладки на Panel или используя кратчайшие пути Hot-
key. 

 
Browse  
Можно просматривать устройства в CircuitMaker, используя Browse дерево в Panel. Чтобы найти и ус-

тановить устройство: 
1. Щелкнуть Browse закладку на верху Panel. 
2. В дереве выбрать устройство, которое необходимо установить. Например, транзистор 2N3904 

может быть обнаружен в [.General/BJTs/NPN Trans]. Выбранный схемный символ  отображает-
ся в верхнем окне Panel. 

3. Двойной щелчок на имени устройства, модели или щелчок на Place, выбирает устройство для 
размещения в рабочей области. 

 Устройство будет следовать за мышью до щелчка левой кнопки мыши. При перемещении устройства 
можно его вращать правой кнопкой мыши или отображать зеркально клавишей m. 

 
Search  
Можно осуществлять поиск специфических устройств CircuitMaker, используя Search закладку в Panel. 

Осуществляется поиск всех устройств, которые соответствуют индексу или описанию, которые вводит поль-
зователь.  

Возможности поиска позволяют принимать частичные слова, которые соответствуют устройствам. На-
пример, текст поиска op может оказываться результатом как Op-Amp или loop. Можно также использовать 
звездочку как маску.  Например, ввод поиска 74*8 выдаёт результат 748, 7408, 74LS08, 74138, 74285 и так да-
лее. Если вводится много слов как текст поиска, порядок их следования не имеет значения. Например, ввод 
слов 741 op-amp и op-amp 741 дают одинаковые результаты. Для поиска устройств: 

1. Щёлкнуть Search закладку вверху Panel. 
2. Тип, имя устройства, номер или описание вводится в текстовое окно, затем щёлкается Find. 
3. Используя перемещение списка, находится нужное устройство и щёлкается для выделения. 
4. Дважды щёлкнуть в устройство или щёлкнуть Place, чтобы выбрать устройство для размещения 

в рабочей области. 
Примечание: Если файлы пользовательских библиотек USER.LIB постоянно модифицируются, то будет 

наблюдаться небольшая задержка при следующем поиске устройств в Device Search диалоговом окне. За-
держка вызвана тем, что CircuitMaker создаёт новый SEARCHDB.DAT файл списка поиска. Если по какой ли-
бо причине список поиска кажется неправильным или устаревшим, можно создать новый файл списка поиска, 
выбором Macros > Update Search List. 

 
HotKeys 
Можно также выбирать устройства, нажимая на клавиатуре назначенные им Hotkey.  
 
Назначение Hotkey 
Можно просмотреть список Hotkey и переназначить, если это требуется. Чтобы назначить Hotkey на 

специфическое устройство: 
1. Выбрать Browse закладку в Panel и найти устройство, для которого необходимо назначить 

Hotkey. 
2. Щёлкнуть кнопку Hotkey, чтобы отобразить диалоговое окно. Hotkeys указаны в алфавитном 

порядке вместе с устройствами, которые к настоящему времени им назначены. 
3. Перемещая список выбрать устройство и щёлкнуть Hotkey, сделать назначение на выбранное 

устройство, затем щёлкнуть Assign кнопку. 
 

Удаление Hotkey 
Для того чтобы удалить назначение Hotkey из списка: 

1. Следовать шагам 1 и 2 из предшествующей секции. 
2. Выбрать новое устройство на это место. 

или 
           Выбрать none  вверху списка Hotkey. 
 



Размещение устройств 
После поиска и обнаружения устройства можно его установить. Чтобы установить устройство: 

1. Выбрать устройство, используя один из методов обсуждаемых в предшествующей секции. 
2. Нажать r клавишу или правую кнопку мыши, чтобы вращать устройство. 
3. Нажать m клавишу для зеркального отображения устройства. 
4. Щёлкнуть левой кнопкой мыши, чтобы установить устройство в рабочей области. 

 или 
           Нажать любую клавишу, кроме r или m, чтобы отменить размещение. 
 Примечание: чтобы многократно устанавливать идентичные устройства, отметить Auto Repeat кон-

трольное окно Options > Schematic. 
 
Выбор устройств 
Использование Arrow Tool позволяет выбирать и перемещать устройства в рабочей области. Есть четы-

ре различных способа для выбора пунктов в окне схемы. 
 
Выбор единичного пункта 
Для того чтобы выбрать единственный пункт, щёлкнуть его Arrow Tool средством. Щелчок в свободной 

рабочей области отменяет выбор пункта. 
 
Выбор множества пунктов 
Для того чтобы выбрать множество пунктов, придерживая Shift клавишу щелкнуть в один или более 

пунктов с Arrow Tool. Чтобы отменить выбор любого пункта щёлкнуть на нём вторично, придерживая Shift 
клавишу. Для того чтобы отменить выбор всех пунктов, отпустить Shift клавишу и щёлкнуть где-нибудь в ра-
бочей области свободной от всех пунктов. 

Можно также выбрать множество пунктов, придерживая левую кнопку мыши и протаскивая прямо-
угольник выбора вокруг желаемых пунктов. Этот метод особенно хорош для выбора ключей, поскольку щел-
чок в ключ не всегда делает удачным выбор.  

 
Выбор всех пунктов 
Для того чтобы быстро выбрать все пункты, выбрать в меню Edit > Select All или нажать Ctrl+A. 
 
Толчок устройств 
Чтобы немного "толкнуть" устройство в любом направлении, необходимо выбрать устройство, затем 

нажать Left Arrow, Right Arrow, Up Arrow или Down Arrow клавиши. Один толчок перемещает устройство 
на один пиксель, во всяком случае, есть привязка к Snap-to-Grid. 

Примечание: свойство толчка не работает с выбранными проводами или множеством устройств, а толь-
ко с единственным устройством. 

 
Разводка цепей 
Чтобы правильно имитировать и генерировать списки цепей для печатной платы, компоненты в схеме 

должны правильно соединяться между собой. В CircuitMaker провода можно разводить автоматически, в руч-
ную и быстрым соединением. Методы полностью интегрированы и автоматизированы, не нужно выбирать 
или переключаться между способами разводки. В любом случае правильной точкой связи для разводки это 
любой вывод устройства или провод. Провода могут быть только горизонтальными или вертикальными. 

Авто разводка  Щелчок с Wire Tool на первой точке связи, затем не отпускаться кнопки 
протянуть до следующей точки и отпустить кнопку. 

Ручная разводка  Щёлкнуть, и отпустит с Wire Tool в начальной точке провода, один 
щелчок изменяет направление провода, затем один щелчок в точке связи 
или двойной щелчок в свободное место, чтобы закончить провод. 

Быстрое соединение  Когда разрешено, переместить устройство средством Arrow Tool чтобы 
не связанные выводы коснулись провода или выводов других устройств. 

 
Преимущества SmartWires   
Независимо от метода проводки в CircuitMaker используется SmartWires функция, которая позволяет 

подключать провод к выводу устройства или другому проводу без указания точного места. Это гарантирует 



надёжные связи и устраняет любые догадки. Определяемая пользователем область связи существует вокруг 
каждой точки связи. Когда устанавливается Wire Tool в области связи, появляется прямоугольник, выделяя 
точку связи. Можно установить размер области связи отображаемое прямоугольником в Options > Schematic 
меню. 

 
Автоматическая разводка проводов 
Для быстрой и разводки проводов: 

1. Выбрать Wire Tool средство в инструментарии. 
2. Переместить средство к нужной точки связи. 
3. Нажать и держать левую кнопку мыши. 
4. Переместить мышь на другую точку связи и отпустить кнопку мыши. 
5. Провод автоматически разводится между двумя точками. 

Авто разводка требует две точки связи. Нельзя разводить этим способом шины. 
 
Ручная разводка проводов 
Ручная разводка позволяет проводить свободную разводку проводов. Это также позволяет устанавли-

вать "свободные провода" в схеме, которые ни к чему не подключены. 
Примечание: для разводки шин используется только ручной метод. 
Чтобы разводить провода вручную: 

1. Выбрать средство Wire Tool в инструментарии. 
2. Переместить средство в позицию начала провода. 
3. Щёлкнуть и отпустить левую кнопку мыши. Курсор Wire Tool исчезает и заменяется расширен-

ным курсором. Расширенный курсор упрощает задачу точного выравнивания провода с другими 
объектами. 

4. Щелчок левой кнопкой мыши поворачивает провод на 90°, двойной щелчок заканчивает провод. 
5. Один щелчок мыши может использоваться для завершения разводки провода в нужной точке 

связи, если используется Single Click Connect опция в Schematic Options диалоговом окне. 
 

Быстро соединение проводов 
Метод Quick Connect используется для ускорения и облегчения разводки. Эта функция позволяет про-

сто касаться не связанным выводом устройства в провода или не связанные выводы других устройств, и связь 
создаётся автоматически. Чтобы использовать быстрое соединение: 

1. Выбрать новое устройство из библиотеки  
 или 
           Толчком или щелчком перетащить существующее устройство средством Arrow Tool. 

2. Переместить устройство, чтобы конец не связанного вывода касался провода или вывода другого 
устройства. 

3. После этого CircuitMaker подключит провод к устройству и месту касания. 
Тот же размер области связи определяемый как  SmartWires используется в Quick Connect. Эта область 

связи определяет зону захвата провода или вывода, прежде чем CircuitMaker автоматически сделает связь, и 
может изменяться в Schematic>Options диалоговом окне. По умолчанию,  Quick Connect выбор активен.  

 
Продление, объединение и разрезание проводов 
Провода редактируются как обычные объекты, и могут быть продлены, соединены и разрезаны. Чтобы 

продлить провод: 
1. Выбрать Wire Tool средство. 
2. Разместить над концом провода и начать с нового провода, чтобы продлить существующий про-

вод. 
Чтобы соединить два провода вместе: 

1. Протащить провод из конца первого провода в конец второго провода, они становятся одним 
проводом. 

Чтобы разрезать один провод на два отдельных провода: 
1. Выбрать Delete Tool средство в инструментарии. 
2. Разместить над точкой разрезания провода.  
3. Придержать Shift клавишу. 
4. Щёлкнуть левую кнопку мыши, чтобы разрезать провод. Провод подразделяется на два провода. 



Удаление проводного сегмента 
Индивидуальный сегмент провода может быть удалён с потерей связи к примыкающим проводам. Что-

бы удалить проводной сегмент: 
1. Щёлкнуть правой кнопкой в проводной сегмент любым средством. 
2. Выбрать пункт Delete Wire Segment из управляющего меню. 
 

Выделение узлов 
Можно выделить весь узел цепи одним щелчком мыши. Это может быть очень полезным для просмотра 

ошибок разводки проводов. Провода, которые физически не связаны на схеме, узлы земли, например, будут 
тоже выделяться, потому что это тот же узел цепи. Чтобы выделять узлы: 

1. Выбрать Arrow Tool в инструментарии. 
2. Нажать Alt кнопку и щёлкнуть в один из проводов узла. 
 

Перемещение устройств вместе с проводами 
Можно перемещать устройства с подключенными проводами, не разрушая связей. При выборе и пере-

мещении устройств Arrow Tool средством, провода подвергаются эффекту "rubberband", они растягиваются, 
но остаются связанными с устройствами. 

 
Разводка шин 
Шины являются специальным типом групповых проводов, которые содержат множество индивидуаль-

ных проводов. Каждая шина называется своим именем, и каждый индивидуальный провод в пределах шины 
также имеет имя. Шина идентифицируется тем, что сделана более толстой линией. Чтобы сделать шину: 

1. Нажать Shift клавишу. 
2. Выбрать Wire Tool средство в инструментарии и разводить как обычный провод. Заканчивается 

разводка шины двойным щелчком мыши. После завершения шины выводится диалоговое окно 
для ввода имени шины. 

 Примечание: Необходимо придержать Shift только в начале разводки шины, далее можно отпустить 
клавишу и завершать шину без неё.  

 Примечание: Если двум отдельным шинам дано одно имя, считается, что они будут одной шиной, да-
же если они физически не связаны на экране. 

Для того чтобы переименовать шину, дважды щёлкнуть на ней средством Arrow Tool или из меню пра-
вой кнопки выбрать пункт Edit Bus Wire Number. Можно удлинять, объединять или разрезать шины подобно 
обычным проводам. Тем не менее, не нужно придерживать Shift клавишу при удлинении шины. 

 
Подключение проводов к шине 
Провода, которые подключены к шине, названы проводами, связанными шиной. Эти провода подклю-

чаются к другим проводам в пределах шинах. Чтобы создавать провода связи с шиной: 
1. Выбрать Wire Tool средство в инструментарии. 
2. Переместить средство к нужной точке связи. 
3. Щёлкнуть и держать левую кнопку мыши. 
4. Переместить мышь на другую точку связи на шине и отпустить кнопку мыши. 

 После создания связи выводится диалоговое окно назначения имени проводу. 
5. Определить имя провода шины. 
6. Пункт Angle Connection to Top/Left изменяет угол направления связи с шиной. 

Для редактирования провода подключенного к шине или редактирования имени, дважды щёлкнуть 
средством  Arrow Tool или из меню правой кнопки выбрать пункт Edit Bus Connection. CircuitMaker отобра-
зит шины и этикетки связи с шиной по умолчанию, но можно изменить их в Schematic Options диалоговом 
окне. 

  
Провода, связанные шиной 
Если проводам, связанным с шиной назначается одно и то же имя, это значит, что они действуют, как 

если бы имели видимую связь на схеме. 
 
 
 
 



Узловые имена и связи 
CircuitMaker назначает свои имена на узловые цепи. Имена используются для идентификации графиков 

моделирования, а также для идентификации цепей при передаче на печатную плату. Узлы, которые физически 
не связаны на схеме, но имеют одинаковые имена, считаются связанными. 

В общих чертах используемые имена назначаются автоматически в зависимости от компонентов, с ко-
торыми они связаны. Например, узел названный как U2_6 получил своё имя, поскольку он связал вывод 6 уст-
ройства U2. Конечно, этот узел также подключен к выводам других устройств, но он был подключен к узлу 
первым. Узловые имена корректируются всякий раз, когда нажимается Reset кнопка в инструментарии или 
запускается моделирование. 

Есть несколько исключений. Некоторые устройства берут приоритет над другими устройствами, когда 
происходит назначение узловых имён. Например, источник напряжения берёт приоритета над другими компо-
нентами узлового присваивания имён. Если на схеме имеется +V устройство, обозначенное как Vcc, цепь бу-
дет названа Vcc_1,  даже если цепь начиналась как U7B_8. Узел земли всегда будет назван или 0 или GND. 

Предусмотрено принудительное назначение специфических имён цепям, которое имеет преимущество 
перед всеми остальными случаями. Возможен случай запроса назначения имён. И, наконец, узловая этикетка 
может быть установлена в провод, чтобы создать узловое имя. Узловая этикетка появляется как простой текст 
на схеме, но должна устанавливаться выше или вправо от провода. Небольшой прямоугольник связи отобра-
жается на этапе контакта этикетки с проводом. Если из-за своей позиции узловая этикетка не подключена к 
проводу, выводится символ перечёркивания текста, указывающий на отсутствие связи с проводом. Узловая 
этикетка берёт приоритет присваивания имен над всеми устройствами кроме земли. Чтобы установить узло-
вую этикетку: 

1. Выбрать пункт Edit > Place Node Label. 
2. Переместить прямоугольник этикетки, чтобы левый нижний угол касался провода желаемой це-

пи. Щёлкнуть левую кнопку мыши. 
3. Ввести желаемое имя или приняв предлагаемое нажать OK. 

Чтобы просматривать все узловые имена на схеме: 
1. Выбрать пункт Options > Schematic или F5. 
2. Отметить Show Node Names контрольное окно и нажать OK. Узловые имена отображаются в 

центре самого длинного провода узла. 
 

Силовые цепи 
Из предшествующих секций известно, что узлам могут быть назначены специфические имена и если два 

или более узлов имеют одинаковые имена, считается, что они будут одним узлом. Теперь можно посмотреть, 
как это относится к силовым цепям шины, например Vcc или GND. 

 
Подключение силовых цепей к одному источнику 
Предположим, что имеется несколько устройств операционных усилителей (ОУ), которые необходимо 

подключить к  источнику Vcc. Можно было бы просто установить отдельные +V устройства на каждом ОУ. 
Но тогда каждый +V будет независимым источником с отдельным узлом, и иметь уникальное обозначение. 
Это будет неприемлемо при создании списка цепей для печатной платы. 

Чтобы все Vcc точки были общим узлом с одним источником, можно использовать одно +V устройство 
и множество устройств типа Terminal. 

1. Цепь +V подключить к одному ОУ, а устройство Terminal к другим ОУ, и ввести Vcc как 
Terminal Name для каждого терминала. 

2. Установить узловую этикетку на провод, подключенный к +V и дать имя как Vcc. Источник +V 
будет подключен к терминалам с общим узловым именем. 

 или 
Ввести Vcc; включая точку с запятой в Bus Data области окна свойств +V. Источник +V будет         
подключен к терминалам общей шиной. Такое использование терминалов вместо нескольких +V 
создает единый узел или цепь в списке соединений для Spice или печатной платы. 
 

Цифровые силовые цепи 
В CircuitMaker к цифровым устройствам не подключаются Vcc и GND цепи. Тем не менее, они необхо-

димы для аналогового моделирования и платы. Этим "скрытым" выводам назначаются силовые цепи, исполь-
зуя Bus Data область для каждого цифрового устройства. Силовые цепи, назначаемые цифровым устройствам, 
называют как DVCC, DVDD и DGND, чтобы не путать с другими узловыми именами. 



Есть три устройства, которые могут использоваться для создания таких цепей: +V, Terminal и Ground. 
Чтобы подключить одно из этих устройств к силовой цепи, просто ввести имя цепи, сопровождая точкой с за-
пятой, в Bus Data области. Например, установить +V устройство в схеме, затем ввести DVCC; в Bus Data об-
ласть. Устройство +V теперь будет источником для DVCC силовой цепи. Терминал используется так же, но не 
как фактический источник, а как устройство связи с источником. Область Bus Data для терминала заполняется 
автоматически, когда вводится Terminal Name. 

Нужно обратить внимание, что в Ground устройство уже включена GND; строка в Bus Data области, но 
имя цифровой земли DGND. Эти две цепи связаны использованием Power Supply Bus Data области Analog 
Options диалогового окна. Если силовые цепи не используется в схеме, цифровые устройства используют по 
умолчанию значения введённые здесь.  

 
Обозначение устройств на схеме 
Система CircuitMaker предлагает несколько методов обозначения устройств на схеме, включая Text Tool 

средство и редактирование их как устройств. 
 
Использование Text Tool для примечаний 
Чтобы создать примечания использованием средства Text Tool: 

1. Выбрать Text Tool средство. 
2. Щёлкнуть в окне, где необходимо установить текст. 
3. Изменить при необходимости размеры текстового окна. 
4. Ввести текст. 

Текст может быть выровнен и стилизован. Всегда видимый текст может быть перенесён в любое место. 
 
Изменение обозначения устройств 
Ненужно путать обозначение устройств с этикеткой величин устройства. Чтобы обозначать устройства, 

используется Device Properties диалоговое окно: 
1. Дважды щёлкнуть в устройство. 
2. Выводится Device Properties диалоговое окно. 
3. Внести необходимый текст в Label-Value, Designation или Description текстовые области. 
4. Видимость текста на схеме определяется выбором Visible контрольного окна. 

Все этикетки величин, обозначения и описания могут перемещаться использованием средства Arrow 
Tool.  

 
Свойства устройств 
Пользователь можете редактировать большое разнообразие информации об устройствах, имеющих от-

ношение к схеме, имитации, плате и т.д. Для редактирования устройства: 
1. Двойным щелчком на устройстве или из меню правой кнопки выбрать пункт Device Properties 

для вывода диалогового окна. 
 Примечание: На определенных устройствах выводится другое диалоговое окно при двойном щелчке, 

там необходимо нажать Properties кнопку для вывода Device Properties диалогового окна. 
 
Device 
Эта не редактируемая область показывает имя устройства, которое назначается в библиотечном меню. 

Использование Visible контрольного окна позволяет отображать или скрываться имя на схеме. Имя устройства 
сохраняет ту же ориентацию как устройство при вращении. Этикетки величины, обозначения и описания со-
храняют правильную ориентацию независимо от вращения устройства. Названия некоторых устройств, как 
например, “Resistor”, нельзя сделать видимым. 

 
Label-Value 
Эта область используется для ввода информации об устройстве, например названий (1N914, 2N3904) 

или величин (47K, 100U). Область величин может перемещаться мышью на любое расстояние от устройства 
на схеме и оставаться принадлежащей к данному устройству.  

Если установить Visible контрольное окно серым, этикетка заменяется, и будет сохранять ту же ориен-
тацию при вращении, как и устройство. В противном случае, этикетка величин останется с правой стороны 
независимо от вращения устройства. 

 



Designation 
Эта область используется для идентификации устройств на схеме как, например: U3, CR7, RLOAD, и 

т.п. Видимость области управляется Visible контрольным окном. Эта область должна содержать обозначение 
устройства для правильной работы моделирования и формирования списка цепей для печатной платы. Эти-
кетка обозначения может перемещаться мышью на схеме и сохраняет положение независимо от вращения 
устройства. Эта область заполняется автоматически при установке устройства на схеме. 

 
Description 
Эта область можете использоваться для отображения на схеме дополнительной информации как, напри-

мер, заказной индекс, допуски, и т.п. За исключением реле, эта область не влияет на моделирование, реле ис-
пользуют эту область для определения комбинации катушек/контактов. Использование Visible контрольного 
окна может делать эту область невидимой. Можно перемещать мышью этикетку описания на схеме, при этом 
этикетка сохраняет положение при вращении устройства. 

 
Package 
Эта область используется для идентификации типа физического корпуса устройства, например DIP14, 

TO-92B. При создании списка цепей для TraxMaker или других программ создания печатных плат необходимо 
убедиться, что Package имя соответствует библиотечному компоненту корпуса. 

 
Auto Designation Prefix 
Этот префикс используется системой CircuitMaker для автоматического назначения обозначений уст-

ройствам. Префикс может быть длиной до 4 символов. 
 
Spice Prefix Character 
Этот Spice префикс используется вместе с %D и %M флагами, которые будут описаны позже. Область 

используется для связи макромоделей со схемными символами при создании новых устройств. Правильные 
префиксы: 

A  XSpice модель 
BV  Нелинейный зависимый источник напряжения 
BI  Нелинейный зависимый источник тока 
C  Конденсатор 
D  Диод 
DZ  Стабилитрон 
E   Линейный источник напряжения управляемый напряжением 
F   Линейный источник тока управляемый током 
G  Линейный источник тока управляемый напряжением 
H  Линейный источник напряжения управляемый током 
I   Независимый источник тока 
JN  NJFET 
JP  PJFET 
K  Связанные индуктивности (взаимоиндуктивность) 
L   Индуктивность 
MN  NMOS 
MP  PMOS 
O  Линия передача с большими потерями 
QN  NPN 
QP  PNP 
R  Резистор 
S   Ключ, управляемый напряжением  
T   Линия передачи без потерь 
U  RC линия с потерями 
V  Независимый источник напряжения 
W  Ключ, управляемый током  
X  Макромодель 
ZN  NMES 
ZP  PMES 



Analog 
Это контрольное окно идентифицирует устройство, которое может быть использовано в CircuitMaker в 

аналоговом имитационном способе. Аналоговый имитатор может имитировать устройство, если есть Spice 
имитационные данные для этого устройства. При попытке запуска аналогового моделирования с использова-
нием устройства с неотмеченным Analog контрольным окном, CircuitMaker отображает предупреждающее 
сообщение, что устройство будет проигнорировано в моделировании. При создании своих собственных уст-
ройств, это окно должно отмечаться, если используются Spice данные в устройстве или устройство является 
макромоделью, содержащей другие аналоговые устройства. 

 
Digital 
Это контрольное окно идентифицирует устройство, которое может быть использовано в цифровом ими-

тационном способе CircuitMaker. Цифровой имитатор может имитировать устройство, только если есть циф-
ровой SimCode для этого устройства. При попытке запускать цифровое моделирование с использованием уст-
ройства с неотмеченным Digital контрольным окном, CircuitMaker отображает предупреждающее сообщение, 
что устройство будет проигнорировано в моделировании. При создании устройств необходимо отметить это 
окно, если устройство является макромоделью содержащей другие цифровые устройства, или созданное уст-
ройство использует цифровой SimCode. 

 
Parameters 
В эту область загружается информация, которая влияет на моделирование определенных устройств. Для 

цифровых устройств эта область должна содержать текст type:digital, который затем следует за списком па-
раметров, которые обычно устанавливаются в Digital Model Parameters диалоговом окне. 

Некоторые общие модели устройств могут быть переопределены подходящими параметрами как псев-
донимами от других устройств. Например, область параметров кристалла должна содержать 
alias:XCRYSTAL, следующий за списком параметров, которые определяют этот специфический кристалл. 
Обычно эти параметры вводятся в Subcircuit Parameters диалоговом окне. 

  
Bus Data 
Эта область используется для определения выводов устройства подключаемых к мощным или зазем-

ляющим силовым цепям, поскольку эти выводы не указываются в цифровых пакетах устройства. Эта область 
может быть полезна при создании устройств с множеством силовых и земляных выводов. Общий формат для 
этих данных: 

bus1=pin#,pin#,…;bus2=pin#,pin#,…; 
Например, данные для 74LS83: 
DVCC=5; DGND=12; 
Это означает, что Vcc цепь связана с выводом 5 этого устройства и Ground цепь подключается к выводу 

12. Данные для 74AC11190 должны выглядеть следующим образом: 
DVCC=15,16; DGND=4,5,6,7; 
Порядок, в котором силовые цепи указаны, не важен. 
Для аналогового моделирования или для создания списка цепей платы, чтобы экспортировать в 

TraxMaker, каждая силовая цепь должна быть подключена к источнику напряжения. Есть три не цифровых 
устройства, которые могут подключаться непосредственно к Bus Data: +V, Terminal и Ground. Bus Data фор-
мат для этих устройств очень простой: 

busname; 
где busname идентифицирует силовую цепь. Каждое Ground устройство, по умолчанию, содержит в 

Bus Data как GND;, что связывает все символы в единый узел или цепь. Для имитационных целей Ground 
устройство всегда приравнивается к Spice узлу 0, даже если были в Bus Data изменения. 

 
Spice Data 
Эта область используется для определения Spice имитационных данных устройства. Аналоговые уст-

ройства, используемые в CircuitMaker, уже имеют по умолчанию подключенные Spice данные. При создании 
собственных устройств, чтобы использовать их в аналоговом моделировании необходимо заполнять самим эту 
область. Знак процентов (%) используется как флаг для сообщения CircuitMaker ссылок на уже определенные 
области. Их значения: 

Имя (%N) 
Включает имя устройства в Spice строку данных. Это имя используется в библиотечных меню. 



Этикетка (%L) 
Включает название устройства в Spice строку данных. Это требует, чтобы  первый символ в строке был 

буквенным символом. Название не может превышать 8 символов. 
Величина (%V) 
Включает величину в Spice строку данных. Это требует, чтобы первый символ в строке был числовым. 

Величина может быть целой (12, -44), с плавающей точкой (3.14159), целой или с плавающей точкой в показа-
тельной форме (1e-14, 2.65e3), целой или с плавающей точкой с использованием множителей: 

 T= 10e12  u= 10e-6 
 G= 10e9  n= 10e-9 
 Meg= 10e6  p= 10e-12 
 K= 10e3  f= 10e-15 
 m= 10e-3 
При использовании множителей они должны следовать за числом без промежутков. Символы, которые - 

не множители, но следующие за числом игнорируются, как и символы, следующие за множителем, также иг-
норируются. Например, 10, 10V, 10Volts, и 10Hz все представляют то же число и M, MA, Msec, и MMhos пред-
ставляют один и тот же множитель.  Отметим, что 1000, 1000.0, 1000Hz, 1e3, 1.0e3, 1KHz, и 1K представляют 
одно и то же число. 

Модель (%M) 
Включает модель устройства в Spice строку данных.  А также флаг %M требуется для того, чтобы га-

рантировать подключение .MODEL данных для этого устройства в Spice список цепей для моделирования. 
Этикетка не может превышать 8 символов. 

Макромодель (%S) 
Включает макромодель в Spice строку данных. Если первый символ на этикетке не X, это включает X в 

начале строки. А также флаг %S требуется для того, чтобы гарантировать подключение .SUBCKT данных для 
этого устройства в Spice список цепей для моделирования. Этикетка не может превышать 8 символов. 

Обозначение (%D) 
Включает этикетку обозначения в Spice строку данных. Если первый символ в обозначении не соответ-

ствует префиксу устройства, тип префикса включается в начале строки. 
Описание (%I) 
Включает область описания в Spice строку данных. 
Корпус (%P) 
Включает этикетку корпуса в Spice строку данных. 
Bus Data (%B) 
Включает область данных силовых шин в Spice строку данных. 
Именованная макромодель (%X) 
Включает определенную макромодель в Spice строку данных. Если макромодель находится в .SUB фай-

ле, то кроме связи с символьным именем текущего устройства, имя файла, где расположена макромодель, 
должно быть также определено. Например: %XUA741 или %XUA741:OPAMP5. 

Подключение файла (%=“path\filename.ext”) 
Включает ASCII текстовый файл filename в Spice строку данных, используя .INCLUDE команду.  
Узел (%number) 
Включает узловой номер для определенного вывода в Spice строку данных. Число имеет отношение к 

позиции вывода в Edit Device Pin Data диалоговом окне.  
 Имя выхода данных анализа (%[ ) 
Определяет узловой номер для выходных данных анализа. Например, %[TP1] или %[+TP1] включает уз-

ловой номер, связанный с положительным выводом выходных данных анализа, который имеет имя TP1. %[-
TP1] включает узловой номер, связанный с отрицательным выводом. 

 
Примеры использования Spice данных 
Следующие примеры показывают, как можно использовать Spice Data область при создании заказных 

устройств. 
1. Если резистор R3 имеет величину 27 Ом и связан с узлом 5 и землёй, Spice данные для R3 могли 

быть записаны следующим образом: 
R3   5   0   27ohms 



Используя универсальную форму Spice данных, может быть автоматическая коррекция при изменении 
обозначения или узловых номеров. Например, пункты в вышеуказанном примере могут заменяться соответст-
венно: 

R3  Обозначение   %D 
5   Первый узловой номер %1 
0   Второй узловой номер  %2 
27ohms  Этикетка величины  %V 
При использовании этой подстановки, универсальная форма Spice Data выглядит так: 
%D %1 %2 %V 

1. Если транзистор Q2 типа 2N3904 коллектором подключен к узлу 7, базой в узел 4 и эмиттером в 
узел 12, Spice данные будут записаны так: 

Q2   7   4   12   Q2N3904 
Возможно, что нужно вводить Spice данные модели в список цепей вручную следующей строкой: 
%D %1 %2 %3 %M 

2. Если ОУ U4 типа LM741 прямым входом подключен к узлу 3, инверсным входом подключен к 
узлу 1, +V вывод к узлу 5, -V вывод к узлу 12 и выход к узлу 9, Spice данные могут быть записа-
ны так: 

XU4   3   1   5   12   9   XLM741 
Более универсальный метод вводить данные следующей строкой: 
%D %1 %2 %3 %4 %5 %S 

3. Бывает необходимость добавить что-либо к цепи для имитационных целей, но без отображения 
на схеме. Например, в индуктивности требуется учесть его внутреннее сопротивления 0.6 Ом 
для моделирования. Список цепей Spice будет выглядеть приблизительно так: 

L3   3   4   1uH 
RL   4   5   0.6 
Если ввести следующие две строки в Spice Data область индуктивности и не нужно будет использовать 

резистор в цепи: 
%D %1 N%D %V 
R%D N%D %2 0.6 
CircuitMaker произведёт Spice список цепей приблизительно так: 
L3 3 NL3 1uH 
RL3 NL3 5 0.6 
Необходимо обратить внимание на использование %D в узловом имени и в обозначении резистора. Это 

позволяет использовать устройство без конфликтов, поскольку каждый будет уникальным. 
 
Exclude From PCB 
Использование этого контрольного окна исключать устройство из списка цепей для печатной платы. 

Обычно это относится к устройствам, используемым только для имитационных целей. 
 
Exclude From Parts 
Использование этого контрольного окна исключает устройство из материального списка. 
 
Pins 
Нажать Pins кнопку в Edit Device Data диалоговом окне, чтобы отобразить другое диалоговое окно. Это 

диалоговое окно позволяет редактировать обозначения выводов для выбранного устройства и определять их 
видимость на схеме. Здесь можно определять номера выводов, которые могут содержать до пяти текстовых 
символов, можно использовать как стандартные номера, например, 1, 2, 3, но и сочетать их с буквенными 
символами, A1, B1, C1, A2, B2, C2. 

Некоторые корпуса могут содержать несколько устройств, например, устройство 7400 содержит четыре 
однотипных двухвходовых элемента И-НЕ. Каждый элемент имеет различные номера выводов. CircuitMaker 
группирует вместе индивидуальные элементы, чтобы указывать, в который корпус входят элементы. Когда 
устанавливается элемент в цепи, следующие доступные элементы используются из предшествующего корпу-
са. Если элемент уже не доступен из предшествующего корпуса, используется новый корпус. Можно пере-
группировать элементы, если это требуется, используя Edit > Group Items выбор. Каждому элементу в корпу-
се назначается символ (A, B, C, и т.п.) и номера выводов для этих элементов переписываются с этим назначе-
нием. Можно вручную переназначить выводы, используя выбор подходящего элемента. 



По умолчанию данные выводов уже введены для встроенных устройств. Выбор Default Designations 
кнопки восстанавливает номера выводов в значения по умолчанию. 

  
Faults 
Нажатие Faults кнопки отображает Device Faults диалоговое окно, которое позволять добавляете де-

фектные данные к устройству.  
 
Групповое редактирование устройств 
Можно быстро изменить одну из областей для всех выбранных устройств. Из меню правой кнопки на 

одном из выбранных устройств выбрать пункт Selected Device Properties. Выбрать область, которую необхо-
димо отредактировать, затем ввести необходимый текст.  

 
Печать и экспорт схем 
Когда завершается проектирование схемы, её можете напечатать любым принтером, графопостроителем 

или экспортировать в файл для использования в документации, презентации и т.п. 
 
Печать схем 
Чтобы напечатать схему, выбрать пункт File > Print Schematic. Если проект больше чем один лист бу-

маги, он автоматически будет напечатан на нескольких листах бумаги. Чтобы видеть разделители страниц, 
выбрать Options > Schematic и разрешить Show Page Breaks. 

 
Размер бумаги и масштаб печати 
Бумажный размер имеет отношение к физическому размеру бумаги, на которой производится печать. 

Бумажный размер выбирается исключительно принтером. CircuitMaker использует установки принтера, чтобы 
определять позиционирование разделителей страниц. Части схемы, которые находятся в пределах разделите-
лей страниц, будут скорректированы, чтобы помещаться на определённом размере бумаги. 

Масштаб печати имеет отношение к увеличению или уменьшению схемы для печати. Масштаб может 
быть скорректирован от 10% до 1000%. Установка масштаба позволит печатать всю схему на одном листе бу-
маги. Масштаб печати вместе с бумажным размером поможет определить позицию разделителей страниц. 

Масштаб может визуально корректироваться перемещением разделителей страниц мышью, чтобы уста-
навливать часть схемы, которую необходимо поместить на листе бумаги. Чтобы регулировать бумажный раз-
мер: 

1. Выбрать пункт File > Print Setup и нажать Printer кнопку. 
2. Выбрать бумажный размер согласно специфическим возможностям принтера. 

Чтобы регулировать масштаб печати схемы: 
1. Выбрать пункт File > Print Setup пункт и выбрать Fit to Page и схема автоматически масштаби-

руется, чтобы разместиться на одной странице, или выбрать Scale и определить процент необхо-
димого масштабирования. 

 или 
Выбрать Options > Schematic и разрешить Show Page Breaks. Возвратиться к схеме и переме-
щением разделителей страниц определить границы для печати. 

Также доступны различные установки печати, включая цветную печать. Можно также определять печа-
тать цифровых диаграмм, аналоговых графиков, блоков названий, бордюров и сетки. 

  
Экспорт схем как графических объектов 
Можно экспортировать схемы созданные в CircuitMaker для использования их в документации, презен-

тациях и т.п. Можно также сохранять схемы в графических файлах, или копировать и вставлять схемы непо-
средственно в другие программные средства. 

Используя Export Schematic Graphic File опцию можно сохранять схему как Windows Metafile или 
Bitmap. Используя Export Options диалоговое окно необходимо определить формат сохраняемого файла. 
Чтобы экспортировать схему как графический рисунок: 

1. Выбрать пункт File > Export > Schematic Graphic File, определить имя файла для сохранения 
схемы в графическом рисунке, затем выбрать Save. 

 или 
Выбрать Edit > Copy to Clipboard > Schematic, затем открыть другую программу и вставить 
схему непосредственно в документ.  



 

5. Цифровое логическое моделирование 
Одна из наиболее мощных особенностей CircuitMaker это моделирование схем, которое позволяет диаг-

ностировать и производить изменения в проекте прежде, чем будут вкладываться время и деньги в аппаратные 
решения. 

 
Режимы моделирования CircuitMaker 
Система CircuitMaker одна из немногих моделирующих программ предлагающая два различных режима 

моделирования: Analog и Digital. Это дает большую гибкость и контроль над моделированием схемы, и каж-
дый режим имеет свои достоинства в зависимости от типа моделирования. 

Analog Mode - точный, "реальный" режим моделирования, который можно использовать для схем ана-
логового, цифрового и смешанного типа. Этот режим даёт результаты подобные результатам фактического 
макетирования. В этом режиме элементы функционируют точно так же как реальные элементы, а каждые ин-
дивидуальные модели функционируют подобно их реальным практическим прототипам. Например, цифровые 
ИС имеют точные времена задержки распространения сигналов, длительности фронта и среза и т.д. На выво-
дах элементов виден эффект нагрузки на них, и почти все параметры реального элемента приняты во внима-
ние.  

Digital Mode – режим предназначен для чисто цифрового логического моделирования. Этот режим ис-
пользуется только для цифровых схем, и зависит исключительно от логических состояний элементов, которые 
составляют схему. Цифровой режим моделирования принимает во внимание задержки при распространении, 
но они представляют условные единичные задержки вместо фактических задержек при распространении. Ни-
каких источников питания не требуется, и цифровые выходные уровни элементов в этом режиме постоянны. 

Цифровая электроника это обширный мир компьютера. Двоичные  1 и 0 компьютера это фактически вы-
сокие и низкие уровни напряжения крошечных электронных элементов известных как интегральные микро-
схемы. Цифровое логическое моделирование становится относительно простой задачей из-за ограниченного 
числа логических состояний, которые должны быть представлены. Цифровой логический имитатор 
CircuitMaker очень быстр и полностью интерактивен, в нем можно изменять положение выключателей и изме-
нять схему во время выполнения моделирования и немедленно видеть реакцию. 

 
Элементы и моделирование 
CircuitMaker содержит четыре типа элементов, которые могут использоваться в различных режимах мо-

делирования.  
Digital Only     Только цифровой режим моделирования  
Analog Only     Только аналоговый режим моделирования  
Analog/Digital Аналоговый или цифровой режим, большинство элементов относится к 

этой категории 
Schematic Symbol    Нет никаких функциональных возможностей 
Например, любой Digital Only и Analog/Digital элементы будет функционировать должным образом в 

цифровом режиме. При попытке моделировать элемент, который для этого не предназначен, CircuitMaker ото-
бражает предупреждающее сообщение и игнорирует элемент, удаляя его из цепи и оставляя ее разомкнутой 
там, где этот элемент расположен. 

 
Использование цифрового моделирования 
Цифровое моделирование полностью интерактивно, т.е. схема реагирует немедленно на изменения 

входного задающего сигнала, а работа схемы показывается в реальном времени, поскольку воспроизводится 
на экране. Можно наблюдать работу схемы следующими способами: 

 Разрешить CircuitMaker исключительную особенность Trace отображающую пошаговое состоя-
ние каждого узла в схеме при моделировании. В этом режиме, провода в состоянии логической 
единицы показываются красным цветом, провода в состоянии логического нуля - синим, а про-
вода в неизвестном или с тремя состояниями – зеленым, эти цвета могут быть изменены в диало-
говом окне Schematic Options. 

 Подключить любое число элементов Scope [Instruments/Digital/SCOPE] (T) к любым узлам в 
схеме так, чтобы временные диаграммы для тех узлов отображались в цифровом окне анализа. 



Информация отбирается и модифицируется непрерывно, чтобы показать изменения в реальном 
времени. 

 Подключить любой из разнообразных дисплеев и наблюдать состояния, отображаемые на них. 
 Использовать Probe Tool, чтобы зондировать любой провод в схеме или в течение моделирова-

ния или после его остановки. Логические состояния, измеренные Probe Tool, могут также ото-
бражаться на диаграмме в цифровом окне анализа. 

 
Инструментальные средства цифрового моделирования 
Несколько кнопок в инструментальной панели используются для моделирования. Этот раздел описывает 

эти инструментальные средства. 
Замечание: Эти кнопки несколько отличаются от кнопок в аналоговом режиме моделирования. 
  
Пробник 
Инструмент Probe Tool используется для контроля логического состояния любого узла в схеме или для 

ввода логического состояния в узел. Можно также инициировать Probe Tool из меню правой кнопки мыши. 
Видеть состояние узла во время моделирования или после остановки, можно прикасаясь наконечником 

Probe Tool к выводу элемента или к проводу. Инструмент отображает одно из четырех сообщений: H, L, P 
или ничего. Выбрать Simulation > Active Probe заранее, чтобы CircuitMaker помещал диаграммы в окно ана-
лиза, которые просматривают с Probe Tool. Чтобы ввести состояние в узел: 

1. Коснуться наконечником Probe Tool вывода элемента или провода. 
2. Щёлкнуть левой кнопкой мыши. 

Логическое состояние узла изменяется на противоположное состояние, единица становится нулем, а 
ноль становится единицей.  Чтобы ввести сигнал с третьим состоянием: 

1. Удерживая клавишу SHIFT и щёлкнуть левой кнопкой мыши в нужный узел. 
Замечание: В обоих случаях, если узел управляется каким либо другим элементом, изменение состояния 

немедленно отменяется, потому что элемент, управляющий узлом, возвращает его назад к первоначальному 
состоянию. 

Можно также использовать Probe Tool для переключения выключателей во время выполнения модели-
рования. 

 
Кнопка Reset  
Щелчок кнопкой Reset перезапускает моделирование, можно также сбрасывать выбором Simulation > 

Reset или нажатием Ctrl+Q. 
 
Кнопка Trace 
Щелчок кнопкой Trace или F11 включает или отключает эту функцию. Использование Trace поможет 

отладить схему и просто удобно для наблюдения за работы схемы. Trace показывает состояние всех узлов в 
схеме, поскольку провода окрашиваются в различные цвета, чтобы показать логическое состояние каждого 
провода. Провод с высоким состоянием красный, провод с низким состоянием синий и провод с третьим со-
стоянием зелёный. 

  
Кнопка Run/Pause 
Щелчок кнопкой Run запустит моделирование, значок изменится на значок Pause. Щелчок кнопкой 

Pause остановит моделирование, можно также выбрать Simulation > Run и Simulation > Pause или нажать 
F10. Когда выполняется моделирование, нельзя исполнять операции редактирования типа перемещения, 
CircuitMaker выдаст предупреждающий звуковой сигнал. Можно переходить с Arrow на Probe Tool и про-
сматривать или переключать состояние проводов. 

 
Кнопка Step 
Щёлкая кнопку Step можно выполнять пошаговое моделирование или моделирование по "импульсам 

синхронизации". Этот режим можно также выбрать пунктом Simulation > Step или нажать F9. Использование 
вкладки Digital в Panel позволит управлять размером шага. При нажатии этой кнопку моделирование выпол-
няется на один шаг и затем останавливается. Эта команда удобна для отладки схемы, особенно когда исполь-
зуется вместе с кнопкой Trace. 

Кнопки Tile Windows 



Окна схемы и цифровых графиков могут представляться в одном из четырех видов. В цифровом режиме 
моделирование не должно быть бегущим, чтобы просмотреть окно анализа. Цифровые графики описаны под-
робно позже в этой главе. 

 
Задержки при распространении 
Задержка элемента определяет, сколько импульсов сигнала времени при моделировании проходит для 

распространения сигнала от входа до выхода элемента. Импульс сигнала времени - самый маленький модуль 
задержки для цифрового имитатора. Требуется один импульс сигнала времени, чтобы исполнить единствен-
ный шаг моделирования для всех элементов. 

Заданная по умолчанию задержка для всех элементов - 1, но можно изменять её на любую величину от 1 
до 14, определяя в реальном времени величину каждого импульса сигнала времени. Если один элемент имеет 
задержку 1, а другой задержку 3, то реально второй элемент имел бы задержку при распространении в три раза 
большую, чем первый элемент. Чтобы изменить задержку одного или более элементов: 

1. Выбирать элемент. 
2. Выбирать пункт Edit > Set Prop Delays, чтобы открыть диалоговое окно. 
3. Ввести новое значение задержки и выбрать OK. 

Выбрать пункт Options > Schematic и разрешить Show Prop Delays, чтобы отображать задержку при 
распространении для всех элементов в схеме. Значения задержек отображаются в пределах округленного пря-
моугольника, расположенного около центра каждого элемента. Некоторые элементы (Pulsers, Logic Displays, 
macro устройства, и т.д.) не имеют задержки, так что никакого значения не будет показано. В случае macro 
устройств, задержка определяется индивидуальной установкой задержки каждого элемента в пределах макро-
модели. 

Предостережение: Если источником входного сигнала являются Pulser или Data sequencer не нужно де-
лать его длительность меньше, чем наибольшая задержка, иначе можно получить непредсказуемый результат. 

 
Цифровые графики 
Подключая устройства scope [Instruments/Digital/SCOPE] (T) к точкам, представляющим интерес в схе-

ме, можно чертить графики состояния этих узлов пока выполняется моделирование. Щёлкнуть одну из кнопок 
Tile Windows в инструментальной панели, чтобы выделить или скрыть цифровое окно анализа. 

Прежде, чем просматривать временные графики любого узла схемы, необходимо подключить scope к 
узлам, которые необходимо контролировать, или выбрать Simulation > Active Probe, чтобы контролировать 
состояние с помощью Probe Tool в окне анализа. 

 
Изменение порядка графиков 
Чтобы изменять порядок графиков: 

1. Указать мышью любую метку scope в окне графиков. 
2. Нажать и удерживать левую кнопку мыши. 
3. Переместить прямоугольник в желаемое положение. 
4. Отпустить кнопку мыши. 

Все графики автоматически перестраиваются в окне. Повторять этот процесс можно сколь угодно часто, 
чтобы располагать графики в любом порядке. При сохранении схемы CircuitMaker также сохраняет и порядок 
графиков. 

 
Digital опции  
Используя вкладку Digital в Panel можно управлять размером шага при выполнении моделирования в 

шаговом режиме, устанавливать масштаб по X, скорость моделирования и состояния для точек останова.  
Можно определять Step Size или в импульсах сигнала времени или циклах. Цикл всегда составляет 10 

импульсов сигнала времени. Импульс сигнала времени - самый маленький модуль задержки для цифрового 
имитатора. Требуется один импульс сигнала времени, чтобы исполнить единственный шаг моделирования для 
всех элементов. 

При необходимости можно корректировать X Magnification, чтобы просмотреть большую или меньшую 
часть графиков в окне. По умолчанию, установлено увеличение 8. Меньше значение, дает изображение мел-
ким планом, большее значение дает изображение крупным планом. 

Использование Simulation Speed управляет  скоростью моделирования. Это может быть полезно, на-
пример, если моделирование выполняется слишком быстро, чтобы просмотреть состояние семисегментного 
дисплея. Установка в этом поле более низкого числа замедляет моделирование, так что можно просмотреть 



все изменения на дисплее. Другой метод замедления моделирования состоит в том, чтобы выполнить его в ша-
говом режиме. 

Использование в Breakpoint логического умножения опций Туре и Condition, позволяет установить 
комбинированные точки останова. Следующая таблица поясняет исход различных комбинаций параметров 
настройки. 

Level-And   Все условия останова должны быть выполнены перед остановкой моделирования. 
Level-Or   Любое из условий останавливает моделирование. 
Edge-And  Моделирование останавливается, когда соответствующие  условия происходят одно-

временно во всех установленных эпюрах. 
Edge-Or  Моделирование останавливается, если происходит любое из установленных состояний. 
 
Установка Breakpoints в схеме 
Используя переключатели контрольных точек в цифровом окне графиков, позволит установить кон-

трольные точки в схеме. Чтобы установить контрольную точку: 
1. Щёлкнуть однажды в малом флажке контрольной точки налево от метки в окне анализа, чтобы 

заполнить нижнюю часть площадки, указывающей останов при низком состоянии. 
2. Щёлкнуть второй раз, чтобы заполнить верхнюю часть площадки, указывающей останов при вы-

соком уровне. 
3. Щёлкнуть третий раз, чтобы очистить площадку и запретить останов. 
 

Приборы Digital 
Эта секция представляет два цифровых прибора: Pulser и Data Sequencer. 
 
Pulser 
Устройство Pulser [Instruments/Digital] (p) это цифровой генератор импульсов, который обеспечивает 

непрерывный поток высоких и низких логических уровней. В формате импульса, время высокого и низкого 
уровня индивидуально программируется для каждого Pulser в схеме. Для редактирования параметров на-
стройки: 

1. Дважды щёлкнуть Pulser с Arrow Tool средством, чтобы отобразить диалоговое окно. 
2. Изменить число импульсов сигнала времени моделирования, которые определяют длительность 

импульсов высокого и низкого уровней, формат импульсов нормальный или инвертированный, и 
находится ли импульсный генератор в режиме самогенерации или в режиме триггера с внешним 
запуском. 

Предостережение: Параметры настройки Pulse High и Pulse Low должны быть установлены больше чем 
самая длинная задержка в устройствах, иначе можно получить непредсказуемые результаты.  

3. Выбрать External Trigger, чтобы использовать Pulser как программируемый одновибратор. 
В режиме External Trigger, вводы CP1 и CP2 используются как установка и сброс вводов триггера соот-

ветственно. Если любой вывод получает импульс, тогда выходы Pulser будут активными на время Pulse High. 
Затем происходит сброс и ожидание следующего запускающего импульса на входе. 

 
Data Sequencer 
Устройство Data Sequencer [.General/Instruments/Data Seq] (G) можно использовать в цифровом и анало-

говом режиме моделирования для непрерывных процессов. Известный как генератор данных или слов, он по-
зволяет определять до 32767 восьмибитных слов, которые могут выводиться в определенной последователь-
ности. Так как нет ограничения количества Data Sequencers в схеме, можно размещать несколько в параллель, 
чтобы создать поток данных любой ширины. Дважды щёлкнуть в Data Sequencer с Arrow Tool, чтобы ото-
бразить диалоговое окно. 

Start Address определяет начальный адрес данных, которые выводятся первыми в начале моделирова-
ния. Stop Address определяет адрес данных, которые выводятся последние перед повторением последователь-
ности. Использование Use External Clock определяет  работу Data Sequencer с внешней синхронизацией по 
входам CP1 и CP2.  

Опция Present Address указывает адрес данных, которые выводятся в случае, если схема не сброшена. 
Tick Increment определяет, сколько импульсов сигналов времени моделирования происходят прежде, чем 
произойдёт переход к следующему адресу, когда внешняя синхронизация заблокирована. 

В режиме аналогового моделирования Low Level и High Level указывают уровни выходного напряже-
ния. Step Time определяет длительность удержания данных каждого адреса, когда внешняя синхронизация 



заблокирована. Clock VTH определяет уровень порогового напряжения внешней синхронизации для перехода 
к следующему адресу. 

Редактор данных 
Можно вносить данные прямо в список Data в диалоговом окне Data Sequencer. Однако при создании 

большой модели этот метод занимает много времени. Выбрать кнопку Pattern в диалоговом окне Data 
Sequencer. Редактор Pattern поможет быстро создать большие, комплексные модели. 

 
6. Моделирование аналоговых и смешанных сигналов 
CircuitMaker дает большую гибкость и контроль над моделированием схемы, и каждый режим имеет 

преимущества в зависимости от набора возможностей. 
Система даёт точный, "реальный" режим моделирования, который можно использовать для схем анало-

говых, цифровых и смешанных сигналов. В режиме Analog функционирование устройств точно такое же, как 
в реальных компонентах. Смешанное моделирование CircuitMaker использует расширенную версию Беркли 
SPICE 3F5, позволяя точно моделировать любую комбинацию аналоговых и цифровых устройств без ручного 
включения D/A или A/D преобразователей. CircuitMaker включает точные, управляемые событиями поведен-
ческие модели для цифровых устройств, включая ТТЛ и CMOS цифровые устройства. 

Чтобы делать моделирование непрерывных процессов пользователь должен гарантировать, что исполь-
зуется Spice информация для каждого устройства в схеме. Флажок Analog в диалоговом окне Device 
Properties указывает, действительно ли то устройство будет функционировать в режиме моделирования 
Analog. Иначе появляется предупреждение и устройство игнорируется. 

 
Инструментальные средства 
Несколько кнопок в инструментальной панели используются определенно для аналогового моделирова-

ния. Этот раздел описывает эти инструментальные средства. 
  
Probe Tool  
Контекстно-зависимый инструмент Probe Tool позволяет быстро зондировать любую точку в схеме в 

течение моделирования и видеть текущую форму сигнала или данные в окне анализа. Средство Probe Tool 
используется несколько по-другому в режиме Analog, чем в режиме Digital. 

Перед выполнением моделирования, можно щелчком левой кнопки инструмента Probe в схеме добав-
лять или удалять точки теста. Однако не обязательно предопределять контрольные точки перед выполнением 
моделирования в CircuitMaker.  

В течение моделирования касание наконечником Probe Tool к проводу, выводу элемента или телу эле-
мента, позволяет определять данные в той точке. Инструмент отображает один из шести символов: V, I, P, Z, 
N или R. Нажатие левой кнопки мыши, когда Probe Tool находится в нужной точке схемы, значение или фор-
ма сигнала немедленно отображается в окне анализа. Чтобы видеть одновременно сигналы нескольких точек, 
необходимо использовать Probe Tool, придерживая Shift клавишу. 

Замечание: Если CircuitMaker указывает, что измерение тока или мощности не доступны, остановить 
моделирование и в окне Analyses Setup нажать кнопку Analog Options, и выбрать пункт Device Current and 
Power и повторно запустить моделирование. 

 
Кнопка Reset 
В режиме Analog, нажатие кнопки Reset сбрасывает моделирование и генерирует номера узлов схемы 

без выполнения моделирования. Это важно, если необходимо сохранить таблицу соединений Spice или про-
сматривать узловые номера на схеме, не выполняя моделирование. Можно также сбрасывать моделирование 
выбором пункта Simulation > Reset, или нажимая Ctrl+Q. 

 
Кнопка Run/Abort/Stop 
Нажатие кнопки Run запустит моделирование, значок на кнопке временно изменится на квадрат Abort. 

Кнопкой Abort можно остановить моделирование, не теряя данные, которые уже были собраны до точки ос-
танова. Когда процесс моделирования закончен, значок изменяется на круглую кнопку Stop. Нажатие кнопки 
Stop закрывает окно анализа и возвращает в режим редактирования схемы. Можно зондировать схему в любое 
время в течение или после моделирования, пока не возвратились к режиму редактирования. Количество вре-
мени, которое требуется для завершения процесса моделирования, основано на выборе количества данных, 
сложности схемы и скорости компьютера. 



Замечание: Если не было сделано никаких изменений в схеме после моделирования, повторное нажатие 
кнопки Run не будет запускать моделирование, но немедленно загрузит данные предыдущего моделирования. 

 
Кнопки Tile Windows 
Определяют не перекрывающее расположение схемы и окна анализа в одном из четырех вариантов обо-

зрений. Если моделирование остановлено, но не было сброшено, и схема не изменялась после последнего мо-
делирования, щелчок одной из этих кнопок немедленно загрузит предыдущие данные моделирования. 

 
Работа с контрольными точками 
Контрольные точки устанавливаются на схеме для собора данных моделирования. Совсем не обязатель-

но вручную устанавливать контрольные точки перед выполнением моделирования. Контрольные точки опре-
деляют, какие данные должны сохраняться, какие переменные должны отображаться в окне анализа, когда 
выполняется моделирование. Большое количество контрольных точек требует более длительного времени мо-
делирования. 

 
Контрольные точки по умолчанию  
CircuitMaker автоматически размещает заданные по умолчанию контрольные точки в схеме, позволяя 

нажатием Probe Tool на любой провод, вывод или элемент измерять напряжение, ток или мощность. Заданные 
по умолчанию контрольные точки устанавливаются в разделе Collect Data For диалогового окна Analog 
Options. Чем больше выбирается количество данных, тем большее количество контрольных точек и памяти 
будет требоваться. При выборе опции Run-Time Test Points Only, все другие контрольные точки будут забло-
кированы, собор данных будет только для тех точек, которые были определены. Заданные по умолчанию кон-
трольные точки не отображаются на схеме. 

 
Run-Time Test Points 
Этот режим полезен при очень сложных схемах или большом количестве данных, что позволяет сокра-

тить количество данных, а соответственно увеличить скорость моделирования. Эти точки можно определять 
на схеме, CircuitMaker автоматически отобразит графические данные, которые будут собраны в течение моде-
лирования. Их можно использовать для измерения напряжения, тока или рассеиваемой мощности. Можно 
также составлять графики сигналов, просто нажимая средством Probe Tool после того, как моделирование за-
кончено. 

Можно размещать Run-Time Test Points на проводах, чтобы измерять узловые напряжения, на выводах 
элементов, чтобы измерить ток или на элементах непосредственно, чтобы измерить рассеиваемую мощность. 
CircuitMaker не отображает сигналов для некоторых элементов, типа макромоделей. Для размещения Run-
Time Test Points на схеме: 

1. Остановить моделирование. 
2. Выбрать средство Probe Tool в инструментальной панели. 
3. Нажать в нужное место на схеме, используя левую кнопку мыши. 

Для добавления нескольких Run-Time Test Points: 
1. Удерживать клавишу SHIFT при щелчке средством Probe Tool. 

Для удаления всех Run-Time Test Points на схеме: 
1. Щелчок левой кнопкой средством Probe Tool в свободной области схемы. 
 

Выполнение моделирования 
Как только была создана схема, можно выполнять моделирование, просто щёлкнув кнопку Run на инст-

рументальной панели. Одно из преимуществ CircuitMaker над другими Spice имитаторами, полное интегриро-
вание между проектом описания схемы и процессом моделирования. Нет никаких комплексных полей для 
ввода данных, все делается быстро и эффективно в одном рабочем пространстве. 

 
Использование окна анализа 
CircuitMaker отображает данные и формы сигналов в окне анализа, которое позволяет быстро и легко 

проверять, анализировать и зондировать схему в течение моделирования. Множество атрибутов окна анализа 
могут быть изменяться по усмотрению пользователя. Есть также возможность производить точное измерение 
формы просматриваемых сигналов. 



Когда выполняется моделирование, CircuitMaker отображает отдельную позицию в окне анализа для ка-
ждого вида исследований: 

 DC Sweep 
 Анализ AC  
 Transient Analysis  
 Fourier Analysis  
 Operating Point  
 

Отображение формы сигналов 
После выполнения моделирования, можно быстро просматривать данные в любой точке схемы, исполь-

зуя контекстно-зависимый инструмент Probe Tool. Для вывода графиков данных в окне анализа, сначала не-
обходимо нажать внизу на соответствующую вкладку, и затем: 

1. Нажать в любую допустимую точку на схеме наконечником Probe Tool.  
 Щелчок на проводе измеряет напряжение 
 Щелчок на выводе элемента измеряет ток 
 Щелчок на теле элемента измеряет мощность 

2. Если CircuitMaker указывает, что текущие данные не доступны, нажать кнопку Analyses Setup в 
инструментальной панели, затем нажмите кнопку Analog Options. Выбрать нужные кнопки 
Node Voltage, Supply Current или Device Current and Power, и повторно запустить моделиро-
вание. 

3. Удержание клавиши SHIFT и щелчок в нужных точках схемы,  выводит одновременно графики 
множества сигналов в окне анализа. 

  
Выбор Single Cell или All Cells 
Закладка Panel включает пару кнопок, которые позволяют выбрать между единственным представлени-

ем Single Cell  или групповым представлением All Cells графиков сигналов. Выбрать Single Cell, чтобы про-
сматривать данные одного графика в окне. В этом представлении все сигналы имеют один масштаб, но могут 
масштабироваться независимо.  

Представление All Cells отображает множество данных, которые могут содержать один или более сиг-
налов. Ось Y всегда масштабируется автоматически. В All Cells просматривают, зондируя форму сигнала в 
выбранную клетке или ячейке, или в клетке, которая имеет выбранную форму сигнала. Нажать на волновую 
метку, чтобы выбрать форму сигнала, нажать на тело клетки, чтобы выбрать клетку. Выбранная клетка или 
ячейка будет подсвечена полужирным прямоугольником вокруг левого поля той клетки. Если нет никакого 
сигнала или выбранной клетки или ячейки, новые сигналы входят в новую клетку ниже всех существующих 
ячеек. 

Можно перемещать сигналы из одной ячейки в другую перемещением волновой метки слева. Щелчок 
правой кнопкой мыши на волновой метке позволяет удалить сигнал, изменять его цвет и т.д.  Можно также 
щёлкнуть правой кнопкой мыши на теле ячейки и выбирать Insert Cell, чтобы вставить новую ячейку выше 
выбранной клетки.  

Размер клеток может изменяться перемещением границ ячейки. Чтобы изменить размер всех клеток, 
выбрать пункт Wave > Preferences, и ввести желаемую высоту матрицы в пикселях. Если необходимо чтобы 
установленная высота матрицы стала новым значением по умолчанию, отметить Save current settings as 
defaults и нажать OK. 

Если выбрано представление Single Cell, то будет  отображён сигнал только выбранной клетки. Если 
есть другие сигналы доступные в других клетках, то можно их просматривать, щелкая стрелки "вверх" или 
"вниз" в Panel.  

 
Математическая обработка сигналов 
Есть возможность генерировать новые формы сигналов на основе полученных данных моделирования, 

используя список доступных математических функций и операторов. После выполнения моделирования вы-
брать пункт Wave > Math, затем ввести выражение в соответствующее окно. Можно напечатать выражение 
полностью или сформировать выражение, нажимая на нужные пункты в доступных списках Waveforms и 
Functions.  

 
 



Функции и операторы 
Выражения могут быть основаны на любой доступной форме сигналов с использованием списка опера-

торов и функций: 
 ()    Индикаторы приоритета операций. 
+     Операция сложения. 
-      Операция вычитания. 
*     Операция умножения. 
/      Операция деления. 
^    Операция возведения в степень, например y^x, аналогична PWR (,).  
ABS ()     Функция абсолютного значения. ABS (x) возвращений значение |x |.   
ACOS ()     Функция арккосинуса. 
ACOSH ()    Гиперболическая функция арккосинуса. 
ASIN ()     Функция арксинуса. 
ASINH ()    Гиперболическая функция арксинуса. 
ATAN ()    Функция арктангенса. 
ATANH ()    Гиперболическая функция арктангенса. 
AVG ()    Функция усреднения данных. 
BOOL (,)   Булева функция.  
COS ()     Функция косинуса. 
COSH ()    Гиперболическая функция косинуса. 
DER ()     Производная функция dx/dt. Возвращает наклон между пунктами данных. 
EXP ()     Показательная функция EXP (x). 
INT ()     Целая функция. 
LN ()     Функция логарифма натурального, где LN (e) = 1. 
LOG10 ()    Функция логарифма по основанию 10. 
LOG2 ()     Функция логарифма по основанию 2. 
PWR (,)    Степенная функция. PWR (y, x) возвращает значение y в степени x. 
RMS ()    Среднеквадратичная функция.  
SIN ()     Функция синуса. 
SINH ()     Гиперболическая функция синуса. 
SQRT ()     Функция квадратного корня. 
TAN ()     Функция тангенса. 
TANH ()    Гиперболическая функция тангенса. 
UNARY ()    Функция отрицания. UNARY (x) возвращений -x. 
URAMP ()   Функция возвращает x, если х>0, иначе 0.  
USTEP ()   Ступенчатая функция.  
 
Масштабирование и смещение сигналов  
В режиме просмотра Single Cell, сигналы могут масштабироваться вручную или автоматически. Средст-

во управления масштабированием X и Y осей, расположены на Panel. Операции масштабирования по оси Y 
применяются только для сигнала выбранной формы. Но если нет выбранного сигнала, то операции масштаби-
рования оси Y относятся ко всем сигналам. Можно выбирать сигнал, нажимая на ее волновую метку, которая 
отображается на левой стороне графика. На графике отображаемая ось Y принадлежит только выбранному 
сигналу. Если нет выбранного сигнала, то ось Y общая для всех сигналов. Если нет общей оси, значения оси Y 
не отображаются, но размер раздела и нижний уровень для каждого сигнала отмечен с правой стороны графи-
ка. Ось X всегда общая для всех сигналов. 

При исследовании CircuitMaker автоматически масштабирует ось Y, для этого нажать кнопку AutoY на 
Panel. В любое время можно добавлять или удалять сигналы, ось Y будет автоматически масштабироваться, 
чтобы все сигналы совместно использовали общий Y масштаб.  

Выполнение операций масштабирования изменением масштаба изображения возможно при выключении 
режима AutoY. Когда масштабирование Auto Y выключено, можно нажать кнопку FitY, чтобы масштабиро-
вать ось Y. Если есть выбранный сигнал, то операция FitY применяется только для этого сигнала. Для авто 
масштабирования всех сигналов на общей оси Y: 

1. Нажать кнопку AutoY в Panel. 
Для ручного масштабирования или смещения индивидуального сигнала: 

1. Выбрать сигнал, нажимая на ее волновую метку слева от графика. 



2. Откорректировать масштаб средством управления X Division, Y Division и Y Offset в Panel. 
Для ручного масштабирования или смещения всех сигналов на общей оси Y: 

1. Убедиться, что нет выбранных сигналов. 
2. Откорректировать X Division, Y Division и Y Offset. 

Для авто масштабирования по X и Y осям: 
1. Выбрать Wave > Fit Waveforms. 

  или 
Из меню правой кнопкой мыши выбрать пункт Fit Waveforms.  

 
Панорамирование и масштабирование изображения  
Есть разные способы оптимизации вида в окне анализа графиков сигналов. Окно анализа может рас-

сматриваться как отдельное окно, или совместно со схемой горизонтально или вертикально. Имеются кнопки 
на инструментальной панели, чтобы выбрать один из этих видов. Можно использовать область разделителей 
между Panel, окном схемы и окном анализа, чтобы изменять размеры соответствующих областей. 

Можно мышью создать прямоугольную область на графике, чтобы раскрыть её на всё окно анализа. А 
также щёлкнуть правой кнопкой мыши на графике и выбрать Zoom in или Zoom out пункты меню. Можно 
также использовать вертикальные и горизонтальные полосы прокрутки для панорамирования вокруг графика. 

 
Опции масштабирования AC анализа 
Для AC анализа можно корректировать ось X, которая будет отображена в линейном или логарифмиче-

ском масштабе. Можно также выбирать разнообразные Y оси и даже отображать данные относительно двух 
различных Y осей, типа величины и фазы одновременно.  

Даже если две Y оси отображены одновременно, только одна может быть активной. Черная стрелка сле-
ва от графика указывает на активную ось. Курсоры измерения и операции масштабирования, типа смещения 
или размера Y обращаются к активной оси. Операции оси X всегда относятся к обеим графикам, так как ось X 
всегда общая. Доступные величины Y оси включают: реальные, мнимые, амплитуды, амплитуды в децибелах, 
фазы в градусах, фазы в радианах и групповой задержки. Допуск режима двойной оси: 

1. Выбрать вкладку AC Analysis в окне анализа. 
2. Выбрать вид Single Cell в панели. 
3. Выбрать Wave > Scaling. 

  или 
Щёлкнуть правой кнопкой мыши на графике и выбрать Scaling пункт меню. 

4. Выбрать Primary и Secondary Y оси по желанию, или выбрать None, чтобы отключить вторич-
ную ось и нажать OK.  

 
Восстановление установок 
После выполнения моделирования, исследования и конфигурирования графиков, может быть решение 

отредактировать схему и повторно запустить моделирование. Если есть необходимость использовать преды-
дущие установки, отметить опцию Keep last setup для сохранения установок в окне Analyses Setup. Иначе 
использовать опцию Show Run-time test points.  

 
Трэкинг измерительных курсоров 
Два измерительных курсора в окне анализа позволяют точно измерять значения сигналов типа амплиту-

ды и периода. Каждый курсор следит за назначенным ему сигналом. Чтобы назначить сигнал курсору, необ-
ходимо выбрать сигнал в раскрывающемся списке курсора, или щёлкнуть правой кнопкой мыши на метке 
графика. 

Каждый активизированный курсор, имеет вкладку наверху графика. Нажать и перемещать вкладку, что-
бы переместить курсор по оси X. Горизонтальная линия автоматически отслеживает форму сигнала по оси Y. 
Текущие значения X и Y курсора отображаются в панели под списком сигналов курсора. 

Если активизированы оба курсора, то кроме текущих значений курсоров выводится значение Cursor 2 - 
Cursor 1,  которое представляет собой дельту значений курсоров. Если оба курсора назначены на один сигнал, 
то возможно измерение минимума и максимума значений сигнала. Различные опции для одного сигнала вклю-
чают Average, RMS и Frequency измерения. Значения Average и RMS основаны на средних данных между 
курсорами, поэтому для точного измерения, важно измерить хотя бы один законченный период или лучше 
большее количество периодов. Также необходимо убедиться, что форма измеряемого сигнала стабильна меж-
ду курсорами. 



Предпочтения для графиков 
Диалоговое окно Wave Preferences используется, чтобы управлять глобальными и заданными по умол-

чанию видами графиков. Установки могут относиться как к текущему анализу, так и ко всему проекту. Можно 
выбирать и сохранять текущие параметры настройки как настройки по умолчанию для будущих графиков. Для 
использования диалогового окна Wave Preferences: 

1. Выбрать пункт меню Wave > Preferences. 
2. Выбрать желаемые опции и нажать OK. 
 

Выбор и сохранение сигналов 
Формы сигналов могут сохраняться для будущей ссылки или сравнения с другими сигналами после из-

менения схемы. Данные сохраняются в виде текстового файла ASCII, и могут содержать как реальные, так и 
мнимые значения. Для сохранения сигналов: 

1. Щёлкнуть на метке сигнала, чтобы выбрать график. 
2. Выбрать пункт Wave > Store. 
3. Определить название файла, чтобы сохранить сигнал. Каждый сигнал сохраняется в отдельном 

файле. Каждый тип анализа использует различное расширение файла. 
Для повторного вызова сохранённого сигнала и размещения его на графике: 

1. Выбрать пункт Wave > Recall. 
2. Выбрать необходимый файл сигнала в диалоговом окне File Selection и нажать Open. 
3. Чтобы удалить сохранённый сигнала из графика, щёлкнуть правой кнопкой мыши на его волно-

вой метке, и выбрать пункт меню Remove Wave. 
  

Сохранение сигналов как текст 
Формы сигналов могут также экспортироваться для использования в других приложениях. Команда 

Save As Text сохраняет сигнал в текстовом файле ASCII с расширением .txt.  
 
Установки аналогового моделирования 
Мощная возможность моделирования CircuitMaker включает широкое разнообразие стандартных видов 

исследований. Нажать кнопку Analyses Setup в инструментальной панели, чтобы отобразить диалоговое окно 
Analyses Setup. CircuitMaker предлагает следующие стандартные виды моделирования: 

 DC Sweep 
 AC Analysis 
 DC Operating Point 
 Transient Analysis 
 Parameter Sweep 
 Fourier Analysis 
 Transfer Function  
 Noise  
 Temperature Sweep  
 Monte Carlo  
 Impedance Plots  
 

Установки по умолчанию 
Использование Always set defaults for transient and Op analyses переключателя упрощает задачу уста-

новки кратковременных исследований. Для простых DC цепей, которые не содержат никаких генераторов или 
активных составляющих, разрешается только OP анализ. Для более сложных цепей используется Transient 
Analysis, для которого задано по умолчанию точка начала, останова и параметры шага. 

 
 
DC Sweep анализ 
Этот тип анализа исполняет OP анализ в каждом из заданного ряда шагов, определяя кривую DC пере-

дачи устройства. Source Name это название независимого источника электроэнергии, который помещается на 
схеме. Начальное значение, конечное и значения шага определяют диапазон измерения и разрешающую спо-
собность. Первичный источник является основным и обязательным, в то время как вторичный источник явля-
ется дополнительным. Если вторичный источник определен, то первичный источник проходит весь опреде-



лённый для него диапазон для каждого значения вторичного источника. Для установки исполнения DC Sweep 
анализа: 

1. Щёлкнуть на кнопке Analyses Setup в инструментальной панели. 
2. Нажать DC... кнопку, чтобы отобразить диалоговое окно. 
3. Определить параметры настройки, отметить флажок Enabled, и затем нажать OK. 
4. Выполнить моделирование. 

Для примера моделирования можно использовать схему Analog.ckt. Необходимо обратить внимание, что 
ось X представляет напряжение первичного источника, а ось Y представляет напряжение на выходе схемы.  

 
AC анализ 
Анализ AC генерирует выходные данные подобные измерителю АЧХ, вычисляя мало сигнальные пере-

даточные AC переменные в зависимости от частоты. Исполнение начинается с OP анализа, чтобы определить 
режим схемы по постоянному току, затем происходит анализ схемы в определённом частотном диапазоне. 
Вывод результатов мало сигнального AC анализа обычно в виде напряжения. Для установки и исполнения AC 
анализа: 

1. Подключить Signal Generator к схеме как источник AC сигнала. 
2. Дважды нажать в Signal Generator, нажать кнопку Wave и установить опцию Source в разделе 

AC Analysis. 
3. Нажать кнопку Analyses Setup в инструментальной панели. 
4. Нажать кнопку AC, чтобы отобразить диалоговое окно. 

Ввести параметры анализа AC, отметить флажок Enabled, и затем нажать OK. 
Linear – равномерное распределение данных в линейном масштабе. 
Decade – равномерное распределение данных в масштабе log10. 
Octave – равномерно раздельных данных в октавном масштабе log2. 

5. Выполнить моделирование. 
Обратить внимание, что ось X представляет частоту в заданном масштабе. Величина выходного напря-

жения может быть представлена в децибелах.  
Замечание: В AC анализе можно представить графики в виде напряжения, тока источника и выходного 

импеданса, но нельзя выводить графики тока элемента или его мощности. 
 
Operating Point (OP) анализ 
OP анализ генерирует данные, подобные измерению мультиметром. Это определяет DC режим всей 

схемы с замкнутыми катушками индуктивности и отключенными конденсаторами, и осуществляется линеари-
зация режимов для всех нелинейных элементов в схеме. Источники AC сигналов в расчёты не принимаются. 

Анализ OP выполняется автоматически перед каждым другим исследованием, даже если он был забло-
кирован в диалоговом окне Analog Analyses. Однако рекомендуется разрешать эту опцию, если предполагает-
ся использовать Probe Tool как мультиметр, чтобы рассматривать DC, DC AVG или AC RMS значения тока, 
напряжения или мощности. Для установки и исполнения OP анализа: 

1. Нажать кнопку Analyses Setup в инструментальной панели. 
2. Отметить переключатель Enabled рядом с кнопкой Operating Point и нажать OK. 
3. Выполнить моделирование. 
4. Нажать с Probe Tool на точку схемы, где необходимо сделать измерение. 
 

Анализ переходных процессов 
Transient Analysis генерирует выходные данные подобно осциллографу, вычисляя переменные мощно-

сти, напряжения или ток как функции времени в установленном интервале времени. Transient Analysis снача-
ла выполняет OP анализ, чтобы определить режим схемы по постоянному току в начале отсчета времени.  

В интервале времени между нулем и Start Time, XSpice анализирует, но не отображает результатов. В 
интервале времени между Start Time и Stop Time, XSpice анализирует и отображает результаты. Step Time - 
предлагаемый пользователем инкремент времени, хотя временной шаг XSpice будет вычислять автоматиче-
ски, чтобы обеспечить сходимость анализа. Max. Step ограничивает размер шага, который XSpice может ис-
пользовать при вычислении кратковременных данных; по умолчанию, программа выбирает или Step Time или 
(Stop Time - Start Time)/50. Как правило, Step Time и Max. Step должны содержать одно и то же значение.  

Если при анализе необходимо использовать начальные условия, необходимо разрешить UIC опцию. Для 
установки и исполнения Transient Analysis: 

1. Нажать кнопку Analyses Setup в инструментальной панели. 



2. Нажать кнопку Transient/Fourier, чтобы отобразить диалоговое окно. 
3. Ввести Start, Stop, и Step параметры и нажать OK. 

  или 
Ввести Number of Cycles и Points Per Cycle и нажать кнопку Set Default Timing, затем выбрать 
OK.  

Замечание: эта опция может использоваться, только если включено в схему устройство Signal Generator 
или Data Sequencer. При этом необходимо отметить переключатель Always Set Defaults в диалоговом окне 
Analysis Setup. 

4. Выполнить моделирование. 
5. Просмотреть и измерить результаты анализа. 
 

Параметрический анализ  
Анализ Parameter Sweep может использоваться при изменении двух переменных, включая параметры 

транзисторов. Можно изменять только основные компоненты и модели, макромодели не допускают изменение 
параметров. 

Можно использовать анализ Parameter Sweep, когда выбран один из видов стандартных исследований, 
AC, DC Sweep, OP, Transient Analysis и т.д. Анализ изменения параметров требует следующих данных: 
Parameter, Start Value, Stop Value, и Step Value. Parameter может быть единственным обозначением или 
обозначением с параметром элемента в скобках. Вот несколько примеров: 

RF     Сопротивление резистора с обозначением RF 
Q3 [bf]     Бета транзистора Q3 
R3 [r]     Сопротивление потенциометра R3 
R3 [позиция]    Позиция потенциометра R3 
U5 [tp_val]    Задержка распространения в цифровом элементе U5 
Установка и исполнение Parameter Sweep анализа: 

1. Нажать кнопку Analyses Setup в инструментальной панели. 
2. Нажать кнопку Parameter Sweep, чтобы отобразить диалоговое окно. 
3. Ввести желаемые параметры настройки, отметить Enabled, и затем нажать OK. 
4. Выполнить моделирование. 
5. Просмотреть полученные сигналы в окне анализа. 

 
Опция относительных величин 
Это относится к опции Use Relative values в диалоговом окне Parameter Sweep Setup. Например, нужно 

сделать Parameter Sweep анализ со следующими условиями: 
 Parameter резистор 1кОм. 
 Start, Stop и Step поля -50, 50 и 20, соответственно. 
 Допускается опция Use Relative Values. 

При моделировании будут использованы следующие значения сопротивлений резистора: 950, 970, 990, 
1010, 1030, и 1050 Ом. 

 
Метки сигналов 
Для анализа Parameter Sweep CircuitMaker даёт уникальную метку каждому графику сигнала, добавляя 

в конец имени символ p. Если есть также график выполненного моделирования, который был сделан с номи-
нальным значением параметра, то этот символ в конец метки не добавляется. Пример некоторых меток графи-
ков с объяснением: 

U1_6    Напряжение в узле u1_6 при номинальной величине параметра. 
U1_6_p1  Напряжение в узле u1_6 при значении параметра 1. 
U1_6_p2  Напряжение в узле u1_6 при значении параметра 2 
U1_6_p3  Напряжение в узле u1_6 при значении параметра 3 
Можно щёлкнуть правой кнопкой мыши на графике и выбрать пункт Sweep Data, чтобы отобразить 

подробности о значениях параметров компонента, используемого при выполнении моделирования. 
 
Анализ Фурье  
Анализ Fourier генерирует выходные данные подобные анализатору спектра, вычисляя частотные со-

ставляющие выходных переменных. 



Установка Fourier анализа используется совместно с установкой Transient Analysis. Когда моделирова-
ние закончено, Fourier анализ отображается в отдельном окне. Fourier анализ основан на последнем закон-
ченном цикле кратковременных данных. Например, если основная частота - 1.0kHz, то данные последнего 1 
мсек. периода использовались бы для анализа Фурье. Для установки и исполнения Фурье анализа: 

1. Нажать на кнопку Analyses Setup в инструментальной панели. 
2. Нажать кнопку Transient/Fourier, чтобы отобразить диалоговое окно. 
3. Ввести параметры настройки анализа: основную частоту, число гармоник и нажать OK.  
4. Выполнить моделирование. 
5. Просмотреть и измерить результаты в окне анализа. 

Для моделирования и просмотра результатов рекомендуется Bandpass.ckt схема. Здесь можно сделать 
анализ частотного спектра генератора прямоугольных импульсов. Первый пик сигнала соответствует ампли-
туде сигнала основной частоты, амплитуды остальных гармоник распределены в пределах установленного 
диапазона.  

 
Имитатор Spice 
Когда выполняется моделирование, CircuitMaker генерирует таблицу Spice соединений во временном 

файле с расширением .NET, определяя название файла схемы. Spice анализирует таблицу соединений, регист-
рирует и генерирует данные моделирования. Время, требуемое для завершения моделирования, зависит от вы-
бора типов моделирования, сложности схемы и скорости компьютера. Количество собранных данных может 
быть очень большое для комплексного моделирования. Рекомендуется снижать количество данных моделиро-
вания ограничением количества Test Points на схеме.  

 
Предупреждения и сообщения об ошибках 
Иногда CircuitMaker отображает предупреждения или сообщения об ошибках в течение моделирования 

схемы. Эти сообщения сохраняются в текстовом файле с расширением .ERR. Для просмотра этих сообщений 
можно использовать редактор Notepad.  

 
Предупреждающие сообщения 
Предупреждающие сообщения не фатальны для моделирования. Обычно эти сообщения информируют 

об изменениях, которые Spice должен был сделать на схеме, чтобы завершить моделирование. Они обычно 
включают неправильные или отсутствующие параметры, и т.д.  

Замечание: Обычно генерируются правильные результаты моделирования, даже если были предупреж-
дающие сообщения. 

SimCode предупреждения могут включать информацию о нарушении типа выбора времени (tsetup, thold, 
trec, tv и т.д.) или существенных понижениях напряжения источника питания на цифровых компонентах. 

 
Сообщения об ошибках 
Сообщения об ошибках обычно информируют пользователя о том, почему Spice не может произвести 

моделирование. Сообщения об ошибках указывают, что результаты моделирования не могут быть сгенериро-
ваны, что они должны быть исправлены прежде, чем анализировать схему.  

 
Установка Spice переменных 
Spice позволяет управлять некоторыми положениями моделирования типа итеративных пределов, тем-

пературы, и т.д. Нажать кнопку Analyses Setup в инструментальной панели, затем нажать кнопку Analog 
Options, чтобы отобразить диалоговое окно. Чтобы изменять переменные и опции, перечисленные в этом диа-
логовом окне, нужен большой опыт и знания системы Spice. Если такового нет, рекомендуется на первое вре-
мя использовать установки по умолчанию. 

DVCC, DVDD и DGNDD являются шинами электропитания цифровых элементов. Если не определено 
никаких источников в схеме, эти шины будут использоваться по умолчанию. Если введено шинное название 
вместо значения, то шина будет связана с элементами. По умолчанию, DVCC и DVDD = + 5V, DGND = GND.  

 
Метод интегрирования 
Необходимо выбрать численный метод интегрирования, который должен использоваться в XSpice. Ме-

тод Trapezoidal относительно быстрый и точный, но имеет тенденцию колебаться при известных условиях. 
Метод Gear требует более длительного времени моделирования, но более устойчив. Порядок Gear должен 



иметь значение между 2 и 6. Использование более высокого порядка теоретически ведет к более точным ре-
зультатам, но увеличивает время моделирования. По умолчанию используется метод Trapezoidal. 

 
Сбор данных 
Используется пять пунктов для выбора заданий по умолчанию сохранения переменных. От этого зави-

сит, сколько памяти используется, и какие переменные можно выводить на графики в окнах анализа, после 
завершения моделирования. 

Node Voltage and Supply current – позволяет измерять напряжение на проводах и ток источников на-
пряжения. 

Node Voltage, Supply and Device Current – позволяет измерять напряжение на проводах и ток источни-
ков напряжения и выводов компонентов, кроме выводов макромоделей. 

Node Voltage, Supply Current, Device Current and Power – позволяет измерять напряжение на прово-
дах, ток источников напряжения и выводов компонентов и мощность, выделяемую на простых элементах. 

Node Voltage, Supply Current and Subcircuit Variables – позволяет измерять напряжение на проводах, 
ток источников напряжения и внутренние переменные макромоделей. 

Run-TimeTest Points Only – позволяет делать измерения только в назначенных точках теста. 
 
Analog/Mixed инструменты 
Здесь представлено описание инструментов, входящих в библиотеку устройств CircuitMaker, которые 

обычно используются в аналоговых и смешанных схемах. 
 
Универсальный измерительный прибор 
Дополнительно к вкладке Operating Point в окне анализа, CircuitMaker включает элемент комбиниро-

ванного прибора для измерения сопротивления, DC, DC AVG или AC RMS напряжения или тока. Можно раз-
мещать множество комбинированных приборов на схеме, по мере необходимости. При выполнении модели-
рования измеренное значение отображается на измерительном приборе. Необходимо помнить, что при изме-
рении напряжения измерительный прибор подключается параллельно измеряемой схеме; при измерении тока 
подключается последовательно с измеряемой цепью. При измерении сопротивления необходимо удалить лю-
бые источники питания из измеряемой схемы и опасаться повисших элементов, которые могут вызывать 
ошибки XSpice. XSpice видит втекающий ток на вывод элемента как положительный ток. 

Обратите внимание: Чтобы измерить DC AVG или AC RMS, необходимо выполнить моделирование 
Transient Analysis, при этом должно быть выполнено достаточное число циклов переходных данных, чтобы 
сделать измерения значимыми. Аналогично должен быть  разрешён OP анализ, чтобы получать значения DC и 
сопротивления. 

Входное сопротивление вольтметра может быть высокое, а сопротивление амперметра низкое, так что 
он будет иметь минимальную погрешность на процесс измерения. При измерении напряжения на высокоом-
ной схеме желательно увеличить входное сопротивление вольтметра. При измерении тока низкоомной схемы 
желательно уменьшить сопротивление амперметра. При измерении контактного переходного сопротивления, 
желательно увеличить измерительный ток омметра. 

 
Многофункциональный генератор сигналов 
Можно размещать несколько многофункциональных генераторов сигналов на схеме, по мере необходи-

мости. Функции формы сигналов включают: 
 Синусоидальная 
 Одночастотная AM 
 Одночастотная FM 
 Экспоненциальная 
 Импульсная, включая треугольную и пилообразную 
 Кусочно-линейная 

Параметры настройки для каждой из этих функций редактируются через отдельные диалоговые окна, 
которые описаны ниже. 

 
Редактирование генератора сигналов 
После размещения генератора сигналов [.General/Instruments/Signal Gen] (g) на схеме, дважды щёлк-

нуть на нём средством Arrow Tool, чтобы отобразить диалоговое окно, которое имеет следующие пункты: 



Volts / Amps – выбор выхода, который  может быть напряжением или током. 
Properties – отображает диалоговое окно Device Properties. 
Wave – отображает диалоговое окно, где можно определить функцию этого генератора. Чтобы изменить 

функцию сигнала, нажать одну из функциональных клавиш и определить AC параметры. При AC анализе вре-
менно заменяет любые источники синусоидальным сигналом установленной величины и фазы. Флажок 
Source позволяет определять, будет ли этот генератор использоваться как источник AC сигнала в AC анализе. 
Поля редактирования величины и фазы позволяют определять значения, которые будут использоваться в AC 
анализе. 

 
Редактирование синусоидального сигнала 
Нажать кнопку Sine Wave, чтобы отобразить диалоговое окно установки параметров синусоидального 

сигнала.  
DC Offset – используется для установки DC смещения сигнала генератора относительно земли, измеря-

ется в вольтах или амперах. 
Peak Amplitude – максимальная амплитуда выходного сигнала, исключая DC смещение, измеряется в 

вольтах или амперах. 
Frequency – частота выходного сигнала в Герцах. 
Start Delay – изменяет фазу выходного сигнала, задерживая начало синусоиды. 
Damping Factor (theta) – положительное значение приводит к уменьшению амплитуды по экспоненте; 

отрицательное значение приводит к увеличению амплитуды по экспоненте. 
 
Редактирование сигнала с амплитудной модуляцией 
Нажать кнопку AM Signal, чтобы отобразить диалоговое окно установить параметров AM. 
DC Offset – установка DC смещения сигнала генератора относительно земли, измеряется в вольтах или 

амперах. 
Peak Amplitude – максимальная амплитуда выходного сигнала, исключая DC смещение, измеряется в 

вольтах или амперах. 
Carrier Frequency – частота модулируемого выходного сигнала в Герцах. 
Modulation Index – значение индекса  модуляции в процентах от амплитуды. От 1 до 100 %, от 0.5 до 50 

%, и т.д. 
Signal Frequency – частота модуляции в Герцах. 
 
Редактирование сигнала с частотной модуляцией 
Нажать кнопку FM Signal, чтобы отобразить диалоговое окно установить параметров FM. 
Временная диаграмма описывается следующей формулой, где t = текущий момент времени: 
V(t) = VO + VA sin(2πFCt + MDI sin(2πFSt)) 
DC Offset – установка DC смещения сигнала генератора относительно земли, измеряется в вольтах или 

амперах. 
Peak Amplitude – максимальная амплитуда выходного сигнала, исключая DC смещение, измеряется в 

вольтах или амперах. 
Carrier Frequency – частота модулируемого сигнала в Герцах. 
Modulation Index – значение, соответствующее индексу сигнала модуляции, соответствующее уровню 

модуляции. 
Signal Frequency – частота модуляции в Герцах. 
 
Редактирование экспоненциального сигнала 
Нажать кнопку Exponential и используя диалоговое окно установить параметры экспоненциального 

сигнала.  
Initial Amplitude – начальная амплитуда выходного сигнала относительно земли, измеряется в вольтах 

или амперах. 
Pulse Amplitude – максимальная амплитуда выходного сигнала, измеряется в вольтах или амперах. 
Rise Time Delay – время начала выходного сигнала. 
Rise Time Constant – постоянная времени фронта сигнала. 
Fall Time Delay – время спада выходного сигнала. 
Fall Time Constant – постоянная времени спада. 
 



Редактирование импульсного сигнала 
Чтобы устанавливать параметры импульсного сигнала нажать кнопку Pulse, для отображения диалого-

вого окна.   
Initial Amplitude – начальная амплитуда выходного сигнала относительно земли, измеряется в вольтах 

или амперах. 
Pulse Amplitude – максимальная амплитуда выходного сигнала в вольтах или амперах. 
Period (=1/freq) – длительность одного законченного цикла выходного сигнала. 
Pulse Width – длительность импульса. 
Rise Time – время длительности фронта импульса. 
Fall Time – время длительности спада импульса. 
Delay to Start – время задержки импульсного сигнала. 
 
Редактирование кусочно-линейного сигнала 
Нажать кнопку Piece-Wise, чтобы установить параметры кусочно-линейной сигнала. Кусочно-линейные 

данные могут исходить из одного из двух источников:   
1. Можно описывать временную диаграмму сигнала набором до 8 точек, которые вводятся непо-

средственно в диалоговом окне. Время, указанное для каждой последующей точки должно быть 
больше чем её предшествующее значение. Если это не выполнить то цикл закончится, исключая 
все последующие точки. 

2. Можно определять временную диаграмму сигнала в текстовом файле ASCII, содержащем неог-
раниченное число точек. Значения должны вводиться парами, и каждая пара должна включать 
позицию времени, сопровождаемую амплитудой. Первым символом каждой строки данных дол-
жен быть знак "плюс" (+) и каждая строка может содержать максимум 255 символов. Значения 
должны быть отделены одним или более пробелами или табулятором. Значения могут вводиться 
в научной или технической форме. Комментарии могут добавляться к файлу, делая первым сим-
волом строки звездочку (*). Например: 

*Произвольные данные шума 
+ 0.00000e-3  0.6667 0.00781e-3  0.6372 0.01563e-3 -0.1177 
+ 0.02344e-3 -0.6058 0.03125e-3  0.2386 0.03906e-3 -1.1258 
+ 0.04688e-3  1.6164 0.05469e-3 -0.3136 0.06250e-3 -1.0934 
+ 0.07031e-3 -0.1087 0.07813e-3 -0.1990 0.08594e-3 -1.1168 
+ 0.09375e-3  1.4890 0.10156e-3 -0.2169 0.10938e-3 -1.4915 
+ 0.11719e-3  1.4914 0.12500e-3  0.1486 
 
Промежуточные точки определяются линейной интерполяцией. Если определён параметр Max. Amp в 

диалоговом окне, данные в файле будут масштабироваться по вертикали так, чтобы амплитуда полного разма-
ха временной диаграммы была равна указанному параметру в Max. Amp и центрирована относительно нуля. 
Если определён параметр Offset, временная диаграмма сигнала будет смещена по вертикали в указанной вели-
чине. Если определён параметр Max. Time, временная диаграмма будет масштабироваться по горизонтали, 
чтобы соответствовать указанному параметру Max. Time.  

Обратите внимание: .PWL файл должен быть расположен в том же самом каталоге, в котором находится 
моделируемая схема. 

 
Генератор последовательности данных 
Можно использовать этот элемент в цифровых и аналоговых режимах моделирования. Также известный 

как генератор слов или данных, он позволяет определять до 32767  8-битовых слов, которые могут выводиться 
в определенной последовательности. Так как нет ограничения в количестве генераторов на схеме, можно раз-
мещать несколько генераторов в параллель, чтобы создать поток данных любой ширины.  

 
7. Экспорт файлов 
CircuitMaker предлагает большой выбор экспорта данных схемы в любой из следующих типов: 

 Список материалов 
 Данные сигналов как графические файлы  
 Данные сигналов как текстовые ASCII файлы 
 Схемы как графические файлы 



 Spice список цепей 
 Spice макромодели 
 Список цепей для печатной платы 

Этот уровень гибкости позволяет легко внедрять работу сделанную в CircuitMaker в широкий ряд других 
программ редактирования и моделирования схем, и программ создания печатных плат. CircuitMaker полно-
стью интегрирован с программой TraxMaker, поэтому можно экспортировать в TraxMaker список цепей для 
создания печатных плат и также конфигурировать и запускать TraxMaker непосредственно из CircuitMaker. 
Эта глава представляет различные типы выходных файлов и методы работы с ними. 

 
Список материалов 
Список материалов это файл, который содержит информацию о том, сколько и какие типы компонентов 

используются в схеме. Список экспортируется ввиде текстового файла. Чтобы иметь доступ к списку материа-
лов: 

1. Выбрать File > Bill of Materials для отображения диалогового окна. 
2. Определить пути сохранения и формат списка материалов. 

Можно сохранить список материалов в одном из двух форматов: Single Item per line или Multiple items 
per line. 

 
Single Item Per Line 
Этот формат устанавливает каждый компонент в отдельной строке списка материалов. Пункты указаны 

в соответствии с порядком обозначения устройств. Этот формат может легко загружаться в электронную таб-
лицу и затем сортироваться и размещаться в соответствии с предпочтениями. Следующий пример представля-
ет формат списка: 

C:\CM\Circuits\Diffamp.BOM 
Item Label-Value Attributes Designation 
1  1N914  DIODE0.4 D1 
2  1N914  DIODE0.4 D2 
3  2N2222A TO-92  Q1 
4  2N2222A TO-92  Q2 
5  2N2222A TO-92  Q3 
6  3.2k  AXIAL0.4 R1 
7  1.5k  AXIAL0.4 R2 
8  50  AXIAL0.4 RB1 
9  50  AXIAL0.4 RB2 
10 7.75k  AXIAL0.4 RC1 
 
Multiple Items Per Line 
Отличие этого формата в том, что добавлена колонка количества компонентов, и все однотипные ком-

поненты указаны в одной строке списка. Следующий пример показывает особенности формата: 
C:\CM\Circuits\Diffamp.BOM 
Item Quantity Label-Value Attributes  Designations 
1  2  1N914  DIODE0.4  D1,D2 
2  3  2N2222A TO-92   Q1,Q2,Q3 
3  1  3.2k  AXIAL0.4  R1 
4  1  1.5k  AXIAL0.4  R2 
5  2  50  AXIAL0.4  RB1,RB2 
6  2  7.75k  AXIAL0.4  RC1,RC2 
7  1  2.5k  AXIAL0.4  RE 
 
Сохранение, отображение и печать списка материалов 
Чтобы сохранить список материалов в файле: 

1. Ввести желаемый путь и имя выходного файла в Bill of Materials диалоговом окне. 
2. Нажать Save кнопку. 

Для отображения списка материалов: 
1. Нажать Display кнопку. 

 Список материалов появляется в редакторе Notepad. 



2. Выбрать пункт File > Print в редакторе Notepad, чтобы напечатать список. 
 
Ввод атрибутов 
Использование Include Attributes области в Bill of Materials диалоговом окне позволяет вводить пунк-

ты, которые необходимо использовать как вспомогательные колонки в списке материалов. Эти пункты долж-
ны разделяться запятыми, и указаны в порядке появления в списке. Там уже есть два встроенных атрибута: 
package и description. Их можно удалить и ввести свои атрибуты. 

 
Установка параметров экспорта 
Используя Export Options диалоговое окно, определяется формат, используемый для экспорта графики 

схемы в буфер или в файл. Чтобы установить экспортные опции: 
1. Выбрать пункт File > Export > Schematic Options для отображения диалогового окна. 
2. Выбрать On, Off или Simulation в Show LED/LAMP Display State разделе. 
3. Выбрать Color или B/W выходной цвет. 
4. Выбрать экспортный формат:  

Windows Metafile  Формат Windows для векторной графики. 
Device Independent Bitmap Пиксельное представлением графики, которое смотрится хорошо в лю-

бом решении. Не доступно для аналоговых графиков сигналов. 
Device Dependent Bitmap Пиксельное представление графики, которое смотрится хорошо только в 

своем оригинальном решении. Не доступно для аналоговых графиков. 
 
Экспорт графиков сигналов как графических рисунков 
Графики сигналов CircuitMaker можно экспортировать и использовать их в документации, презентации 

и т.п. Можно также сохранять графики сигналов как графические файлы или копировать и вставлять их непо-
средственно в другие программные средства. 

Цифровые логические графики могут сохраняться в Windows Metafile, Device Independent Bitmap и 
Device Dependent Bitmap форматах. Используется Export Options диалоговое окно, чтобы выбрать нужный 
формат. Графики аналоговых и смешанных сигналов сохраняются только в Windows Metafile формате. 

Примечание: CircuitMaker сохраняет только информацию, отображаемую в активном окне анализа. 
Чтобы сохранить графики цифровой логики: 

1. Запустить моделирование, чтобы появились графики в цифровом окне. 
2. Выбрать пункт File > Export > Options и определить нужный формат. 
3. Выбрать пункт File > Export > Waveforms as Graphic, ввести имя файла, затем выбрать Save. 

 или 
Выбрать пункт Edit > Copy to Clipboard > Waveforms, затем открыть другую Windows про-
грамму и вставить график непосредственно в документ.  

Чтобы сохранить аналоговые или смешанные графики сигналов: 
1. Запустить моделирование, чтобы  графики сигналов появились в окне анализа. 
2. Выбрать пункт File > Export > Waveform Metafile, ввести имя файла, затем выбрать Save.  

 или 
Выбрать пункт Edit > Copy to Clipboard > Waveforms, затем открыть другую Windows про-
грамму и вставить графики непосредственно в документ. 

 
Экспорт данных графиков 
Аналоговые данные графиков могут экспортироваться для использования в других приложениях. Со-

храняемые данные имеют формат и описание в виде текстовых файлов ASCII. В зависимости от типа анализа 
и установок данные могут быть не линеаризованы, то есть не могут равномерно располагаться вдоль оси X. 
Чтобы сохранять аналоговые данные в текстовом файле ASCII: 

1. Щёлкнуть этикетку нужного графика для выбора. 
2. Выбрать пункт Wave > Save As Text. Ввести имя файла и нажать Save. 

 
Экспорт схем как графических рисунков 
В CircuitMaker можно экспортировать схемы и использовать их в документации, презентациях и т.п. 

Можно также сохранять схему как графический файл, копируя и вставляя схему непосредственно в другие 
программные средства. Использование Export Schematic as Graphic опции позволяет сохранять схемы как 



Windows Metafile, Device Independent Bitmap или Device Dependent Bitmap. Чтобы экспортировать схему 
как графический рисунок: 

1. Выбрать пункт File > Export > Schematic Options и определить желаемый формат. 
2. Выбрать пункт File > Export > Schematic as Graphic. Ввести имя файла и нажать Save. 

 или 
Выбрать пункт Edit > Copy to Clipboard > Schematic, затем открыть другую Windows програм-
му и вставить рисунок схемы непосредственно в документ. 

 
Экспорт Spice списка цепей 
Spice список цепей предназначен для моделирования. Использование этого выбора позволяет создать 

Spice совместимый текстовый файл, описывающий схему. Можно затем импортировать этот текстовый файл в 
другие Berkeley Spice3 совместимые имитационные программы. 

1. Выбрать пункт File > Export > Spice Netlist. 
2. Определить имя файла с .NET расширением, и выбрать OK. 

 
Экспорт Spice макромоделей 
Использование этой опции позволяет создавать текстовый файл .SUB, описывающий схему макромоде-

ли. Затем можно подключить текстовый файл .SUB к файлу символа устройства. Соединительные устройства 
SCOPE [Instruments/Digital/SCOPE] (T) устанавливаются на схеме, чтобы указывать соединительные узлы 
макромодели. Можно пометить их как TP1 (1-й узел), TP2 (2-й узел), и т.п., или что-нибудь другое, но окан-
чивающее числом (1, 2, 3, и т.п.) до максимального числа 64. Чтобы экспортировать Spice макромодель: 

1. Выбрать пункт File > Export > Spice Subcircuit. 
2. Определить имя файла макромодели с расширением .SUB, затем выбрать OK. 

 
Экспорт PCB списка цепей 
Использование экспортного выбора PCB Netlist позволяет создавать файл списка цепей схемы для пе-

чатной платы. CircuitMaker генерирует PCB список цепей для TraxMaker, Protel, Tango и множества других 
форматов, используемых в производстве печатных плат. 

 
Что такое Net? 
Каждая цепь (Net) представляет одну электрическую соединительную точку или узел. Множество выво-

дов устройств могут быть подключены к одной цепи. 
Что такое Netlist? 
Netlist это текстовый файл ASCII, перечисляющий связи и описывающий цепи компонентных соедине-

ний в электронной схеме. Широко используясь в электронных CAD системах, список цепей  позволяет пере-
давать проектные детали между приложениями, например между CircuitMaker и TraxMaker. Netlists обычно 
содержит два типа информации: 

 Индивидуальное описание компонентов 
 Список всех меж выводных связей 

PCB Netlist в различных форматах обычно содержат аналогичные данные, и часто могут переводиться в 
другой формат использованием текстового редактора. Как простые текстовые файлы ASCII, списки цепей мо-
гут легко просматриваться, создаваться и модифицироваться использованием простого текстового редактора 
как, например Notepad. 

 
Требования к PCB Netlist 
Для того чтобы создавать PCB список цепей схема должна удовлетворить следующие требования: 

 Каждое устройство на схеме должно иметь уникальное обозначение (D1, C3 и т.п.). 
 Каждое устройство должно иметь этикетку величины или названия (10k, 2N2222A и т.п.). 
 Каждое устройство должно иметь назначенный тип корпуса, который должен соответствовать 

одному из доступных в используемой программе разработки печатных плат (DIP14, AXIAL0.4, и 
т.п.). 

 Номера выводов в корпусе должны быть назначены каждому устройству в схеме. 
 Обозначения компонентов и описание типов ограничено 12-ю текстовыми символами. Имена 

цепей могут содержать до 20-и символов.  Номера выводов в списке цепей ограниченные 4-я 
текстовыми символами. Пробелы не допускаются к использованию в пределах этих строк. 



Любое нарушение этих требований выводит сообщение ошибки. 
 
Экспорт PCB Netlist в популярные форматы  
CircuitMaker может экспортировать PCB netlist в следующие форматы: 

 TraxMaker 
 Protel 
 Tango 

Чтобы экспортировать PCB netlist в другие форматы кроме TraxMaker: 
1. Выбрать пункт File > Export > PCB Netlist. 
2. Выбрать нужный формат из списка. 
3. Определить имя файла списка цепей и выбрать Save. 

 
Формат списка цепей TraxMaker 
TraxMaker является мощной программой создания печатных плат и их авто трассировки. Она полностью 

совместима с CircuitMaker, и предназначена для их совместной работы, образуя единую систему сквозного 
проектирования. Следующий пример описывает формат TraxMaker: 

 [   Выделяет начало описания каждого компонента. 
U8  Область обозначения компонентов. 
DIP16  Указывает описание корпуса, типа или образца (Package область). Идентичное описа-

ние требуется в компонентной библиотеке TraxMaker. 
74LS138  Отображает имя компонента или величину. 
Пустая строка Левый пробел для будущей вставки, используются обычно три пустых строки. 
]   Выделяет конец описания компонента. 
(   Выделяет начало каждой цепи. 
NETU5_5 Название цепи. 
U5-5  Отображает номер вывода обозначенного компонента.  Номера выводов в назначенных 

библиотечных компонентах TraxMaker должны им соответствовать. 
U8-3  Указывает другой вывод. 
)   Выделяет конец цепи. 
Необходимо отметить, что описания цепей отличны от описаний компонентов использованием круглых, 

а не квадратных скобок. 
 
Передача схемы в TraxMaker 
Поскольку CircuitMaker и TraxMaker плотно интегрированы для совместной работы, можно автоматиче-

ски экспортировать список цепей, определять рабочую область, управлять размещением компонентов, исполь-
зуя Export PCB Netlist кнопку в CircuitMaker. Чтобы передать схему из CircuitMaker в TraxMaker: 

1. Выбрать пункт File > Export > PCB Netlist или нажать кнопку в инструментарии, чтобы отобра-
зить диалоговое окно. 

2. Выбрать TraxMaker из списка, который выбран по умолчанию. 
3. Определить выбор пунктов описанных ниже. 

Run TraxMaker and Load Netlist – экспортирование текущего открытого файла .CKT в .NET формат, 
запуск TraxMaker и загрузка списка цепей. Если CircuitMaker не может найти исполняемый файл TraxMaker, 
используйте Find TraxMaker кнопку для поиска.  

Create Keep-Out Layer – этот выбор используется, чтобы оставаться в пределах определённого размера 
печатной платы при авто размещении компонентов и авто трассировки списка цепей.  

Board Size in Mils – этот выбор используется для определения размера печатной платы.  
Automatically Place Components – этот выбор активизирует функцию авто размещения компонентов на 

плате, которая использует несколько стратегий при размещении. При авто размещении компоненты сначала 
группируются, затем группы размещаются с использованием сетки размещения.  

 
8. Моделирование дефектов 
Использование системы CircuitMaker в образовательных целях позволяет устанавливать неисправные 

устройства в схеме. Это позволяет создавать диагностические упражнения для студентов. Например, можно 
создать рабочие цепи из неисправных устройств, создавая короткие замыкания, обрывы или другие дефекты 



на выбранных выводах устройств. Дефектные данные могут защищаться паролем для ограничения доступа 
студента. Дефекты могут добавляться как к цифровым, так и аналоговым цепям. 

 
9. File меню 
File меню содержит команды, чтобы открывать, сохранять и печатать схемы и графики сигналов. 
 
New 
Выбор New удаляет текущую схему из рабочей области для создания новой схемы. Если в рабочей об-

ласти присутствует не сохранённая схема при выборе этой команды, то обязательно будет запрос на сохране-
ние текущей схемы. 

 
Open 
Выбор Open закрывает текущую схему и загружает другую в рабочую область. Если в рабочей области 

присутствует не сохранённая схема при выборе этой команды, то обязательно будет запрос на сохранение те-
кущей схемы. Диалоговое окно отображает список файлов, чтобы выбрать и загрузить схему в рабочую об-
ласть. По умолчанию используется файловое расширение .CKT. Файлы схем созданные более старыми вер-
сиями CircuitMaker имеют расширение .CIR. Чтобы открывать эти файлы, выберите файловый тип расшире-
ния .CIR. Когда эти файлы открываются, они преобразовываются в новый формат и сохраняются с расшире-
нием .CKT. 

 
Reopen 
Использование Reopen команды позволяет быстро открывать любую из 8-и последних загружаемых 

схем.  Если были сделаны изменения в текущей схеме, то будет запрос на сохранение схемы перед закрытием. 
 
Merge 
Merge опция позволяет объединять схему, сохраненную на диске со схемой в рабочей области. Эта ко-

манда полезна тем, что позволяет сохранять часть схемы на диск, затем использовать её многократно по мере 
необходимости, не создавая всякий раз её заново. 

Выбрать Merge и выбрать схему, которую нужно добавлять к рабочей области. Схема будет установлена 
в верхнем левом углу экрана, её необходимо позиционировать в рабочей области. 

 
Close 
Использованием Close закрывается текущее открытое окно. Если сделаны изменения в текущей схеме, 

то будет запрос на сохранение схемы перед закрытием. 
 
Save 
Выбор Save сохраняет текущую схему в рабочей области с использованием текущего имени. Если схема 

сохраняется под название UNTITLED.CKT, то выводится диалоговое окно для назначения имени. 
 
Save As 
Выбор Save As позволяет сохранять текущую схему под другим именем.  CircuitMaker отображает диа-

логовое окно для выбора пути и имени файла до восьми символов. Схема сохраняется в ASCII формате с рас-
ширением .CKT. 

 
Revert 
Выбор Revert отменяет любые изменения сделанные на схеме, загружая в рабочую область, прежде со-

храненную версию. CircuitMaker выводит диалоговое окно запроса подтверждения возврата к последней со-
хранённой версии. 

 
Import > Simulate Spice Netlist 
Используя этот выбор можно импортировать и имитировать Spice список цепей созданных в других 

имитационных программах. При использовании этой функции CircuitMaker не отображает чертёж схемы, а 



выполняет моделирование, отображает окно результатов анализа, внизу Panel можно выбирать другие пере-
менные для отображения. Чтобы импортировать и имитировать Spice список цепей: 

1. Выбрать пункт Import > Simulate Spice Netlist. 
2. Выбрать файл с .NET расширением и нажать Open. 
3. Выбрать переменную или переменные из списка внизу Panel, затем выбрать Show. 
4. Вычерчивается график для выбранной переменной. 
5. Использованием Show и Hide кнопок просматриваются другие графики. 

 
Export 
CircuitMaker позволяет экспортировать ряд файлов и форматов, включая схемы и графики, PCB и Spice 

списки цепей.  
 
Bill of Materials 
Список материалов содержит информацию о количестве и типе используемых компонентов в схеме. 

При необходимости можно экспортировать список материалов в текстовый файл.  
 
Schematic Print Setup 
Выбор Schematic Print Setup позволяет масштабировать выходную печать от 10% до 1000%, и выбирать 

печать между черно-белым или цветным. Можно выбирать тип принтера, бумажный размер, страничную ори-
ентацию и другие свойства принтера, нажимая Printer кнопку. Использование Fit to Page выбора в Print 
Setup диалоговом окне, автоматически масштабирует всю схему на печатаемую страницу. 

Примечание: Бумажный размер, выбранный для принтера, определяет размер схемы в Circuit-Maker.  
 
Print Schematic 
Выбор Print Schematic даёт возможность отпечатать текущую схему на бумаге или в файле, диалоговое 

окно Printer позволяет выбираться желаемый вывод. Если схема слишком большая, чтобы уместиться на 
единственной странице, то автоматически схема будет разделена на блоки страничного размера печати. Уста-
новки принтера изменяются в зависимости от его типа. 

 
Print Waveforms 
Выбор Print Waveforms даёт возможность печатать графики сигналов на бумаге или сохранять их в 

файле. Печатаются только активные графики в окно анализа. 
 
Exit 
Выбор Exit закрывает программу CircuitMaker и возвращает в Windows. Если есть не сохранённые из-

менения, то будет запрос на сохранение. 
 
10. Edit меню 
Undo 
Многие редактирующие команды CircuitMaker могут быть отменены, к ним относятся команды Cut, 

Paste, Delete и Move. Может быть отменено только самое последнее редактирование, и многие команды отме-
нить уже не возможно, включая Run, Single Step, Reset, Define New Macro, Expand Macro и Delete Macro. 

 
Cut 
Использование Cut команды удаляет выбранные пункты в буфер, откуда могут быть вставлены в другое 

место. 
 
Copy 
Использование Copy команды копирует выбранные пункты в буфер, которые могут быть вставлены в 

другое место. 
 
Paste 



Paste выбор вставляет содержимое буфера в рабочую область CircuitMaker, и отображаемые пункты сле-
дуют за мышью по экрану. Курсор заменяется курсором вставки, указывая верхний угол области вставки.  Ко-
гда пункты установлены в желаемой позиции, щелкните мышь, чтобы завершать вставку. Чтобы отменять 
вставку, дважды щёлкнуть мышь. 

 
Move 
Использование Move выбора выполняет сразу Cut и Paste. Это позволяет быстро перемещать схему или 

часть схемы в новую позицию на экране. Связи с другими частями схемы будут потеряны. 
 
Delete 
Эта функция удаляет все выбранные пункты из рабочей области. 
 
Duplicate 
Выбор Duplicate делает копию всех выбранных пунктов. При выполнении команды копии выбранных 

пунктов следуют за мышью по экрану. Курсор заменяется курсором вставки, указывая верхний угол области 
вставки.  Когда пункты установлены в желаемой позиции, щелкните мышь, чтобы завершить дублирование. 

 
Copy to Clipboard 
Это меню позволяет копировать схемы или графики сигналов в буфер для размещения в других прило-

жениях. 
 
Copy to Clipboard > Schematic 
Выбор Copy to Clipboard > Schemetic копирует схему в буфер в одном из трех форматов: 

 Windows Metafile 
 Device Independent Bitmap 
 Device Dependent Bitmap 

Выбор File > Export > Schematic Options определяет желаемый формат. Эта функция позволяет позже 
вставлять содержимое буфера в графические программы для дальнейшей обработки, распечатки и т.п. После 
выполнения команды появляется сообщение, что схема скопирована в буфер. 

 
Copy to Clipboard > Waveforms 
Использование Edit > Copy to Clipboard > Waveforms копирует содержимое цифрового окна графиков 

или окна анализа в системный буфер в одном из трех форматов: 
 Windows Metafile 
 Device Independent Bitmap (только для цифровых схем) 
 Device Dependent Bitmap (только для цифровых схем) 

Выбрать File > Export > Options, чтобы определить желаемый формат. При копировании графиков в 
буфер выводится сообщение о копировании. 

 
Select All 
Эта опция выбирает все пункты в рабочей области. Это полезно когда необходимо вырезать, копировать 

или перемещать всю схему. 
 
Find and Select 
Использование Find and Select характеристики позволяет производить поиск устройств и их выбор в ра-

бочей области, используя узловые имена, обозначения, величины или символьные имена. Если CircuitMaker 
находит устройство, которое соответствует описанию поиска, оно выделяется. 

Например, если Spice сообщение указывает на проблему в узле c7_2 схемы, эта команда поможет найти 
данный узел. Все провода, подключенные к этому узлу, будут выделены. Можно также производить поиск 
многочисленных устройств. Например, чтобы выбрать все транзисторы, ввести Q* в области обозначения.  

 
Rotate 
Этот пункт меню аналогичен действию Rotate кнопки в инструментарии. 
 



Mirror 
Этот пункт меню аналогичен действию Mirror кнопки в инструментарии. 
 
Straighten Wires 
Если провода на схеме имеют многократные изгибы, эта опция  позволяет быстро оптимизировать неко-

торые "перегибы" без необходимости ручной регулировки. Чтобы спрямлять провода: 
1. Выбрать провод для спрямления. 
2. Выбрать пункт Edit > Straighten Wires. 

 
Place Node Label 
Эта команда позволяет устанавливать узловые этикетки в цепях схемы. 
 
Set Label Positions 
Эта команда автоматически устанавливает этикетки для всех выбранных устройств в их стандартные по-

зиции. 
 
Set Designations 
Выбор Edit > Set Designations отображает Set Designations диалоговое окно. Использование этой функ-

ции позволяет перенумеровать обозначения устройств, которые уже установлены на схеме. Можно перенуме-
ровать все устройства или группу выбранных устройств. 

Эта опция полезна, если все устройства на схеме или конкретная группа устройств, должны иметь обо-
значения в определённом диапазоне чисел. Например, необходимо перенумеровать все резисторы в схеме как 
R40, R41, R42, R43, и так далее. Чтобы перенумеровать обозначения устройств: 

1. Ненужно делать выбор устройств, если необходимо перенумеровать все устройства на схеме. 
 или 
           Выбрать группу устройств, удерживая левую кнопку мыши и охватывая нужные устройств. 
 или 
           Придерживая Shift клавишу щелчком выбрать нужные устройства. 

2. Выбрать пункт Edit > Set Designations. 
3. Ввести число в Starting Number текстовое окно. 
4. Выбрать All, если необходимо перенумеровать все устройства.  

 или 
           Выбрать Selected Devices, чтобы перенумеровать только выбранные устройства. 

5. Отметить Show Device Designations, чтобы обозначения появились на схеме, и нажать ОК. 
Можно установить префикс обозначения для индивидуальных устройств, используя Device Properties 

диалоговое окно. 
  
Set Prop Delays 
Использование Edit > Set Prop Delays, только для цифрового логического моделирования, позволяет 

изменять задержку распространения всех выбранных устройств. Задержка устройства определяется числом 
имитационных меток, которые она принимает, пока сигнал распространяется от входа до выхода устройства. 

1. Отметить устройство, затем выбрать пункт Edit > Set Prop Delays для отображения диалогового 
окна. 

2. Ввести новую величину задержки, затем нажать OK. 
По умолчанию задержка для всех устройств установлена в единицу (1), используя Set Prop Delays мож-

но изменять эту величину от 1 до 14.  
 
Group Items 
Используя этот выбор можно определять устройства, которые содержатся в пределах одного корпуса. 

Например, компонент 7400 содержит в одном корпусе четыре 2-х входовых NAND элемента, которые имеют 
различные номера выводов. Индивидуальные элементы группируются автоматически по мере установки в 
схеме, можно перегруппировать элементы, используя эту опцию. Чтобы группировать элементы: 

1. Выбрать элементы, которые необходимо сгруппировать в один корпус. 
2. Выбрать пункт Edit > Group Items. 

 



11. View меню 
Меню View даёт возможность управления отображением пунктов и инструментов.  
 
Panel 
Использование выбора Panel позволяет отображать или скрывать панель. Panel в левой области окна 

содержит Browse, Search, Digital и Wave закладки. Скрытие Panel увеличивает рабочую область. 
 
Toolbar 
Использование выбора Toolbar отображает или скрывает инструментальное меню.  
 
Status Bar 
Использование выбора Status Bar отображает или скрывает полосу статуса. Полоса статуса находится в 

нижней части рабочей области CircuitMaker и используется для отображения информации как, например, ими-
тационного прогресса и описания текущего вида моделирования. 

 
Collapse Device Tree 
Команда Collapse Device Tree позволяет быстро сворачивать структуру дерева просмотра устройств. 
 
Schematic 
Один из четырех возможных типов отображения. Этот тип отображает только схему. 
 
Waveforms 
Этот тип отображает только графики. 
 
Split Horizontal 
Этот тип отображает горизонтально схему и графики. 
 
Split Vertical 
Этот тип отображает вертикально схему и графики. 
 
Display Scale 
Эта функция позволяет изменять масштаб отображения схемы. 
Normal Size/Position  
Эта функция восстанавливает 100% масштаб отображения и перемещает горизонтальный и вертикаль-

ный бары в их нулевые позиции. 
 
Refresh Screen 
Выбор Refresh Screen перерисовывает рабочую область со схемой. Эта необходимость возникает при 

редактировании схемы, когда необходимо убрать всякий мусор в рабочей области. 
 
12. Options меню 
Options меню содержит команды управления отображением, редактированием и имитацией. 
 
Schematic 
Выбор Schematic позволяет определять и изменять различные установки в CircuitMaker для создания 

схем. Установки по умолчанию сохраняются в файле Cirmaker.dat. 
 
Arrow/Wire 
Этот выбор позволяет создавать провода, щёлкая на выводах устройств используя средство Arrow Tool. 

Нельзя создавать провода из середины других проводов, используя Arrow Tool, это можно сделать только 



средством Wire Tool. Этот выбор может быть использован как для автоматической, так и ручной разводки 
проводов. 

 
Auto Refresh 
Этот выбор позволяет управлять способом восстановления. Когда выбран Auto Refresh, экран перери-

совывается автоматически после каждого редактирования схемы. Если этот выбор отключен, экран должен 
перерисовываться вручную при редактировании схемы.  

 
Auto Repeat 
Этот опция позволяет управлять выбором устройств из библиотеки. Если Auto Repeat отмечен, как 

только какое либо устройство будет выбрано из библиотеки и установлено, другое идентичное устройство ав-
томатически будет готово для размещения. Этот процесс повторного размещения остается до тех пор, пока Вы 
не отмените его нажатием любой клавиши или двойным щелчком мыши. Если Auto Repeat отключен, Вы 
должны выбирать и устанавливать каждое устройство отдельно. 

 
Prompt To Save 
Если на схеме сделаны изменения, то может потребоваться сохранить изменения, прежде чем сделать 

моделирование. Если эта опция отмечена, то всякий раз при запуске моделирования CircuitMaker предупредит 
о необходимости сохранения схемы. 

 
Quick Connect 
Этот выбор позволяет просто устанавливать провод между выводами устройств, CircuitMaker проводит 

провод автоматически.  
 
Single Click Connect 
Этот выбор используется для ручной разводки проводов. Когда опция Single Click отмечена, заверше-

ние разводки провода производится одним щелчком мыши в любой точке связи. Можно также завершать про-
вод в любой позиции двойным щелчком, даже если конец провода не в правильной точке связи. Когда этот 
выбор отключен, то необходим двойной щелчок, чтобы завершить провод. Завершение провода двойным щел-
чком разрешается при очень близком расстоянии к другим проводам или выводам. 

 
Show Bus Labels 
Эти выбор отображает этикетки на шинах до 5 текстовых символов, устанавливая небольшие текстовые 

окна в конце каждой шины, и также отображает имя каждого провода связанного с шиной. 
 
Show Node Names 
Этот выбор отображает название каждого узла в схеме. Имя отображается в центре самого длинного 

проводного сегмента каждого узла. Узловые имена, которые определены CircuitMaker, используются для ими-
тационных целей и для PCB. Они также включаются в имена графиков в окне анализа. 

 
Show Page Breaks 
Этот выбор отображает страничное  разделение многостраничной схемы при отправке на принтер. Вы-

бор Show Page Breaks также полезен при позиционировании схемы на единственной странице. Разделители 
страниц, отображаемые на экране, определяются выбором принтера, размером бумаги и коэффициентом мас-
штабирования. Масштаб может корректироваться визуально перемещением разделителей страниц мышью. 

 
Show Pin Dots 
Этот выбор позволяет управлять видимостью связи между проводами и устройствами с целью контроля. 

Если сделан этот выбор, то каждый вывод устройства, к которому подключен провод будет иметь небольшую 
точку в месте связи. 

 
Show Prop Delays 
Использование Show Prop Delays отображает задержку распространения всех устройств на схеме. Ве-

личины задержки для каждого устройства будут показаны в пределах закруглённого прямоугольника распо-
ложенного в центре каждого устройства. Некоторые устройства (генераторы, индикаторы, макромодели, и 
т.п.) не имеют параметров задержки, никаких величин отображаться не будет. В случае макромоделей задерж-



ка определяется индивидуально установленной задержкой каждого устройства содержащего в пределах мак-
ромодели.  

 
Connection Area 
Область связи определяется прямоугольником вокруг правильных точек связи. Свойство системы 

SmartWire позволяет подключать провод к нужной точке связи, даже если курсор не точно установлен в этой 
точке. Регулировкой Size определяется размер закрытой области в пикселях, которая появляется в точке связи 
прежде, чем провод будет подключен в эту точку. По умолчанию, курсор должен быть в пределах 3 пикселей 
от точки связи. Когда Show окно отмечено, всякий раз появляется прямоугольник вокруг области связи, когда 
вводится курсор в эту область. 

 
Grid Setup 
Использование Visible выбора установит сетку выравнивания в окне схемы. Сетка полезна в точном вы-

равнивании объектов. Выбор Snap To позволит устанавливать новые устройства, которых ещё нет на схеме, 
согласно определенной сетке, а также позволяет перемещать уже установленные устройства согласно выбран-
ной сетке, относительно их позиции. 

Примечание: При установке устройств точно в сетке, устройство всегда остается в сетке независимо от 
перемещаемой позиции. Тем не менее, Snap To выбор не гарантирует выравнивание компонентных выводов. 
Большинство устройств в CircuitMaker разработаны для размера сетки в 9 точек. 

 
Designations 
CircuitMaker автоматически назначает обозначение на каждое новое установленное устройство. Исполь-

зование этого выбора определяет стартовый номер обозначения, и отображения их на вновь установленных 
устройствах. Чтобы изменять выборы обозначения устройства:  

1. Выбрать пункт Options > Schematic. 
2. В Designations секции выбрать Show for new devices, чтобы показывать обозначения для всех 

вновь устанавливаемых устройств. 
3. Определить стартовое число в Starting текстовом окне. 

Устройства, которым устанавливаются обозначения с использованием стартового числа, используют 
свободное ближайшее число после определенного стартового номера.  Например, если стартовое число 10, а 
схема уже содержит резисторы R10, R11, и R12, то следующему резистору назначается обозначение R13. 

 
Border 
Использование этого выбора устанавливает координатную границу вокруг схемы. Граница имеет числа 

вверху и низу, а также символы по обеим сторонам. Эта граница может быть полезной для быстрого опреде-
ления специфических областей на схеме. Использование Visible on screen контрольного окна отображает гра-
ницу в окне схемы. 

Выбор Do not print отменяет видимость границы на схеме при печати на принтере. Выбор Print around 
entire schematic печатает общую границу для всех страниц схемы. Выбор Print around each page печатает 
границу на каждой странице схемы. 

 
Device Font 
Этот выбор позволяет определять шрифты для устройств, используемых в схемах CircuitMaker. Этот 

шрифт будет использован на всех этикетках устройств, имён проводов, имён выводов, и т.д. Он не влияет на 
свободный текст, который устанавливается с использованием Text Tool. CircuitMaker использует шрифт по 
умолчанию типа Courier New.  

 
Circuit Fault Data 
Выбор Circuit Fault Data кнопки даёт возможность выбора и модификации дефектных цепей схемы.  
 
Text Font 
Выбор Text Font кнопки изменяет шрифтовые атрибуты любой выбранной, свободно перемещаемой 

текстовой области, или определяет шрифт по умолчанию для нового текста. Чтобы изменять шрифт: 
1. Выбрать свободный текст, щёлкнув на нём. 
2. Выбрать пункт Options > Schematic и нажать Text Font кнопку. 
3. Сделать желаемые изменения и нажать OK.  



Title Block 
Использование Title Block закладки позволяет добавлять окно названия к схеме в правом нижнем углу 

страницы. Блок названия содержит следующие области: Name, Title, Revision, ID, Date и Page. Name и Title 
области расширены в высоту, чтобы оперировать многочисленными колонками текста. Если оставить Name 
или Title области пустыми, CircuitMaker исключает их из блока названия. Блок названия увеличивается по 
ширине согласно длине вводимого текста. Можно напечатать блок названия на первой странице, на последней 
странице или на всех страницах. К тому же, можно напечатать полный блок названия на первой странице и 
сокращенный блок без Name и Title областей на последующих страницах. 

 
Colors 
Использование закладки Colors позволяет выбирать цвета связанные с некоторыми функциями и объек-

тами. Некоторым устройствам могут быть назначены цвета на индивидуальной основе, другим назначаются 
глобальные цвета. Следующий пример показывает, как изменять назначенный по умолчанию цвет для LED. 
Чтобы изменять цвет по умолчанию для всех новых LED: 

1. Выбрать пункт Options > Schematic и нажать Colors закладку. 
2. Щёлкнуть в цветной прямоугольник около LED. 
3. Выбрать новый цвет и нажать OK.  

Чтобы изменить цвет одного LED: 
1. Установить LED устройство на схему. 
2. Из меню правой кнопки на LED выбрать пункт Device Color. Выбрать желаемый цвет и нажать 

OK. 
 
Save current settings as defaults 
Когда отмечено это контрольное окно, все текущие изменения в Schematic Options диалоговом окне бу-

дут сохранены как установки по умолчанию. Эти установки будут использоваться при каждом запуске Cir-
cuitMaker или создании новой схемы.  

 
Cursor Tools 
Это субменю обеспечивает альтернативным выбором Arrow, Wire, Text, Delete, Probe и Zoom инстру-

ментальных средств. 
 
Schematic Display Data 
Эта функция позволяет временно аннулировать установки отображения каждого устройства в схеме. 

Кнопки на верху каждой колонки быстро изменяют установки для всей колонки, или можно изменять индиви-
дуальные пункты, отмечая кнопки.  

 
Device Display Data 
Эта функция позволяет быстро изменять установку видимости пунктов всех выбранных устройств.  
 
Library Location 
Определение пользователем путей к директориям, используемым в CircuitMaker. Models Directory ука-

зывает путь расположения библиотек Spice моделей. User Library File указывает путь и файловое имя биб-
лиотеки символов компонентов. Circuits Directory указывает путь хранения файлов схем. 

Примечание: Файлы Devicedb.dat, Hotkeydb.dat и Symboldb.dat должны быть в том же директории где 
находится файл User.lib. 

 
13. Macros меню 
Использование команд в Macros меню значительно расширяет возможности CircuitMaker, чтобы удов-

летворять самые высокие потребности пользователей. Эта глава описывает использование возможностей сис-
темы для создания, редактирования и манипулирования устройствами макро.  

 
New Macro 
Выбор New Macro используется для создания нового схемного символа и добавления его к библиотеке. 

Если есть открытая схема, то CircuitMaker запрашивает о сохранении схемы как устройства макро. Устройство 



макро сохраняется в файле USER.LIB и после этого доступно для использования в любой схеме или в других 
макро устройствах. 

 
Edit Macro 
Для редактирования макро устройств: 

1. Расширить символ макро устройства, выделив его и выбрав пункт Macros > Expand Macro. 
 Примечание: Когда устройство расширено, рабочая область будет очищена, необходимо сохранить 

схему заблаговременно. 
2. Щёлкнуть в расширенный символ макро, чтобы выбрать его. 
3. Выбрать пункт Macros > Edit Macro, чтобы редактировать имя, данные устройства или символа. 

Можно также дважды щёлкнуть в расширенный символ устройства средством Arrow Tool. 
Если существующее макро устройство расширено и сохранено под новым именем, сохраняемое новое 

макро устройство не перезаписывает исходное устройство. Если никаких расширенных макро устройств не 
присутствует в рабочей области, Edit Macro пункт меню будет не доступен.  

 
Save Macro 
Использование Macros > Save Macro выбора позволяет сохранять или перезаписывать макро устройст-

ва. Существующее устройство, сохраняемое этим способом, будет установлено в своей оригинальной позиции 
в библиотеке устройств. Все устройства требуют Major Device Class обозначения. При использовании Save 
Macro выбора для сохранения нового устройства, CircuitMaker отображает Macro Utilities диалоговое окно, 
для определения major и minor class. Чтобы сохранять существующие макро устройства в новой позиции, по-
смотреть описание Macro Utilities в этой главе ниже. Для сохранения устройств под другим именем, исполь-
зуется пункт Edit Macro. Устройства макро сохраняются в USER.LIB файле. 

 
Expand Macro 
Выбор Macros > Expand Macro должен использоваться для редактирования прежде сохранённых макро 

устройств. Расширение устройства означает, что "черный ящик", содержащий электрическую схему, открыт и 
вся внутренняя электрическая схема видима. 

Примечание: Большинство устройств CircuitMaker не являются устройствами макро и не могут быть 
расширены. Чтобы расширить макро: 

1. Щёлкнуть в макро устройство для выбора. 
2. Выбрать пункт Macros > Expand Macro. Появляется предупреждение, что расширение макро 

очистит рабочую область. 
 Примечание: Если имеется не сохранённая схема, нажать Cancel кнопку для прерывания расширения, 

сохраните текущую рабочую область, и затем выбрать Expand Macro. Если не нужно сохранять рабочую об-
ласть, нажать OK для завершения расширения макро. 

3. Сделать изменения в расширенном макро, используя доступные средства редактирования. 
4. После завершения изменений в макро выбрать пункт Macros > Save Macro. 

 
Macro Lock 
Этим пунктом инструктор может запереть макро, чтобы он не был доступен студентам для расширения, 

создавая таким образом "черный ящик".  
 
Macro Utilities 
Macro Utilities опция отображает диалогового блок, который допускает сохранение, расширение или 

удаление макро. 
 
Save Macro 
Кнопка Save Macro позволяет сохранять или перезаписывать макро устройство. Если в рабочей области 

нет макро устройства, эта кнопка будет не активна. Чтобы сохранить макро устройство: 
1. Выбрать major и minor классы, чтобы указать место сохранения в библиотеке устройств. 

 Примечание: Можно добавлять новые major и minor классы, вводя новое имя в Major Device Class и 
Minor Device Class текстовые области. 

2. Нажать Save Macro. 
 CircuitMaker сохраняет макро устройство в USER.LIB файле и очищает рабочую область.  



Class Selected Device 
Используя Add и Remove кнопки в Class Selected Drive разделе, можно перемещать устройства в другие 

major и minor классы. Для использования этого раздела: 
1. Выбрать устройство в окне схемы. 
2. Выбрать пункт Macros > Macro Utilities. 
3. Выбрать major и minor классы устройств из списка. 
4. Нажать Add, чтобы добавить устройство к выбранным классам. 

 или 
           Нажать Remove, чтобы удалить устройство из выбранных классов. 
 Если устройство удаляется из всех классов, оно будет включено в User Defined major класс. Чтобы 

удалить устройство полностью, используется Delete Macro функция. 
 
Expand Macro 
Использование Expand кнопки в Expand/Delete Macro разделе, выполняет функцию описанную выше. 

Чтобы расширять макро устройство, выбрать макро и нажать Expand кнопку. 
 
Delete Macro 
Использование Delete кнопки в Expand/Delete Macro разделе, удаляет макро устройство из USER.LIB 

файла. 
Предупреждение: Нет возможности открывать схемы, которые используют макро удалённое из библио-

теки, необходимо создать новое макро с тем же именем.  
Чтобы удалить макро устройство: 

1. При необходимости сохранить рабочую область. 
 Когда удаляется макро, рабочая область будет очищена. 

2. Рекомендуется сделать копию USER.LIB файла перед созданием или удалением макро на слу-
чай, если что-то пойдёт неправильно и будет необходимость восстановить оригинальную биб-
лиотеку. 

 Примечание: Большинство устройств указанных в Macro Utilities окне используются в DEVICE.LIB 
файле и не могут удаляться. 

3. Выбрать макро. 
4. Нажать Delete Macro. 
 

Model Data 
Кнопка Model Data в Macro Utilities диалоговом окне используется для добавления новой Spice модели 

в библиотеку CircuitMaker. Эта кнопка отображает диалоговое окно, которое позволяет устанавливать новые 
ссылки файла модели для выбранного символа.  

 
Macro Copier 
Следующий пример показывает, как использовать Macro Copier для копирования макро в новую вер-

сию USER.LIB. 
1. Выбрать пункт Macros > Macro Copier для отображения диалогового окна. 
2. Нажать внизу слева Open кнопку для отображения диалогового окна. 

 CircuitMaker делает запрос. 
3. Если копируется устройство созданное пользователем, нажать Yes. 
4. Выбрать файл, из которого макро будут копироваться.  
5. Нажать внизу справа Open или New кнопку, чтобы отобразить Open или Save As окно. 
6. Выбрать файл, в который макро будет скопирован. 

Это обычно USER.LIB файл в директории CircuitMaker. 
7. Выбрать макро для копирования из левого файлового списка. Если макро уже существует с тем 

же именем в правом списке, CircuitMaker его удалит. 
8. Нажать >>>Copy>>> кнопку. 

 Необходимо подсказать CircuitMaker информацию относительно предполагаемого имитационного ре-
жима для устройства. Если устройство может быть использовано в цифровом моделировании, необходимо от-
метить Digital окно, если может использоваться в аналоговом моделировании, отметить Analog окно. Если 
устройство может быть использовано в любом имитационном способе, отметить оба окна. 

 



Save ASCII Library 
Использование Save ASCII Library переписывает к настоящему времени загруженный USER.LIB файл 

в файл ASCII. CircuitMaker отображает диалоговое окно для ввода имени файла ASCII. В этом формате сохра-
няемые Windows метафайлы или побитовые отображения могут быть потерены, и заменены простым прямо-
угольником. Выводы, тем не менее, остаются целыми. Формат ASCII используется для преобразования между 
16 и 32-битовыми системами. Эта библиотека может быть преобразована в двоичный формат выбором Macros 
> Convert ASCII Library. 

 
Convert ASCII Library 
Использование Convert ASCII Library преобразовывает библиотечный файл пользователя ASCII, соз-

данного командой Save ASCII Library, в двоичный формат. CircuitMaker отображает диалоговое окно ввода 
имени библиотечного файла ASCII, который нужно преобразовывать. Затем необходимо определить имя но-
вого двоичного файла. Этот выбор предусмотрен для совместимости между 16 и 32-битовыми системами. 

 
Update Search List 
Использование этой функции обновляет SEARCHDB.DAT файл. Нормально, SEARCHDB.DAT файл 

при необходимости корректируется автоматически. Если по какой либо причине список поиска устройств ка-
жется неправильным или устарелым, необходимо его обновить выбором Macros > Update Search List. 

 
14. Simulation меню 
Simulation меню содержит опции, которые позволяют выбирать имитационный тип и параметры анали-

за. 
 
Analog Mode 
Этот пункт используется для выбора смешанного имитационного способа.  
 
Digital Mode 
Этот пункт используется для выбора цифрового имитационного способа.  
 
Analyses Setup 
Использование Analyses Setup диалогового блока поможет установить тип Spice анализа, а также ими-

тационные параметры как, например, температура, допуски и т.п.  
 
Check Pin Connections 
Использование Check Pin Connections проверяет схему и сообщает об устройствах с неподключенными 

выводами. 
 
Reset 
Действует подобно Reset кнопки в инструментарии. 
 
Step 
Действует подобно Step кнопки в инструментарии. 
 
Run/Stop 
Действует подобно Run/Stop кнопки в инструментарии. 
 
Trace 
Действует подобно Trace кнопки в инструментарии. 
 
Active Probe 
Этот выбор позволяет измерять логические уровни с помощью Probe Tool и отображать в окне графики 

при цифровом логическом моделировании. 



15. Wave меню 
Это меню даёт доступ к командам управления графиками смешанных сигналов. 
 
Fit Waveforms 
Эта команда автоматически масштабирует X и Y оси всех графиков, чтобы они были установлены на 

общей шкале по максимальной амплитуде. Эту команду можно также выбрать из управляющего меню правой 
кнопки в окне графиков. 

 
Zoom In 
Эта команда увеличит вид графиков, регулируя как X, так и Y масштаб, поддерживая приближённый 

центр точки зрения. Эту команду можно также выбрать из управляющего меню правой кнопки в окне графи-
ков. 

 
Zoom Out 
Эта команда уменьшит вид графиков, регулируя как X, так и Y масштаб, поддерживая приближённый 

центр точки зрения. Эту команду можно также выбрать из управляющего меню правой кнопки в окне графи-
ков. 

 
Preferences 
Эта команда позволяет модифицировать по заказу пользователя вид и установки для окна анализа. Эту 

команду можно также выбрать из управляющего меню правой кнопки в окне графиков. 
 
Colors 
Foreground (значения осей), Background (фон), Grid (сетка) и Selected Cursor (выбор) цвета в окне ана-

лиза могут быть установлены по предпочтениям пользователя. Есть также две схемы окрашивания, исполь-
зуемые для самих графиков, но схемы CircuitMaker выбирает автоматически, основываясь на выбранном цвете 
фона. Одна схема предусмотрена для светлого фона, а другая для темного фона. 

 
Print / Export Colors 
Этот выбор определяет используемые цвета при печати графиков или экспорте в другие приложения. 

Тем не менее, если окно анализа имеет цветной фон, то на это уйдёт много дополнительных чернил или тоне-
ра. Второй выбор при печати использует белый фон, но с цветными графиками. Третий выбор при печати ис-
пользует белый фон и черные графики. При выборе последнего пункта для идентификации графиков можно 
использовать Show Designation Symbols выбор. 

 
Bold Waveforms 
При выборе CircuitMaker сделает все графики двойной толщины. Это может быть полезным при печати 

или экспорте графиков на темном фоне. 
 
Show Data Points 
Включение этого выбора заставляет CircuitMaker небольшим кругом выделять каждую точку на графи-

ке, где Spice производил расчёт точки данных. CircuitMaker делает соединительные линии между этими точ-
ками данных, чтобы начертить график. Большее разрешение или меньший размер шага, который определяется 
при установке анализа, делает ближе расстояние между точками данных. Включение этого выбора может ино-
гда быть очень полезным при отладке моделирования.  

 
Show Designation Symbols 
Символы обозначения могут быть полезны при установке графиков в одном цвете. Если графики пока-

заны в индивидуальных ячейках, то все графики будут использовать квадратный символ. Если два или более 
графиков в одной ячейке, то будут использованы разные формы символов для каждого графика в этой ячейке.  

 
Cell Height in pixels 
Этот выбор устанавливает высоту каждой ячейки при отображении всех ячеек. 
 



View 
Выбор Single Cell или All Cells отображает график в одной ячейке или графики всех ячеек.  
 
Apply to... 
Этот список позволяет делать изменения в Wave Preferences диалоговом окне только для активного 

графика или для всех графиков. 
 
Save current settings as defaults 
Это контрольное окно предусмотрено для того, чтобы установки сделанные в Wave Preferences были 

приняты как по умолчанию. Установки сделанные по умолчанию всякий раз принимаются автоматически при 
запуске CircuitMaker. 

 
Scaling 
Эта команда позволяет выбирать тип сетки для использования в окне анализа. Эту команду можно также 

выбрать из управляющего меню правой кнопки в окне графиков. 
 
X Scale 
AC графики могут быть отображены в линейном или логарифмическом масштабе. Другие графики ото-

бражаются только в линейном масштабе. 
 
Y Axis 
Графики AC анализа могут быть отображены в различных типах сетки, включая: Real, Imaginary, 

Magnitude, Magnitude в децибелах, Phase в градусах, Phase в радианах и Group Delay. Два различных типа 
сетки могут отображаться одновременно. Другие графики отображаются только в Real сетке.  

 
Math 
Эта опция позволяет создавать новые графики, базируясь на математических выражениях. Эту команду 

можно также выбрать из управляющего меню правой кнопки в окне графиков.  
 
Store 
Эта команда позволяет сохранять графики в файле для будущей ссылки. Эту команду можно также вы-

брать из управляющего меню правой кнопки в окне графиков. 
 
Recall 
Эта команда позволяет восстановить исходные графики. Эту команду можно также выбрать из управ-

ляющего меню правой кнопки в окне графиков. 
 
Save As Text 
Эта команда позволяет экспортировать графики для использования в других приложениях. Эту команду 

можно также выбрать из управляющего меню правой кнопки в окне графиков. 
 
16. Основы SPICE  
Эта глава обсуждает стратегии диагностики Spice сходимости, выбора Spice переменных и элементар-

ных устройств.  
 
Диагностика сходимости SPICE  
Spice3 использует одновременные линейные уравнения, выраженные в матричной форме, для определе-

ния постоянного напряжения и тока в каждой точке схемы в каждом шаге моделирования. Схема сводится к 
массиву электропроводимости установленной в матрице, чтобы формировать уравнения (G * V = I). Когда в 
цепь включены нелинейные элементы, Spice использует множественную итерацию линейных уравнений для 
линеаризации. Spice инициализирует узловые напряжения, затем вычисляет базовые токи в зависимости от 
проводимости цепей схемы, затем, используя рассчитанные токи, пересчитывает узловые напряжения и цикл 
повторяется. Этот цикл сохраняется пока узловые напряжения, и базовые токи находятся в пределах опреде-
ленных допусков. 



Тем не менее, если напряжение или ток не сходятся в пределах определенного количества итераций, 
Spice выдаёт сообщение об ошибке как, например, “singular matrix”, “Gmin stepping failed”, “source stepping 
failed” или “iteration limit reached” и отказывается от моделирования. Spice использует результаты каждого 
имитационного шага как основу для следующего шага. Если при выполнении Transient анализа Spice не мо-
жет найти решение, используя определенный временной шаг, временной шаг будет автоматически умень-
шаться, а цикл повторяться. Если временной шаг уменьшен до предельного значения, Spice отображает сооб-
щение “Timestep too small” и отказывается от моделирования. Использование Analog Options диалогового ок-
на, позволяет определять допуски и ограничения итерации для различных типов анализа. 

OP анализ может не сходиться по различным причинам. Например, инициализируемое узловое напря-
жение может быть слишком далёко от реального, цепь может быть неустойчивой или бистабильной (более чем 
одно решение в уравнениях), могут быть проблемы в моделях, или цепь может содержать нереальные полные 
сопротивления. 

Необходимо использовать следующие методы, чтобы решать проблемы сходимости. Когда есть пробле-
ма сходимости, сначала идентифицируется, какой анализ вызывает проблему. Необходимо иметь в виду, что 
OP анализ обычно выполняется автоматически перед каждым типом анализа, даже если он отключен в 
Analyses Setup диалоговом окне. Необходимо начать с шага 1, затем рассмотреть требуемые рекомендации и 
разрешить ошибку. 

 
Решения неудачного OP анализа 

1. Проверить топологию цепей и связей:  
 Убедиться, что цепи правильно разведены. Изолированные узлы и выводы компонентов 

от других узлов схемы не допустимы. Использование RSHUNT выбора может решить 
эти проблемы. 

 Не путать нули с символом O. 
 Использовать соответствующие Spice множители (MEG вместо M для 1E+6). 
 Не делать пробелов между величиной и множителем (1.0uF, а не 1.0 uF). 
 Каждая цепь и каждый узел в цепи должны иметь утечку тока на землю. Убедиться, что 

цепи не изолированы от земли трансформаторами, конденсаторами, и т.п. 
 Нет последовательно включенных конденсаторов или источников тока. 
 Нет параллельно включенных индуктивностей или источников напряжения. 
 Убедиться, что все устройства и источники установлены в их точных значениях. 
 Убедиться, что все зависимые источники имеют корректное значение усиления. 
 Убедиться, что все модели и макромодели правильно определены. 

2. Увеличить ITL1 до 300 в Analog Options диалоговом окне.  Это определит прохождение OP ана-
лиза через большую серию итераций. 

3. Добавление .NODESET устройств. Если начальные узловые напряжения далеки от реальных 
значений, .NODESET устройство может быть установлено в узел, чтобы определить более ре-
альную величину начального напряжения. 

4. Добавление сопротивлений и использование OFF ключевого слова. Определить последователь-
ные параметры сопротивления в моделях и увеличить GMIN выбор с показателем 10. Опреде-
лить начальные условия для полупроводниковых устройств, особенно диодов, как OFF. 

5. Использование начальных условий. Определить UIC контрольное окно для Transient Analysis в 
Analyses Setup диалоговом окне.  Установить .IC устройства в схеме или использовать прила-
гаемые начальные условия, чтобы помочь на начальных этапах Transient Analysis. 

 
Решения неудачного DC анализа  

1. Проверить топологию цепей и связей. Посмотреть общие ошибки, указанные под шагом 1 выше. 
2. Увеличить ITL2 до 200 в Analog Options диалоговом окне.  Это определит прохождение DC 

анализа через большую серию итераций в каждом шаге. 
3. Сделать входную пошаговую DC развертку с увеличением или уменьшением шага. Если нару-

шения существуют в моделях устройств, возможное между линейными регионами и насыщени-
ем модели, повышение размера шага может решить проблемы моделирования, чтобы пересту-
пить прерываемость. Получение меньших шагов тоже может помочь моделированию, чтобы ре-
шать нарушения быстрых переходных напряжений. 



4. Не использовать DC анализ. Некоторые проблемы, например гистерезис не могут быть решены 
DC анализом. В таких случаях более эффективно использование Transient Analysis с подходя-
щими силовыми источниками. 

 
Решения неудачного Transient анализа  

1. Проверить топологию цепей и связей. Посмотреть общие ошибки, указанные под шагом 1 выше. 
2. Установить RELTOL как 0.01 в Analog Options диалоговом окне.  Увеличивая допуск итерации 

от 0.001 уменьшением точности, повышает вероятность в схождении решения, и моделирование 
завершится намного быстрее. 

3. Увеличить ITL4 до 100 в Analog Options диалоговом окне. Это определит прохождение 
Transient Analysis через большее число итераций для каждого временного шага. 

4. Уменьшить допустимый уровень точности ABSTOL/VNTOL для тока/напряжения. Реальные 
цепи не могут требовать точность решений до 1µВ или 1пА. Возможен допуск точности, по 
крайней мере, на порядок ниже самого низкого ожидаемого напряжения или тока в схеме. 

5. Достоверно смоделировать схему. Добавить реалистичные паразитные параметры, особенно па-
разитные емкости. Использовать RC демпферы на диодах. Заменять модели устройств макромо-
делями, особенно для ВЧ и силовых устройств. 

6. Увеличить время фронта/спада Pulse Generators. Даже самые лучшие генераторы импульсов не 
могут переключаться мгновенно. 

7. Измените метод интегрирования на Gear. Gear интегрирование требует больше имитационного 
времени, но более стабильно, чем trapezoidal метод. Gear интегрирование особенно полезно в 
цепях, которые колеблются или имеют обратные связи. 

 
Выбор SPICE переменных 
Использование Spice переменных управляет определенными аспектами моделирования как, например, 

пределы итерации, температура и т.п. Чтобы изменять величину Spice переменных: 
1. Выбрать пункты Simulation > Analyses Setup > Analog Options для отображения Analog Options 

- Spice Variables диалогового окна. 
2. Выбрать переменную и набрать новую величину в Option Value области редактирования. 
3. Если необходимо установить значение по умолчанию, занести звездочку в Value область редак-

тирования. 
Далее приводится список переменных и их эффект в моделировании. 
ABSTOL  Устанавливает абсолютную допустимую ошибку тока в программе. 

ABSTOL=RELTOL* (минимальная величина тока в цепи). По умолчанию=1 пА. 
CHGTOL  Допустимая ошибка расчёта заряда. По умолчанию=1.0e-14 Кулон. 
DEFAD   Диффузионная площадь стока MOS транзистора. По умолчанию=0.0 М2. 
DEFAS   Диффузионная площадь истока MOS транзистора. По умолчанию=0.0 М2. 
DEFL   Длина канала MOS транзистора.  По умолчанию=100.0 мкм. 
DEFW   Длина канала MOS транзистора.  По умолчанию=100.0 мкм. 
GMIN  Минимальная проводимость или максимальное сопротивление ветвей в цепи. А 

также определяет величину проводимости, которая устанавливается параллель-
но с каждым p-n переходом в цепи.  По умолчанию=1.0e-12 Сименс. 

ITL1  Устанавливает предел итераций OP анализа. По умолчанию=100.  Примечание: 
Может подниматься до 500 для многих цепей. 

ITL2  Устанавливает предел итераций DC анализа.  По умолчанию=50. Примечание: 
Может подниматься до 200 для некоторых цепей. 

ITL3  Устанавливает более низкий предел итерации для Transient Analysis.  По умол-
чанию=4.   

ITL4  Устанавливает предел итерации в каждой временной точке для Transient 
Analysis. По умолчанию=10.  Note: Поднимая эту величину до 100 или более, 
может помочь устранять “timestep too small” ошибки, улучшать как сходимость, 
так и имитационная скорость. 

ITL5  Устанавливает общий предел итераций для Transient Analysis.  По умолча-
нию=5000.   

PIVREL  Устанавливает относительную величину элемента строки матрицы, необходи-
мую для его выделения в качестве ведущего элемента.  По умолчанию=1.0e-3.  



PIVTOL  Устанавливает абсолютную величину элемента строки матрицы, необходимую 
для его выделения в качестве ведущего элемента.  По умолчанию=1.0e-13. 

RELTOL  Устанавливает допустимую относительную ошибку расчёта напряжений и тока 
в программе. По умолчанию как 0.001 (0.1%).  

TEMP  Устанавливает фактическую рабочую температуру цепей схемы. Любое откло-
нение от TNOM произведет изменение в имитационных результатах. По умол-
чанию=27°C. 

TNOM  Устанавливает номинальную температуру для которой созданы модели уст-
ройств.  По умолчанию=27°C.  

TRTOL  Устанавливает коэффициент, определяющий допустимую ошибку округления. 
По умолчанию=7.0. 

VNTOL  Устанавливает абсолютный допуск ошибки напряжения в программе. VNTOL= 
RELTOL* (самая низкая величина напряжения в цепи). По умолчанию=1 µВ. 

BOOLL   Устанавливает низкий логического уровень. По умолчанию=0.0В. 
BOOLH   Устанавливает высокий логического уровень. По умолчанию=4.5В. 
BOOLT   Устанавливает входной уровень логического порога. По умолчанию=1.5В. 
BADMOS3  Использование старой версии MOS3 с параметром "kappa". По умолчанию=NO. 
KEEPOPINFO  Сохраняет OP информацию когда запущен AC анализ. По умолчанию=NO. 
TRYTOCOMPACT Применяется к LTRA модели.  Использование компактной формы информации 

о распределении токов и напряжений в линии. По умолчанию=NO. 
NOOPITER  Пропустить пошаговый GMIN алгоритм. По умолчанию=NO. 
GMINSTEP  Устанавливает число пошаговых GMIN алгоритмов. По умолчанию=10. 
SRCSTEP  Устанавливает число шагов в пошаговом алгоритме источника для DC сходи-

мости. По умолчанию=10. 
ACCT   Вызывает статистику времени прогона для отображения.  По умолчанию=NO. 
LIST  Отображает список всех элементов в схеме со связями и величинами. По умол-

чанию=NO. 
OPTS   Отображает список выбора параметров стандарта Spice3.  По умолчанию=NO. 
BYPASS  Допуск обходной схемы устройства для нелинейной оценки модели. По умол-

чанию=1. 
MINBREAK  Устанавливает минимальное время между точечными разрывами. По умолча-

нию=0 сек. 
MAXOPALTER  Устанавливает максимальное число чередований аналога/случая для DC сходи-

мости. По умолчанию=0. 
MAXEVTITER  Устанавливает максимальное число итераций случая для DC сходимости.  По 

умолчанию=0. 
NOOPALTER  Допускает DC чередования. По умолчанию=NO. 
RAMPTIME  Элемент управления от времени независимых источников, конденсаторов и ин-

дуктивностей с начальными условиями от нуля до их финала, оцениваются че-
рез некоторый определенный период времени. По умолчанию=0.0 сек. 

CONVLIMIT  Отключает алгоритм сходимости используемый в некоторых компонентных 
моделях.  По умолчанию=NO. 

CONVSTEP  Устанавливает предел относительного размера шага для DC сходимости кодо-
вых моделей.  По умолчанию=0.25. 

CONVABSSTEP  Устанавливает предел абсолютного размера шага для DC сходимости кодовых 
моделей.  По умолчанию=0.1. 

AUTOPARTIAL  Разрешает автоматическое вычисление частичных производных для кодовых 
модулей XSpice. По умолчанию=NO. 

PROPMNS  Коэффициент масштабирования, используемый для определения минимальной 
задержки распространения, когда фактическая величина не определена в 
SimCode модели. По умолчанию=0.5. 

PROPMXS  Коэффициент масштабирования, используемый для определения максимальной 
задержки распространения, когда фактическая величина не определена в 
SimCode модели. По умолчанию=1.5. 

TRANMNS  Коэффициент масштабирования, используемый для определения минимального 
времени перехода, когда фактическая величина не определена в SimCode моде-
ли. По умолчанию=0.5. 



TRANMXS  Коэффициент масштабирования, используемый для определения максимально-
го времени перехода, когда фактическая величина не определена в SimCode мо-
дели. По умолчанию=1.5. 

LOADMNS  Коэффициент масштабирования, используемый для определения минимальной 
входной погрузки или максимального входного сопротивления, когда фактиче-
ская величина не определена в SimCode модели. По умолчанию=1.5. 

LOADMXS  Коэффициент масштабирования, используемый для определения максимальной 
входной погрузки или минимального входного сопротивления, когда фактиче-
ская величина не определена в SimCode модели. По умолчанию=0.5. 

DRIVEMNS  Коэффициент масштабирования, используемый для определения максимально-
го выходного сопротивления, когда фактическая величина не определена в 
SimCode модели. По умолчанию=1.5. 

DRIVEMXS  Коэффициент масштабирования, используемый для определения минимального 
выходного сопротивления, когда фактическая величина не определена в 
SimCode модели. По умолчанию=0.5. 

CURRENTMNS  Коэффициент масштабирования, используемый для определения максимально-
го внутреннего сопротивления, когда фактическая величина не определена в 
SimCode модели. По умолчанию=1.5. 

CURRENTMXS  Коэффициент масштабирования, используемый для определения минимального 
внутреннего сопротивления, когда фактическая величина не определена в 
SimCode модели. Default=0.5. 

TPMNTYMX  Временное аннулирование глобального индекса задержки распространения в 
устройствах SimCode (0=default, 1=min, 2=typ, 3=max). 

TTMNTYMX  Временное аннулирование глобального индекса временного перехода в устрой-
ствах SimCode (0=default, 1=min, 2=typ, 3=max). 

LDMNTYMX  Временное аннулирование глобального входного индекса нагрузки в устройст-
вах SimCode (0=default, 1=min, 2=typ, 3=max).  

DRVMNTYMX  Временное аннулирование глобального выходного индекса нагрузки в устрой-
ствах SimCode (0=default, 1=min, 2=typ, 3=max). 

IMNTYMX  Временное аннулирование глобального индекса тока потребления в устройствах 
SimCode (0=default, 1=min, 2=typ, 3=max). 

SIMWARN  Ненулевая величина указывает, что предупреждающие сообщения SimCode мо-
гут быть отображены в течение моделирования. По умолчанию=0. 

RSHUNT  Величина сопротивлений добавленных между каждым узлом и землёй, чтобы 
устранять проблемы ошибок как, например, “singular matrix”. По умолчанию=0. 

ADCSTEP  Минимальный размер шага, требуемый для регистрации случая на входе внут-
реннего A/D преобразователя. По умолчанию=0.01 В. 

 
Модели устройств 
Общая форма 
.MODEL MNAME TYPE (PNAME1=PVAL1 PNAME2=PVAL2 ...) 
Пример представления в списке цепей 
.MODEL MOD1 NPN (BF=50 IS=1E-13 VBF=50) 
Даже самым простым элементам цепи обычно требуется несколько величин параметров. Тем не менее, 

некоторым устройствам, конкретно полупроводниковым устройствам требуется множество величин парамет-
ров. Часто многие устройства в схеме определяются одними и теми же параметрами модели. По этим причи-
нам набор параметров модели устройства определяется отдельной .MODEL строкой и назначается уникальное 
имя модели. Элементы устройств в Spice строке затем ссылаются на имя модели. 

Для более сложных типов устройств каждая элементная строка содержит имя устройства, узлы с кото-
рыми устройство связано и имя модели устройства. Кроме того, для некоторых устройств могут быть опреде-
лены другие дополнительные параметры: геометрические показатели и параметры инициализации. 

MNAME в вышеуказанной общей форме это имя модели, и TYPE это один из следующих пятнадцати 
типов: 

R  Сложная модель резистора 
C  Сложная модель конденсатора  
SW Ключ, управляемый напряжением 



CSW Ключ, управляемый током 
URC Распределённая RC линия 
LTRA Линия с большими потерями 
D Модель диода 
NPN Модель NPN транзистора 
PNP Модель PNP транзистора 
NJF Модель NJFET транзистора 
PJF Модель PJFET транзистора 
NMOS Модель NMOS транзистора 
PMOS Модель PMOS транзистора 
NMF Модель NMES транзистора 
PMF Модель PMES транзистора 
Величины параметров определяются добавлением имени параметра сопровождаемого знаком равенства 

и величиной параметра. Не заданным величинам назначаются значения по умолчанию. Модели, параметры 
моделей и значения по умолчанию указаны в следующей секции вместе с описанием устройств. 

 
Элементарные устройства 
Каждое устройство, используемое в схеме, требует определенную информацию для Spice моделирова-

ния. Эта секция описывает каждый тип устройства и требуемую информацию.  CircuitMaker обеспечивает этой 
информацией в Spice списке цепей.  

Показанная здесь информация поможет лучше понять, как каждый компонент влияет на результаты мо-
делирования цепи. Параметры, приложенные в “< >” символы являются дополнительными.  

 
Резисторы 
Общая форма 
RXXXXXXX N1 N2 VALUE 
Пример в списке цепей 
R1 1 2 10K 
Пример Spice данных 
%D %1 %2 %V 
N1 и N2 –  выводы элемента. Величина определяет сопротивление в Омах и может быть положительной 

или отрицательной, но не нуль. Если на N1 более высокое напряжение, чем на N2, ток через резистор будет 
положительным, иначе отрицательным. 

 
Сложные резисторы 
Общая форма 
RXXXXXXX N1 N2 <VALUE> <MNAME> <L=LENGTH> <W=WIDTH> <TEMP=T> 
Пример в списке цепей 
R1 1 2 10K 
R3 5 6 RMOD L=12u W=1u 
Пример Spice данных 
%D %1 %2 %M TEMP=100 
Пример Spice модели 
.MODEL RMOD R (TC1=15E-6) 
Это общая форма описания резистора, которая допускает моделирование температурных эффектов, вы-

числение фактической величины сопротивления из геометрической информации и спецификации процесса. 
Если параметр VALUE определен, геометрическая информация аннулируется. Если параметр MNAME опре-
делен, сопротивление может быть вычислено из информации модели MNAME и данных LENGTH и WIDTH. 
Если параметр VALUE не определен, параметры MNAME и LENGTH должны быть определены обязательно. 
Если параметр WIDTH не определен, принимается ширина, данная в модели по умолчанию. Дополнительная 
TEMP величина определяет рабочую температуру устройства и аннулирует температурную спецификацию в 
Analog Options диалоговом окне. 

 
Параметры модели (R) 
Доступные параметры: 
Имя  Параметр     Размер  По умолчанию 



TC1  температурный коэфф. сопротивления Ом/°C  0.0 
TC2  квадратичный температурный коэфф.  Ом/°C2  0.0 
RSH  удельное сопротивление   Ом/м2  - 
DEFW  ширина по умолчанию    м  1e-6 
NARROW сужение из-за бокового травления  м  0.0 
TNOM  температура измерения параметров  °C  27 
Удельное сопротивление использует параметры сужения, L и W резистора, чтобы определить номи-

нальное сопротивление по формуле: 
R = RSH (L – NARROW) / (W – NARROW) 
Параметр DEFW используется по умолчанию для W, если он не определён в устройстве. Если также не 

определены параметры RSH или L, используется стандартная величина сопротивления по умолчанию 1kОм. 
TNOM используется, чтобы аннулировать величину, данную в Analog Options, когда параметры этой модели 
измерены при другой температуре. После того, как номинальное сопротивление будет вычислено, то с учетом 
температуры сопротивление определяется формулой: 

R(T) = R(T0) [1 + TC1 (T – T0) +TC2 (T – T0)2] 
 
Конденсаторы 
Общая форма 
CXXXXXXX N+ N- VALUE <IC=INCOND> 
Пример в списке цепей 
C2 13 0 0.1UF 
C5 7 0 10UF IC=3V 
Пример Spice данных 
%D %1 %2 %V IC=12V 
N+ положительный узел и N- отрицательный узел. Параметр VALUE ёмкость в Фарадах. Начальное ус-

ловие является величиной инициализации напряжения на конденсаторе. Начальные условия принимаются, 
только если сделан UIC выбор в Transient Analysis. Если на N+ более высокое напряжение, чем на N- значит 
токовый поток через конденсатор положительный, иначе отрицательный. 

Spice использует идеальные конденсаторы, то есть конденсаторы без DC утечки. Все узлы в схеме 
должны иметь DC утечку на землю, поэтому нет возможности имитировать цепи с последовательно включен-
ными конденсаторами потому как создаётся полностью изолировать узел между конденсаторами. Одним из 
решений этой проблемы может быть соединение резистора с большим сопротивлением, например, 1ГОм в 
параллель с каждым конденсатором, чтобы создать принудительную утечку. 

 
Сложные конденсаторы 
Общая форма 
CXXXXXXX N+ N- <VALUE> <MNAME> <L=LENGTH> <W=WIDTH> <IC=INCOND> 
Пример в списке цепей 
C2 13 0 0.1UF 
C5 7 0 10UF CMODEL L=12u W=1u 
Пример Spice данных 
%D %1 %2 %M L=10U 
Пример Spice модели 
.MODEL CMOD C (CJ=120E-12 CJSW=200E-6) 
Это общая форма описания конденсатора с вычислением величины емкости из геометрической инфор-

мации и спецификации процесса. Если параметр VALUE определен, он определяет емкость конденсатора. Ес-
ли параметр MNAME определен, ёмкость вычисляется из информации процесса в модели MNAME и данных 
LENGTH и WIDTH. Если параметр VALUE не определен, параметры MNAME и LENGTH должны быть 
обязательно определены. Если параметр WIDTH не определён, то принимается ширина, определённая  по 
умолчанию.  

 
Параметры модели (C) 
Модель конденсатора содержит информацию процесса, которая может быть использована для вычисле-

ния емкости из геометрической информации. 
Имя  Параметр     Размер  По умолчанию 
CJ  удельная емкость    Ф/м2  - 



CJSW  емкость боковой стены   Ф/м  - 
DEFW  ширина устройства по умолчанию  м  1e-6 
NARROW сужение из-за бокового травления  м  0.0 
Ёмкость конденсатор вычисляется следующим выражением: 
CAP = CJ (LENGTH-NARROW) (WIDTH-NARROW) + 2 CJSW (LENGTH+WIDTH - 2 NARROW) 
 
Индуктивность 
Общая Форма 
LYYYYYYY N+ N- VALUE <IC=INCOND> 
Пример в списке цепей 
L3 12 9 1UH 
L4 5 0 100UH  IC=12.3MA 
Пример Spice данных 
%D %1 %2 %V IC=5MA 
N+ положительный узел и N- отрицательный узел. Параметр VALUE представляет индуктивность в 

Генри. Начальные условия определяют величину тока через индуктивность в нулевой момент времени. Если 
на N+ более высокое напряжение, чем на N- ток через индуктивность будет положительный, иначе отрица-
тельный.  

Индуктивность порождают напряжение в своей катушке, основанное на сумме изменения магнитного 
поля. Нельзя соединять индуктивности в параллель. Необходимо соединить резистор небольшой величины, 
например, 0.001 Ом последовательно с каждой индуктивностью, чтобы индуктивность имело реальное актив-
ное сопротивление. 

 
Связанные индуктивности (взаимоиндуктивность) 
Общая форма 
KXXXXXXX LYYYYYYY LZZZZZZZ VALUE 
Пример в списке цепей 
K12 L4 L3 0.999 
KXFRMR L1 L2 0.87 
Пример Spice данных (индуктивность с отводом) 
%DA %1 %2 50UH (индуктивность A) 
%DB %2 %3 50UH (индуктивность B) 
K%D %DA %DB .85 (коэффициент связи) 
LYYYYYYY и LZZZZZZZ - имена двух связанных индуктивностей, VALUE коэффициент связи (K), 

который должен быть больше чем 0 и меньше или равно 1.  Используется соглашение "точки", установка 
"точки" в первом узле каждой индуктивности указывает, что напряжения в этих узлах находятся в фазе. 

Если связываются более двух индуктивностей, Spice данные должны быть предусмотрены для каждой 
связи.  Например, трансформатор с одной первичной катушкой (L1) и двумя вторичными катушки (L2 и L3) 
могут выражаться следующим образом: 

L1 5 0 10MH 
L2 6 7 1MH 
L3 8 9 1MH 
K12 L1 L2 0.93 
K13 L1 L3 0.93 
K23 L2 L3 0.97 
Коэффициенты трансформации для данной пары катушек могут быть определены следующей форму-

лой, где LP и LS индуктивность первичной и вторичной катушек: 

Коэффициент трансформации = 
LP
LS

 

 
Ключи, управляемые напряжением/током 
Общая форма 
SXXXXXXX N+ N- NC+ NC- MODEL <ON><OFF> 
WXXXXXXX N+ N- VNAM MODEL <ON><OFF> 
Пример в списке цепей 



S1 1 2 3 4 SVS1  
S2 5 6 3 0 SVS2 ON 
W1 1 2 VS1 WIS1 
Пример Spice данных 
%D %1 %2 %3 %4 %M ON 
Пример Spice модели 
.MODEL NE2S SW (RON=1 ROFF=1T VT=55 VH=15) 
Узлы 1 и 2, с которыми связан ключ. ON/OFF указывает начальное состояние ключа. Узлы 3 и 4 поло-

жительный и отрицательный узлы управления ключом. Для управления токовым ключом используется ток 
через определенный источник напряжения. Положительным направлением управляющего тока принят ток из 
положительного узла управления через источник в отрицательный узел. 

 
Параметры модели (SW/CSW) 
Модель ключа позволяет создать почти идеальный ключ. Ключ не может быть идеальным, потому что 

сопротивление не может изменять от 0 до бесконечности, а должно всегда иметь положительную конечную 
величину. Эти значения определяются соответствующим выбором RON и ROFF сопротивлений. Доступные 
параметры: 

Имя Параметр   Размер  По умолчанию  Тип ключа 
VT пороговое напряжение  В  0.0   S 
IT пороговый ток   А  0.0   W 
VH напряжение гистерезиса В  0.0   S 
IH ток гистерезиса  А  0.0   W 
RON сопротивление  замыкания Ом  1.0   S W 
ROFF сопротивление размыкания Ом  1/GMIN  S W 
Использование идеальных элементов как, например нелинейные ключи, могут вызвать нарушения моде-

лирования. Быстрое изменение сопротивления ключа может вызвать проблемы допуска, ведущие к ошибоч-
ным результатам или трудностям выбора временного шага. Для улучшения ситуации использования ключей 
можно принять следующие меры: 

Сначала изменить идеальные полные сопротивления ключа ближе к реальным сопротивлениям. Исполь-
зование полных сопротивлений ключа, которые близки к "идеалу" во всех случаях усугубляют проблемы упо-
мянутые выше. Когда ключ моделирует реальные устройства как, например, MOSFET сопротивление замыка-
ния должно быть скорректировано в реалистичный уровень в зависимости от мощности устройства. 

Если большая разность сопротивлений должна быть использована в ключе (ROFF/RON > 1e+12), необ-
ходимо допуск на ошибку TRTOL сделать меньше чем значение по умолчанию 7.0 в Analog Options. Когда 
ключи используются вместе с конденсаторами, необходимо также уменьшить CHGTOL. Рекомендуемые ве-
личины для этих двух параметров 1.0 и 1e-16 соответственно. Эти изменения сообщают Spice3 быть более ос-
торожным в точках расчёта ключа, чтобы не было сделано ошибок из-за быстрых изменений величин в схеме. 

 
Независимые источники 
Общая форма 
VXXXXXXX N+ N- <<DC> VALUE> <AC <MAG <PHASE>>> 
IYYYYYYY N+ N- <<DC> VALUE> <AC <MAG <PHASE>>> 
Пример в списке цепей 
VCC 10 0 DC 6     
ISRC 1 2 AC .3 45 SIN (0 1 1MEG)  
VMEAS 12 9     
Пример Spice данных 
%D %1 %2 DC 0 SIN (0 1 1k 0 0) AC 1 0  
N+ положительный узел и N- отрицательный узел источника. Источники напряжения не обязательно 

должны быть заземлены. Положительный ток принят втекающим в положительный узел, через источник и из 
отрицательного узла. Источник тока заставляет течь ток положительной величины в узел N+, через источник и 
из N- узла. Источник напряжения дополнительно используется в качестве амперметра для Spice, при нулевом 
напряжении источника может включаться в цепь с целью измерения тока. Они не влияют на цепи, поскольку 
представляют собой короткое замыкание. 

VALUE это DC величина или смещение источника. Если исходная величина является нулем, она может 
быть опущена. Если источник неизменяемый во времени, величина может следовать за символами DC. 



Символы AC указывает на мало-сигнальный AC источник. MAG и PHASE используются только для 
AC анализа. Если MAG величина опущена следуя за ключевым словом AC, величина принимается как 1. Если 
PHASE величина опущена, она принимается как 0. 

Любой независимый источник может быть назначен с изменяющимися во времени величинами для 
Transient Analysis. Если источнику назначена изменяющаяся во времени величина, нулевая величина времени 
используется для DC анализа. Имеется пять независимых выходных функций: импульсная, экспоненциальная, 
синусоидальная, кусочно-линейная и одночастотная FM. 

Примечание: Для Spice имитации источники напряжения не могут устанавливаться параллельно, а ис-
точники тока не могут устанавливаться последовательно. 

 
Линейный источник тока управляемый напряжением 
Общая форма 
GXXXXXXX N+ N- NC+ NC- VALUE 
Пример в списке цепей 
G1 2 0 5 0 0.1MMHO 
Пример Spice данных 
%D %1 %2 %3 %4 %V 
N+ положительный узел и N- отрицательный узел источника. Токовый поток из положительного узла, 

через источник в отрицательный узел.  NC+ положительный узел управления и NC- отрицательный узел 
управления. Параметр VALUE определяет передачу проводимости. 

 
Линейный источник напряжения управляемый напряжением 
Общая форма 
EXXXXXXX N+ N- NC+ NC- VALUE 
Пример в списке цепей 
E1 2 3 14 1 2.0 
Пример Spice данных 
%D %1 %2 %3 %4 %V 
N+ положительный узел и N- отрицательный узел источника. Токовый поток из положительного узла, 

через источник в отрицательный узел. Параметр VALUE определяет усиление по напряжению. 
 
Линейный источник тока управляемый током 
Общая форма 
FXXXXXXX N+ N- VNAM VALUE 
Пример в списке цепей 
F1 5 17 VS2 0.5K 
Пример Spice данных 
V%D %3 %4 DC 0V   
%D %1 %2 V%D %V   
N+ и N- положительный и отрицательный узлы, соответственно.  Токовый поток из положительного уз-

ла, через источник в отрицательный узел. VNAM имя источника напряжения, ток которого управляет источ-
ником тока. Направление положительного управляющего тока из положительного узла, через источник в от-
рицательный узел VNAM. Параметр VALUE определяет усиление по току.  

 
Линейный источник напряжения управляемый током 
Общая форма 
HXXXXXXX N+ N- VNAM VALUE 
Пример в списке цепей 
H1 5 17 VS2 0.5K 
Пример Spice данных 
V%D %3 %4 DC 0V   
%D %1 %2 V%D %V   
N+ и N- положительный и отрицательный узлы, соответственно.  VNAM имя источника напряжения, 

через который течет управляющий ток. Направление положительного управляющего тока из положительного 



узла, через источник в отрицательный узел VNAM. Параметр VALUE определяет передачу по сопротивле-
нию.  

 
Нелинейный зависимый источник 
Общая форма 
BXXXXXXX N+ N- <I=EXPR> <V=EXPR> 
Пример в списке цепей 
BSO1 0 1 I=COS(V(1))+SIN(V(2)) 
BVS1 0 1 V=LN(COS(LOG(V(1,2)^2))) (3)^4+V(2)^V(1) 
Пример Spice данных 
%D %1 %2 V=%L 
N+ положительный узел, N- отрицательный узел источника. Величины V и I параметров определяют на-

пряжение и ток через устройство. Если в выражении дано I, тогда устройство является источником тока, если 
в выражении дано V, то устройство является источником напряжения. Только один из этих параметров дол-
жен быть определён для каждого источника. 

Выражения, данные для V и I, могут быть любой функцией напряжения и тока через источник напряже-
ние в системе. Например, V(2) указывает DC напряжение в узле 2 со ссылкой на землю, V(3,4) указывает на 
разность напряжения между узлами 3 и 4,  I(VS2) указывает DC ток через источник напряжения VS2. Сле-
дующие функции реальных переменных допускаются в выражениях: 

abs acos acosh asin asinh atan 
atanh  cos cosh exp ln log 
sin sinh sqrt tan u uramp 
Где u – функция размера шага с величиной аргументов больше чем нуль, и величиной нуля для аргумен-

тов менее чем нуль. Функция uramp – интеграл размера шага: для входа X, величина является нулем, если X 
менее нуля, или X, если величина X больше чем нуль. Эти две функции полезны в синтезе кусочно-
нелинейных функций. Следующие стандартные операторы допускаются в выражениях: 

+  * / ^ unary   - 
Если аргумент log, ln или sqrt становится менее нуля, используется абсолютная величина аргумента. 

Если делитель становится нулем или аргумент log или ln  становится нулём, произойдет ошибка. Другие про-
блемы могут произойти, когда аргумент для функции в частичной производной вводит регион, где эта функ-
ция не определена. 

Кроме того, допустимы следующие логические операторы.  Входная пороговая величина (BOOLT) и 
выходные величины (BOOLL и BOOLH) определяются в Analog Options диалоговом окне. 

 & (AND) 
 | (OR) 
 ! (XOR) 
 ~ (NOT) 
Более старые версии Spice использовали POLY функции описания нелинейных источников. Например, 

следующие утверждения являются эквивалентными: 
E1 19 0 POLY(2)7 4 2 0 3 .1 .5  (Spice2) 
E1 19 0 POLY(2)(7,4)(2,0)3.1.5 (Spice2) 
B1 19 0 V = 3 + .1*V(7,4) + .5*V(2,0) (Spice3) 
B1 19 0 V = 3 + .1*V(7,4) + .5*V(2) (Spice3) 
Каждое утверждение указывает, что напряжение в узле 19 равняется 3 Вольта, плюс .1 времени напря-

жения между узлами 7 и 4, плюс .5 времени напряжения в узле 2 относительно земли.  Много существующих 
Spice макромоделей используют этот тип нелинейного источника.  CircuitMaker автоматически преобразовы-
вает их в Spice3 формат при запуске моделирования. 

Чтобы получать время в выражении, можно использовать источник тока с конденсатором и использо-
вать результирующее напряжение, только нужно не забывать устанавливать начальное напряжение на конден-
саторе. Нелинейные резисторы, конденсаторы и индуктивности могут быть синтезированы нелинейным зави-
симым источником. Нелинейный резистор очевиден. Нелинейные конденсаторы и индуктивности осуществ-
ляются их линейными аналогами изменением переменных нелинейным зависимым источником. Следующая 
макромодель осуществляет работу нелинейного конденсатора: 

.Subckt nlcap pos neg 
* Bx: вычисляет f(входное напряжение) 
Bx   1    0    v = f(v(pos,neg)) 



* Cx: линейная емкость 
Cx   2    0    1 
* Vx: источник напряжения измеряет ток конденсатора 
Vx   2    1    DC 0 
* Источник тока управляемый током через Cx  
Fx   pos   neg   Vx 1 
Нелинейные индуктивности создаются аналогично. 
 
Линия передачи без потерь 
Общая форма 
TXXXXXXX N1 N2 N3 N4 Z0=VALUE 
+ <TD=VALUE> <F=FREQ <NL=NRMLEN>> <IC=V1,I1,V2,I2> 
Пример в списке цепей 
T1 3 0 2 0 Z0=50 TD=20NS 
Пример Spice данных 
%D %1 %2 %3 %4 Z0=%V TD=10NS 
N1 и N2 узлы порта 1, N3 и N4 узлы порта 2. Параметр Z0 определяет полное характеристическое со-

противление. Длина линии может быть выражена в двух формах. Задержка передачи в линии TD может опре-
деляться непосредственно. Частота F может быть дана вместе с NL, нормализованной электрической длиной 
линии передачи определяющую длину волны в линии на частоте F. Если частота определена, а NL опущена, 
то NL принимается как 0.25, то есть четверть волны. 

Спецификация начальных условий состоит из напряжения и тока в каждом порте линии передачи. На-
чальные условия принимаются, если сделан UIC выбор в Transient Analysis. Линия передачи с большими по-
терями описанная ниже может быть точнее, чем линия передачи без потерь из-за деталей реализации. 

 
Линия передачи с потерями  
Общая форма 
OXXXXXXX N1 N2 N3 N4 MNAME 
Пример в списке цепей 
O2 3 0 2 0 OXLINE 
Пример Spice данных 
%D %1 %2 %3 %4 %M 
Пример Spice модели 
.MODEL OXLINE LTRA(LEN=0.11 LININTERP=SET) 
Это двух портовая  модель свертки для однопроводной линии передачи с большими потерями.  N1 и N2 

узлы порта 1 и N3 и N4 узлы порта 2.    
 
Параметры модели (LTRA) 
Однородная RLC/RC/LC/RG модель линии передачи, именованная как модель LTRA моделирует одно-

родную с постоянными параметрами распространения линию передачи. Случаи RC и LC могут быть смодели-
рованы использованием URC и TRA моделей, тем не менее, новая LTRA модель более быстрая и точнее чем 
другие. Действие LTRA модели основано на свертке выходных импульсов линии передачи с входными им-
пульсами. LTRA модель имеет множество параметров, некоторые из них должны быть даны обязательно, а 
некоторые из них дополнительные. 

Имя  Параметр      Размер  По умолчанию 
R   погонное сопротивление    Ом/м  0.0 
L   погонная индуктивность    Г/м  0.0 
G  погонная проводимость    См/м  0.0 
C   погонная ёмкость     Ф/м 0.0 
LEN  длина линии      м  - 
REL  управление точечными разрывами   -  1 
ABS  управление точечными разрывами   -  1 
NOSTEPLIMIT отключение ограничения временного шага  флаг  не установлен 
NOCONTROL отключение управления временным шагом  флаг  не установлен 
LININTERP использование линейной интерполяции  флаг  не установлен 
MIXEDINTERP использование линейной вместе с квадратурной флаг  не установлен 



COMPACTREL специальный reltol для уплотнения   -  RELTOL 
COMPACTABS специальный abstol для уплотнения   -  ABSTOL 
TRUNCNR использование метода Ньютона-Рафсона  флаг  не установлен 
TRUNCDONTCUT отключение лимита временного шага  флаг  не установлен 
 Поддерживаются следующие типы линий: RLC однородная линия передачи с последовательным зату-

ханием, RC однородная RC линия, LC линия передачи без потерь и RG с распределённым последовательным 
сопротивлением и параллельной проводимостью. Любая другая комбинация даёт ошибочные результаты и не 
должны анализироваться. 

Длина линии LEN должна быть определена обязательно. NOSTEPLIMIT это флаг, который удаляет ог-
раничение по умолчанию временного шага, чтобы быть менее чем задержки в линии для RLC. NOCONTROL 
это флаг, который предохраняет ограничение по умолчанию временного шага находящегося в критериях 
ошибки свертки для RLC и RC случая. Это ускоряет моделирование, но может в некоторых случаях умень-
шить точность результатов. LININTERP это флаг, который определяет использование линейной интерполя-
ции вместо определённой по умолчанию квадратурной интерполяции для расчета задержки сигнала. 
MIXEDINTERP это флаг, который позволяет использовать независимо квадратурную интерполяцию при ис-
пользовании линейной интерполяции. TRUNCDONTCUT это флаг, который отменяет снижение по умолча-
нию временного шага, чтобы ограничить ошибки в фактическом вычислении импульсного ответа.  

COMPACTREL и COMPACTABS это величины, которые управляют уплотнением предшествующих 
величин сохраняемых для свертки. Их большие величины уменьшают точность, но обычно увеличивают ими-
тационную скорость. Это может быть использовано определением TRYTOCOMPACT параметра в Analog Op-
tion окне. TRUNCNR это флаг, который включает использование итерации Ньютона-Рафсона, чтобы опреде-
лять подходящий временной шаг в управляющих программах. По умолчанию эта процедура при ошибке уда-
ляет предшествующий временной шаг и заменяет уменьшенным на половину.  

REL и ABS это величины, которые управляют установкой точечных разрывов. Выбор REL наиболее 
стоящий для экспериментирования с повышением скорости моделирования. Значение по умолчанию 1 обычно 
сохраняет точность, но вычислительное время увеличивается. Величина больше чем 2 устраняет все точечные 
разрывы и может иметь смысл, в зависимости от топологии схемы, если будет безопасной с точки зрения точ-
ности. Точечные разрывы можно устранить полностью, если ожидается что цепь, не отобразит острые нару-
шения. Величины между 0 и 1 обычно не требуются, но могут быть использованы для установки многоточеч-
ных разрывов. 

Параметр COMPACTREL может также экспериментироваться, когда в Analog Option определен 
TRYTOCOMPACT параметр. Обычно определяется диапазон между 0 и 1, большая величина уменьшает точ-
ность моделирования, но в некоторых случаях увеличивает скорость. Если параметр TRYTOCOMPACT не 
определен в Analog Options, уплотнения не будет и точность будет высокая. Параметры NOCONTROL, 
TRUNCDONTCUT и NOSTEPLIMIT также увеличивают скорость за счет точности. 

 
Однородная RC линия с потерями 
Общая форма 
UXXXXXXX N1 N2 N3 MNAME L=LEN <N=LUMPS> 
Пример в списке цепей 
U1 1 2 0 UXLINE L=50UM N=6 
Пример Spice данных 
%D %1 %2 %3 %M L=25u 
Пример Spice модели 
.MODEL UXLINE URC(K=1.2 FMAX=6.5MEG) 
N1 и N2 два элементных узла соединения линии RC, узел N3 для связи с ёмкостью. MNAME имя моде-

ли, LEN длина RC линии в метрах. LUMPS определяет количество единовременных сегментов, используемых 
в моделировании RC линии, если параметр опущен, используется значение по умолчанию. 

 
Параметры модели (URC) 
URC модель производная от модели предложенной L.Gertzberrg в 1974. Модель URC линии выполнена в 

виде макромодели одновременным подключением RC сегментов с непосредственно сгенерированными узла-
ми. Величины RC сегментов в геометрической прогрессии повышаются к середине URC линии, где K кон-
станта прямой пропорциональности. Если количество используемых сегментов не определено для URC линии, 
то количество определяется следующей формулой: 

N = log [Fmax (R/L) (C/L) 2pL^2 {(K-1)/K}^2] / log K 



URC линия создается строго из сегментируемых резисторов и конденсаторов. Но если величина ISPERL 
параметр дана не равной нулю, в этом случае конденсаторы заменяются обратно смещёнными диодами с ну-
левым эквивалентом соединительной емкости и током насыщения ISPERL Ампер на метр линии передачи и 
последовательным эквивалентным сопротивлением диода RSPERL Ом на метр. 

Имя  Параметр     Размер  По умолчанию 
K  константа распространения   -  2.0 
FMAX  максимальная частота    Гц  1.0G 
RPERL  сопротивление на единицу длины  Ом/м  1000 
CPERL  ёмкость на единицу длины   Ф/м  1.0e-15 
ISPERL  ток насыщения на единицу длины  A/м  0 
RSPERL  сопротивление диода на единицу длины Ом/м  0 
 
Диод 
Общая форма 
DXXXXXXX N+ N- MNAME <AREA> <OFF> <IC=VD> <TEMP=T> 
Пример в списке цепей 
D3 2 10 D1N914 OFF 
D5 7 12 D1N4001 3.0 IC=0.2 
Пример Spice данных 
%D %1 %2 %M OFF IC=.6 TEMP=70 
Пример Spice модели 
.MODEL DCLAMP D(IS=1E-15 IBV=1E-13) 
N+ положительный узел и N- отрицательный узел диода.  MNAME имя модели, AREA показатель крат-

ности параллельно соединённых диодов и OFF указывает дополнительный условия к устройству для OP ана-
лиза. Использование спецификации начальных условий IC=VD возможно, если сделан UIC выбор в Transient 
Analysis. TEMP величина является температурой, при которой это устройство должно работать, и аннулирует 
температурную спецификацию в Analog Options окне. 

 
Параметры модели (D) 
DC характеристики диода определяются параметрами IS и N, внутреннее сопротивление параметром 

RS. Эффекты хранения заряда имеют отношение к транзитному времени TT и нелинейной ёмкости слоя, ко-
торая определяется параметрами CJO, VJ и M. Температурная зависимость тока насыщения определяется па-
раметрами EG и XTI, температурным показателем насыщения тока. Номинальная температура TNOM, при 
которой эти параметры были измерены, устанавливается по умолчанию в Analog Options. Обратный пробой 
смоделирован экспоненциальным увеличением обратного тока диода и определен параметрами BV и IBV. 

Имя Параметр    Размер  По умолчанию  Кратность 
IS ток насыщения    А  1.0e-14   * 
RS сопротивление    Ом  0   * 
N коэффициент эмиссии   -  1 
TT время транзита заряда   с  0 
CJO ёмкость при нулевом смещения Ф  0   * 
VJ соединительный потенциал  В  1 
M коэффициент умножения  -  0.5 
EG энергия активизации   эВ  1.11 (Si=1.11, Sbd=0.69, Ge=0.67) 
XTI температурный коэффициент IS -  3.0 (jn=3.0, Sbd=2.0) 
KF коэффициент фликкер-шума  -  0 
AF показатель фликкер-шума  -  1 
FC коэффициент нелинейности CJO -  0.5 
BV обратное напряжение пробоя  В  бесконечное 
IBV ток напряжения пробоя  А  1.0e-3 
TNOM температура измерения параметров °C  27 
 
Биполярный транзистор 
Общая форма 
QXXXXXXX NC NB NE <NS> MNAME <AREA> <OFF> <IC=VBE, VCE> <TEMP=T> 
Пример в списке цепей 



Q5 11 26 4 Q2N3904 IC=0.6, 5.0 
Q3 5 2 6 9 QNPN .67 
Пример Spice данных 
%D %1 %2 %3 %M .67 OFF 
Пример Spice модели 
.MODEL BF1234C NPN(IS=1E-15 BF=150 VKF=200 
+     IKF=0.01 CJE=13pF CJC=10pF CJS=10pF) 
NC, NB и NE это узлы коллектора, базы и эмиттера, соответственно, а NS дополнительный узел под-

ложки; если неопределён то используется земля. MNAME это имя модели, AREA показатель кратности па-
раллельных переходов, OFF указывает дополнительные условия запуска устройства для OP анализа. Исполь-
зование спецификации начальных условий IC=VBE, VCE возможно, если определён UIC выбор для Transient 
Analysis. TEMP определяет температуру при которой устройство работает, и аннулирует спецификацию в 
Analog Options диалоговом окне. 

 
Параметры модели (NPN/PNP) 
Модель биполярного транзистора в Spice адаптирована под управляющую модель Gummel-Poon. Эта 

модель расширяет оригинальную модель, включая несколько эффектов при высоких уровнях смещения. Мо-
дель автоматически упрощается до простой модели Ebers-Moll, когда некоторые параметры не определены. 
Имена параметров используемые в модифицированной модели Gummel-Poon обычно не вызывают затрудне-
ний у потребителей, и необходимы для улучьшения работы схемы. 

Модель определяется DC параметрами IS, BF, NF, ISE, IKF и NE, которые определяют основные харак-
теристики усиления по току. Параметры IS, BR, NR, ISC, IKR и NC определяют обратные характеристики 
усиления по току, VAF и VAR определяют выходную проводимость для основных и обратных регионов. 
Включены параметры объёмных сопротивлений RB, RC и RE, причём RB может сильно зависить от тока. Па-
раметры, связанные с зарядом внутренних ёмкостей, моделируется основным и обратным транзитным време-
нем TF и TR. Основное транзитное время TF зависит от смещения нелинейной ёмкости перехода, которая оп-
ределяется параметрами CJE, VJE и MJE для перехода база-эмиттер, CJC, VJC и MJC для перехода база-
коллектор и CJS, VJS, MJS для перехода коллектор-подложка. Температурная зависимость тока насыщения 
IS определяется шириной запрещённой зоны EG, и температурным коэффициентом XTI. К тому же темпера-
турная зависимость передачи по току моделируется температурным показателем XTB в новой модели. Опре-
деленные величины измерены при температуре TNOM, которая может быть определена в Analog Options или 
в Spice Data области. 

BJT параметры, используемые в модифицированной модели Gummel-Poon, показаны ниже. Имена пара-
метров, используемые в более ранних версиях Spice2 все еще действительны. 

Параметры BJT:  
Имя Параметр     Размер  По умолчанию  Кратность 
IS ток насыщения     А  1.0e-16   * 
BF максимальный коэфф. передачи по току -  100 
NF основной коэффициент не идельности -  1.0 
VAF напряжение Эрли в основном режиме  В  ∞ 
IKF спад зависимости BF от тока коллектора А  ∞   * 
ISE ток насыщения перехода Б-Э   А  0   * 
NE коэффициент не идеальности Б-Э  -  1.5 
BR обратный коэфф. передачи тока  -  1 
NR обратный коэффициент не идеальности -  1 
VAR обратное напряжение Эрли   В  ∞  
IKR обратный спад зависимости BF от  А  ∞   * 
  тока коллектора 
ISC ток насыщения перехода Б-К   А  0   * 
NC коэфф. не идеальности перехода Б-К  -  2 
RB объёмное сопротивление базы   Ом  0   * 
IRB ток снижения сопротивления базы  А  ∞   * 
  на половину своей величины 
RBM минимальное сопротивление базы  Ом  RB   * 
  при больших токах 
RE объёмное сопротивление эмиттера  Ом  0   * 



RC объёмное сопротивление коллектора  Ом  0   * 
CJE ёмкость при нулевом смещении Б-Э  Ф  0   * 
VJE контактное напряжение перехода Б-Э  В  0.75 
MJE коэффициен плавности перехода Б-Э  -  0.33 
TF основное идеальное время транзита  с  0 
XTF коэфф. зависимости TF от смещения  -  0 
VTF напряжение зависимости TF от  В  ∞ 
  смещения перехода Б-К  
ITF высокий ток воздействия на  параметр TF А  0   *  
PTF фазовый сдвиг на частоте 1.0/(TF*2π)Гц º  0 
CJC ёмкость при нулевом смещении Б-К  Ф  0   * 
VJC контактное напряжение перехода Б-К  В  0.75 
MJC коэффициен плавности перехода Б-К  -  0.33 
XCJC коэффициент расщепления ёмкости Б-К -  1 
TR обратное идеальное время транзита  с  0 
CJS ёмкость коллектор-подложка при  Ф  0   * 
  нулевом смещении 
VJS контактный потенциал подложки  В  0.75 
MJS коэффициент плавности подложки  -  0 
XTB температурный коэффициент BF и BR -  0 
EG ширина запрещённой зоны   эВ  1.11 
XTI температурный коэффициент IS  -  3 
KF коэффициент фликкер-шума   -  0 
AF показатель фликкер-шума   -  1 
FC коэффициент нелинейности ёмкости  -  0.5 
  прямо смещённых переходов 
TNOM температура измерения параметров  °C  27 
 
Полевой транзистор с управляющим переходом (JFET) 
Общая форма 
JXXXXXXX ND NG NS MNAME <AREA> <OFF> <IC=VDS, VGS> <TEMP=T> 
Пример в списке цепей 
J2 6 3 21 J2N3819 OFF 
Пример Spice данных 
%D %1 %2 %3 %M .67 
Пример Spice модели 
.MODEL 2N1234 NJF(VTO=-1 RD=100 RS=90 CGS=5pF) 
ND, NG и NS это узлы стока, затвора и истока, соответственно. MNAME это имя модели, AREA - пока-

затель кратности, и OFF указывает дополнительное начальное условие в устройстве для OP анализа. Исполь-
зование начальных условий возможно, если отмечен UIC выбор в Transient Analysis. TEMP это рабочая тем-
пература устройства, которая аннулирует температурную спецификацию в Analog Options диалоге. 

 
Параметры модели (NJF/PJF) 
JFET модель производная от FET модели Шихмана-Ходжеса. Характеристики DC определяются пара-

метрами VTO и BETA, которые определяют изменение тока стока от напряжения затвора. LAMBDA, которая 
определяет выходную проводимость, и IS, ток насыщения перехода затвор-канал. Два значения объёмного 
сопротивления стока RD и истока RS. Хранение зарядов моделируется нелинейными ёмкостями переходов 
для обоих соединений затвора, и определяются параметрами CGS, CGD и PB. Необходимо отметить, что в 
Spice3f и более поздних версиях, добавлен параметр B. 

Имя  Параметр    Размер  По умолчанию  Кратность 
VTO  напряжение порога   В  -2.0 
BETA  коэффициент пропорциональности А/В2  1.0e-4   * 
LAMBDA параметр модуляции канала  1/В  0 
RD  объёмное сопротивление стока Ом  0   * 
RS  объёмное сопротивление истока Ом  0   * 
CGS  ёмкость З-И при нулевом смещении  Ф  0   * 



CGD  ёмкость З-С при нулевом смещении Ф  0   * 
PB  контактный потенциал затвора В  1 
IS  ток насыщения затвора  А  1.0e-14   * 
B   параметр легирования   -  1 
KF  коэффициент фликкер-шума  -  0 
AF  показатель фликкер-шума  -  1 
FC  коэффициент нелинейности  -  0.5 
   прямой ёмкости переходов 
TNOM  температура измерения параметров °C  27 
 
МОП-транзистор (MOSFET) 
Общая форма 
MXXXXX ND NG NS NB MNAME <L=VAL> <W=VAL> <AD=VAL> 
+ <AS=VAL> <PD=VAL> <PS=VAL> <NRD=VAL> <NRS=VAL> <OFF> 
+ <IC=VDS,VGS,VBS> <TEMP=T> 
Пример в списке цепей 
M6 23 16 0 17 MRF150 
Пример Spice данных 
%D %1 %2 %3 %3 %M TEMP=55 
Пример Spice модели 
.MODEL MOSMOD1 NMOS(LEVEL=1 VTO=1 RD=1 RS=1 
+  IS=1E-15 KF=1.0E-26 CJ=2.0E-4 CJSW=1.0E-9 
+  KP=3.1E-5 PB=0.87) 
ND, NG, NS и NB это узлы стока, затвора, истока и подложки, соответственно. MNAME это имя моде-

ли.  L и W - канальная длина и ширина в метрах. AD и AS – площадь диффузионных областей стока и истока в 
метрах квадратных. Если параметры L, W, AD или AS не определены, используются значения по умолчанию. 
Использование установок по умолчанию упрощает подготовку входного файла, однако требует редактирова-
ния, если геометрия устройства должна изменяться. PD и PS – периметр диффузионных областей стока и ис-
тока в метрах. NRD и NRS определяют удельное относительное сопротивление областей стока и истока. OFF 
указывает дополнительные условия запуска устройства для DC анализа. Спецификация начальных условий 
используется, только если UIC выбор определён в Transient Analysis. Использование .IC устройств лучший и 
более удобный путь определения нерезидентных начальных условий. 

TEMP это дополнительная величина температуры при которой это устройство должно действовать, и 
аннулирует температурную спецификацию в Analog Options диалоге. Температурная спецификация действи-
тельна только для MOSFET 1, 2, 3 и 6 уровня. 

 
Параметры модели (NMOS/PMOS) 
Spice предоставляет четыре MOSFET модели устройств, которые отличаются формулировкой характе-

ристики I-V. Переменная LEVEL определяет уровень модели для использования: 
LEVEL=1 Шихмана-Ходжеса 
LEVEL=2 MOS2 
LEVEL=3 MOS3, эмпирическая модель 
LEVEL=4 BSIM1 
LEVEL=5 BSIM2 
LEVEL=6 MOS6 
DC параметры 1-3 уровней MOSFET определяются параметрами VTO, KP, LAMBDA, PHI и GAMMA. 

Эти параметры вычисляются Spice, если даны параметры процесса (NSUB, TOX, …), при этом величины 
определённые потребителем всегда аннулируются. VTO может быть положительным или отрицательным в 
зависимости от типа транзистора, с N или P каналом. Хранение зарядов моделируется тремя постоянными ём-
костями CGSO, CGDO и CGBO, которые представляют собой нелинейные ёмкости перекрытия между затво-
ром и стоком, истоком и подложкой. Spice параметры уровня 1, 2, 3 и 6: 

Имя  Параметр     Размер  По умолчанию 
LEVEL  индекс модели     -  1 
VTO  пороговое напряжение    В  0.0 
KP  параметр удельной крутизны   А/В2  2.0e-5 
GAMMA  параметр влияния потенциала подложки В0,5  0.0 



PHI  поверхностный потенциал   В  0.6 
LAMBDA параметр модуляции длины канала  1/В  0.0 
   только MOS1 и MOS2 
RD  объёмное сопротивление стока  Ом  0.0 
RS  объёмное сопротивление истока  Ом  0.0 
CBD  емкость С-П при нулевом смещении  Ф  0.0 
CBS  емкость И-П при нулевом смещении  Ф  0.0 
IS  ток насыщения прехода С-П   А  1.0e-14 
PB  соединительный потенциал подложки  В  0.8 
CGSO  ёмкость перекрытия З-И   Ф/м  0.0 
   на ширину канала 
CGDO  ёмкость перекрытия З-С   Ф/м  0.0 
   на ширину канала 
CGBO  ёмкость перекрытия З-П   Ф/м  0.0 
   на ширину канала 
RSH  удельное сопротивление диффузионных Ом/кв.  0.0 
   областей стока и истока  
CJ  удельная ёмкость С-П и И-П   Ф/м2 0.0 
   при нулевом смещении 
MJ  коэфф. плавности перехода С-П и И-П -  0.5 
CJSW  удельная ёмкость боковой поверхности Ф/м 0.0 
   С-П и И-П при нулевом смещении 
MJSW  коэфф. наклона боковой поверхности  -  0.50 (уровень 1) 
   переходов С-П и И-П       0.33 (уровень 2, 3) 
JS  плотность тока насыщения   А/м2  
   переходов С-П и И-П 
TOX  толщина оксида    м  1.0e-7 
NSUB  уровень легирования подложки  1/см3  0.0 
NSS  плотность подложки    1/см2  0.0 
NFS  быстрая поверхностная плотность  1/см2  0.0 
TPG  тип легирования затвора   -  1.0 
   +1 как на подложке 
   -1 противоположный подложке 
   0 металл 
XJ  глубина металлургического перехода  м  0.0 
LD  длина боковой диффузии   м  0.0 
UO  подвижность носителей тока   см2/В*с 600 
UCRIT  критическая напряжённость поля  В/см  1.0e4 
   снижения подвижности, только MOS2 
UEXP  критический показатель области   -  0.0 
   снижения подвижности, толькоMOS2 
UTRA  коэфф. подвижности поперечной области -  0.0 
   удалено для MOS2 
VMAX  максимальная скорость носителей  м/с  0.0 
NEFF  коэффициент коррекции концентрации -  1.0 
   примесей, только MOS2 
KF  коэффициент плотности фликкер-шума -  0.0 
AF  показатель фликкер-шума   -  1 
FC  коэффициент нелинейности ёмкости  -  0.5 
   прмосмещённого перехода подложки 
DELTA  коэфф. влияния ширины канала на  -  0.0 
   пороговое напряжение, в MOS2 и MOS3 
THETA  коэфф. модуляции носителей, только MOS3 1/В  0.0 
ETA  статическая обратная связь, только MOS3 -  0.0 
KAPPA  параметр модуляции длины канала  -  0.2 
   только MOS3 
TNOM  температура измерения параметров  °C  27 



В моделях 4 и 5 уровней  (BSIM1 и BSIM2) параметры являются величинами, полученными из характе-
ристик технологического процесса специальным тестером, и генерируются автоматически. Таким образом, нет 
установок по умолчанию для параметров, и единственное расхождение считается ошибкой. Spice параметры 
BSIM транзистора 4 уровня: 

Имя  Параметр      Размер  l/w 
VFB  напряжение плоских зон    В  * 
PHI  поверхностный потенциал инверсного слоя  В  * 
K1  коэффициент влияния подложки   В0,5  * 
K2  коэффициент разделения заряда   -  * 
   обеднённой области С-И 
ETA  коэффициент зависимости порогового  -  * 
   напряжения от напряжения П-С  
MUZ  подвижность посителей при нулевом смещении см2/В*с 
DL  уменьшение длины канала    мм 
DW  уменьшение ширины канала    мм 
U0  коэффициент изменения подвижности  В-1  * 
   от смещения поперечной области 
U1  коэффициент скорости носителей   мм/В  * 
   от напряжения стока 
X2MZ  чувствительность носителей    см2/В2*с 
   к напряженю подложки 
X2E  чувствительность индуцированного слоя  В-1  * 
   к напряжению подложки 
X3E  чувствительность индуцированного слоя  В-1  * 
   к напряжению на стоке 
X2U0  чувствительность подвижности носителей  В-2  * 
   к напряжению подложки 
X2U1  чувствительность скорости носителей   мм*В-2  * 
   к напряжению подложки 
MUS  подвижность носителей при    см2/В2*с 
   нулевом смещении подложки 
X2MS  чувствительность подвижности носителей  см2/В2*с * 
   при нулевом смещении подложки 
X3MS  чувствительность подвижности носителей  см2/В2*с * 
   к напряжению стока 
X3U1  чувствительность скорости носителей   мм*В-2  * 
   к напряжению стока 
TOX  толщина оксида затвора    мм 
TEMP  температура измерения параметров   °C 
VDD  коэффициент влияния напряжения смещения  В 
CGDO  ёмкость перекрытия З-С    Ф/м 
   на длину канала 
CGSO  ёмкость перекрытия З-И    Ф/м 
   на длину канала 
CGBO  ёмкость перекрытия З-П    Ф/м 
   на длину канала 
XPART  флаг распределения заряда С-И   - 
N0  субпороговый коэффициент наклона   -  * 
   при нулевом смещении подложки 
NB  чувствительность коэффициента наклона  -  * 
   к напряжению на подложке 
ND  чувствительность коэффициента наклона  -  * 
   к напряжению на стоке 
RSH  удельное сопротивление диффузионных  Ом/кв. 
   областей стока и истока 
JS  плотность тока насыщения С-П и И-П   А/м2 

PB  встроенный потенциал соединения С-И  В 



MJ  коэффициент плавности соединения С-И  - 
PBSW  встроенный потенциал соединительной  В 
   боковой стены С-И 
MJSW  коэффициент наклона  соединительной  - 
   боковой стены С-И 
CJ  удельная ёмкость переходов С-П и И-П  Ф/м2 

   при нулевом смещении 
CJSW  удельная ёмкость соединительной боковой  Ф/м 
   стены С-П и И-П при нулевом смещении 
WDF  ширина переходов С-П и И-П по умолчанию  м 
DELL  уменьшение соединительной длины по умолчанию м 
Когда XPART=0 устанавливается соотношение зарядов С-И равное 40/60, при XPART=1 соотношение 

равно 0/100. 
 
Арсенидгаллиевый полевой транзистор (GaAsFET) 
Общая форма 
ZXXXXXXX ND NG NS MNAME <AREA> <OFF> <IC=VDS, VGS> 
Пример в списке цепей 
Z1 3 5 6 ZM2 OFF 
Пример Spice данных 
%D %1 %2 %3 %M OFF 
Пример Spice модели 
.MODEL ZM2 NMF(VTO=-1.0 RD=1.0E-4 RS=100) 
ND, NG и NS это узлы стока, затвора и истока, соответственно. MNAME - имя модели, AREA - показа-

тель кратности, OFF указывает дополнительный условия запуска устройства для OP анализа. Начальная спе-
цификация условий используется, только если определён UIC выбор в Transient Analysis. 

Параметры модели (NMF/PMF) 
MESFET модель производная от GaAsFET модели. DC характеристики определяются параметрами 

VTO, B и BETA, которые определяют изменение тока стока от напряжения затвора. Параметр ALPHA опре-
деляет напряжение насыщения, и LAMBDA определяет выходную проводимость.  

Включены параметры объёмных сопротивлений RD и RS. Хранение зарядов моделируется ёмкостями 
переходов затвора со стоком и истоком и определяется параметрами CGS, CGD и PB. 

Имя  Параметр    Размер  По умолчанию  Кратность 
VTO  барьерное напряжение   В  -2.0 
BETA  параметр пропорциональности А/В2  1.0e-4   * 
B   параметр легирования   1/В  0.3   * 
ALPHA  параметр напряжения насыщения 1/В  2   * 
LAMBDA параметр модуляции канала  1/В  0 
RD  объёмное сопротивление стока Ом  0   * 
RS  объёмное сопротивление истока Ом  0   * 
CGS  соединительная ёмкость З-И  Ф  0   * 

при нулевом смещении 
CGD  соединительная ёмкость З-С  Ф  0   * 
   при нулевом смещении 
PB  соединительный потенциал затвора В  1 
KF  коэффициент фликкер-шума   -  0 
AF  показатель фликкер-шума  -  1 
FC  коэффициент нелинейности   -  0.5 
   ёмкости прямосмещённого затвора 
 
Макромодель 
Общая форма 
XYYYYYYY N1 <N2 N3 …> SUBNAM 
Пример в списке цепей 
XU1 7 5 6 12 3 XLM741 
Пример Spice данных 



%D %1 %2 %3 %4 %5 %S 
Макромодели, используемые в Spice, определяются обозначение устройств символом X, сопровождае-

мое списком узлов для подключения и именем макромодели. 
 
Устройства SimCode 
Общая форма 
AXXXXXXX [NPI NGI NI1I <NI2I …>][NPO NI1O <NI2O …> NO1O <NO2O …>] MNAME 
Пример в списке цепей 
A2 [6 8 4] [7 9 5] 2404B 
Пример Spice данных 
%D [%4bi %2bi %1i] [%4bo %1o %2o] %M 
Все узлы, указанные в цифровом SimCode устройстве является цифровыми узлами устройства. NPI и 

NGI цифровые входные узлы для силовых и земляных выводов. NI1I, NI2I и т.п. цифровые входные узлы для 
входных выводов устройства.  NPO цифровой выходной узел силового вывода. NI1O, NI2O и т.п. цифровые 
выходные узлы входных выводов устройства. NO1O, NO2O и т.п. цифровые выходные узлы выходных выво-
дов устройства. Квадратными скобками ([ ]) отделяют входные узлы от выходных узлов. В Spice Data области 
силовая и земляная шины включают символ “b”, который указывает, что узел этих выводов входит в Bus Data 
область. 

 
.NODESET директива 
Общая форма 
.NODESET V(NODNUM)=VAL V(NODNUM)=VAL ... 
Пример в списке цепей 
.NODESET V(7)=3.33 V(11)=1.5 
.NODESET строка помогает программе находить начальное DC решение, делая предварительным про-

ходом с определенными в узлах напряжениями. Ограничение затем отменяется, и итерация продолжается на 
основе этих начальных решений. Строка .NODESET может быть необходима для сходимости в бистабильных 
или неустойчивых цепях. В общем случае, когда моделирование проходит без проблем, в этой директиве нет 
необходимости. 

 
.IC директива 
Общая форма 
.IC V(NODNUM)=VAL V(NODNUM)=VAL ... 
Пример в списке цепей 
.IC V(3)=2.5 V(4)=-1 V(9)=1 
Строка .IC используется для установки начальных условий. У неё есть две разных интерпретации, если 

выбран или не выбран UIC параметр в Transient Analysis, и действуют следующим образом: 
 Когда выбран UIC параметр в Transient Analysis, узловые напряжения, определённые в управ-

ляющей строке .IC используются для вычисления начальных условий на конденсаторах, диодах, 
BJT, JFET и MOSFET транзисторах. Это эквивалентно определению IC=… параметра в каждой 
строке устройства. При этом можно определять и IC=… параметр, который имеет приоритет над 
.IC величиной.  В этом случае никаких вычислений начальных DC напряжений не выполняется 
перед Transient Analysis, необходимо быть осторожным в определении всех исходных DC на-
пряжение в .IC управляющей строке, чтобы вычислять начальные условия устройства. 

 Если не выбран UIC параметр в Transient Analysis, решение начального DC смещения будет 
вычислено перед Transient Analysis. В этом случае узловые напряжения, определённые в .IC 
управляющей строке являются ограничителями желаемых величин в течение решения смещения. 
Transient Analysis затем удаляет ограничения этих узловых напряжений. Это более предпочти-
тельный метод, поскольку допускает последовательное вычисление решений DC. 

 
17. Создание новых устройств 
Устройства, которые можно создать в CircuitMaker входят в две основные категории. Не функциональ-

ные символы устройств, которые просто представлены на схеме или экспортируются в PCB список цепей, а 
также полностью функциональные устройства, которые можно имитировать. Функциональное имитационное 
назначение достигается присоединением внутренней электрической схемы или Spice модели/макромодели к 



символу устройства. Термин макро устройство свободно используется в этом руководстве, чтобы ссылаться на 
любое устройство, которое создаётся или модифицируется. 

Следующая информация содержится в этой главе: 
 Создание символов устройств: Показано, как использовать Symbol Editor для создания или ре-

дактирования заказных символов устройств. Как в ручную создавать символы с помощью мыши, 
создавать новые символы на основе существующих символов и быстро создавать DIP, LCC или 
QFP символы. Показано, как создавать и использовать выводы для связи с проводами, а также 
как подготовить символ к использованию в CircuitMaker, добавляя по умолчанию Device Proper-
ties в символ. На основе примера будет показан путь создания собственных символов устройств. 

 Создание макро устройств с внутренней электрической схемой: Показано, как подключать 
скрытую внутреннюю электрическую схему к заказному символу устройства. Этот простой про-
цесс может быть использован для расширения выбора имитируемых устройств CircuitMaker. По-
казано как макро устройства могут быть вложены в иерархические конструкции цепей для моде-
лирования. На примере показано подключение электрической схемы к символу, чтобы таким об-
разом получить функциональное макро устройство. 

 Работа с Spice моделями: Рассказано о трех основных типах компонентов в Spice, о выборе 
Spice моделей для моделирования, модифицировании Spice моделей, и о подключении новых 
Spice моделей к символам устройств. На основе примера показано, как добавлять новые Spice 
модели. 

 Создание новой Spice модели с использованием параметров: Показано, как создавать общие 
Spice модели, которые могут быть использованы, чтобы имитировать любое число подобных 
компонентов, передавая специфические параметры на каждое устройство в общую модель. 

 Редактирование параметров цифровых моделей: Показаны SimCode цифровых устройств, их 
различные параметры и как их модифицировать. 

 
   
Создание символов устройств 
Для создания или модифицирования символов устройств используется один из следующих путей: 

 Черчение символа с помощью мыши. 
 Составление описания в Element List. 
 Дополнение существующей формы. 
 Импорт метафайла. 
 Дополнение DIP, LCC и QFP корпусов. 

Чтобы создавать символ для нового макро: 
1. Очистить рабочую область выбором New кнопки в инструментарии. 
2. Выбрать пункт Macros > New Macro. 
3. Ввести уникальное имя макро не более 13 символов. 

Имя используется для идентификации макро в библиотеке устройств. 
4. Определить число элементов входящих в один корпус. 

Примечание: Один и тот же символ используется для каждого элемента в корпусе. 
5. Нажать OK, чтобы отобразить окно Symbol Editor. 

Необходимо воспринимать Symbol Editor как программу для чертежей. Следующая секция описывает 
использование Symbol Editor и выбор её опций. 

 
Использование элементов управления Symbol Editor  
Как только в окно будет установлен символ устройства, использование выборов Symbol Editor должны 

управлять видом символа. Можно щёлкать и перемещать обозначения устройства в любые необходимые по-
зиции. 

Redraw   Перерисовывает изображение.  
Clear   Стирает изображение не удаляя элементов.  
Trace  Один шаг в списке Element List выделяет поочередно каждый элемент, начиная 

с текущего выбранного элемента. Выбрать первый элемент в списке, щёлкнуть 
Clear кнопку для стирания окна рисования, и затем многократно щёлкнуть 
Trace кнопку. Это поможет идентифицировать элементы, которые скрыты дру-
гими элементами и т.п.  



Grid  Отображает или скрывает определенную сетку в окне рисования. Рекомендует-
ся определить сетку в 9 точек, для правильного размещения выводов.  
Примечание: В Symbol Editor не используется Snap To Grid опция.  

Symbol Name  Отображает или скрывает символьное имя устройства.  
Pin Names  Отображает или скрывает имена выводов устройства.  
Pin Designations  Отображает или скрывает обозначение выводов устройства.  
View  Изменение размера окна 25%-800%, чтобы повысить удобство просмотра уст-

ройства при его создании.  
 
Чертёж символа мышью 
Для создания символов или части символов в ручную с помощью мыши: 

1. Выбрать цвет элемента и заполнителя. 
Любой замкнутый элемент будет заполнен цветом элемента или цветом фона. 

2. Выбрать тип создаваемого элемента, щёлкая кнопку в соответствующем разделе.  
Можно создать следующие типы элементов: Line (линия), 1/4 Arc (четверть дуги), 1/2 Arc (половина ду-

ги), Circle (круг), Ellipse (эллипс), Polyline (ломаная линия), Polygon (многоугольник), Rectangle (прямо-
угольник), Round Rect (скруглённый прямоугольник), и выводы Pin. Выводы могут быть направлены вверх, 
вниз, влево или вправо и могут иметь пузыри, чтобы указывать инверсию логического вывода. Выводы с пу-
зырями указываются с помощью тильды (~). 

Примечание: Любой символ устройства должен иметь выводы для связи с проводами. 
3. Чтобы создать линию, дугу, круг, эллипс, прямоугольник или вывод, нажимая и придерживая 

левую кнопку мыши протащить в нужный размер и отпустить. Чтобы создать ломаную линию 
или многоугольник, щёлкнуть и отпустить кнопку мыши для начала, затем делать единственный 
щелчок для поворота и двойной щелчок для завершения. 

 Примечание: После установки вывода появляется диалоговое окно для ввода имени вывода и обозна-
чения. Имя и обозначение вывода необходимы для моделирования и генерации PCB списка цепей. 

При установке элемента его описание добавляется в раздел Element List. При выборе описания выбира-
ется и выделяется элемент, позволяя перемещать или удалять элементы, которые были установлены. После 
установки элемента выбранный Element Type не изменяется, пока не будет выбран новый тип элемента или 
будет щелчок в текстовой строке Element List. 

 
Выбор элементов формы 
Чтобы выбрать единственный элемент: 

1. Сделать  Select выбор в Element Type разделе. 
2. Выбрать элемент в окне обзора. 

 или 
Щёлкнуть его описание в Element List. 

Чтобы выбрать множество элементов: 
1. Сделать Select выбор в Element Type разделе. 
2. Протащить мышью прямоугольник выбора вокруг нужных элементов формы в окне. 

 или 
Щёлкнуть и протащить курсор в Element List разделе. 

 или 
Придерживая Shift клавишу щёлкнуть индивидуальные элементы формы в окне, или придержи-
вая Ctrl щёлкнуть нужные описания элементов в Element List разделе. 

Для удаления элементов: 
1. Выбрать элементы, которые необходимо удалить. 
2. Нажать Delete кнопку. 

Для перемещения элементов: 
1. Сделать Select выбор в Element Type разделе. 
2. Переместить элемент формы, придерживая левую кнопку мыши. 

 или 
Если выбрано множество элементов, переместить все за один из элементов, придерживая левую 
кнопку мыши. 

Для изменения размера элементов: 
1. Сделать Resize выбор в Element Type разделе. 



2. Переместить в необходимый размер конец линии, угол прямоугольника, сторону закругленного 
прямоугольника или эллипса придерживая левую кнопку мыши. 

 Примечание: Можно использовать Element List или Edit Buffer разделы, чтобы изменять размер и 
форму различных элементов.  

 
Добавление существующих форм 
Чтобы облегчить создание новых символов устройств, можно использовать и модифицировать формы 

существующих устройств. Чтобы добавить существующую форму: 
1. В Symbol Editor диалоговом окне открыть Add Existing Shape список. 
2. Выбрать имя существующей формы для добавления. 
3. Если необходимо подключить выводы к существующим устройствам, отметить Include Pins 

контрольное окно 
4. Если необходимо изменить размер добавляемой формы, ввести нужную величину в Shape/Pkg 

Scale окно редактирования. 
5. Нажать Add Shape кнопку. 
6. Нажать r клавишу или правую кнопку мыши для вращения формы. 
7. Нажать m клавишу для зеркального отображения формы. 
8. Переместить форму в желаемую позицию окна Symbol Editor. 
9. Щёлкнуть левую кнопку мыши, чтобы установить форму или нажать пробел, чтобы отменить 

операцию. 
 Примечание: Будет масштабироваться только позиция подключенных выводов, но не размер. 
 
Импорт устройств из метафайлов  
В Symbol Editor можно импортировать символы устройств в виде изображений созданные в других 

графических программах, только если эти чертежи символов в формате метафайлов и могут копироваться че-
рез Windows буфер.  

Чтобы импортировать устройство из метафайла: 
1. Скопировать объект метафайла в Windows буфер. 
2. Из Symbol Editor выбрать Clipboard-WMF как существующую форму. 

 Примечание: Только векторные графические формы: линии, прямоугольники, круги и т.п. в объекте 
метафайла будут преобразованы. Цвета, побитовые изображения и текст не будет включены. 

 
Добавление DIP, LCC и QFP символов 
Используя Symbol Editor можно быстро создавать DIP, LCC и QFP символы. LCC и QFP квадратные 

микросхемы с равным количеством выводов на каждой стороне. LCC символ имеет первый вывод в центре 
верхней стороны, QFP символ имеет первый вывод на левой верхней стороне. Здесь можно управлять разме-
ром добавляемого символа использование Scale величины, числом символов в имени выводов и числом выво-
дов. При размещении символы могут вращаться и отображаться зеркально. Чтобы добавить DIP, LCC или QFP 
символ: 

1. Используя Symbol Editor определить количество выводов в Pins per Pkg области. 
2. Определить Scale, по умолчанию 100%. 
3. Нажать Add Pkg кнопку. 
4. Переместить символ в желаемую позицию. 

Примечание: Можно нажать пробел, чтобы отменить это действие. 
5. Щёлкнуть левую кнопку мыши, чтобы установить символ. 

 
Редактирование информации выводов 
Название и обозначение выводов необходимы для моделирования схемы и PCB списка цепей. Для со-

вместимости с TraxMaker, каждое обозначение вывода в символе должно соответствовать обозначению пане-
ли в TraxMaker компоненте. Чтобы редактировать имена и обозначения выводов: 

1. В Symbol Editor выбрать Select опцию в Element Type разделе. 
2. Щёлкнуть правой кнопкой на выводе и выбрать пункт Edit, чтобы отобразить диалоговое окно. 
3. Назначить каждому выводу имя до 15 символов и обозначение до 5 текстовых символов, даже 

если имена не будут отображаться. 
 Примечание: Для множества элементов в одном корпусе, обозначение вывода должно быть указано 

для каждого элемента, разделяя их запятыми. 



Разделы Element List и Edit Buffer 
При добавлении элементов к чертежу, они также добавляются в Element List. Раздел Element List со-

держит текстовое описание каждого элемента в символе устройства. Между окном рисования и разделом Ele-
ment List связь постоянная. Когда выбирается элемент в окне рисования, соответствующая строка выделяется 
в Element List, а также возможно и обратное действие. Элементы в начале списка созданные первыми нахо-
дятся на заднем плане чертежа, элемент в списке созданный последним находится на переднем плане.  

Раздел Edit Buffer используется для добавления или редактирования текстового описания элементов, 
содержащихся в Element List разделе. Используя следующие кнопки можно редактировать и изменять поря-
док следования элементов. 

Cut Удаляет выбранные элементы из Element List и размещает в Edit Buffer. 
Copy Устанавливает копию выбранных элементов в Edit Buffer. 
Replace Заменяет выбранные элементы содержимым Edit Buffer. 
Insert Вставляет содержимое Edit Buffer перед выбранным элементом в Element List. 
Append Вставляет содержимое Edit Buffer в конец Element List. 
Delete Удаляет выбранные элементы из Element List. 
При редактировании элементов необходимо соблюдать строгие правила синтаксиса. Определение для 

каждого элемента должно указывать тип элемента, атрибуты (линии, цвет наполнителя или имя вывода), и на-
бор x-y координат. Более полное описание синтаксиса необходимое для каждого элемента дано в следующей 
секции. 

 
Определение элементов 
Когда цвет в элементе сопровождается звездочкой, например, LtBlue* то цвет наполнителя будет таким 

же, как и цвет элемента, иначе цвет наполнителя будет цветом фона. 
 
Общий формат 
[тип элемента] [атрибут] x1,y1 x2,y2 x3,y3 x4,y4 [номер вывода] 
Line 
Атрибут цвет элемента 
x1,y1 стартовая точка линии 
x2,y2 конечная точка линии 
x3,y3 n/a 
x4,y4 n/a 
Пример: 
Line Device -36,-7 20,-7 
Polyline 
Атрибут  цвет элемента 
x1,y1 1-я точка ломаной линии 
x2,y2 2-я точка ломаной линии  
x3,y3 3-я точка ломаной линии  
x4,y4 4-я точка ломаной линии  
Примечание: Плюс (+Polyline) указывает, что это продолжение предыдущего элемента ломаной линии. 
Примеры: 
Polyline Device -24,-46  42,-22  24,35 
или 
Polyline Device -51,-54  46,-23  34,42  -53,32 
+Polyline Device -53,-19 
Polygon 
Атрибут  цвет фона* 
x1,y1 1-я точка многоугольника 
x2,y2 2-я точка многоугольника 
x3,y3 3-я точка многоугольника 
x4,y4 4-я точка многоугольника  
Примечание: Плюс (+Polygon) указывает, что это продолжение предыдущего элемента многоугольника. 
Пример: 
Polygon Device -39,12  0,55  -61,75 
или 



Polygon Device -30,-44  12,-44  29, -21  15,6 
+Polygon Device -25,6  -42,16 
Rect 
Атрибут  цвет фона* 
x1,y1 левый верхний угол прямоугольника 
x2,y2 нижний правый угол прямоугольника 
x3,y3 n/a 
x4,y4 n/a 
Пример: 
Rect Device -25,-30  15,28 
RRect 
Атрибут  цвет фона* 
x1,y1 левый верхний угол закругленного прямоугольника 
x2,y2 нижний правый угол закругленного прямоугольника 
x3,y3 ширина и высота эллипса, определяющего углы 
x4,y4 n/a 
Пример: 
RRect Device -56,-22  11,8  10,10 
Ellipse/Circle 
Атрибут  цвет фона* 
x1,y1 левый верхний угол прямоугольника, охватывающего круг или эллипс 
x2,y2 нижний правый угол охватывающего прямоугольника 
x3,y3 n/a 
x4,y4 n/a 
 
Пример: 
Ellipse Device -49,-44 9,33 
Arc 1/4, 1/2 
Атрибут  цвет элемента 
x1,y1 левый верхний угол прямоугольника, охватывающего полный эллипс 
x2,y2 нижний правый угол прямоугольника, охватывающего полный эллипс 
x3,y3 первая точка выходной линии дуги 
x4,y4 вторая точка выходной линии дуги 
Примечание: Координаты точек линии дуги располагаются против часовой стрелки. 
Пример: 
Arc Device -51,-13 -13,33 -32,-13 -51,10 1/4 
Arc Device -28,-11 5,45 5,17 -28,17 1/2 
Text 
Атрибут текстовый цвет 
x1,y1 нижняя позиция центра текста 
x2,y2 n/a 
x3,y3 n/a 
x4,y4 n/a 
text строка, приложенная в единые кавычки, 15 символов максимум 
Пример: 
Text Device 0,25 'symbol text' 
PinUp, PinDown, PinLeft, PinRight 
Атрибут  имя вывода максимум 16 символов 
x1,y1 точка подключения вывода 
x2,y2 n/a 
x3,y3 n/a 
x4,y4 n/a 
Примеры одной части в корпусе: 
Pinleft P1 -26,-27 [1] 
Pinright P9 26,36 [9] 
Примеры двух частей в корпусе: 
Pinleft P1 -26,-27 [1,2] 



Pinright P9 26,36 [9,10] 
Пример инверсного вывода: 
Pinleft~ P7 -26,27 [7] 
Примечание: Вывод является точкой связи для проводов. Выводы могут иметь пузыри, чтобы указывать 

инверсию логики. Выводы с пузырями создаются с помощью тильды (~). 
 
Создание символа устройства 
Следующий последовательный пример показывает использование Symbol Editor для создания макро. 

1. Сделать резервную копию USER.LIB файла до создания или удаления макро. 
В случае, если библиотека повреждена или изменена нежелательным образом, всегда можно будет воз-

вратиться к исходной библиотеке. 
2. Выбрать пункт Macros > New Macro,  чтобы отобразить Define New Macro диалоговое окно. 

Возможно, что появится запрос о включении текущей схемы в рабочей области в новый символ. Для 
этого примера можно щёлкнуть No.  

3. Ввести уникальное имя до 13 символов в Name текстовую область. Для этого примера набрать 
имя AND-NOR. 

4. Определить число Parts Per Package. Для этого примера использовать по умолчанию 1 элемент 
на корпус. 

Это имеет отношение к количеству устройств, входящих в состав одного чипа. Например, 7400 корпус 
содержит 4 NAND логических элемента, а 556 корпус содержит 2 таймера. 

5. Нажать OK, чтобы отобразить Symbol Editor. 
Для этого примера можно начать с установки 8 выводного DIP корпуса в окно рисования. 

6. Ввести число 8 в Pins Per Pkg область, затем нажать Add Pkg кнопку. 
7. Щёлкнуть левую кнопку мыши, чтобы установить корпус в центре окна. 
8. Изменить масштаб в View разделе на 200%, щёлкая верхнюю стрелку. 

Имя макро AND-NOR отображено в центре окна. 
9. Щёлкнуть и переместить имя в позицию выше DIP. 

Можно обратить внимание, что устройство состоит из: 1 Rect, 4 PinLefts и 4 PinRights. Необходимо уда-
лить 3 из 4 PinRights. 

10. Щёлкнуть правосторонний верхний вывод на чертеже, чтобы выбрать его и нажать Delete. По-
вторить это ещё для  двух правосторонних выводов. 

11. Щёлкнуть оставшийся правосторонний вывод для выбора и нажать Copy, чтобы копировать вы-
вод из Element List в Edit Buffer. 

12. Изменить PinRight на PinRight~. 
13. Нажать Replace, чтобы заменить выбранные выводы новым. 

Можно обратить внимание, что вывод на чертеже теперь имеет пузырь. 
14. Из меню правой кнопки на верхнем левом выводе выбрать пункт Edit. 
15. Изменить P1 на I1, и затем нажать OK. Повторить это для остальных выводов, присваивая им 

имена I2, I3, I4 и O1. 
16. Нажать OK в Symbol Editor диалоговом окне. 

После этого новый символ будет следовать за мышью в рабочей области. 
17. Щёлкнуть мышь, чтобы установить символ в рабочей области. 
18. Дважды щёлкнуть в макро для вывода окна Edit Macro. 
19. Нажать Properties…. 

 Любые данные, которые вводятся в Device Properties диалоговом окне, будут там каждый раз при вы-
боре этого макро из библиотечных меню. Теперь самое время, чтобы добавить по умолчанию данные Package, 
Auto Designation Prefix, Spice Prefix Character(s) и Spice Data если требуется. 

 Примечание: Для совместимости с TraxMaker Package область должна соответствовать имени соответ-
ствующего компонента в TraxMaker. 

20. Если макро готово для сохранения в библиотеке, выбрать Macros > Macro Utilities, чтобы ото-
бразить Macro Utilities диалоговое окно. 

21. Чтобы установить устройство в существующих Major или Minor Device Class разделах, щёлк-
нуть подходящие пункты в списках. 

22. Чтобы создать новый Major или Minor Device Class раздел, ввести новое имя в соответствую-
щие текстовые области редактирования. 

23. Для завершения создания нового символа устройства нажать Save Macro. 



Это сохранит новое макро в файле USER.LIB и очистит рабочую область. Для использования нового 
макро просто выбрать его из библиотеки устройств подобно любым другим устройствам. 

 
Редактирование существующих макро устройств 
Редактирование макро устройств позволяет модифицировать символы устройств, определённые по 

умолчанию атрибуты, добавлять или редактировать внутреннюю электрическую схему. Чтобы редактировать 
существующее макро устройство: 

1. Установить редактируемое макро в рабочую область. 
2. Выбрать макро средством Arrow Tool. 
3. Выбрать пункт Macros > Expand Macro и нажать OK. 
4. Дважды щёлкнуть в макро устройство.  
5. При необходимости можно назначить новое имя макро. 

Сохранение макро под новым именем создаёт новое макро, но не удаляет старое макро устройство. 
6. Использование Parts Per Package выбора изменяет количество элементов в одном корпусе. 

 Примечание: Рекомендуется использовать этот выбор только при создании новых устройств. 
7. Нажать Properties… кнопку для отображения Device Properties диалогового окна. 

 В зависимости от редактируемого макро устройства, нужно определять обязательные параметры уст-
ройства, включая Label-Value, Package, Auto Designation Prefix, Spice Prefix и Spice Data. 

8. Нажать Symbol… кнопку для отображения Symbol Editor, где можно отредактировать схемный 
символ макро. 

9. Нажать OK после завершения редактирования графики и определения параметров символа. 
 Щелчок OK возвращает в расширенный режим редактирования макро, где можно добавить или редак-

тировать электрическую схему прежде, чем новое устройство будет сохранено.  
 
Создание макро устройств с внутренней электрической схемой 
Если нет нужного устройства в библиотеке CircuitMaker, которое выполняло бы конкретную функцию, 

можно создать своё функциональное макро устройство, подключая скрытую электрическую схему к нужному 
символу. 

Макро устройство может содержать внутреннюю электрическую схему, которая базируется на сущест-
вующих устройствах. Можно также вкладывать макро устройства в пределы другого макро, позволяя созда-
вать блочное построение схем, чтобы создать конечное устройство. 

Новое макро сохраняется вместе с электрической схемой, которая спрятана в пределах своего символа и 
функционирует согласно электрической схеме. Новые макро созданные подобным образом могут использо-
ваться в любых схемах. Чтобы создать макро устройство с внутренней электрической схемой: 

1. Сделать резервную копию USER.LIB файла. 
 В случае если библиотека будет повреждена или сделаны нежелательные изменения, всегда будет воз-

можность воспользоваться её копией. 
2. Создать символ, как описано выше в этой главе.  
3. Выбрать последний созданный символ AND-NOR, разместить в рабочую область и расширить 

выбором Macros > Expand Macro. 
4. Создать электрическую схему, которая будет выполнять функцию AND-NOR нового макро уст-

ройства. 
5. Выбрать средство Wire Tool в инструментарии и соединить проводами выводы макро символа с 

частями схемы.  
6. Если по умолчанию данные не были добавлены при создании символа, двойным щелчком в мак-

ро символ открыть окно и нажать кнопку Properties….  Добавить необходимые данные как 
Package и Auto Designation Prefix.  

7. Сохранить макро, используя Macros > Save Macro пункт. 
 
Работа с SPICE моделями 
Spice - стандартная промышленная программа для имитации цепей. Для создания устройств работаю-

щих в аналоговом моделировании, должны быть определены Spice данные в каждом устройстве. Используя 
возможности системы можно подключать информацию Spice моделей и макромоделей к новым или сущест-
вующим устройствам. Можно также отредактировать Spice информацию, используя ASCII текстовый редак-
тор. 



Примечание: Если создаваемые новые символы устройств предназначены для экспорта в PCB список 
или создания простых схем, подключать Spice информацию не нужно. Тем не менее, даже если есть необхо-
димость имитировать создаваемые компоненты, подключение Spice моделей из различных источников легкая 
задача. Есть три основных типа компонентов в Spice: 

 Элементарные компоненты как, например, резисторы, конденсаторы, источники и т.п. 
 Модели, определяющие дискретные устройства как, например, BJT, JFET, MOSFET и т.п. 
 Макромодели, комбинированные устройства созданные на основе элементарных компонентов, 

моделей и другие макромодели, чтобы создавать более сложные устройства. 
Spice модели и макромодели доступны из многих источников, включая изготовителей компонентов, 

журналы и книги по проектированию, из Интернета.  
 
Редактирование SPICE моделей в текстовом редакторе 
Так как Spice модели и макромодели представляют собой текстовые файлы и могут модифицироваться 

текстовым редактором как, например, Notepad. После редактирования эти файлы необходимо сохранять толь-
ко в текстовом формате. 

 
Редактирование SPICE моделей в CircuitMaker 
Двойной щелчок в устройство, который имеет связанную с ним Spice модель, выводит диалоговое окно 

с выделенной моделью в списке. Чтобы выбрать другую модель, щёлкнуть её в окне мышью, затем нажать Se-
lect. Макромодели в списке указываются первым символом x, а модели символом p. Чтобы редактировать или 
просматривать существующую модель: 

1. Щёлкнуть имя модели, которую необходимо отредактировать или просмотреть.  
2. Нажать Edit кнопку, чтобы отобразить диалоговое окно. 

Отображаемые Spice параметры модели это не книжные справочные данные. Если пользователь не зна-
ком с Spice моделированием, не рекомендуется модифицировать существующие Spice модели. 

Величины, указанные для каждого параметра представляют величины определённые для этого специфи-
ческого типа устройства. Spice величины параметров модели по умолчанию указаны звездочкой (*) после ве-
личины. Чтобы изменить величину Spice параметра: 

1. Щёлкнуть имя Spice параметра. 
Это выбирает параметр и копирует величину параметра в Value окно редактирования. 

2. Изменить данные в Value окне и нажать Enter кнопку. 
Если необходимо установить специфический параметр в значение по умолчанию, ввести звездочку (*) в 

Value область и нажать Enter. 
3. Нажать OK, чтобы сохранить модель. 

 или 
           Чтобы сохранить модель под новым именем, набрать новое имя в Name области и затем нажать 

OK. 
Примечание: Модели созданные или модифицированные хранятся непосредственно в .MOD файле вме-

сто ссылки на модели. Подлинник .LIB файл остаётся неизменным. 
Чтобы удалить существующую модель: 

1. Выбрать модель мышью. 
2. Нажать Delete. 

Это действие удаляет только ссылку на модель в связующем файле, а не удаляет фактическую модель из 
библиотеки. 

 
Назначение новой модели в существующий символ 
При получении новых моделей из внешнего источника, они обычно приводятся в ASCII текстовом фор-

мате. Использование Model Data кнопки в Macro Utilities диалоговом окне создаёт связь с каждой новой мо-
делью в библиотечном файле. Следующий пример иллюстрирует способ добавления новой модели. Чтобы до-
бавить транзистор 2N5209 к CircuitMaker: 

1. Выбрать пункт Macros > Macro Utilities. 
2. Выбрать символ NPN транзистора, затем нажать Model Data. 
3. Нажать Open и открыть библиотечный файл MCEBJT.LIB, в котором находится модель 

2N5209. 
 Вся имена моделей и макромоделей обнаруженные в этой библиотеке будут отображены в окне слева. 

4. Нажать 2N5209. 



5. Ввести необходимую информацию о модели в Description область, например: Si 625mW 50V 
50mA 30MHz Amp. 

6. В Pkg Name области ввести TO-92B, чтобы соответствовать имени корпуса в TraxMaker. 
7. Сделать назначение выводов схемного символа соответствующим панелям компонента в 

TraxMaker. При виде TO-92B с плоской стороной 1 вывод находится справа, вывод 2  в середине 
и вывод 3 слева. Для 2N5902 выводы коллектора, базы и эмиттера будут соответствовать C=1, 
B=2, E=3. 

8. Нажать Add, чтобы добавить новую ссылку. 
 Теперь можно выбирать новую модель в алфавитном порядке из списка NPN транзисторов. 
 
Назначение существующей модели новому символу 
Чтобы назначить существующую модель новому макро символу: 

1. Создать новый не функционирующий макро символ, как описано ранее в этой главе. 
 Необходимо установить выводы в той же последовательности, как они указаны в синтаксисе соответ-

ствующей модели. Например, если был создан новый символ диода, то анодный вывод должен быть первым, а 
катодный вывод вторым, чтобы соответствовать Spice определению диода.  

 Чтобы связать новый символ с существующим файлом модели, необходимо дать соответствующее имя 
новому символу. Например, необходимо назвать символ Diode:A чтобы связать с DIODE.MOD файлом или 
Schottky:A чтобы связать с SCHOTTKY.MOD файлом. 

2. С расширенным новым макро дважды щёлкнуть в устройство, и затем нажать Properties…, что-
бы отобразить Device Properties диалоговое окно. Ввести следующие данные: 

 Установить Auto Designation Prefix устройств, например, Q для транзисторов, D для 
диодов, и т.п. 

 Установить Spice Prefix Character(s) устройств, чтобы отобразить тип модели исполь-
зуемого устройства. Например, биполярный транзистор NPN должен иметь префикс QN.  

 Ввести подходящую Spice инструкцию для этого устройства в Spice Data область.   
3. Нажать OK. 
4. Выбрать пункт Macros > Save Macro, чтобы сохранить макро. 
После ввода необходимых данных, Spice модель будет связана с новым символом. 

Пример 
Чтобы создать новый символ устройства для стандартного диода: 

1. Создать новый макро символ диода, используя Symbol Editor описанный ранее в этой главе. 
Назвать новый макро символ как DIODE:A. При размещении выводов в новом устройстве, установить 

первый вывод в анод (N+), и второй вывод в катод (N-), чтобы соответствовать синтаксису модели диода. 
2. Расширить новый макро символ, если не расширен щёлкнув его левой кнопкой мыши, и затем 

выбрать пункт Macros > Expand Macro, или из меню правой кнопки. 
3. Дважды щёлкнуть в символ устройства и нажать кнопку Properties…. 
4. Ввести следующую информацию в Device Properties диалоговом окне расширенного макро: 

 Auto Designation Prefix: D 
 Spice Prefix Character(s): D 
 Spice Data:   %D %1 %2 %M 

5. Сохранить макро. 
 
Редактирование SPICE макромоделей 
В Spice макромодели входят три основные категории: 

 Компонентные макромодели 
 Блочные макромодели 
 Эквивалентные цепи 

Компонентная макромодель представляет собой полную схему устройства, созданную на основе дис-
кретных компонентов. Этот тип макромоделей требует немало времени для имитирования. Макромодель 
блочного типа состоит не только из дискретных компонентов, но из простых пунктов как, например, блоки 
усиления, управляемые источники и т.п.  Этот тип макромоделей имитируется довольно быстро и в большин-
стве случаев достаточно точно, что бы исключить использование компонентных моделей. Эквивалентные це-
пи необходимы для создания дискретных устройств, которые не имеют Spice моделей. Например, тиристор 
SCR может быть создан из пары NPN и PNP транзисторов связанных вместе. 



Двойной щелчок на устройстве, которое имеет макромодель в библиотеке, откроет диалоговое окно. 
Выбранная макромодель будет выделена в списке. Чтобы выбрать другую макромодель, щёлкнуть на ней мы-
шью, затем нажать Select. Чтобы редактировать или просматривать существующую макромодель: 

1. Щёлкнуть её мышью. 
2. Нажать Edit для отображения диалогового окна. 

Это диалоговое окно отображает текстовое описание макромодели, которое начинается строкой её на-
звания и оканчивается .ENDS строкой. Любые изменения заставляют модифицировать макромодель, изменяя 
ссылку на макромодель в связывающем файле. Оригинальная макромодель остаётся неизменной в библиотеч-
ном файле, но ссылка на неё будет потеряна.  

 
Назначение новых макромоделей существующим символам 
Использование Model Data кнопки в Macro Utilities диалоговом окне создаёт связь с каждой модель в 

новом библиотечном файле. Следующий пример иллюстрирует процесс назначения новой макромодели суще-
ствующему символу. Чтобы добавить действующую макромодель усилителя LF412C к CircuitMaker: 

1. Выбрать пункт Macros > Macro Utilities. 
2. Выбрать 5- выводный символ Op-Amp5, затем нажать Model Data. 
3. Нажать Open и открыть библиотечный файл MCEMODS2.LIB, в котором находится модель 

LF412C. 
Все модели и макромодели, обнаруженные в этой библиотеке будут отображены в окне слева. 

4. Нажать LF412C. 
5. Ввести необходимую информацию о модели в Description область, например: Dual LoOffset Lo-

Drift JFET OpAmp. 
6. В Pkg Name область ввести DIP8, чтобы назначить соответствующий корпус в TraxMaker. 
7. Ввести выводы в соответствии с обозначением панелей в корпусе компонента. 

 Так как LF412C является сдвоенным ОУ, необходимо ввести номера выводов для обоих элементов 
PART A и PART B, щёлкая стрелки для переключения между ними. 

 Для PART A номера выводов должны быть: IN+ = 3, IN- = 2, V+ = 8, V- = 4 и Out = 1.  Для PART B 
номера выводов должны быть: IN+ = 5, IN- = 6, V+ = 8, V- = 4 и Out = 7.   

8. Нажать Add, чтобы создать новую ссылку. 
 Теперь можно выбрать новую макромодель в алфавитном порядке из списка ОУ. 
 
Назначение существующей макромодели новому символу 
Чтобы назначить существующую макромодель новому символу: 

1. Создать новый не функционирующий макро символ устройства, как описано выше в этой главе. 
 Ненужно  забывать устанавливать выводы в той же последовательности, как они указаны в соответст-

вующей макромодели. Например, если создаётся новый символ для 5-выводного ОУ, необходимо установить 
выводы в следующей последовательности: +IN, -IN, +V, -V и OUT, чтобы было соответствие Spice описанию 
5-выводной макромодели ОУ.  Для того чтобы связать новый символ с существующим файлом макромодели, 
необходимо дать новому символу соответствующее имя.  Например, можно назвать символ Op-Amp5:A что-
бы связать с OPAMP5.SUB файлом. 

 Примечание: Поскольку CircuitMaker идентифицирует выводы в порядке размещения в символе уст-
ройства, необходимо убедиться, что порядок размещения выводов соответствует порядку узлов указанных в 
макромодели.  

Фактическая связь между выводами символа и макромодели управляется Spice Data областью устройст-
ва, где %n имеет отношение к энному выводу в элементном списке.  Например, в Spice Data области содер-
жится следующая запись: %D %1 %2 %3 %4 %S. Это значит, что первое узловое число макромодели подклю-
чается к первому выводу в символе представленному как %1, второй вывод как %2, и т.п.  Когда использует-
ся макромодель, которая представлена как: 

.SUBCKT XMR9933A 21 23 6 15 
то узел 21 макромодели будет подключен к первому выводу символа, узел 23 ко второму выводу и т.п. 

2. С новым расширенным символом дважды щёлкнуть в устройство, затем нажать кнопку 
Properties…, чтобы открыть Device Properties диалоговое окно.  Ввести следующие данные: 

 Ввести Auto Designation Prefix устройства, например, U или IC. 
 Установить Spice Prefix Character(s) как X для макромоделей. 
 Установить необходимую Spice инструкцию для этого устройства в Spice Data область.   

3. Нажать OK. 



4. Выбрать пункт Macros > Save Macro для сохранения макро. 
Пример 
Чтобы создать новый символ устройства оптрона: 

1. Создать новый макро символ оптрона, используя символьный редактор. 
 Дать имя символу как Opto Isol:A. При размещении выводов в новом устройстве установить первый 

вывод на аноде (N+), второй вывод на катоде (N-), третий вывод на коллекторе и четвертый вывод на эмитте-
ре. Этот порядок следования соответствует синтаксису макромодели оптрона. 

2. Расширить новый макро символ, если не расширен щёлкнув его левой кнопкой мыши, и затем 
выбрать пункт Macros > Expand Macro, или из меню правой кнопки. 

3. Дважды щёлкнуть в символ устройства и нажать кнопку Properties…. 
4. Ввести следующую информацию в Device Properties диалоговое окно расширенного макро: 

 Auto Designation Prefix: OP 
 Spice Prefix Character(s): X 
 Spice Data:   %D %1 %2 %3 %4 %S 

5. Нажать OK, затем выбрать пункт Macros > Save Macro. 
 
Связывающие файлы моделей и макромоделей 
Данные моделей и макромоделей загружены в текстовые ASCII файлы, обычно с расширением .LIB. 

Эти файлы могут редактироваться любым текстовым редактором. 
Каждый аналоговый символ устройства в CircuitMaker имеет связанный с ним связующий файл. Для то-

го чтобы использоваться Spice модели в CircuitMaker, необходимо связать модель с соответствующим симво-
лом устройства, устанавливая ссылку на модель в связующем файле. Чтобы создавать новую связь или моди-
фицировать существующую: 

1. Выбрать пункт Macros > Macro Utilities. 
2. Выбрать символ, которому необходимо назначить модель или макромодель. 
3. Нажать Model Data для отображения диалогового окна. 

Первоначально в центре окна будет отображаться один список. Это список, который находится в свя-
зующем файле, отображает устройства связанные с выбранным символом. Щелкнуть одну из моделей, чтобы 
просмотреть описание, корпус и цоколевку. Чтобы модифицировать эту информацию: 

1. Выбрать имя модели или макромодели, которую необходимо изменить. 
2. Внести необходимые изменения. 
3. Нажать Modify кнопку. 

Чтобы удалить ссылку из связующего файла: 
1. Выбрать имя модели или макромодели, которую необходимо удалить. 
2. Нажать Delete кнопку. 

Чтобы добавить новые ссылки в связующий файл: 
1. Нажать Open кнопку и открыть библиотечный файл, в котором находится необходимая модель 

или макромодель. 
Все имена моделей и макромоделей обнаруженные в этой библиотеке будут отображены в окне слева. 

При необходимости список может быть ограничен только теми устройствами, которые совместимы с выбран-
ным символом устройства. 

2. Ввести описание, тип корпуса и назначить выводы для модели. 
Если в корпус входят несколько элементов, необходимо определить номера выводов для каждого эле-

мента PART A, PART B и т.п.  
3. Нажать Add кнопку, чтобы включить новую ссылку. 

Имена связующих файлов переписываются в символьные имена устройств со следующими исключе-
ниями: 

 Имена связующих файлов ограниченны 8 символами. 
 Все пробелы и символы пунктуации удаляются. 
 Если последние символы в имени устройства являются числами, то числа заменяют последние 

символы в длинном файловом имени. 
 Если символьное имя устройства включает двоеточие (:), то двоеточие и все символы после неё 

удаляются.  Например, устройства NPN Trans, NPN Trans:A, NPN Trans:B и NPN Trans:C будут 
связаны с файлом NPNTRANS.MOD. 

Если CircuitMaker не может найти связующий файл, то этот символ может имитироваться с использова-
нием простой Spice модели, используя взамен файловое имя по умолчанию. Файловое имя по умолчанию ос-



новано на Spice Prefix Character(s) области. Следующий список определяет Spice prefix character(s) и их со-
ответствие файловым именам по умолчанию: 

C   CAP.MOD   
D  DIODE.MOD  
DZ  ZENER.MOD  
JN  NJFET.MOD  
JP  PJFET.MOD  
MN  NMOS.MOD   
MP  PMOS.MOD   
O  LTRA.MOD 
QN  NPN.MOD 
QP  PNP.MOD 
R   RESISTOR.MOD 
S   SW.MOD 
U  URC.MOD 
W  CSW.MOD 
ZN  NMESFET.MOD 
ZP  PMESFET.MOD 
Все другие устройства, включая макромодели, не имеют файловых имён по умолчанию. Устройства 

символов, которым назначены макромодели,  используют для связи файлы с .SUB расширением. Файл связи с 
.MOD расширением содержит ссылки на Spice модели и специфические макромодели для конкретных дис-
кретных символов устройств в CircuitMaker. В некоторых случаях желательно заменять модели макромоделя-
ми, которые будут более точно моделировать конкретные устройства. Например, некоторые ВЧ или силовые 
транзисторы не могут точно моделироваться простой Spice моделью. В таких случаях более предпочтительны 
макромодели.  

При нормальных обстоятельствах связующие файлы не должны редактироваться. Файловый формат, 
приведённый ниже, показан только для информации. Общий формат для ссылки в связующем файле: 

*Device Description pkg:PACKAGE [DVCC=14;DGND=7;] 1,2,3,… 
.PARAM QXXXXXXXX File:Filenam.lib 
В строке PACKAGE [DVCC=14;DGND=7;] 1,2,3,… определено имя корпуса и обозначение панелей в 

TraxMaker, данные шин здесь приводятся для цифровых символов. Q это Spice префиксный символ для спе-
цифического типа устройства, XXXXXXXX это имя модели и Filenam.lib это имя библиотечного файла в ко-
тором находится модель или макромодель. 

Необходимое описание устройства должно обязательно следовать перед каждой .PARAM строкой. Пер-
вым символом строки описания должна быть звездочкой (*). В конце описания строки обязательно должна 
включаться информация о типе корпуса и выводах. Эта информация необходима при создании PCB списка 
цепей для TraxMaker. Например: 

*500mW 40V 800mA pkg:TO-18 3,2,1 
.PARAM Q2N2222A File:Mcebjts.lib 
Необходимо отметить, что порядок выводов определён как 3,2,1, так как Spice определяет порядок сле-

дования выводов BJT как коллектор, база, эмиттер. Транзистор 2N2222A использует корпус типа TO-18.  
Если одно и то же устройство производят в различных корпусах, то можно определять дополнительные 

корпуса с использованием псевдонимов. Spice заменяет префиксный символ Q символом A и удаляет файло-
вую ссылку: 

*350mW 40V 800mA alias:Q2N2222A pkg:TO-92B 1,2,3 
.PARAM APN2222A 
Если в одном корпусе содержится несколько элементов, выводы должны определяться для каждого эле-

мента с символом его обозначения: 
*Dual Op Amp pkg:DIP8 (A:3,2,8,4,1)(B:5,6,8,4,7) 
.PARAM XMC1458 File:Mcemods.lib 
Эти два метода могут объединяться, когда устройства с множеством элементов производятся в различ-

ных корпусах. 
 
Ссылка на макромодели с использованием псевдонимов 
Иногда бывае необходимо связать два различных устройства с одной макромоделью. Это необходимо 

когда два устройства содержат идентичную внутреннюю схему, но разные корпуса или цоколёвку. Наилучший 



способ это добавить псевдоним в файл (*.sub) макромодели, используя любой текстовый редактор. Ниже при-
водится общий текстовый формат: 

*Description alias:XLINK|SUBNAME pkg:[Package & Pins] 
.PARAM XNEWNAME 
Данные  Описание 
Description Информация о параметрах устройства, как например, напряжение, ток, и т.п. 
XLINK  Имя макромодели, на которую нужно ссылаться. Первый символ X определяет  Spice 

макромодель, сопровождаемый её именем. 
|  Вертикальный разделитель.  
SUBNAME Имя файла (*.sub) где расположена макромодель, на которую нужно ссылаться. Должно 

включать не более 8 символов без пробелов, без учёта расширения .sub. 
pkg  Имя корпуса и номера выводов для экспорта в PCB программы. 
XNEWNAME Новое имя устройства для отображения в списке устройств. 
Следующий пример отображает использование псевдонимов: 
Существующая ссылка 
*Instrumentation Amp: LoPWR pkg:DIP8 3,2,7,4,6,5,1,8 
.PARAM XAD620A File:AnalogD.lib 
Новые данные устройства 
*Instrument Amp: LoPWR alias:XAD620A|INSTAMP pkg:SMD8A 3,2,7,4,6,5,1,8 
.PARAM XAD620AR 
 
 
Создание новой SPICE модели с прохождением параметров 
Прохождение параметров упрощает задачу создания новых компонентов. Это позволяет передавать 

справочные величины непосредственно в общие Spice модели или макромодели, используя математические 
выражения, чтобы создавать Spice параметры модели. Общая модель установленная в связующем файле свя-
зывается с символом устройства, или используется ссылка через псевдоним. 

Устройства созданные таким способом выбираются и редактируются подобно любым другим моделям 
устройств. Чтобы редактировать параметры прохождения, дважды щёлкнуть в устройство и затем нажать Edit. 

Общая форма (общая модель) 
*MNAME:Device Title 
*MNAME:P1:|P1 Description [<<Min>,<Max>>]|Default 
*MNAME:P2:|P2 Description [<<Min>,<Max>>]|Default 
 . 
 . 
 . 
*MNAME:Pn:|Pn Description [<<Min>,<Max>>]|Default 
*{P1=Default P1=Default ... Pn=Default} 
*Desc pkg:Package Pins 
Общая форма (псевдоним) 
*Desc alias:MNAME {P1=Val P2=Val} pkg:Package Pins 
.PARAM ANAME 
 
MNAME  Имя общей модели или макромодели, включая подходящий Spice префиксный 

символ. 
P1, P2, и т.п.  Имена параметров для прохождения. 
P1 Description, и т.п. Описание параметров. 
Min и Max  Дополнительные пункты, ограничивающие величину, которая может быть вве-

дена для каждого параметра. 
Default   Значение по умолчанию для каждого параметра, если величина не определена. 
Desc   Описание устройства. 
Package и Pins  Информация, используемая для экспорта в TraxMaker. 
ANAME   Имя псевдонима. 
В математические выражения включаются следующие операторы: 
+  -  *  / 



Следующий пример является общей макромоделью для кварцевых кристаллов, который может быть ис-
пользован как шаблон для создания других кристаллов: 

*XCRYSTAL: Параметры кристаллической макромодели 
*XCRYSTAL:FREQ:| Фундаментальная частота [1,]|1MEG 
*XCRYSTAL:RS:| Последовательное сопротивление [1,]|750 
*XCRYSTAL:CX:| Параллельная ёмкость [0,]|13pf 
*XCRYSTAL:Q:| Показатель добротности [10,1000]|1000 
*{FREQ=1Meg RS=750 C=13pf Q=1000} 
*Generic 1MHz Crystal:crystal pkg:XTAL1 1,2 
.SUBCKT XCRYSTAL 1 2 
LS 1 2 {((Q*RS)/(6.2831852*FREQ))} IC=0.5M 
CS 2 3 {(1/(Q*6.2831852*FREQ*RS))} 
RS 3 4 {RS} 
CX 1 4 {CX} 
.ENDS XCRYSTAL 
*alias:XCRYSTAL {FREQ=2E6 RS=250} pkg:XTAL1 1,2 
.PARAM A2.000MHZ 
Так как CX и Q не проходят в список параметров псевдонима, будут использованы значение по умолча-

нию 13pF и 1000.  
 
Редактирование цифровых параметров модели 
Цифровые simcode устройства используют поведенческие модели управляемого случая созданные для 

CircuitMaker. Пользователь не может добавлять новые simcode модели, тем не менее, simcode устройства мо-
гут быть использованы для создания новых смешанных/цифровых устройств. 

При невозможности отредактировать саму модель, всё же можно изменить определенные параметры 
модели. Чтобы это сделать, дважды щёлкнуть в устройство мышью, затем нажать Edit, чтобы отобразить диа-
логовое окно. 

Кнопки позволяют определять независимо каждый параметр модели, чтобы был по умолчанию, мини-
мальной, типовой или максимальной величины для выбранного устройства. Все параметры могут измениться 
для каждого вывода, разделяться для каждого типа. 

Propagation Delays Необходимое время для изменения на выходе, при сигнальном изменении на 
входе. 

Transition Times Длительность фронтов. 
Input Loading  Суммарное сопротивление нагрузки, подключенное к выходу устройства. 
Output Drive  Сумма выходного тока. 
Device Current  Потребляемый ток. 
User Defined  Этот параметр не влияет на цифровые модели в CircuitMaker. 
Области редактирования позволяют вводить специфические параметры величин. Эти величины берут 

приоритет над семейными специфическими величинами. При нормальных условиях они должны содержать 
пробел. 

GND & PWR  Эти два параметра должны быть запрограммированы как пара, если установлен 
один, то должен быть установлен и другой.  Установка этих напряжений анну-
лирует все другие определения напряжений для этих устройств. 

VOL & VOH  Эти два параметра аннулируют все типовые установки по умолчанию. 
VIL & VIH  Эти два параметра аннулируют все типовые установки по умолчанию. 
WARN Flag:  Когда установлена единица (1), будет сгенерировано предупреждение сообще-

ние, когда есть нарушения уровней напряжения. 
 
 
 
 
 
 
 
 
 



TraxMaker 
 
1. Введение 
Добро пожаловать в TraxMaker, средство создания печатных плат, которое объединяет профессиональ-

ные возможности с интуитивно удобным интерфейсом. Система занимает лидирующее положение в доле про-
граммного обеспечения низкой стоимости. 

TraxMaker предлагает полный набор средств создания печатных плат, включая среду авто трассировки с 
множеством функций, которые обычно присущи программам с очень высокой стоимостью.  Объединение 
CircuitMaker как схемного редактора с TraxMaker как редактора печатных плат позволило создать мощную 
систему сквозного проектирования электронных устройств под названием CircuitMaker Design Suite. 

 
Возможности TraxMaker  
TraxMaker генерируя переходные отверстия, создаёт до шести сигнальных слоёв, плюс силовой и земля-

ной слой, слой шёлкографии и маски пайки.  Размер печатной платы может быть квадратом со стороной 32 
дюйма или 81см.  Точность размещения составляет 1 mil,  или 0,025 мм.  Метрическая/дюймовая сетка систе-
мы позволяет работать точно в обеих системах измерения и может переключаться. Количество компонентов, 
которые можно включать в проект ограничивается только памятью используемого компьютера. 

Включена полная поддержка для самых популярных форматов.  Импорт PCB списка цепей из схемных 
продуктов позволяет оценить полное преимущество авто размещения компонентов в TraxMaker, а также отме-
ну и повторную попытку авто трассировки и контроль проектных правил разводки цепей. Программа печатает 
результаты разработки проекта на принтерах и графопостроителях. Генерирует файлы фотоплоттера Gerber 
RS274X, файлы сверловки формата Excellon, Pick и Place файлы авто размещения компонентов, список мате-
риалов и DXF. 

 
Различия с другими приложениями 
TraxMaker запускается и отображается подобно другим Windows приложениям, и обладает такой же гиб-

костью.  Тем не менее, необходимо понять, что TraxMaker отличается от других Windows графических прило-
жений в некоторых фундаментальных областях. 

Во-первых, при создании PCB проекта появляется несколько обязательных слоёв, как например, Top и 
Bottom сигнальные слои и Overlay слои шёлкографии. TraxMaker отображает и управляет этими слоями неза-
висимо, но некоторые действия, как например, разводка трассы, делает слой зависимым, необходимо сначала 
выбраться слой, затем развести трассу.   

Во-вторых, PCB проект отличается от других графических задач своим высоким требованием к точности.  
В результате, TraxMaker это более среда размещения, чем среда чертежа графики.  Кроме того, можно обна-
ружить, что некоторые TraxMaker инструментальные средства действует иначе аналогичных инструменталь-
ных средств других графических приложений. 

Другим фундаментальным различием является связанность, TraxMaker имеет способность признавать 
связи между сегментами трассы, трассой и панелями компонентов через импортируемый или созданный непо-
средственно список цепей.  TraxMaker также позволяет сохранять связи при перемещении компонентов, не 
разрывая сегментов трассы к панелям.  

 
Системные требования 
Для запуска TraxMaker необходимо: 

 Microsoft® Windows NT4, 95, 98 или 2000 
 PC с процессором класса Pentium 
 32MB RAM 
 40MB дискового пространства 
 Дисплей не менее 800x600 пикселей 
 Цветовой минимум палитры 256 
 CD ROM 
 Мышь или совместимое координатное устройство 
 Устройства печати  

 
 



Содержание руководства пользователя  
Данное руководство рассчитано на то, что пользователь TraxMaker знаком с основами работы в Windows.  

Руководство пользователя содержит следующие секции: 
 
1. Введение в систему 
Эта глава дает общее введение в программу, руководящие принципы установок и выбора конфигурации 

TraxMaker. 
 
2. Обзор 
Эта глава даёт обзор проектной среды TraxMaker, включая многие инструментальные средства и функ-

ции, которые можно использовать, ключевые понятия и терминологии, используемые в проекте печатной пла-
ты. 

 
3. Учебник 
Короткий путеводитель по основным действиям в проекте TraxMaker: установка слоев, размещение ком-

понентов, соединение компонентов трассами, загрузка списка цепей созданного в CircuitMaker, авто размеще-
ние компонентов, использование авто трассировки и контроль сделанной работы. 

 
4. Функции размещения и редактирования 
Эта глава подробно описывает различные инструментальные средства размещения и редактирования, 

большинство из которых обеспечивают прямой доступ к ключевым особенностям TraxMaker. 
 
5. Управление библиотеками 
TraxMaker имеет исчерпывающий набор библиотек рисунков корпусов наиболее общих компонентов, за-

зоров и панелей.  Эта глава показывает, как создавать новые пункты и содержит указания по управлению биб-
лиотеками. 

 
6. Цепи и списки цепей 
Глава содержит информацию об автоматизированных функциях TraxMaker: генерация цепей и импорт 

списка цепей, авто размещение компонентов, авто трассировка и контроль проектных правил. 
 
7. Трассировка 
Можно разводить трассы на плате вручную или можно использовать любую функцию авто трассировки в 

TraxMaker. Эта глава объясняет все принципы трассировки и методы её оптимизации для получения наилуч-
ших результатов. 

 
8. Вывод результатов проекта 
В этой главе находятся инструкции по использованию принтеров для генерации PCB топологических 

чертежей. 
 
2. Обзор TraxMaker 
 
Введение в PCB проект 
Построение PCB проектов в TraxMaker является простым процессом: 

 Определение физической схемы PCB. 
 Выбор и установка необходимых компонентов из компонентной библиотеки.  Или, при работе из 

схемного списка цепей, импорт и размещение вручную или с авто размещением компонентов на 
печатной плате. 

 Соединение панелей компонентов трассами вручную, авто трассировкой, или комбинацией руч-
ной и автоматической трассировки. 

 Проверка завершённой работы использованием встроенного контроля проектных правил. 
 Печать или вывод необходимых производственных топологических чертежей или файлов. 

В отличие от общих CAD систем TraxMaker обеспечивает специальными функциями, которые удовле-
творяют уникальным требования к PCB топологическим чертежам, как например, способность редактировать 
и печатать индивидуальные слои пред производством печатных плат. Независимо от того является ли проект 



простой односторонней или многослойной печатной платой, с отдельными слоями питания и земли, имеется 
возможность управлять каждым пунктом платы. 

 
Связанность 
Ключевая характеристика TraxMaker является признание электрических связей между элементами про-

екта. Понятие связанности лежит в основе автоматического размещения компонентов, авто трассировки и 
контроле проектных правил. 

Программа загружает информацию о связях в форме списка цепей сгенерированных редактором схем 
или созданных непосредственно в TraxMaker. TraxMaker принимает список цепей непосредственно из 
CircuitMaker, импортирует и экспортирует списки цепей из других популярных форматов, включая Protel, 
Tango, OrCAD PCB II и другие.  

TraxMaker обеспечивает поддержку слоёв и библиотечных компонентов, включая переходные отверстия 
и компоненты поверхностного монтажа (SMD). 

 
О слоях TraxMaker 
TraxMaker хранит каждый проект как серию слоев, которые создают фактической отпечаток цепей пла-

ты. Например, Top Overlay слой используется для производства верхнего слоя шёлкографии с компонентной 
графикой корпусов и текстом. 

Это понятие многослойности проекта отличает TraxMaker от других чертежей или проектных приложе-
ний. Хотя все слои в проекте могут просматриваться одновременно, необходимо выбирать каждый индивиду-
альный слой, чтобы установить принадлежащие этому слою пункты, как например, трассы, экранные области 
или текст.  

TraxMaker также включает некоторые специальные обзорные слои, которые непосредственно не участ-
вуют в финальных производственных слоях платы. Одним из примеров является Multi Layer. В TraxMaker 
панели и переходы могут занимать один слой или через переходные отверстия могут проходить через все слои 
PCB. Multi Layer позволяет отображать эти пункты вместе с единственным объектом слоя как, например, 
трассой. 

Чтобы упростить редактирование проекта, TraxMaker позволяет делать выбор специфических слоёв не-
обходимых для проекта, устанавливается отображение этих слоёв по требованию пользователя. 

 
Соглашения в TraxMaker  
TraxMaker соответствует стандарту Windows, руководствуясь принципами интерфейса пользователя. Ес-

ли у пользователя есть опыт работы с другими Windows приложениями, то у него не должно быть проблем с 
запуском и выходом из TraxMaker, созданием и сохранением документов, выбором пунктов меню и использо-
ванием мыши.  

TraxMaker имеет специальные функции, которые нельзя отнести к общим функциям для других Windows 
приложений. Эти уникальные функции TraxMaker выполняют некоторые специальные задачи в PCB проекте.  

 
Рабочая область TraxMaker 
При запуске TraxMaker отображается окно печатной платы, где размещаются компоненты, трассы, тек-

сты, медные заполнители и так далее. Максимальная область платы составляет квадрат со стороной 32 дюйма 
или 81 см. Рабочая область также включает инструментарий, пункты меню и полосу статуса.  Полоса статуса 
включает специальный список выбора слоя. Окно выбора слоя отображает цвет, назначенный текущему слою. 
Текущее имя файла отображается выше в полосе названия. 

 
Слои платы 
TraxMaker отображает проект как систему слоёв, которые передаются на топологический чертеж, ис-

пользуемый при создании PCB. Эти слои при необходимости могут отображаться или скрываться. Использо-
вание пункта Options>Setup>Layers позволяет отображать или скрывать, а также окрашивать каждый слой.  

 
Что такое текущий слой? 
Один слой является всегда текущим слоем в данный момент времени. Имя и цвет, назначенный в этот 

слой, отображаются в окне выбора слоя слева Status Bar. Трассы, медные заполнители, внешние площадки, 
дуги, панели сигнальных слоёв и тексты устанавливаются в текущем слое. Можно устанавливать компоненты, 
многоуровневые панели и переходные отверстия, не учитывая текущего выбора слоя. Тем не менее, выбор, 



перемещение, удаление, вставка и копирование требует определения конкретного слоя. Только выбор прямо-
угольной области не зависит от выбора слоя. Как только это будет сделано, можно будет вырезать, копиро-
вать, вставлять и удалять, не учитывая слоя. 

 
Типы слоёв 
Эта секция описывает каждый слой более подробно. Все слои рассматриваются с верхней стороны пла-

ты. 
Top Layer  Верхний сигнальный слой со стороны компонентов. 
Mid Layers Четыре внутренних сигнальных слоя. 
Bottom Layer  Нижний сигнальный слой со стороны пайки. 
Top Overlay Верхний слой шёлкографии, отображающий графику компонентов и тексты. 
Bottom Overlay  Шёлкография для нижних компонентов, если имеются. 
Ground Plane  Медный средний слой земли. 
Power Plane  Медный средний слой электропитания. 
Board Layer Специальный слой ссылки, предусмотрен для размещения с целью выравнива-

ния структурированных дорожек или механических деталей. Детали этого слоя 
могут быть напечатаны с другими слоями. 

Keep Out Layer Отображающий слой, который определяет периметр запретных областей при ав-
то размещении компонентов и авто трассировки. 

Multi Layer  Отображает панели и переходные отверстия, которые занимают все слои. 
Не имеющим отношение к слоям объектам Background и Selections можно назначить цвета, так чтобы 

было различие между ними. 
 
Использование мыши 
Как в других Windows приложениях, TraxMaker использует мышь для щелчка, выбора и перемещения 

объектов. При перемещении мыши соответствующее выбранное средство или курсор перемещаются по экра-
ну. Знакомый указатель Arrow Tool используется для стандартных Windows действий, как например, выбор 
пунктов меню и диалоговых окон. Для возврата в стандарт Arrow Tool выбрать средство в инструментарии, 
нажать Esc или из меню правой кнопки мыши. 

 
Система измерения, сетка и координаты 
Печатная плата обычно при производстве имеет очень малые допуски. TraxMaker обеспечивает абсолют-

ное проектное разрешение 1 mil, это 0.001 дюйм или .0254 мм, которое должно обеспечить достаточную точ-
ность для большинства проектных задач PCB. TraxMaker позволяет определять как дюймовую, так и метриче-
скую систему измерения. 

 
Изменение системы измерения 
При отображении окна платы, координатная и другая измеряемая информация отображается в милли-

метрах (мм) или mils (1mil =0.001 дюйма). Чтобы изменить систему измерения: 
1. Выбрать пункт Options > Setup и нажать Grid/Draw закладку. 
2. Выбрать систему измерения English (mils) или Metric (mm). 
 
Видимая сетка и мгновенная сетка 
Чтобы дать пользователю полностью использовать встроенную точность, TraxMaker позволяет опреде-

лять две независимые сетки: невидимая мгновенная сетка Snap Grid и видимая сетка Visible Grid. 
Мгновенная сетка регулирует позицию пунктов установленных в окне платы. Объекты автоматически 

фиксируются в мгновенной сетке при установке или перемещении.  Мгновенная сетка также определяет сетку 
для авто трассировки.  По умолчанию, эта мгновенная сетка установлена в 25 mils. 

Видимая сетка отображается как система небольших координатных точек или меток на фоне окна платы.  
Этот размер по умолчанию больше и составляет 1000 mils. 

Изменение величины мгновенной и видимой сетки 
Чтобы изменить величину сетки: 
1. Выбрать пункт Options > Setup и нажать вкладку Grid/Draw. 
2. Определить величины в Snap Grid и Visible Grid областях, затем выбрать OK. 
Большинство инструментальных средств редактирования и размещения используют преимущественно 

Snap Grid, удовлетворяя требованиям к очень точному размещению и установки. 



Система координат 
Позиция курсора относительно начала координат окна платы отображается внизу слева Status Bar. Ко-

ординаты отображают измеренное расстояние от начала в mils или миллиметрах, в зависимости от выбранной 
системы измерения. 

 
Абсолютное и относительное начало координат 
Абсолютное начало координат 0,0  составляет левый нижний угол рабочей области. Относительное нача-

ло может устанавливаться в любой точке рабочей области. 
 
Установка относительного начала координат 
Относительное начало позволяет временно установить новые 0,0 координаты в любой точке рабочей об-

ласти. Чтобы установить относительное начало: 
1. Выбрать пункт Options > Setup. 
2. Выбрать Relative в Cursor Mode разделе. 
3. Выбрать Set Floating Origin, затем щёлкнуть в желаемой точке нового начала в окне платы. 
Можно переопределять относительное начало координат в любое время. 
 
Поиск начала 
Используя функцию Find Origin можно быстро перемещать курсор на начало координат. Если абсолют-

ное начало всегда известно, то это особенно полезное для расположения относительного начала. Чтобы найти 
начало: 

1. Выбрать пункт Edit > Find > Origin. 
В зависимости от выбора курсор перемещается на абсолютное или относительное начало координат. 
 
Поиск позиции 
Использование функции Find Location быстро перемещает курсор на специфическую позицию платы. 

Чтобы найти позицию: 
1. Выбрать пункт Edit > Find > Location. 
2. Ввести X и Y координаты в текстовом окне, затем нажать OK. 
Курсор перемещается в определённую позицию. 
 
Инструментальные средства 
Проектирование в TraxMaker в основном связано с четырьмя основными процедурами:  
1) размещение объектов в рабочей области как, например, компонентов, панелей, переходов, текстов, 

трасс, заполнителей областей и дуг;  
2) перемещение объектов;  
3) удаление объектов;  
4) редактирование или изменение атрибутов объектов как, например, ширина трассы или содержание 

текстовой строки. 
Можно выполнить все эти пункты, используя кнопки инструментария. 
 
Сокращенные ключи 
Командная клавиша равнозначна непосредственному выбору команды из меню и инструментальных 

средств.  Следующий список включает доступные сокращённые ключи в TraxMaker:  
A   Размещение Arc 
C   Размещение Component 
E   Размещение External Plane 
F   Размещение Fill 
P   Размещение Pad 
S   Размещение Text String 
T   Размещение Track 
V   Размещение Via 
X   Зеркальное отображение пунктов по оси X при перемещении 
Y   Зеркальное отображение пунктов по оси Y при перемещении 
Alt+A  Arrow Tool 
Alt+D  Delete Tool 



Alt+Z  Zoom Tool 
Ctrl+C  Copy 
Ctrl+D  Duplicate 
Ctrl+F  Refresh Screen 
Ctrl+I  Gets Info 
Ctrl+M  Measure 
Ctrl+N  New 
Ctrl+O  Open 
Ctrl+P  Print 
Ctrl+S  Save 
Ctrl+V  Paste 
Ctrl+X  Cut 
Ctrl+Z  Undo 
F2  Отобразить все цепи 
Shift+F2  Скрыть все цепи 
F3  Normal Size/Position 
F4  Fit Board to Window 
F5  Setup 
End  Refresh Screen 
Esc  Отказа от текущего действия  
Page Up  Zoom In в позиции курсора 
Page Down Zoom Out в позиции курсора 
Delete  Delete 
Spacebar  Вращение пунктов при перемещении 
+ и -   Последовательность через все доступные слои 
*        Последовательность через слои трассировки 
Arrow Keys Толчок пунктов с использованием Left, Right, Up или Down клавиш позиционирования 

в течение размещения или перемещения. Каждое нажатие клавиши переместит выбран-
ный пункт на текущий шаг мгновенной сетки. 

 
Файлы TraxMaker  
TraxMaker включает множество файлов специального назначения. Следующий список включает различ-

ные типы файлов, которые используются в системе: 
Расширение Как используется 
.APT  Апертурные файлы 
.BOM  Файлы списка материалов 
.DRC  Результаты контроля правил проекта 
.DRL  Файлы сверловки формата Excellon 
.DXF  Файлы формата AutoCAD 
.INI  Файлы предпочтительных установок 
.LIB  Библиотеки компонентов 
.LOG  Результаты авто трассировки платы 
.MAT  Текстовый файл назначения Gerber апертур 
.NET  Файл списка цепей 
.PAD  Библиотеки панелей 
.PCB  Файлы печати печатных плат 
.PIK  Файлы авто установки компонентов на плату 
.SET  Файлы распределения слоёв при импорте файлов .DXF 
.TOL  Средство сопоставления файлов 
.TXT  Текстовая версия файла сверловки 
 
Файлы библиотек (.LIB) 
TraxMaker поставляется со стандартными библиотеками компонентов с выводами штырькового типа и 

компонентов поверхностного монтажа (SMD или SMT). Стандартный библиотечный файл TRAXSTD.LIB 
всякий раз загружается автоматически при запуске TraxMaker, если эта библиотека находится в папке с при-
ложением TraxMaker. Пользователь может создавать новые компоненты и добавлять их к стандартной биб-



лиотеке или создавать заказные библиотеки. Тем не менее, только одна библиотека может загружаться за один 
раз. Каждая библиотека может содержать максимум 600 компонентов.  

 
Предпочтения TraxMaker  
TraxMaker сохраняет многие пользовательские установки, как например, установки принтера, цвета, сет-

ки и множество других установок, названные предпочтениями TraxMaker в специальном файле 
TRAXMAKR.INI.  Этот файл корректируется каждый раз при выходе из TraxMaker. Пользователь можете 
загрузить и использовать другие предпочтения или использовать установки по умолчанию. 

 
Загрузка другого файла предпочтений 
1. Выбрать пункт File > Preferences. 
2. Для загрузки другого файла предпочтений нажать кнопку Load Preferences…, определить имя файла 

и затем выбрать Open. 
 
Сохранение нового файла предпочтений 
Если необходимо иметь набор предпочтений для каждого типа проекта TraxMaker, можно создать новые 

файлы предпочтений. 
1. Выбрать пункт File > Preferences. 
2. Нажать кнопку Save Preferences…, определить имя файла с расширением .INI затем выбрать Save. 
 
Восстановление установок по умолчанию 
Если пользовательские установки предпочтений, по какой либо причине стали неопределёнными, для 

начала можно восстановить их загрузкой заводских установок TraxMaker. 
1. Выбрать пункт File > Preferences. 
2. Нажать кнопку Restore Factory Defaults. 
Предупреждение: Если были изменены многие установки в TraxMaker, рекомендуется сохранить их в 

другом файле предпочтения прежде, чем загрузятся заводские установки по умолчанию.  В противном случае 
будут потеряны все заказные установки. 

 
Основы управления PCB файлами 
Эта секция объясняет основные процедуры управления файлами TraxMaker. 
 
Запуск, сохранение и закрытие PCB файлов 
Функции New, Save и Save As используются чаще всего: 
1. Выбрать пункт File > New, чтобы открыть новый файл. 
2. Выбрать пункт File > Save, если имя сохраняемого файла установлено. 
или 

  Выбрать пункт File > Save As, чтобы дать файлу новое имя. Это путь копирования PCB файлов. 
3. Выбрать пункт File > Close, затем Yes, чтобы сохранить файл и выйти из PCB, не выходя из 

TraxMaker. 
или 

  Выбрать пункт File > Exit, затем Yes, чтобы выйти из TraxMaker и сохранить работу. 
 
Открытие и повторное открытие PCB файлов 
1. Выбрать пункт File > Open. 
2. Выбрать файл с .PCB расширением, который необходимо открыть, затем выбрать Open. 
Можно открыть любой из последних четырёх PCB файлов, которые открывались ранее. 
3. Выбрать пункт File > Reopen. 
4. Выбрать файл для открытия. 
 
Возврат к прежде сохранённому файлу 
Если были сделаны изменения в PCB файле, которые не желательно сохранять, то можно возвратиться к 

последней версии файла сохранённом под тем же именем. Чтобы возвратиться к прежде сохранённому файлу: 
1. Выбрать пункт File > Revert. 
 



Слияние файлов 
Слияние файлов позволяет объединять два или более PCB файлов в один. Чтобы объединить файлы в те-

кущий файл: 
1. Выбрать пункт File > Merge. 
2. Выбрать PCB файл, который необходимо объединить с текущим открытым файлом, затем выбрать 

Open. 
Необходимо переместить контур платы, который необходимо объединить. 
3. Позиционировать контур, затем щёлкнуть, чтобы завершить слияние. 
 
3. Учебник 
Следующие консультации постепенно дают основы действий пользователя при создании PCB в 

TraxMaker. Для более тщательного объяснения специфических процессов, необходимо изучить другие главы в 
этом руководстве пользователя. Здесь будут рассмотрены три основные темы: 

1. Создание плат вручную. 
2. Автоматизированное создание плат. 
3. Создание новых компонентов. 
Постепенный процесс обучения будет следовать за общим порядком, в котором они должны нормально 

выполняться.  Работа через примеры обеспечит общее понимание путей работы с TraxMaker и проиллюстри-
рует то, что часто есть несколько путей решения одной задачи. 

 
Создание плат вручную 
Первая консультация покрывает следующие темы: 

 Создание нового файла в TraxMaker 
 Установка слоёв платы 
 Определение границ платы 
 Размещение компонентов 
 Соединение компонентов трассами 
 Контроль сделанной работы 

 
Шаг 1: Начало проекта 
Запустить программу TraxMaker и, если необходимо, очистить рабочую область выбором File > New.  
 
Шаг 2: Установка слоёв платы 
Это нормально начать с определения слоёв в проекте. Прежде, чем иметь доступ к конкретному слою, 

необходимо этот слой разрешить.  Без этого слои не могут быть отображены или отредактированы.  
1. Выбрать пункт Options > Setup, затем нажать Layers . 
2. Отметить Board Layer контрольное окно. 
Убедиться, что разрешены активные слои по умолчанию Top Layer, Bottom Layer, Top Overlay и Multi-

Layer. 
Board Layer это слой ссылки, который служит в качестве "основной страницы" для проекта. На нём 

можно устанавливать отметки или тексты, указывать монтажные отверстия или другие механические детали 
или элементы, которые необходимо воспроизвести вместе с выбранными слоями на готовом топологическом 
чертеже. Слой Keep Out является другим слоем ссылки, используемый для определения периметра авто раз-
мещение компонентов и авто трассировки, а также запретных областей. 

Layers закладка Setup диалогового окна также позволяет назначать уникальные цвета в каждый слой. 
Чтобы назначать новый цвет образцам печатной платы: 

1. Щёлкнуть Board Layer цветное окно вправо от каждого обозначения слоя. 
2. Выбрать новый цвет из диалогового окна и нажать OK. 
Не смотря на то, что могут быть активизировано несколько слоёв и отображаются они одновременно, 

только один слой является текущим слоем. Единственные пункты как, например, трассы, заполнители, дуги 
или тексты всегда устанавливаются только в текущем слое. Текущее имя слоя и его цвет отображается внизу 
экрана, с левой стороны полосы статуса. 

 
 
 



Шаг 3: Определение границ платы 
Трассы в основном предназначены для соединения компонентных панелей в сигнальных слоях Top 

Layer, Mid Layers, Bottom Layer. Тем не менее, трассы могут быть установлены как не электрические линии 
в слоях Top или Bottom Overlay, Board Layer и Keep Out Layer. Например, трассы используются для опре-
деления контура печатной платы или границы рабочей области. Чтобы это сделать: 

1. Щёлкнуть окно списка выбора слоя внизу экрана, с левой стороны полосы статуса. 
2. Выбрать Board Layer слой. 
3. Выбрать Place Track средство из инструментария. 
 Обратить внимание на сообщение в полосе статуса: “Щёлкнуть левой кнопкой для размещения трассы, 

щёлкнуть правой кнопкой для выхода из режима размещения”.   
4. Переместите курсор ближе к нижнему левому углу рабочей области с координатами 0,0.  Это будет 

началом контура платы. 
5. Теперь тщательно позиционировать курсор в X 100, Y 100 mils и щёлкнуть. 
6. Переместите курсору на позицию X 3100, Y 100 mils и щёлкнуть. 
7. Переместите курсору на позицию X 3100, Y 3100 mils и щёлкнуть. 
8. Переместите курсору на позицию X 100, Y 3100 mils и щёлкнуть. 
9. Теперь переместите курсор на начальную позицию X 100, Y 100 mils и щёлкнуть, затем щёлкнуть 

правой кнопкой. 
 
Шаг 4: Размещение компонентов 
Хотя каждый компонент сохраняется как единое целое устройство, в действительности собран из прими-

тивов стандарта TraxMaker, трасс, панелей, дуг и текстов. Эти компонентные примитивы принадлежат раз-
личным слоям.  Независимо от текущего слоя компоненты устанавливаются на верхней или нижней стороне 
PCB. 

Компонент включает его контур на основе трасс и/или дуг в Top или Bottom Overlay слоях, чтобы ука-
зать физическую форму компонента. Создание новых компонентов является простым процессом размещения 
и группирование примитивов, которые затем добавляются к текущей библиотеке.  Можно затем создавать но-
вые компоненты, основываясь на существующих компонентах. 

Компонентный текст обозначения или величины, могут быть также назначены на оверлейные или "мед-
ные" слои.  Top и Bottom Overlay слои печатаются на поверхности платы как помощь в поиске расположения 
компонентов во время, и после сборки. 

1. Выбрать Place Component средство инструментария или нажать клавишу C на клавиатуре. 
2. Перемещая Components список найти корпус DIP16 и выбрать его. 
3. Нажать кнопку Place. 
4. Определить как U1 в Designation области, оставить Label-Value область пустой, и нажать OK. 
5. Нажать пробел для вращения компонента на 90 градусов против часовой стрелки. 
6. Переместить компонент на координаты X 400 Y 2300 и щёлкнуть для установки. 
 Компонент будет использовать Top Overlay цвет слоя, чтобы отображать контур и обозначение ком-

понента, цветом Multi-Layer слоя отображаются панели. 
7. Повторить пункты с 1 по 4, обозначение U2 будет предложено автоматически, нажать OK. 
8. Переместить компонент на координаты X 1400 Y 2000 и щёлкнуть для установки. 
9. Теперь выбрать корпус AXIAL0.3, определить обозначение как R1,  и установить X 550 Y 1700.  
 
Шаг 5: Соединение компонентов 
Трассы разводятся в слоях Top Layer, в любом из четырех Mid Layers или в Bottom Layer. На данном 

этапе могут устанавливаться переходные отверстия, где трассы проходят с одного слоя на другого. 
 
Выбор размера трасс 
При размещении трасс на Board Layer для определения границ PCB использовалась ширина дорожек по 

умолчанию 12 mils. Для следующего примера необходимо увеличить размер до 15 mils. Чтобы изменить ши-
рину трассы: 

1. Выбрать пункт Options > Setup. Выбрать General закладку, где в Track разделе находятся опции ус-
тановки. 

2. Определить 15 mils в Default Width текстовом окне, затем выбрать OK. 
 
 



Выбор размера переходных отверстий 
Via это специальный тип панелей, называемые переходными отверстиями и используемые для соедине-

ния трасс расположенных на различных слоях PCB.  Подобно сквозным панелям  переходные отверстия зани-
мают слой Multi Layer. Имеются различные установки для изменения размера переходных отверстий. Боль-
ший размер переходов необходим для более широких трасс. Чтобы изменить размер: 

1. Выбрать пункт Options > Setup. Выбрать General закладку, где расположены Vias опции установки. 
2. Определить 60 в Via Size области и нажать OK. 
 
Идентификация компонентов и выводов 
Прежде чем создавать связи необходимо идентифицировать компоненты и номера выводов.  Выбор Find 

позволяет быстро перемещать курсор на определённую позицию. Это отменит необходимость постоянно из-
менять размер окна, чтобы рассмотреть номера выводов и особенно полезно для больших или сложных печат-
ных плат. Чтобы быстро найти компонент и его выводы: 

1. Выбрать пункт Edit > Find > Component. 
2. Выбрать U1 из Component списка и 1 из Pin списка, и нажать OK. 
Курсор установится на компонент U1, на выводе номер 1. 
 
Размещение трасс 
Теперь, когда определены размеры трасс и переходов, и есть возможность поиска компонентов и выво-

дов, можно делать первые связи.  Необходимо подключить U1-1 к U2-1 с использованием переходного отвер-
стия. Установить текущий слой Top Layer, затем выполнить следующие шаги: 

1. Выбрать Place Via средство инструментария. 
2. Позиционировать курсор в X 400 Y 2000, затем щёлкнуть для установки перехода.  Щёлкнуть правой 

кнопкой для отмены текущего средства. 
3. Выбрать Place Track инструментальное средство. 
4. Щёлкнуть в центре панели U1-1. 
5. Провести трассу к переходному отверстию, позиционировать курсор в центре перехода и щёлкнуть 

снова. Щёлкнуть правой кнопкой для отмены текущего средства. 
6. Выбрать текущий слой Bottom Layer. 
7. Снова выбрать Place Track средство и щёлкнуть в центр панели U2-1. 
8. Провести трассу к переходу, чтобы сделать окончательное соединение. 
9. Чтобы видеть точное изображение сделанных изменений, выбрать пункт View > Refresh Screen или 

нажать End клавишу клавиатуры. 
Теперь имеются два компонента, которые связаны двумя трассами через переход. В большинстве случаев 

трасса изменяет направление в позиции сетки, чтобы точно попасть в центр панели или перехода при ручной 
трассировке. При изменении сетки или выборе более тонкой сетки, имеется вероятность не попадания в центр 
панели и соответственно не возможности создания связи. 

При перемещении курсора в течение трассировки, выбранная трасса сегментируется на горизонтальное, 
вертикальное и 45 градусное направление сегментов. Это называется ортогональным  размещением трасс и 
практически считается стандартом, особенно при ручной трассировке.   

 
Трассировка от панели до панели 
Одно из инструментальных средств Route Pad-to-Pad Without Net использует установки трассировки 

для автоматической разводки между двумя панелями. Эти установки определяют сетку, размеры трасс и пере-
ходов и допустимые зазоры. Однако здесь будут использованы установки по умолчанию. Чтобы соединять 
компоненты с использованием Route Pad-to-Pad Without Net средства: 

1. Выбрать средство Route Pad-to-Pad Without Net в инструментарии. 
2. Переместить курсор на R1-2, щёлкнуть и удерживать кнопку мыши.  
3. Переместить курсор на панель U2-1 и отпустить мышь. TraxMaker соединит две панели с использо-

ванием переходного отверстия. 
4. Для практики завершить следующие связи: U1-12 до U2-9 и U1-13 до U2-6.  
 
Шаг 6: Проверка сделанной работы 
Как только трассировка платы будет закончена, TraxMaker обеспечивает дополнительной функцией кон-

троля сделанной работы проектным требованиям. 
 



Автоматизированное создание платы 
Кроме ручной разработки TraxMaker имеет множество функций автоматизированного процесса проекти-

рования печатной платы. TraxMaker совместим со стандартом большинства программ ввода схем, и находится 
в плотной интеграции с программой создания и имитации схем CircuitMaker. Эта плотная интеграция делает 
возможным исходить из схемы в PCB простым нажатием кнопок. Здесь будут рассмотрены следующие темы: 

 Создание списка цепей в CircuitMaker и автоматическое перемещение на печатную плату исполь-
зованием кнопки. 

 Импорт списка цепей из других схемных программ и вручную: 
o Определение Keep Out Layer 
o Загрузка списка цепей 
o Использование авто размещения 

 Использование авто трассировки 
 
Шаг 1: Создание списка цепей в CircuitMaker 
Здесь показан процесс преобразования схемы CircuitMaker в список цепей, из которого создаются свя-

занные панели, переходы, компоненты и трассы с использованием TraxMaker: 
1. Запустить CircuitMaker. 
2. Открыть проект PCB.CKT,  простой схемы регулятора напряжения.  Генератор сигналов и внешняя 

нагрузка установлены в цепи только для имитационных целей и не будут включены в список цепей 
для передачи на печатную плату. 

Каждому устройству в схеме назначено Label-Value, Designation, Package и Pin Numbers, это требуется 
для создания списка цепей (Netlist).  Имя в Package области каждого компонента CircuitMaker должна соот-
ветствовать одному из компонентных имен доступных в TraxMaker.  Например, если на схеме есть компонент 
типа 7400, то Package область должна содержать DIP14, чтобы TraxMaker мог выбрать правильный корпус 
для этого устройства. 

3. Нажать Export PCB Netlist кнопку инструментария. 
При экспорте из CircuitMaker в TraxMaker можно разрешить автоматический запуск TraxMaker с загруз-

кой списка цепей, создание запретных зон и авто размещение компонентов. В появившемся диалоговом окне: 
4. Изменить размер платы X 2000 и Y 1000, и нажать OK. 
5. CircuitMaker подскажет о сохранении TraxMaker списка цепей, используя имя файла с .NET расши-

рением. Нажать Save. 
6. TraxMaker открывается автоматически с отображением границ платы, и выводом Netlist Load сооб-

щения, чтобы показать результаты загруженного списка цепей. Нажать OK, и компоненты автомати-
чески распределятся по плате.   

Теперь печатная плата готова к авто трассировке, о которой будет рассказано в Шаге 5. 
 
Шаг 2: Определение запретного слоя 
Один из наиболее важных слоёв для автоматизированного создания печатной платы является Keep Out 

Layer. Его задача в том, чтобы определять “разрешённые” области при авто размещении и авто трассировке. 
Размещение прямоугольника в этом слое создаёт периметр, который нельзя ни пересекать, ни касаться. Чтобы 
определить Keep Out границы: 

1. Запустить TraxMaker и выбрать пункт File > New, чтобы начать с нового файла. 
2. Выбрать пункт Options > Setup, нажать Layers закладку, включить Keep Out Layer и нажать OK. 
3. В рабочей области выбрать слой Keep Out Layer. 
4. Выбрать Place Track средство инструментария. 
5. Установить курсор в позицию X 100, Y 100 и щёлкнуть. 
6. Переместить курсор в позицию X 100, Y 1100 и щёлкнуть. 
7. Переместить курсор в позицию X 2100, Y 1100 и щёлкнуть. 
8. Переместить курсор в позицию X 2100, Y 100 и щёлкнуть. 
9. Наконец, переместите курсор в начало X 100, Y 100, щёлкнуть, и затем щёлкнуть правой кнопкой для 

выхода из Place Tracks. 
Теперь имеется прямоугольная область определённых границ. 
 
Шаг 3: Загрузка Netlist 
Netlist это текстовый файл, перечисляющий все компоненты и связи между ними.  Этот список допускает 

автоматизированное размещение компонентов, автоматизированную трассировку связей и контроль проект-



ных правил.  Эти функции устраняют большинство скучных ручных усилий присущие большинству PCB про-
ектам. Следующая цель это загрузка списка цепей: 

1. Выбрать пункт Netlist > Load Netlist, и выбрать тип для импорта. 
2. Выбрать Netlist and components и нажать OK. 
3. Выбрать файл списка для импорта, например Pcb.net и нажать Open. 
4. По подсказке щёлкнуть в позицию, где необходимо установить компоненты. Щёлкнуть в созданной 

области Keep Out, компоненты будут установлены друг на друге в одном месте печатной платы.  
Нормально, если они будут размещены последующим использованием функции авто размещения. 

5. Изучить информацию в Netlist Load диалоговом окне и нажать OK. 
  
 
Шаг 4: Использование авто размещения 
Функция авто размещения группирует компоненты с использованием стратегии размещения, чтобы сде-

лать конечную оптимизацию печатной платы более эффективной. Следующий шаг использует авто размеще-
ние, которое распространяется на компоненты, содержащиеся в загруженном списке Netlist. 

1. Выбрать пункт Netlist > AutoPlacement > Arrange Components. 
Используя установки сетки, функция авто размещения устанавливает компоненты наилучшим образом в 

пределах the Keep Out Layer. Пользователь здесь может переместить компоненты в более желательные пози-
ции в пределах Keep Out Layer. 

 
Отображение связанностей 
Связанности обычно имеют отношение ко всем связям между компонентами на печатной плате.  Это ви-

зуальное отображение физических связей между компонентами без трассировки. Чтобы отобразить связанно-
сти: 

1. Выбрать пункт Netlist > Show Nets > All Nets. 
 
Шаг 5: Использование авто трассировки 
TraxMaker используя базовую сетку, делает повторные попытки многопроходной авто трассировки, оп-

тимизации, чтобы достигать высокие показатели оптимизации и разумной стоимости. Авто трассировка чрез-
вычайно гибкая функция, с множеством выборов конфигурирования трассировщика. Можно трассировать всю 
плату, индивидуальные цепи или единственную связь. Следующая задача соединить компоненты, которые 
установлены на плате: 

1. Выбрать пункт Route > Board. 
2. Отменить выбор Save Log файла, набрать полное имя файла в текстовом окне Netlist Filename 

(Pcb.net), и нажать OK. 
Полоса статуса отображает информацию о прогрессе трассировки. Когда трассировка завершится, 

TraxMaker отобразит разведённую плату. В случае неудачной трассировки необходимо принять меры для оп-
тимизации размещения компонентов и связей. 

 
Создание новых компонентов 
Здесь обсуждаются следующие темы: 

 Создание нового компонента. 
 Создание нового компонента основанного на существующем компоненте. 

Можно создавать компоненты одним из двух предложенных способов.  Первый путь в том, чтобы соз-
дать индивидуальные примитивы, сгруппировать их, а затем добавить в библиотеки.  Другой путь в том, что-
бы создать новый компонент, базируясь на существующем.  

 
Шаг 1: Создание компонента 
1. Использованием инструментальных средств Place Track, Place Pad, Place Arc, и т.п. создаются кор-

пусные компоненты. Используя Duplicate команду из Edit меню можно быстро устанавливать ко-
лонки или столбцы равномерно расположенных панелей. 

2. Каждой панели в новом компоненте необходимо дать обозначение панели.  
3. Выбрать Arrow Tool средство и выбрать все примитивы нового компонента охватом прямоугольни-

ка. 
4. Нажать Place Component средство инструментария. 
5. Выбрать Add, определить имя нового компонента и нажать OK. 



6. Выбрать OK, чтобы подтвердить дополнение нового компонента. 
7. Чтобы просмотреть новый компонент, выбрать имя компонента из списка. 
 
Шаг 2: Создание компонента из существующих компонентов 
Подобрать компонент из библиотеки, который аналогичен новому создаваемому компоненту.  Вместо 

создания полностью нового компонента можно разгруппировать существующий компонент на примитивы, 
затем редактировать их в отдельности.  Затем можно сохранить отредактированную версию как новый биб-
лиотечный компонент. Этот метод также полезен, если необходимо сделать незначительные изменения в су-
ществующих библиотечных образцах. Чтобы создать новый компонент на существующем: 

1. Выбрать компонент установленный на плате. 
 или 

Нажать Place Component средство инструментария, выбрать компонент и нажать Place, установить 
компонент где-нибудь на плате. 

2. Выбрать пункт Edit > Ungroup Component. 
3. Выбрать OK, чтобы подтвердить разгруппирование. 
Даже если компонент появляется неизменным, за исключением того, что удалён компонентный текст, 

каждый элемент компонента теперь может редактироваться отдельно. Это означает, что вместо единого ком-
понента это будет сбор линий, дуг и панелей. 

4. Используя инструментальные средства можно удалять, редактировать или добавлять новые элементы 
к компоненту. 

5. Выбрать Arrow Tool средство. 
6. Выбрать все элементы отредактированного компонента охватом прямоугольника вокруг них. 
7. Выбрать Place Component средство. 
8. Выбрать Add, определить имя нового компонента или использовать старое имя, заменяя существую-

щий компонент новым. Нажать OK. 
9. Нажать OK, чтобы подтвердить дополнение. 
10. Для просмотра нового компонента выбрать имя из списка. 
 
4. Функции размещения и редактирования 
Большинство функций TraxMaker черчения, размещения и редактирования доступны через инструмен-

тальные средства, отображаемые на верху рабочей области.  Чтобы выбрать средство, просто щёлкнуть икон-
ку нужного средства. Отключать средство можно щелчком правой кнопки мыши или выбором другого средст-
ва. 

 
Полноэкранный курсор 
TraxMaker позволяет выбирать между стандартным или полноэкранным перекрестным курсором.  Пере-

крестия полноэкранного курсора пересекают всю рабочую область для повышенной точности.  Этот выбор 
очень полезен для точной установки и выравнивания пунктов с другими частями на плате. Для выбора полно-
экранного курсора: 

1. Выбрать пункт Options > Setup. 
2. Отметить Full Screen Cross Cursor контрольное окно в Cursor Mode области General закладки, за-

тем щёлкнуть OK. 
Необходимо отметить, что перекрестный курсор, стандартный или полноэкранный активен только при 

установке или перемещении объектов. 
 
Средство измерения 
Встроенное сканирующее средство измерения позволяет точно измерять расстояния между объектами 

печатной платы, устраняя необходимость ручного вычисления расстояния с использованием координат. При 
измерении между панелями, каждая панель выделяется при перемещении курсора над панелью. Чтобы ис-
пользовать средство измерения: 

1. Выбрать пункт Edit > Measure. 
2. Щёлкнуть в отправном пункте измерения. 
3. Щёлкнуть в конечном пункте измерения. 
Диалоговое окно отобразит результаты измерения, X расстояние и Y расстояние между двумя точками. 
4. Нажать OK и затем измерить расстояние следующих двух точек. 



5. Правой кнопкой или выбором другого средства, можно закончить измерения. 
 
Средство Arrow Tool 
Средство Arrow Tool используется для выбора, перемещения и редактирования пунктов. Двойной щел-

чок средством Arrow Tool в большинство пунктов используется для редактирования их специфических 
свойств. Выбранные пункты могут перемещаться, удаляться, вырезаться, копироваться, дублироваться, вра-
щаться или отображаться зеркально. 

 
Выбор пунктов 
Многоуровневые компоненты могут быть выбраны из любого слоя.  Если компонент является устройст-

вом поверхностного монтажа (SMD), то необходимо выбрать правильный слой. Чтобы выбрать пункт: 
1. Выбрать Arrow Tool средство. 
2. Позиционировать курсор над пунктом платы. 
3. Щёлкнуть левую кнопку мыши. 
При выборе пункта он изменяется в белый цвет, установленный по умолчанию.  
 
Выбор множества пунктов 
Многочисленные пункты могут быть выбраны использованием Arrow Tool средства или выбором гло-

бального пункта Select из Edit меню. Чтобы выбрать множество пунктов с использованием Arrow Tool: 
1. Выбрать Arrow Tool средство. 
2. Протянуть прямоугольную область вокруг группы пунктов, которые необходимо выбрать. Пункты 

будут выбраны во всех слоях платы. 
или 

Придерживая Shift клавишу щёлкнуть в каждый пункт. Только пункты в текущем слое или пункты в 
слое Multi-Layer могут быть выбраны. 

Теперь можно выбранные пункты вырезать, копировать, дублировать, удалять, перемещать, вращать или 
отображать зеркально. 

 
Выбор связей и цепей 
Удержание Ctrl или Alt клавиш при щелчке средством Arrow Tool позволяет выбирать связи или целые 

цепи. 
Ctrl+Click Все сегменты трассы и переходы единственной связи между двумя или более 

панелями. 
Alt+Click   Целая цепь связанных трасс, панелей и переходов. 
Ctrl+Shift+Click  Многочисленные связи, одна на щелчок. 
Alt+Shift+Click  Многочисленные цепи, одна на щелчок. 
Только после выбора можно приступать к редактированию. 
 
Средство глобального выбора 
Вместе с Arrow Tool средством выбора, есть также множество глобальных средств выбора доступных из 

Edit меню. Для глобального выбора пунктов: 
1. Выбрать пункт Edit > Select. 
2. Щёлкнуть один из следующих пунктов: 
All   Все объекты на плате. 
All on Layer  Все объекты в одном слое платы. 
All Tracks  Все трассы на плате. 
All Free Pads  Все свободные панели на плате. 
All Vias   Все переходы на плате. 
All Text Strings  Все текстовые строки на плате. 
All Components  Все компоненты на плате. 
Теперь их можно редактировать. 
 
Включение слоёв для выбора 
Необходимо определить слои, которые включены в область выбора, прежде чем выполнять операции над 

пунктами платы. Чтобы определять слои для выбора: 
1. Выбрать пункт Options > Setup и нажать Layers закладку. 



2. Сделать следующий выбор в Cut, Copy, Delete, Move разделе и нажать OK: 
All Layers Включает все слои для выбора без подтверждения. 
Current Layer Включает только текущий выбранный слой. 
Ask Layers Подтверждение выполнения действия во всех слоях. Если выбрать No, действия выпол-

няются только в текущем слое. 
 
Перемещение пунктов 
1. Выбрать Arrow Tool средство. 
2. Позиционировать курсор над пунктом, который необходимо переместить, затем нажать и удерживать 

кнопку мыши. 
или 

Выбрать группу пунктов, как описано выше, позиционировать курсор над группой пунктов, затем 
нажать и удерживать кнопку мыши. 

3. Переместить пункты в нужную позицию и отпустить кнопку. 
Компоненты, панели, текстовые строки и группы пунктов могут вращаться или отображаться зеркально 

при перемещении. Нажать пробел для вращения пунктов, клавиша x отображает зеркально в X направлении, а 
клавиша y в Y направлении. Центр вращения и зеркального отражение будет в позиции курсора. Слои под-
держиваемые выбор, в которых действительно перемещение зависят от установок, которые были сделаны в 
Setup Layers диалоговом окне. Чтобы отменить перемещение выбрать пункт Edit > Undo Move. 

 
Cut, Copy, Paste и Delete 
Использование операций Cut, Copy, Paste и Delete возможно после выбора пунктов на плате.  Duplicate 

позволяет определять множество копий  любых выбранных пунктов. 
 
Вырезание пунктов 
Cut удаляет выбранный пункт из окна платы и помещает в буфер. Чтобы вырезать пункт: 
1. Выбрать пункт или группу пунктов, затем щёлкнуть Cut кнопку инструментария. Курсор изменяется 

в перекрестие. 
2. Щёлкнуть в точку пункта для вырезания. Эта точка будет использована как ссылка при вставке пунк-

та. 
Для отмены операции выбрать Edit > Undo Delete. 
 
Копирование пунктов 
Copy дублирует выбранный пункт в буфер. Чтобы копировать пункт: 
1. Выбрать пункт или группу пунктов, затем щёлкнуть Copy кнопку инструментария. Курсор изменяет-

ся в перекрестие. 
2. Щёлкнуть в точку пункта для копирования. Эта точка используется как ссылка при вставке пункта. 
 
Вставка пунктов 
Paste копирует пункты из буфера в окно платы. Чтобы вставить пункт: 
1. Щёлкнуть Paste кнопку инструментария. 
2. Переместить пункт в нужную позицию и щёлкнуть левой кнопкой мыши для установки пункта. 
Если буфер пуст Paste кнопка будет не активна. Для отмены вставки нажать Esc клавишу до щелчка 

кнопки мыши. Чтобы отменить сделанную вставку немедленно нажать Delete, пока пункты все еще выбраны. 
 
Удаление пунктов 
Использовать Delete Tool средство или нажать Delete клавишу для удаления пунктов с платы. Чтобы 

удалять пункты: 
1. Убедиться что слой, содержащий пункты для удаления, активен. 
2. Выбрать Delete Tool средство. 
3. Позиционировать курсор над пунктом для удаления, и затем щёлкнуть. 
Для удаления пунктов, используя Delete клавишу: 
1. Выбрать пункты для удаления. 
2. Нажать Delete клавишу клавиатуры. 
Для отмены удаления выбрать пункт Edit > Undo Delete. 
 



Восстановление экрана 
Иногда после перемещения или удаления пунктов плата будет выглядеть фрагментированной. Чтобы 

восстановить изображение на плате, выбрать пункт Edit > Refresh Screen или нажать End клавишу клавиату-
ры. 

 
Дублирование пункта или группы пунктов 
Дублирование подобно действию Copy и Paste средствам, но с добавлением дополнительных функций 

автоматизации повторного размещения.  Это полезно при установке, например массива панелей. Для дублиро-
вания пункта или группы пунктов: 

1. Выбрать Arrow Tool средство. 
2. Выбрать пункт или группу пунктов. 
3. Выбрать пункт Edit > Duplicate. 
4. Определить количество продублированных пунктов и где установить копии, затем выбрать OK. 
 
Count   Установка количества дубликатов максимум до 1000. 
X and Y offset Определение позиции каждого дубликата вдоль любой из осей.  Например, ус-

тановка X 100 и Y 0 продублирует выбранный пункт с шагом в 100 mil направо в 
количестве определённом в Count текстовом окне. 

Duplicate All Layers Независимый выбор дублирования на все слои. Если необходимо дублировать 
пункт только на текущий слой, необходимо отменить этот выбор. 

Use Same Designators Независимый выбор использования компонентных обозначений в дубликатах 
как в подлиннике. 

 
Панорамирование 
Панорамирование является способностью перемещения рассматриваемой области экрана при увеличен-

ной области окна платы.  TraxMaker обеспечивает автоматическое смещение рабочей области при размещении 
или перемещении выбранных пунктов. Чтобы смещать рабочую область: 

1. Выберитесь одно из инструментальных средств размещения, как например, Place Component или 
Place Pad, или выбрать Arrow Tool средство, чтобы выбрать большую область печатной платы. 

2. Используя одно из средств, при перемещении объекта к границе рабочей области можно увидеть, как 
перемещается рабочая область. 

 
Средство размещения компонентов 
Это средство позволяет выбирать компоненты из библиотеки, добавлять текстовые этикетки к компонен-

ту, затем установить на плату. Чтобы установить компонент: 
1. Выбрать Place Component средство. 
2. Листая Components список найти компонент, который необходимо установить. 
3. Выбрать компонентное имя корпуса, затем нажать Place, чтобы установить компонент на плате.  

Можно также нажать Place and Return кнопку, чтобы установить компонент и автоматически воз-
вратиться в диалоговое окно для выбора другого компонента. 

4. Набрать имя или величину в Label-Value текстовой области. Компонентная этикетка или величина 
являются компонентным именем или электрической величиной, как например, 0.01uF, 470k или 
1N4002. 

5. Набрать обозначение компонента в Designation текстовой области. Компонентное обозначение 
обычно состоит из символов как, например U, C, J или R сопровождаемое числом.  Можно называть 
разъем как J3 или конденсатор как C4. 

6. Выбрать OK, и при размещении нажать пробел для вращения компонент против часовой стрелки с 
шагом 90 градусов или нажать X или Y клавиши для зеркального отображения компонента по x или y 
оси. 

7. Контрольная точка ссылки компонента находится на выводе 1. Переместить компонент в нужную по-
зицию и щёлкнуть для установки. 

 
Редактирование компонентов 
Компоненты могут легко редактироваться в TraxMaker. Редактирование позволяет переименовывать 

компонент в Package области, изменять Label-Value и Designation, разрешать отображение компонентных 
текстов и делать другие изменения. Чтобы редактировать компонент: 



1. Выбрать Arrow Tool средство. 
2. Дважды щёлкнуть в компонент (не щёлкать в панель), который необходимо изменить. 
3. В Edit Component диалоговом окне сделать желаемые изменения и нажать OK. 
Package Область изменения компонентного имени корпуса.  Переименование компонен-

та не повлияет на библиотеки. 
Label-Value Область изменения компонентного имени или величины.  Например, изменить 

величину конденсатора 0.1uF на 0.3uF. 
Designation Область изменения обозначения компонента.  Например, изменить обозначение 

резистора R34 на R43. 
Height   Область изменения высоты Label-Value и Designation текста. 
Line Width  Область изменения толщины символов Label-Value и Designation текста. 
Visible Разрешение отображения Label-Value и Designation текста. 
Top or Bottom Определение установки компонента на верхней или нижней стороне платы.   
Locked in Place Определение компонента свободно перемещаемым или заблокированным при 

прогоне функции авто размещения.   
Reference X Область изменения позиции x координаты компонента, ссылкой которой являет-

ся центр вывода 1. 
Reference Y Область изменения позиции y координаты компонента. 
 
Поиск компонентов 
Использование Find Component позволит быстро находить любой компонент установленный на плате. 

Чтобы найти компонент: 
1. Выбрать пункт Edit > Find > Component. 
2. Выбрать имя компонента и его вывод, затем нажать OK. 
Курсор переместиться на компонент и выбранный вывод. 
 
Кнопка Rotate 90  
Использование Rotate 90 кнопки вращает выбранный пункт против часовой стрелки с шагом 90 граду-

сов. Чтобы вращать пункт: 
1. Выбрать Arrow Tool средство. 
2. Выбрать пункт для вращения. 
3. Нажать Rotate 90 кнопку, чтобы вращать компонент. 
 
Вращение пунктов при размещении 
Чтобы вращать компонент при установке: 
1. Выбрать Place Component средство. 
2. Выбрать компонент из Component списка. 
3. Нажать Place или Place and Return. 
4. Нажать пробел для вращения компонента на 90 градусов. 
5. Щёлкнуть мышь, чтобы установить компонент в нужной позиции. 
 
Вращение текста 
Для вращения свободного текста или компонентного текста, используются те же методы что и при вра-

щении пунктов. Необходимо только определить правильный слой размещения текста. 
 
Кнопка Mirror   
Использование Mirror кнопки отображает зеркально выбранный пункт по горизонтали. Для зеркального 

отображения пункта: 
1. Выбрать пункт для зеркального отображения. 
2. Нажать Mirror кнопку инструментария. 
 
Зеркальное отражение пунктов при размещении 
Для зеркального отображения компонентов при размещении: 
1. Выбрать Place Component средство. 
2. Выбрать компонент из Component списка. 
3. Нажать Place или Place and Return. 



4. Нажать y, чтобы отобразить зеркально компонент по оси Y, нажать x, для отображения по оси X. 
5. Щёлкнуть мышь, чтобы установить компонент в нужной позиции. 
 
Средство Place Pad 
Свободные панели, которые не принадлежат библиотечным компонентам, могут устанавливаться вруч-

ную в проекте.  Панели со сквозными отверстиями и переходы относятся к Multi Layer объектам, которые 
занимают все слои печатной платы. Панели с единственным слоем как SMD компоненты или краевые разъё-
мы, могут быть установлены в Top или Bottom слоях.  Можно устанавливать многоуровневые панели или пе-
реходы, не учитывая текущего выбора слоя. 

TraxMaker библиотеки панелей идентифицируются .PAD расширением файлов, которые могут содержать 
до 200 стандартов описания панелей.  По умолчанию библиотека TraxMaker содержит 42 панели.  Пользова-
тель можете редактировать стандартную библиотеку панелей или создавать заказные библиотеки.  Тем не ме-
нее, только одна библиотека панелей может открываться за один раз. Чтобы установить панель: 

1. Нажать Place Pad средство, чтобы отобразить диалоговое окно. 
2. Листая Select pad список выбрать необходимую панель. 
3. Выбрать имя панели, затем щёлкнуть Place. 
4. Позиционировать курсор в место установки панели и щёлкнуть левую кнопку мыши. 
5. Позиционировать курсор в другом месте и щёлкнуть снова, чтобы установить другую панель.  Про-

должить до установки всех панелей.  Нажать Esc клавишу или правую кнопку мыши, чтобы отклю-
чить Place Pad средство. 

 
Вращение панелей 
Для вращения панелей нельзя использовать Rotate 90 кнопку инструментария. Чтобы вращать панель: 
1. Нажать и удерживать кнопку мыши на панели, используя Arrow Tool средство. 
2. При этом нажимать пробел для вращения панели на 90 градусов. 
 
Поиск панелей 
Использование Find Pad позволит быстро определить расположение панели на плате. Чтобы найти па-

нель: 
1. Выбрать пункт Edit > Find > Pad. 
2. Выбрать имя панели, которую необходимо найти и нажать OK или дважды щёлкнуть в имя панели. 

Панель будет выделена, и курсор переместится на выбранную панель. 
 
Редактирование панелей 
Использованием Edit Pad диалогового окна можете изменять характеристики панелей, как например, 

обозначение, слой размещения, размер, размер отверстия и форму. Можно также назначить панели на специ-
альные Power и Ground слои.  Панели могут быть подключены к этим медным слоям непосредственно или с 
использованием термических панелей. Для редактирования панелей: 

1. Выбрать Arrow Tool средство. 
2. Дважды щёлкнуть в панель для редактирования. 
3. Изменить необходимые характеристики панели, затем выбрать OK. 
Designation Область назначения обозначения панели.  
Shape Область определения формы панели.   
Layer Type   Выбор слоя расположения панели. 
X-Size    Размер панели по оси X. 
Y-Size    Размер панели по оси Y. 
Hole size Область определения размера отверстия. Отверстия могут быть опреде-

лены на 2 mils больше текущего диаметра панели, это удобный путь оп-
ределения механических отверстий свободных от меди при производст-
ве. Максимальный размер отверстий 1000 mils. 

X Position   Область изменения текущих координат панели по оси X. 
Y Position   Область изменения текущих координат панели по оси Y. 
No Connection   Определяет панель не связанную с силовыми слоями. 
Relief to Power Plane Преобразование панели в термическую панель для подключения к Power 

слою.  Доступно только при выборе Multi-Layer.  
Direct to Power Plane  Непосредственное подключение панели к Power слою. 



Relief to Ground Plane Преобразование панели в термическую панель для подключения к 
Ground слою.  Доступно только при выборе Multi-Layer. 

Direct to Ground Plane  Непосредственное подключение панели к Ground слою. 
Only this pad   Ограничение изменений текущей панелью. 
Matching pads  
in this component Ограничение изменения панелей текущим компонентом.  Изменения 

действительны только если размер и атрибуты формы соответствуют вы-
бранной панели. 

All matching pads  
same hole size Изменения действительны к панелям с соответствующим размером от-

верстий, а также размером и формой. 
All matching pads Изменения действительны ко всем компонентам или свободным панелям 

того же самого размера и формы. 
Tagged to Power Plane Маркировка SMD панелей подключенных к Power слою для соответст-

вующей трассировки. 
Tagged to Ground Plane Маркировка SMD панелей подключенных к Ground слою для соответст-

вующей трассировки. 
 
О термических рельефных панелях 
Термические рельефные панели используются для облегчения быстрой пайки и выпаивания выводов, ко-

торые соединяются с Power или Ground слоями.  Поскольку термические рельефные панели имеют секции,  в 
которых срезаны участки меди, тепло концентрируется в небольшой области вокруг панели, не рассеиваясь в 
Power или Ground слои меди.  Компонентные панели со сквозными отверстиями из-за своей многоуровневой 
конфигурации естественно подключаются к Power и Ground медным слоям, если они определены.  

Использование SMD (поверхностного монтажа) компонентных панелей, с другой стороны, требуют спе-
циальной техники применения.  Поскольку SMD панели не могут непосредственно подключаться к Power или 
Ground слоям, панели должны подключаться коротким сегментом трассы через отдельные сквозные панели. 
Есть два пути создавать дополнительных сегментов и панелей: 

 Установить сегменты и сквозные панели вручную, используя инструментальные средства. 
 Выбрать цепи, которые должны быть связаны с Power или Ground слоями использованием 

Pwr/Gnd Plane Nets пункта Netlist меню. 
 
Маркировка Ground или Power SMD панелей 
Для маркировки панели подключенной к Power или Ground слою: 
1. Дважды щёлкнуть в панель, выбрать Tagged to Power Plane или Tagged to Ground Plane и нажать 

OK. 
 Если необходимо маркировать многоуровневую панель, необходимо изменить слой панели на Top или 

Bottom, затем сделать выбор маркировки. 
2. Выбрать пункт Options > Setup, и нажать Router закладку. 
3. Отметить SMD to Pwr/Gnd, и нажать OK. 
 
Средство Route Pad to Pad Without Net 
Использование Route Pad-to-Pad Without Net средства автоматически завершает связь между любыми 

двумя панелями, не используя и не влияя на список цепей. Чтобы соединить панели использованием этого 
средства: 

1. Выбрать Route Pad-to-Pad Without Net средство. 
2. Позиционировать курсор над панелью до изменения цвета, затем нажать и держать левую кнопку 

мыши. 
3. Переместить трассу на другую панель.  Когда панель изменит цвет отпустить кнопку мыши.  Панели 

автоматически будут соединены. 
 
Средство Place Track 
Использование Place Track средства предназначено для ручной трассировки на плате. Создаваемые 

трассы всегда располагаются в текущей мгновенной сетке.  При изменении сетки установленные трассы оста-
ются в старой сетке, пока не будут перемещаться. Для ручной трассировки: 

1. Выбрать Place Track средство. 



2. Позиционировать курсор в начальной точке трассы и щёлкнуть. 
3. Переместить курсор в другую позицию.  Щёлкнуть в точке изменения направления трассы. 
4. Щёлкнуть правой кнопкой для завершения трассы. 
 
Изменение установок трассировки 
Использование Track и Drag Mode разделов в Setup диалоговом окне изменяет форму и направление 

трасс, а также перемещение трасс вместе с компонентами. Для установок трассировки: 
1. Выбрать пункт Setup > Tracks. 
2. Сделать выбор, описанный ниже и нажать OK. 
Orthogonal  Размещение трасс горизонтально, вертикально и под углом 45 градусов. 
Any Angle  Размещение трасс под любым углом. 
Curved Размещение прямых трасс со скруглёнными углами в стиле дуги. Трассы несу-

щие цифровые или аналоговые сигналы ВЧ могут потребовать применение та-
ких углов, чтобы устранять эффект "отражения" и связанные с этим проблемы. 

Default Width Определение ширины трасс в mils или миллиметрах. 
All Tracks Переместить все трассы, которые находятся в пределах перемещаемого пункта, 

независимо от того подключены они к пункту или нет. 
Connected Tracks Переместить все подключенные трассы перемещаемого компонента. 
None   Не перемещать никаких трасс при перемещении пункта. 
Ask for Drag TraxMaker сделает запрос после перемещения пункта, о необходимости переме-

щения связанных трасс. 
 
Редактирование трасс 
Чтобы визуально редактировать специфические трассы: 
1. Выбрать Arrow Tool средство. 
2. Щёлкнув и удерживая мышь на конце трассы переместить точку в новую позицию. X-Y координаты 

и длина дорожки отображаются на полосе статуса. 
Чтобы изменять атрибуты одной или множества трасс: 
1. Выбрать Arrow Tool средство. 
2. Дважды щёлкнуть в единственную трассу или из меню правой кнопки на трассе выбрать пункт Edit 

Track. 
 или  

Выбрать множество трасс, затем из меню правой кнопки на любой трассе выбрать пункт Edit Track. 
3. Сделать необходимые изменения, как описано ниже, и нажать OK. 
Track Width  Определение ширины трассы. 
Start X   Определение начальной X координаты трассы. 
Start Y   Определение начальной Y координаты трассы. 
End X   Определение конечной X координаты трассы. 
End Y   Определение конечной Y координаты трассы. 
Layer   Перемещение выбранной трассы на другой слой выбором из списка. 
Change width of  Изменения ширины относятся ко всем выбранным трассам. 
all selected tracks 
Change layer of  Изменения слоя относиться ко всем выбранным трассам. 
all selected tracks 
 
Средство Break Track 
Использование Break Track средства создаёт одну или более точек излома на прежде установленных 

трассах. Эти точки делят трассу на связанные сегменты, которые могут затем легко удаляться или редактиро-
ваться, не мешая остальным частям трассы. Чтобы сломать дорожку в текущем слое: 

1. Выбрать Break Track средство. 
2. Тщательно позиционировать курсор в точку излома и затем щёлкнуть. Оставаясь связанной, трасса 

разбивается на два сегмента. 
3. Щёлкнуть в других точках создания изломов. Правой кнопкой или выбором другого средства отклю-

чить средство Break Track. 
Если щёлкнуть и удерживая средством Break Track перемещать мышь, трасса перемещается вместе с 

мышью до отпускания кнопки. 



Средство Re-Route Track 
Использование Re-Route Track средства предназначено для повторной трассировки прежде установлен-

ных сегментов трассы, не изменяя существующих связей с панелями или другими трассами.  Это средство по-
зволяет создавать многочисленные точки излома трассы в течение одного сеанса. Для повторной трассировки: 

1. Выбрать Re-Route Track средство. 
2. Тщательно позиционировать курсор на начало повторной трассировки, затем щёлкнуть. 

В точке щелчка Re-Route Track средством создаётся точка излома трассы, которая следует за пере-
мещением курсора. 

3. Переместить курсор в другую позицию, затем только щёлкнуть. 
4. Переместите курсор в другую позицию, затем щелкните снова, чтобы уложить другую секцию.  Про-

должить перемещение и щелчки до завершения повторного выбора маршрута трассы. 
5. После завершения щёлкнуть правой кнопкой или нажать Esc. 
 
Средство Place Via 
Использование Place Via средства добавляет переходные отверстия на плату. Переходы это панели спе-

циального назначения, которые сверлятся при производстве платы, чтобы обеспечить электрическое соедине-
ние трасс в отдельных сигнальных слоях. В TraxMaker переходы всегда проходят через все слои платы.   

Переходы устанавливаются автоматически при использовании функции авто трассировки или при ис-
пользовании Route Pad-to-Pad Without Net средства.  Тем не менее, можно также устанавливать переходы и 
вручную, используя Place Via средство. Для установки перехода: 

1. Выбрать Place Via средство. 
2. Позиционировать курсор в место установки перехода, затем щёлкнуть мышь. 
3. Позиционировать курсор на другом месте, и щёлкнуть снова, чтобы установить другой переход.  

Продолжать до установки всех необходимых переходов. 
4. Нажать правую кнопку мыши или нажать Esc для отключения Place Via средства. 
 
Редактирование Via 
Использование Edit Via диалогового окна позволяет изменять диаметр перехода или диаметр отверстия с 

шагом 1 mil или .0254 мм.  Для редактирования перехода: 
1. Выбрать Arrow Tool средство. 
2. Дважды щёлкнуть в переход, который необходимо редактировать, или выбрать группу переходов для 

редактирования. 
3. Выбрать атрибуты и сделать изменения в соответствующих областях описанных ниже. 
Via Size    Область изменения размера перехода. 
Hole Size    Область изменения размера отверстия. 
X Position   Область изменения текущей x координаты. 
Y Position   Область изменения текущей y координаты. 
Only This Via   Все изменения действительны только для текущего перехода. 
Highlighted Vias Все изменения действительны для всех выбранных переходов.   
All Vias Same Hole Size Все изменения действительны для переходов с одним размером отвер-

стия. 
All Vias Same Size Все изменения действительны для переходов с одним размером диамет-

ра. 
 
Средство Place Text 
Использование Place Text средства позволяет добавлять короткие текстовые строки в любом слое платы. 

Text String диалоговое окно позволяет определять текстовые атрибуты при размещении текста. Свободные 
текстовые строки могут быть длиной до 128 символов. Чтобы установить свободный текст на плату: 

1. Выбрать Text Tool средство. 
2. В текстовой области Text набрать текстовую строку. 
3. Определите другие атрибуты для текстовой строки описанные ниже. 
4. Выбрать OK, переместить курсор в позицию установки текста, затем щёлкнуть.   
Character Height  Область изменения высоты символов. 
Track Width  Область определения толщины символов.  
Layer   Выбор слоя размещения текстовой строки. 



Rotation Вращение текста с шагом 90 градусов против часовой стрелки, None отменяет 
вращение текста. 

Mirror   Зеркальное отражение текста. 
 
Поиск текста 
Использование Find Text средства определяет расположение специфических текстовых строк на плате. 

Для поиска текста: 
1. Выбрать пункт Edit > Find > Text. 
2. Выбрать необходимый текст из списка и нажать OK. 
Курсор переместится на выбранный текст. 
 
Редактирование текста 
1. Выбрать Arrow Tool средства. 
2. Дважды щёлкнуть в текстовую строку для редактирования. 
3. Выбрать текстовые атрибуты, сделать изменения в соответствующих областях и нажать OK. 
Text   Область изменения содержания текста. 
Character Height  Область определения высоты символов. 
Track Width  Область определения толщины символов.  
Layer   Выбор слоя размещения текстовой строки. 
Rotation Вращение текста с шагом 90 градусов против часовой стрелки, None отменяет 

вращение текста. 
Mirror   Зеркальное отражение текстовой строки. 
Only This String  Все изменения действительны только для текущей текстовой строки. 
Highlighted Strings Все изменения действительны для всех выбранных текстовых строк. 
All Strings  Все изменения действительны для всех текстовых строк на плате. 
String Position X Область изменения текущей x координаты текстовой строки. 
String Position Y Область изменения текущей y координаты текстовой строки. 
 
Установка текстового размера по умолчанию 
По умолчанию в TraxMaker текстовые строки имеют размер 60 mils в высоту и 10 mils в толщину. Ис-

пользование Text раздела в Setup диалоговом окне, позволяет изменять эти установки по умолчанию. Чтобы 
изменить установки по умолчанию: 

1. Выбрать пункт Options > Setup. 
2. Определить высоту и толщины символов в Free Text разделе, которые используются в Place Text 

средстве. 
 или 

Определить высоту и толщины символов в Designation Text разделе, которые используются в тексто-
вой идентификации специфических компонентов, например, в обозначении резистора R34. 

 или 
Определить высоту и толщины символов в Label-Value Text разделе, которые используются в тексте 
компонентных величин,  например,  в величине ёмкости конденсатора 0.1uF. 

3. Нажать OK. 
 
Средство Place Arc 
Средство Place Arc используется для установки дугообразных линий и трасс на печатной плате. Дуги 

могут использоваться в Overlay слое для определения компонентных форм или в слое Board для механиче-
ских деталей, как например, монтажных отверстий.  Электропроводящие дуги могут быть установлены в лю-
бом из сигнальных слоёв.  Дуги ограничены любым из четырёх квадрантов 90 градусов каждый. Ширина дуги 
определяется также как для трасс, с шагом 1 mil или 0.025 мм. Для установки дуги: 

1. Выбрать Place Arc средство. 
2. При создании дуги позиция курсора определяет центр дуги.  Придерживая кнопку мыши при пере-

мещении определить радиус дуги, который отображается на полосе статуса. 
3. Отпустить кнопку мыши, чтобы открыть Edit Arc диалоговое окно. 
4. Выбрать необходимые параметры дуги в диалоговом окне, затем нажать OK. 
Radius  Область изменения радиуса уже установленной дуги. 
Line Width Область определения толщины линии дуги. 



X Position Область изменения текущей x координаты центра дуги. 
Y Position Область изменения текущей y координаты центра дуги. 
Layer  Выбор слоя размещения дуги. 
Quadrant  Выбор квадранта, в котором должна появиться дуга. 
 
Редактирование дуги 
1. Выбрать Arrow Tool средство. 
2. Дважды щёлкнуть в дугу для редактирования. 
3. Сделать необходимые изменения в Edit Arc диалоговом окне, затем нажать OK. 
 
Средство Place Fill 
Использование Place Fill средства добавляет медные заполнители на плату. Заполнители представляют 

собой медные прямоугольные области, устанавливаемые в сигнальных слоях, чтобы обеспечивать защиту эк-
ранированием определённых областей.  Заполнители различных размеров могут объединяться, чтобы покры-
вать нерегулярно сформированные области платы, что часто бывает необходимо для ВЧ устройств.  Заполни-
тели областей могут объединяться трассами, сегментами дуги и считаются электрически связанными при ис-
пользовании функций выбора. 

Можно устанавливать не электрические заполнители в Overlay  и Board слоях.  Заполнители установ-
ленные в Keep Out слое указывают на запретные зоны при авто трассировке и авто размещении компонентов. 
Чтобы установить заполнители: 

1. Выбрать Place Fill средство. 
2. Позиционировать курсор, где будет начальный угол заполнителя. 
3. Нажать и удерживая кнопку перемещением определить прямоугольную область заполнителя. 
4. Пока средство Place Fill не выключено, можно продолжить определение областей заполнителя.  Для 

отключения средства нажать правую кнопку мыши. 
 
Редактирование заполнителей 
Можно редактировать двойным щелчком в заполнителе, установкой x и y координат, а также определе-

нием слоя размещения заполнителя. 
 
Средство Place External Plane 
Средство Place External Plane используется для установки внешних металлизированных областей земли 

в Top или Bottom слоях проекта. Эти области имеют специальную структуру заполнения. В отличие от пря-
моугольных заполнителей, внешние металлизированные области могут быть сложными многоугольниками.  
При их установке они окружают, но не подключаются к трассам, панелям, переходам, заполнителям и текстам. 
Зазор между металлизированной областью и другими примитивами определяется  в Clearance разделе Router 
закладки Setup окна. 

 
Анатомия внешних областей 
Внешние металлизированные области могут быть созданы как решетки или как сплошные многоуголь-

ники созданные параллельными сегментами трасс. 
 
Изменение установок внешних областей 
Прежде, чем создавать металлизированную область необходимо определить некоторые параметры: 
1. Выбрать пункт Options > Setup. 
2. В External Plane разделе определить величину размера сетки, это пространство между дорожками 

решётки в Grid Size текстовой области. 
3. Ввести новую величину ширины дорожек решётки в Track Width текстовой области и нажать OK. 
Если Track Width и Grid Size установки будут равны, будет сгенерирована сплошная металлизирован-

ная область.  Если величина Track Width больше Grid Size, будет сгенерирована решётка из пересекающихся 
трасс. 

 
Размещение внешних областей 
Поскольку могут быть трудности с удалением внешних металлизированных областей, и нет возможности 

удаления использованием Undo команды, необходимо сохранить существующий проект перед размещением. 
Чтобы установить внешнюю металлизированную область: 



1. Выбрать Save средство, чтобы сохранить копию платы на случай не удачного размещения. 
2. Выбрать Place External Plane средство. 
3. Щёлкнуть в отправной пункт многоугольника. При перемещении курсора периметр плоскости ука-

зывается выделенной линией. 
4. Щёлкнуть в каждый угол многоугольника пока не будет определена вся область внешней металлиза-

ции. Щелчок правой кнопкой завершает создание области. 
Как только новая область будет сгенерирована, можно продолжать создание других металлизированных 

областей.  Для отключения External Plane средства нажать Esc или правую кнопку мыши. 
 
Редактирование внешних металлизированных областей 
Внешние области являются простыми трассами, которые могут редактироваться индивидуально или гло-

бально подобно другим трассам. Концы горизонтальных и вертикальных трасс области закрываются автома-
тически при достижении допустимого зазора.   

Определение минимальных размеров ширины трассы и сетки требует больше времени для генерирования 
и вычерчивания металлизированных областей на печатной плате. 

 
Средство Zoom 
Zoom средство позволяет расширять или сокращать вид окна платы.  Когда Zoom средство активно, кур-

сор изменяется в образ лупы. Для изменения области обзора: 
1. Выбрать Zoom средство. 
2. Щелчок левой кнопкой в окне платы сужает область обзора, увеличивая размер пунктов. 
3. Удержание Shift кнопки и щелчок левой кнопкой расширяет область обзора. 
4. Щелчок правой кнопкой мыши отключает Zoom средство, включая Arrow Tool. 
Лупа при этом отображает символ “+” или “-” соответственно. 
 
Средство Select Area and Zoom 
Это удобное средство поможет быстро расширить выбранную область платы на всё окно.  Чтобы устано-

вить выбранную область в окно: 
1. Выбрать Select Area and Zoom средство. 
2. Нажать и перемещением мыши определить прямоугольную область, которую необходимо отобразить 

в границах окна платы. 
или 
1. Выбрать Arrow Tool средство. 
2. Нажать и перемещением мыши определить прямоугольную область, которую необходимо отобразить 

в границах окна платы. 
3. Выбрать пункт меню View > Fit Selection to Window. 
 
Средство Fit Board to Window 
Это удобное средство поможет быстро расширить всю область платы на всё окно. Чтобы установить пла-

ту в пределы окна: 
1. Выбрать Fit Board to Window средство. 
 или 
   Выбрать пункт View > Fit Board to Window. 
 
Установки Draw Mode 
Использование Draw Mode раздела в Setup диалоговом окне определяет способы отображения пунктов 

платы в проекте. Черновой режим использует меньший объём данных и таким образом имеет более быструю 
частоту регенерации. Чтобы установить способы отображения: 

1. Выбрать пункт Options > Setup. 
2. Выбрать Draft или Final для индивидуальных примитивов. 
или 
   Выбрать All Draft или All Final для всех примитивов. 
3. Сделать другие выборы, описанные ниже и затем щёлкнуть OK. 
Show Pad Holes  Отображение отверстий на каждой панели. 
Show Pad Names  Отображение имени каждой панели. 



Transparent Mode Отображение насквозь всех слоёв платы только для чёрного фона. 
 
5. Управление библиотеками 
TraxMaker поставляется с обширными библиотеками компонентов и панелей.  Тем не менее, пользова-

тель можете сам добавлять новые библиотеки, а также изменять или добавлять компоненты и панели в суще-
ствующие библиотеки.  Кроме того, имеется возможность создавать новые компоненты, управлять сущест-
вующими библиотеками и создавать новые библиотеки. 

 
Управление библиотекой компонентов 
 Эта глава объясняет как, используя Component Selection диалоговое окно, делать предварительный про-

смотр, вставлять, добавлять, удалять, копировать, перемещать и переименовывать компоненты.  А также пока-
зано как управлять библиотекой компонентов. 

 
О компонентах 
TraxMaker поставляется с обширными библиотеками, стандартными штыревыми компонентами и по-

верхностного монтажа (SMD). Компоненты обычно включают одну или более панелей, которые назначаются 
выводам компонента. Компонентные панели, подобно свободным панелям и переходам, занимают Multi, Top 
или Bottom слои.  Форма компонентов нормально отображается в Overlay слоях. 

Компонентный текст, который обычно включает обозначение, тип и величину нормально располагается в 
Top Overlay слое, но также могут быть перемещены в Top или Bottom слои. Компонентные текстовые уста-
новки могут изменяться перед размещением или редактироваться после размещения. 

Библиотека, которая загружалась в предшествующем рабочем сеансе, загрузится автоматически при сле-
дующем запуске TraxMaker.  Стандартный компонентный библиотечный файл в TraxMaker называется 
Traxstd.lib. 

 
Просмотр библиотек компонентов 
Компонентные библиотеки легко открываются для просмотра. Чтобы просматривать библиотеки: 
1. Выбрать Place Component средство. 
2. Открыть библиотеку, которую необходимо просматривать. Загруженные библиотеки указаны в 

Libraries разделе Component Selection диалогового окна. 
3. Перемещая Components список можно просматривать имена всех компонентов выбранной библио-

теки. 
4. Щелчок Zoom In увеличивает компонент для лучшего обзора, Zoom Out уменьшает. 
 
Добавление нового компонента 
 Можно создавать компоненты двумя способами.  Первый путь в том, чтобы создать индивидуальные 

примитивы, сгруппировать их, затем добавьте их к библиотеке как новый компонент.  Другой путь в том что-
бы создать новый компонент, базируясь на существующем компоненте. Оба этих метода описаны ниже. 

 
Создание компонента рисованием 
1. Использованием инструментальных средств Place Track, Place Pad, Place Arc и т.п. создать компо-

нент по индивидуальным предпочтениям пользователя. Использованием Duplicate команды из Edit 
меню можно быстро установить колонки равномерно расположенных панелей. 

2. Каждой панели в новом компоненте необходимо дать обозначение в виде номера.  
3. Выбрать Arrow Tool средство и выделить все примитивы нового компонента. 
4. Нажать Place Component средство. 
5. Выбрать Add, набрать имя нового компонента, затем нажать OK. 
6. Выбрать OK, чтобы подтвердить добавление нового компонента. 
7. Чтобы просмотреть новый компонент, выбрать имя компонента из списка. 
 
Создание компонента на основе существующего 
Бывает необходимость создать компонент аналогичный уже существующему компоненту в библиотеке.  

Вместо создания полностью нового компонента рисованием, можно разгруппировать существующий компо-
нент, добавить свои примитивы или отредактировать существующие.  Затем сохранить отредактированную 
версию как новый библиотечный компонент. Этот метод также полезен, если необходимо сделать незначи-



тельные изменения в существующих библиотечных образцах. Чтобы создать новый компонент на основе су-
ществующего: 

1. Выбрать компонент установленный на плате. 
или 

Выбрать Place Component средство, выбрать компонент и нажать Place, установить компонент на 
плате и выбрать его. 

2. Выбрать пункт Edit > Ungroup Component. 
3. Выбрать OK, чтобы подтвердить разгруппирование. 
Не смотря на то, что компонент выглядит неизменным, за исключением удалённого компонентного тек-

ста, каждый элемент компонента теперь доступен для индивидуального редактирования.  
4. Используя инструментальные средства можно удалять, редактировать или добавлять новые элементы 

к компоненту. 
5. Выбрать Arrow Tool средство. 
6. Выбрать все элементы отредактированного компонента, например протаскиванием прямоугольника. 
7. Выбрать Place Component средство. 
8. Выбрать Add, определить имя нового компонента или использовать старое имя, чтобы заменить су-

ществующий компонент новым, затем выбрать OK. 
9. Выбрать OK, чтобы подтвердить дополнение нового компонента. 
10. Для просмотра нового компонента, выбрать компонентное имя из списка. 
 
Удаление компонента из библиотеки 
Как только компонент удаляется из библиотеки, он теряется безвозвратно.  Потому рекомендуется делать 

резервную копию библиотеки перед удалением компонентов. Чтобы удалить компонент из библиотеки: 
1. Выбрать Place Component средство. 
2. Выбрать из списка компонент для удаления. 
3. Нажать Delete. 
4. Выбрать OK для подтверждения удаления. 
 
Уплотнение библиотеки компонентов 
При добавлении и удалении множества компонентов, возможно фрагментирование библиотечных фай-

лов. Это может стать проблемой при ограниченном свободном пространстве на диске. Уплотнение библиотеки 
удаляет пробелы, не удаляя компонентной информации. Чтобы уплотнить компонентную библиотеку: 

1. В Component Selection диалоговом окне выбрать Compact. 
2. Нажать Yes, чтобы подтвердить действие. 
 
Создание новой библиотеки компонентов 
TraxMaker даёт возможность создавать новые компонентные библиотеки, например, необходимо иметь 

другую библиотеку для специфического проекта. Чтобы создать новую библиотеку компонентов: 
1. Выбрать Place Component средство. 
2. Нажать New. 
3. Определить новое имя библиотеки, затем щёлкнуть Save.  Или набрать имя существующего библио-

течного файла, чтобы откорректировать или заменить существующую библиотеку, нажать Save, за-
тем Yes, чтобы подтвердить замену. 

Новая библиотека компонентов появится в списке других библиотек. 
 
Открытие другой библиотеки компонентов 
При размещении компонентов на плате может появиться необходимость загрузки компонентов из другой 

библиотеки. Чтобы открыть другую библиотеку: 
1. Выбрать Place Component средство. 
2. Выбрать Open в Libraries разделе, выбрать имя другой библиотеки и нажать Open. 
или 

Если кроме открытой библиотеки имя необходимой библиотеки отображается в Libraries разделе, 
щёлкнуть её имя для быстрого открытия. 

 
 
 



Слияние библиотек компонентов 
Используя Copy и Paste функции в Component Selection диалоговом окне, можно копировать компонен-

ты из одной библиотеки в другую. Для копирования компонентов между библиотеками: 
1. Выбрать Place Component средство. 
2. Выбрать компонент из Components списка. 
3. Нажать кнопку Copy. 
4. Нажать Open, выбрать другую библиотеку компонентов, затем выбрать Open. 
5. Нажать кнопку Paste, затем OK, чтобы подтвердить вставку компонента скопированного из другой 

библиотеки. 
 
Управление библиотеками панелей 
Эта секция объясняет использование Pad Selection диалогового окна для просмотра, добавления, удале-

ния и редактирования панелей, а также показано, как управлять библиотеками панелей. Библиотека, исполь-
зуемая на предшествующем рабочем сеансе, загрузится автоматически при следующем запуске TraxMaker. 
Стандартная библиотека панелей, которая поставляется с TraxMaker, названа TRAXSTD.PAD. 

 
О панелях 
TraxMaker поставляется с обширными стандартными библиотеками панелей со сквозными отверстиями и 

поверхностного монтажа (SMD). Одна библиотека может содержать до 200 панелей, стандартная библиотека 
панелей содержит 42 встроенные формы. Панели, подобно свободным панелям и переходам, занимают Multi, 
Top или Bottom слои. Панели имеют уникальное имя, форму, X и Y размеры, размер отверстия и определение 
как SMD или штырьковые панели. Параметры панели могут быть выбраны перед размещением или отредак-
тированы после размещения. 

 
Размеры отверстий в панелях 
Отверстия панелей всегда сохраняются как часть определения панелей, и могут отображаться и печатать-

ся в TraxMaker. Раздел Draw Mode в Setup меню изменяет опции отображения для отверстий панели и имён. 
При вычерчивании топологических чертежей печатной платы размер отверстий игнорируется, за исключением 
создания файлов формата Excellon или Drill Drawing. Использованием Hole Size опции в Edit Pad Type диало-
говом окне, определяется размер отверстия. Чтобы определять размер отверстия для Gerber графики использу-
ется пункт File > Gerber Setup > Options, затем вводится величина в Pad Hole Guide Size. 

 
Отверстия SMD панелей 
Отверстия могут быть определены для любых SMD панелей. Это обеспечивает дополнительную гибкость 

при смешанном использовании SMD и штыревых компонентов, особенно при размещении компонентов на 
обоих Top и Bottom слоях. 

 
Просмотр библиотек панелей 
Можно просматривать образцы панелей сохраненных в библиотеке. Чтобы просмотреть панели: 
1. Выбрать Place Pad средство. 
2. Перемещая Select pad список можно просматривать имена панелей выбранной библиотеки. 
3. Нажать Zoom In для увеличения размера панели, Zoom Out для уменьшения. 
 
Создание или редактирование панелей 
Можно создавать новые панели и добавлять к библиотеке панелей, или можно отредактировать сущест-

вующие панели. Чтобы создавать новые определения панелей или редактировать существующие: 
1. Выбрать Place Pad средство. 
2. Нажать New кнопку, определить атрибуты новой панели, затем выбрать Save Changes. 
или 

Выбрать панель, нажать Edit кнопку, сделать изменения атрибутов панели в Edit Pad Type диалого-
вом окне, затем выбрать Save Changes. 

3. Чтобы просмотреть новую панель, выбрать имя панели из списка. 
Name Область определения обозначение панели.  
Shape Область выбора формы панели.  
Layer Type Выбор независимой панели поверхностного монтажа или со сквозным отверстием. 
X-Size  Размер панели относительно X координаты. 



Y-Size  Размер панели относительно Y координаты. 
Hole size Область определения размера отверстия используемая для создания файлов управления 

сверловки формата Excellon. Отверстия могут определяться на 2 mils больше чем теку-
щий диаметр панели.  Это удобный путь определения механических отверстий, с доста-
точным допуском пространства свободного от меди при производстве. При попытке 
вводить размер отверстия на 2 mils больше чем текущий диаметр панели, TraxMaker ис-
ключит величину большую 2 mils. Максимальный размер отверстия 1000 mils (1 дюйм). 

 
Удаление панели из библиотеки 
Как только панель удаляется из библиотеки, она теряется безвозвратно.  Рекомендуется сделать резерв-

ную копию библиотеки прежде, чем удалять панель. Чтобы удалить панель из библиотеки: 
1. Выбрать Place Pad средство. 
2. Выбрать панель, которую необходимо удалить. 
3. Нажать кнопку Delete. 
или 
    Чтобы удалить все панели, нажать Delete All. 
4. Нажать OK, чтобы подтвердить удаление. 
 
Создание новой библиотеки панелей 
Иногда бывает необходимость иметь несколько библиотечных файлов панелей.  Чтобы создать новую 

библиотеку панелей: 
1. Выбрать Place Pad средство. 
2. Нажать кнопку New Pad File. 
3. Определить новое имя библиотеки, затем нажать Save.  Или набрать имя существующего библиотеч-

ного файла, чтобы скорректировать или заменить существующую библиотеку, нажать Save, затем 
Yes, чтобы подтвердить замену. 

 
Открытие других библиотек панелей 
При размещении панелей на плате может возникнуть необходимость загрузки панелей из другой библио-

теки. Чтобы открыть другую библиотеку: 
1. Выбрать Place Pad средство. 
2. Нажать Load Pad File кнопку в Pad Selection диалоговом окне, выбрать имя другой библиотеки, за-

тем нажать Open. 
 
Копирование панелей из других библиотек 
При необходимости можно копировать панели из одной библиотеки в другую. Чтобы копировать панели 

между библиотеками: 
1. Выбрать Place Pad средство. 
2. Нажать кнопку Load Pad File, чтобы открыть библиотеку панелей, в которую будет копироваться 

панель. 
или 
   Выбрать New Pad File для создания новой библиотеки панелей, в которую будет копироваться па-

нель. 
3. Нажать кнопку Merge Pad from File. 
4. Выбрать директорий и имя файла библиотеки, из которого необходимо копировать панели. 
5. Выбрать панель, затем нажать Merge. 
Панель копируется в библиотеку панелей, которая была открыта в пункте 2. 
 
6. Цепи и список цепей 
Одной из наиболее полезных функций TraxMaker является способность автоматического создания цепей 

основанных на связях списка цепей Netlist.  Список цепей может быть импортирован из CircuitMaker или дру-
гих схемных программ, или сгенерирован в пределах TraxMaker. Другой полезной функцией является авто 
размещение компонентов из информации списка цепей. TraxMaker может оптимально расставить компоненты 
на плате, это проще чем размещать их вручную с самого начала проекта. Прежде, чем выполнить авто трасси-
ровку платы есть множество функций и понятий, имеющих отношение к списку цепей которым нужно уде-
лить некоторое внимание. 



Что такое цепь? 
Цепь это серия связанных трасс, панелей и переходов, и описывает основную сеть примитивов, которые 

физически подключены друг к другу. 
 
Что такое Netlist? 
Это ASCII текстовый файл списка цепей, перечисляющий и описывающий все связи между компонента-

ми в электронной схеме.  Широко используясь в электронных CAD пакетах, список цепей позволяет переда-
вать проектные детали между приложениями, как например, CircuitMaker и TraxMaker.  Список цепей обычно 
содержит два типа информации: 

 Описание индивидуальных компонентов 
 Список всех межвыводных связей 

Netlist входит в различные форматы, но обычно он несёт аналогичные данные. TraxMaker может импор-
тировать и экспортировать ряд Netlist форматов, и таким образом совместим со многими проектными сервис-
ными программами.  Файловое расширение .NET используется для TraxMaker файлов списков цепей. 

 
Формат TraxMaker Netlist  
Некоторые списки цепей имеют отдельные форматы для описания компонентов и описания связей.  Дру-

гие форматы объединяют оба комплекта данных в единственную секцию.  Следующее описание представляет 
формат списка цепей TraxMaker. Первая часть списка описывает каждый компонент: 

 [   Выделяет начало каждого описания компонента. 
U8  Этикетка компонентного обозначения. 
DIP16 Идентификатор корпуса компонента.   
74LS138  Отображение имени компонента или величины. 
Blank line Левый пробел для будущего определения, обычно три пустых строки. 
]   Выделяет конец описания компонента. 
Вторая часть списка включает описание каждой цепи: 
 (   Выделяет начало каждой цепи. 
NETCLK Название цепи. 
U8-3 Показывает первый компонент и номер вывода.  
J21-1  Указывает второй узел цепи. 
U5-5  Указывает следующий узел. 
)   Выделяет конец цепи. 
 
 
Другие форматы Netlist 
Списки цепей схемных редакторов при упаковке имеют сходство с форматом, используемым в 

TraxMaker. Тем не менее, имена корпусов и идентификаторы выводов могут отличаться. TraxMaker формат 
списков цепей идентичен Tango и Protel форматам и способен загрузить списки цепей следующих форматов: 

 TraxMaker 
 Protel 
 Tango 
 OrCAD PCB II (профессиональная версия) 
 PADS PCB (профессиональная версия) 
 Cadnetix  (профессиональная версия) 

Тем не менее, в некоторых случаях необходимо редактирование списка перед импортом, чтобы обеспе-
чить совместимость.  

 
Просмотр и редактирование Netlists 
Как простые текстовые файлы ASCII списки цепей легко просматриваются, создаются и модифицируют-

ся использованием простого текстового редактора.   
 
Ограничения Netlist  
Обозначения и описания корпусов ограничены 12 текстовыми символами.  Имена цепей должны быть не 

более 20 символов.  Имена выводов ограничены 4 текстовыми символами.  Никаких пробелов и пустых строк 



не допускается. До 2000 узлов может быть указано в одной цепи.  Схема может содержать не более 2000 це-
пей. 

 
Загрузка Netlist 
Прежде, чем использовать любой из списков цепей необходимо сначала его загрузить.  TraxMaker при-

нимает ряд форматов, включая: 
 TraxMaker 
 Protel 
 Tango 
 OrCAD PCB II (профессиональная версия) 
 PADS PCB (профессиональная версия) 
 Cadnetix  (профессиональная версия) 

При загрузке можно выбирать списки цепей с сопутствующими компонентами, или нагружать только 
списки без компонентов. Чтобы загрузить Netlist: 

1. Выбрать пункт Netlist > Load Netlist, затем выбрать из списка нужный формат для загрузки. 
2. Выбрать Netlist and Components, затем нажать OK. 
или 
    Выбрать Netlist only, чтобы загрузить список после прежде размещённых компонентов. 
3. Перейти в место хранения файла списка цепей, выделить файл, затем выбрать Open для загрузки 

файла. 
4. Нажать OK, затем щёлкнуть в позицию, где необходимо установить компоненты. 
Список цепей не содержит никакой информации о размещении компонентов.  Следовательно, при за-

грузке списка все компоненты будут собраны в одной точке. Только после этого компоненты вручную или 
автоматически могут быть размещены на плате. 

5. Просмотреть Netlist results и Component results разделы в Netlist Load диалоговом окне.  Сделать 
необходимый выбор, описанный ниже затем нажать OK. 

Nets Loaded  Отображает общее число загруженных цепей. 
Missing Components  Количество компонентов пропущенных из списка при установке на плате. 
Missing Pins Количество выводов в списке, которые не соответствуют установленным ком-

понентам. 
Components Loaded Количество загруженных компонентов. 
Missing Patterns Компонентный образец, определённый в списке цепей не совместим с загружен-

ным компонентом из библиотеки.  
Existing Components Показывает прежде установленные компоненты, чьи назначения соответствуют 

одному или более компонентов в списке цепей. 
Shortest Path Выбор сортировки списка цепей, чтобы получить самые короткие расстояния 

связей. 
X Bias Порядок связывания выводов для коротких связей вдоль оси X. 
Y Bias   Порядок связывания выводов для коротких связей вдоль оси Y. 
Select Net Отображать связанность для одной выбранной цепи. 
Nets on Selected  
Component Отображать связанности для выбранного компонента. 
  
All Nets   Отображать связанности всех установленных компонентов. 
None   Загрузка списка цепей без отображения связанностей. 
View details of errors Разрешение отображения детализации ошибок. 
 
Создание Netlist 
TraxMaker командой Make Netlist действительно создаёт список цепей, базируясь на связях текущей пе-

чатной платы.  Эта команда наиболее полезна для обновления существующего списка цепей после того, как 
были сделаны изменения на плате. Или можно использованием Make Netlist команды сгенерировать список 
цепей в другом формате.  TraxMaker может сделать список цепей в следующих форматах: 

 TraxMaker 
 Protel 
 Tango 
 OrCAD PCB II (профессиональная версия) 



 PADS PCB (профессиональная версия) 
 Cadnetix  (профессиональная версия) 
 Calay  (профессиональная версия) 
 Calay90  (профессиональная версия) 

Чтобы создать список цепей: 
1. Выбрать пункт Netlist >Make Netlist, затем выбрать желаемый формат из списка. 
2. Определить имя нового списка цепей, затем выбирать Save. 
 
Отображение и скрытие связанностей 
TraxMaker даёт возможность просматривать все или различные комбинации связанности цепей после за-

грузки списка, чтобы помочь в трассировке печатной платы. Использование Show Nets и Hide Nets выбора 
позволяет отображать или скрывать некоторые или все связанности на плате. Чтобы отобразить или скрыть 
связанности: 

1. Выбрать пункт Netlist >Show Nets или Hide Nets. 
2. Определить выбор для цепей, связанность которых необходимо показать или скрыть. 
Select Net   Выбор цепей из списка в Choose Net диалоговом окне. 
Nets on Selected Components Выбор цепей подключенных к компоненту. 
All Nets    Выбор всех цепей на плате. 
Unrouted Nets   Выбор всех не разведённых цепей на плате. 
Routed Nets   Выбор всех разведённых цепей на плате. 
Необходимо отметить, что Show Nets и Hide Nets команды действительны только при загруженном спи-

ске цепей.  
 
Поиск цепей 
Choose Net диалоговое окно позволяет быстро выбирать имя цепи, так что можно быстро позициониро-

вать курсор в этой цепи. Чтобы использовать эту функцию, необходимо сначала загрузить список цепей, затем 
использованием Show Nets отобразить связанности цепей. Для поиска цепи: 

1. Выбрать пункт Netlist > Show Nets > All Nets. 
2. Выбрать пункт Edit > Find > Net. 
3. Выбрать имя цепи из списка и нажать OK, курсор переместиться в позицию нужной цепи. 
 
Идентификация цепей 
После отображения связанностей, использованием Identify Net выбора можно определить имя любой це-

пи. Чтобы идентифицировать цепь: 
1. Выбрать пункт Netlist > Identify Net. 
2. Щёлкнуть в связанность нужной цепи. 
Отображается окно с именем цепи. 
 
 
Авто размещение 
Загрузка списка цепей в TraxMaker допускает автоматическое размещение компонентов на печатной пла-

те.  Очень важно знать о стратегиях и ограничениях функции авто размещения. Этот выбор предназначен для 
снижения трудоёмкости ручного размещения компонентов на плате. Функция группирует компоненты, ис-
пользуя специальные стратегии размещения, чтобы в конечном итоге оптимизировать связи между компонен-
тами. Окончательное размещение может доводиться вручную, тем не менее, это экономит значительное время. 

 
Перед запуском авто размещения 
Прежде, чем загружать список цепей, необходимо следовать двум простым правилам. Сначала необхо-

димо вручную установить краевые разъемы или другие компоненты, которые должны быть на конкретном 
месте платы. Размещение вручную автоматически помечает эти компоненты как не перемещаемые при работе 
авто размещения. Вторым правилом устанавливается размещение второстепенных компонентов вокруг основ-
ного. Примером основного компонента может быть микропроцессор.  

При очень небольших размерах печатной платы результаты могут быть далеки от ожидаемых результа-
тов размещения. Тем не менее, использование программы авто размещения и при необходимости ручное  пе-
ремещение компонентов более быстрый способ по сравнению с размещением каждого компонента вручную. 



Прежде, чем использовать функцию авто размещения необходимо определить границы, в пределах которых 
должны быть установлены компоненты. 

 
Определение Keep Out слоя 
Область Keep Out определяет разрешённую область для авто размещения и авто трассировки в границах 

печатной платы. Для создания такой области определить прямоугольную секцию из трасс в Keep Out слое. 
Кроме того, можно также определять запретные области в пределах прямоугольника и в этом же слое, уста-
новкой прямоугольных заполненных областей. 

 
Установка сетки и зазоров 
Определение Auto Place Grid и Clearance разделов Grid/Draw закладки Setup диалогового окна  позво-

ляет управлять шагом размещения компонентов. Для установки сетки и зазоров авто размещения: 
1. Выбрать  пункт Options > Setup, и нажать Grid/Draw закладку. 
2. Сделать установки, описанные ниже затем выбрать OK. 
Large X & Y Placement Grids Определение сетки для позиции вывода 1 больших компонентов, кото-

рые имеют от 4 и более выводов. 
Small X & Y Placement Grids Определение сетки для позиции вывода 1 небольших компонентов, кото-

рые имеют от 3 и менее выводов. 
Large X & Y Clearance Определение минимального расстояния для больших компонентов. 
Small X & Y Clearance  Определение минимального расстояния для небольших компонентов. 
 
Стратегии авто размещения 
Функция использует несколько стратегий при размещении компонентов на печатной плате. Перед раз-

мещением компоненты сначала группируются, затем используется размещение групп в определённой сетке и 
зазорах. 

Чтобы группировать компоненты, сначала их классифицируют как один из трех типов: большие с че-
тырьмя или более выводами, небольшие или дискретные с тремя выводами и меньше и обычно связанные с 
большим компонентом и проходные конденсаторы.  Классификация основана только на связях списка цепей, а 
не на описании корпусов. 

Небольшие или дискретные компоненты назначаются большим компонентам простыми правилами.  Иг-
норируя две определённых силовых цепи, дискретный компонент назначается большому компоненту, если 
50% или более его выводов подключены к большому компоненту. 

Когда дискретные компоненты сгруппированы и связанны с большими компонентами, вся группа уста-
навливается как устройство в укрупнённых X и Y сетках.  Любые не назначенные небольшие компоненты за-
тем устанавливаются в малых X и Y сетках. Группирование и размещение компонентов будет находиться под 
влиянием метода оптимизации на минимально короткие связи, который определяется при загрузке списка це-
пей. 

 
Запуск авто размещения 
Чтобы автоматически разместить компоненты на плате в пределах определённой области Keep Out: 
1. Выбрать пункт Netlist > AutoPlacement > Arrange Components. 
 
Перемещение компонентов в сетке 
Использование Move all Components to Grid выбора в AutoPlacement меню сдвигает центры панелей 

установленных компонентов в другую позицию, основанную на сетке определённой ранее в Setup диалоговом 
окне. Нормально это будет сетка, которая будет использоваться при трассировке на плате. 

В идеале сетки размещения и трассировки должны быть кратны расстоянию между панелями компонен-
тов. Например, стандартное расстояние 100 mil между выводами ИС допускает успешное использование 100, 
50, 25, 20, 10 и 5 mil сеток размещения и трассировки. Чтобы переместить компоненты на определённую сет-
ку: 

1. Выбрать пункт Netlist > AutoPlacement > Move Components to Grid. 
2. Определить величину сетки, затем выбрать OK. 
TraxMaker пытается устанавливать компоненты логично и удобно, чтобы облегчить конечное ручное 

размещение.  
 
 



Особенности авто размещения 
Из-за множества возможных вариантов размещения обычно требуется, методом проб и ошибок найти та-

кую комбинацию размещения, которая даёт наилучшие результаты.  Рекомендуется сохранить печатную пла-
ту, включая Keep Out определения, заранее установленные компоненты, разъемы, и так далее,  перед исполь-
зованием авто размещения.  Затем, если первый результат не удовлетворительный, можно перезагрузить пе-
чатную плату сделать изменения и запустить AutoPlacement снова. 

Следующие руководящие принципы помогут в эффективном использовании множества выборов авто 
размещения: 

Если плата требует очень плотного размещения компонентов, допускается определение дополнительного 
места для первого авто размещения, затем постепенно перемещая в свой конечный размер с предустановлен-
ными компонентами.  Если компоненты не умещаются в Keep Out периметр, они установятся за пределами 
периметра. 

После того, как компоненты будут установлены, они блокируются на своём месте. Это означает, что ис-
пользование повторного авто размещения не переместит эти компоненты.  Если для компонента не нашлось 
места на плате, и он был установлен за пределами Keep Out области, при этом он не блокируется и определя-
ется как свободный для перемещения. При использовании повторного авто размещения будет попытка пере-
мещения компонента в область печатной платы. Свободный или блокированный статус компонента может 
быть изменено в Edit Component диалоговом окне. 

 
Авто размещение с множеством библиотек 
Библиотеки TraxMaker ограниченны 600 компонентами. Тем не менее, возможна ситуация когда необхо-

димо загружать и устанавливать компоненты из нескольких библиотек. При загрузке списка цепей TraxMaker 
ищет все загруженные (открытые) библиотеки компонентов. Если в проекте используются компоненты из не-
скольких библиотек, необходимо убедиться, что все нужные библиотеки открыты при загрузке списка цепей. 

 
7. Трассировка 
После установки компонентов на плате, следующий основной шаг создание связей между компонентами.  

Трассировка использует ряд инструкций для управления созданием соединяющих трасс на плате для опти-
мального их исполнения и производства. Есть различные способы трассировки платы: можно выполнять 
вручную, используя встроенный авто трассировщик или комбинацию обеих способов. Авто трассировщик 
TraxMaker базируясь на определённой сетке, делает многопроходные попытки трассировки определённой це-
пи с целью оптимизации, чтобы достигать высокие показатели в стоимости за счёт сокращения переходов и 
длины связей.  

Авто трассировщик чрезвычайно гибкая функция с множеством выборов, позволяя конфигурировать 
трассировку по ряду типов. Можно трассировать всю плату, индивидуальную цепь или единственную связь. 
Другой комплект установок определяет правила, такие как размеры трасс и зазоров и могут быть приложены к 
индивидуальным цепям или связям. Есть также множество команд для редактирования и исправления пред-
шествующей трассировки. 

 
Установки трассировки 
Перед прогоном трассировщика, важно, чтобы были выбраны подходящие установки для печатной пла-

ты. Использование Router закладки Setup диалогового окна  позволяет определять стратегии трассировки, 
которые будут приложены к проекту. Для установки трассировки: 

1. Выбрать пункт Options > Setup, затем нажать Router закладку. 
2. Выбрать сигнальные слои для трассировки и направление в слое. 
3. Сделать установку проходов трассировки, используя Routing Passes раздел. 
4. Выбрать способ сглаживания трасс в Smoothing разделе. 
5. Определить величину сетки, ширину трасс и размер переходов в Variables разделе. 
6. Определить величину зазоров в Clearances разделе. 
 
Выбор слоев трассировки 
Имеется шесть слоев, которые могут быть использованы авто трассировщиком: 

 Top Layer  
 Mid Layer 1  
 Mid Layer 2  



 Mid Layer 3 
 Mid Layer 4 
 Bottom Layer 

 
Установка видимости слоев трассировки 
Прежде чем определять слои трассировки, сначала используя Layers закладку в Setup диалоговом окне 

разрешить видимость сигнальных слоев, которые будут использоваться для трассировки.  
Примечание: Эти установки не управляют слоями в трассировке, а только отображают. Чтобы включить 

видимость слоев: 
1. Выбрать пункт Options > Setup и нажать Layers закладку. 
2. Установить контрольные отметки в слоях, которые необходимо просматривать. 
 
Выбор направления трассировки 
Связи, разведённые в активных слоях трассировки должны следовать направлениям, которые определе-

ны в Layer Routing Setup разделе Router закладки Setup диалогового окна. Если какой либо слой установлен 
как Single Layer, все другие слои автоматически будут установлены в Not Used. Это определение означает, 
что трассировка будет произведена только в этом слое в любых направлениях. Чтобы установить направления 
трассировки в слоях: 

1. Выбрать пункт Options > Setup и нажать Router закладку. 
2. Выбрать Horizontal, Vertical или Not Used для слоев. 
или 
    Выбрать Single Layer, чтобы трассировать только в этом слое. 
3. Сделать другие изменения в Router установках, и выбрать OK. 
 
Раздел Routing Passes 
Опции, отображаемые в этом разделе, обрабатываются в названном порядке. Простые и быстрые прохо-

ды трассировки сопровождаются более сложными стратегиями. 
SMD to Pwr/Gnd Автоматизирует соединение компонентов поверхностного монтажа с внутрен-

ними Power и Ground слоями. Когда сделан этот выбор, компоненты  SMD ко-
роткими сегментами через переходы подключаются к нужному слою с исполь-
зованием термических панелей.   

Memory Быстрая эвристическая трассировка, которая устанавливает короткие горизон-
тальные и вертикальные трассы без использования переходов, которые обычно 
используются для соединения параллельных колонок микросхем памяти.  

Line Probe Этот выбор допускает множественное расследование линии трассировки при 
проходе образца с использованием не более трёх переходов. Эта трассировка 
очень быстрая и может обеспечить отличные результаты при условии хорошего 
размещения компонентов и правильных установок. Тем не менее, этот способ 
подходит для плат малой плотности и вероятно не обеспечит ту степень завер-
шения как более передовая Maze трассировка. 

Maze Это трассировка волнового расширения с возможностью повторных попыток 
методом итерации. Трассировка может потребовать некоторого времени, чтобы 
полностью завершиться в сложной плате, но всегда обеспечивает самую высо-
кую степень завершения на любом проходе трассировки, если использованы 
правильные установки.  

 
 
Раздел Smoothing 
Выбор в Smoothing разделе позволяет привести в порядок разведённые связи. Проход сглаживания мо-

жет выполняться немедленно, следуя за проходом трассировки. Рекомендуется запускать проходы трассиров-
ки отдельно от проходов сглаживания. Это позволит возвратиться к разведённой плате для редактирования, 
если не было прохода сглаживания. 

Smooth User Routed Производит проход сглаживания для всех связей, независимо от того, как или 
когда они были выполнены. Если опция не отмечена, то только связи созданные 
инструментальными средствами трассировки и входящие в список цепей будут 
сглажены. 



Basic Разрешает использование Via Minimization, Diagonal Remover, Loop Remover, 
Double-back Remover, Dual Stub Remover, Two-Via Remover и Arc Replacer 
опций, если они определены. 

Advanced Предварительное сглаживание, используемое Maze трассировкой, поможет в 
улучшении поиска путей трассировки. Многократные проходы с предваритель-
ным сглаживанием обычно заканчивается лучшим размещением трасс. 

Arc Replacer Выбор преобразовывает 90 градусные углы в 90 градусных дуги, с разрешением 
зазоров.  Радиус дуги можно определить в Arc Radius текстовом окне. Ширина 
линии дуги зависит от Track Width переменной трассировщика.  

 
Раздел Variables 
Установки Variable раздела определяют шаг сетки, ширину трасс, размер переходов и отверстий, кото-

рые используются при авто трассировке. 
 
Раздел Clearances 
Установки Clearance раздела определяют минимальный зазор между установленным и разведёнными 

примитивами как, например, между трассами, трассой и переходом, между переходами, переходом и панелью 
и между панелями. Чтобы изменить величину зазора, ввести её в соответствующем текстовом окне. 
 

Особенности определения сетки и зазоров 
Размер определённой сетки имеет основное влияние на исполнение трассировки. Меньшая сетка обеспе-

чивает большие потенциальные возможности для соединения трасс и, следовательно, улучшает завершающие 
показатели. Тем не менее, уменьшение вдвое размера сетки вчетверо увеличивает потенциальные возможно-
сти трассировки с пропорциональным увеличением времени трассировки. 

Сетка, используемая авто трассировкой определяется Routing Grid установкой. Определение Auto Place 
Grid  должно быть ровно или кратно Routing Grid. Например, компоненты установленные с шагом 100 mil в 
Auto Place Grid могут быть успешно соединены с шагом сетки 100, 50, 25, 20, 10 или 5 mil определённой в 
Routing Grid. 

Очень важно понять, что установки сетки и зазора взаимозависимы. Неудачи трассировки могут про-
изойти там, где зазоры соответствуют требуемым, но не могут быть использованы, поскольку позиция сетки 
ограничивает размещение трасс. Например, достаточный зазор между панелями позволяет развести две трас-
сы, но может быть разведена только одна трасса, поскольку сетка слишком большая. 

 
Использование авто трассировки 
После определения Router установок всё готово к авто трассировке связей. Для этого можно использо-

вать одно или более средств автоматизированной трассировки, которые доступны в Route меню. TraxMaker 
также предоставляет различные команды отмены трассировки, чтобы делать изменения.  

Board    Авто трассировка всей платы. 
Manual With Net   Ручная трассировка отдельных цепей. 
Pad-to-Pad Without Net  Авто трассировка одной связи между двумя панелями. 
Net    Авто трассировка всей цепи щелчком в линию связанности. 
Net by Name   Авто трассировка всей цепи выбором имени из списка. 
Connection   Авто трассировка одной связи щелчком в линию связанности. 
Unroute All Удаление всех разведённых трасс. 
Unroute Net   Удаление трассы одной цепи щелчком в трассу. 
Unroute Connection  Удаление одной связи цепи щелчком в эту связь. 
ReRoute    Ручное редактирование существующей трассы. 
 
Авто трассировка всей платы 
Эта функция использует встроенный в TraxMaker авто трассировщик для разводки всей платы.  В первом 

проходе авто трассировщик проверяет проект на наличие уже разведённых трасс, затем трассирует остальные 
не разведённые цепи на всей плате. 

Количество используемых слоев, ширина трасс, зазоры и другие аспекты трассировки могут все коррек-
тироваться. Поскольку имеется очень много переменных, необходимо отрегулировать их установками, чтобы 
получить самые высокие результаты трассировки всей платы. Для авто трассировки платы: 

1. Выбрать пункт Route > Board. 



2. Отметить Save log file для сохранения результатов трассировки в файле с .LOG расширением. 
3. Определить имя файла списка цепей, затем нажать OK, чтобы начать авто трассировку. 
4. Чтобы прервать авто трассировку в любое время нажать Esc кнопку, затем нажать OK. 
Прогресс процесса трассировки будет отображаться на полосе статуса внизу экрана. 
 
Ручная трассировка отдельных цепей 
Manual With Net пункт меню позволяет вручную разводить связи, основываясь на линиях связанностей.  

Перед использованием ручной трассировки необходимо  загрузить список цепей. Чтобы вручную разводить 
связи: 

1. Выбрать необходимый сигнальный слой. 
2. Выбрать пункт Netlist > Show Nets > UnRouted Nets для отображения линий связанностей. 
3. Выбрать пункт Route > Manual With Net. 
4. Тщательно позиционировать курсор в цепи, которую необходимо развести, затем щёлкнуть. 

Цепь будет следовать за перемещением курсора, отображая точки поворота, начальную и конечную 
точки, и можно теперь разводить вручную. 

5. Переместить курсор в желаемую точку, затем щёлкнуть, чтобы сформировать трассу от отправного 
пункта до точки щелчка. 

6. Переместить курсор на другие точки и щёлкнуть, чтобы сформировать следующие секции. При необ-
ходимости нажать звездочку (*) на вспомогательной клавиатуре, чтобы переключать слой размеще-
ния трассы в любое время. Переходное отверстие будут установлено автоматически всякий раз при 
переключении слоя. Продолжить перемещение и щелчки пока не будет завершена трассировка цепи. 

7. Для завершения трассы нажать правую кнопку или Esc. 
 
Авто трассировка между панелями без определения цепи 
Использование функции Pad-to-Pad Without Net не требует обязательной загрузки списка цепей. Чтобы 

автоматически создать связь без определения цепей: 
1. Выбрать пункт Route > Pad-to-Pad Without Net. 
2. Позиционировать курсор над панелью пока она не изменит цвет, затем нажать и удерживать левую 

кнопку мыши. 
3. Переместить курсор на другую панель, когда она изменит цвет отпустить кнопку мыши.  Трасса ме-

жду панелями автоматически будет разведена. 
 
Авто трассировка отдельных цепей 
Можно произвести авто трассировку отдельной цепи щелчком на ней: 
1. Выбрать пункт Netlist > Show Nets > UnRouted Nets. 
2. Выбрать пункт Route > Net. 
3. Щёлкнуть в линию связанности цепи, которую необходимо развести. 
4. Повторить шаг 3 для авто трассировки всех необходимых цепей, для завершения нажать правую 

кнопку мыши или Esc. 
 
Авто трассировка цепей по имени 
Можно произвести авто трассировку цепей, выбирая их из списка: 
1. Выбрать пункт Route > Net by Name. 
2. Выбрать цепь для трассировки из списка, затем нажать OK. 
 
Авто трассировка отдельных связей цепи 
Для использования функции загрузить список цепей: 
1. Выбрать пункт Netlist > Show Nets > UnRouted Nets. 
2. Определить приемлемый масштаб отображения платы. 
3. Выбрать пункт Route > Connection. 
4. Щёлкнуть желаемую линию связанности, которую необходимо развести. 
5. Продолжить авто трассировку индивидуальных связей цепи, щёлкая линии связанностей. Для отклю-

чения функции нажать правую кнопку или Esc. 
 
 
 



Удаление всех трасс 
Команда Unroute All позволяет удалить все трассы на плате, которые были разведены с использованием 

списка цепей и инструментальных средств.  Другими словами трассировка,  выполненная любыми инструмен-
тальными средствами кроме Place Track и Pad-to-Pad Without Net средствами, удаляется данной командой. 

Чтобы удалить все трассы на плате, выбрать пункт Route > Unroute All. 
 
Удаление трассы всей цепи 
Команда Unroute Net позволяет удалить всю цепь, щёлкая в трассу этой цепи. Чтобы удалить цепь: 
1. Выбрать пункт Route > Unroute Net. 
2. Щёлкнуть в трассу цепи для удаления. 
3. Повторять шаг 2 для удаления других цепей, для отмены функции нажать правую кнопку или Esc. 
 
Удаление одной связи в цепи 
Команда Unroute Connection позволяет удалить одну связь цепи, щелчком в трассу этой связи. Чтобы 

удалить связь: 
1. Выбрать пункт Route > Unroute Connection. 
2. Щёлкнуть в трассу удаляемой связи. 
3. Повторять шаг 2 для удаления других связей, для отмены функции нажать правую кнопку или Esc. 
 
Список цепей и авто трассировка 
Список цепей содержит все связи в схеме, но не содержит информации о порядке трассировки цепей. Вот 

почему необходимо выбирать стратегию оптимизации на самые короткие связи, x смещения или y смещение 
при загрузке списка цепей. Этот список связей будет обрабатываться всякий раз при использовании пункта 
Optimize Nets в Netlist меню. Переупорядочение будет сделано только для тех цепей, которые были полно-
стью удалены перед загрузкой списка цепей. Следовательно, при трассировке части связей использованием 
ручных инструментальных средств, дальнейшая авто трассировка всей платы не будет завершена, так как мо-
гут помешать трассы, разведённые ручным способом. 

При сохранении файла текущий список установленных связей, включая статус маршрута каждой связи, 
сохраняется как часть файла. Это позволит перезагрузить файл и продолжить трассировку, не перезагружая 
подлинник списка цепей или оптимизированный список связей. 

 
Получение наилучших результатов авто трассировки 
Почти всегда есть способы улучшить результаты авто трассировки. Но выбор оптимальных решений не 

всегда даёт оптимальный результат. Не все проекты подходят для авто трассировки. Необходимо рассмотреть 
другие средства автоматизации разводки, которые при правильном использовании повышают общую произво-
дительность. 

Переменные, которые определяются пользователем, имеют значимое влияние на завершающие показате-
ли, качество и скорость трассировки. Наиболее важным показателем является выбранная сетка. Если вдвое 
уменьшить сетку, в четыре раза увеличивается количество потенциальных решений для каждого маршрута 
трассировки, правда при этом пропорционально возрастает время трассировки. Выбор сетки, форма компо-
нентов, предварительно разведённые связи, установка переменных, зазоров и т.п. влияют на показатель каче-
ства трассировки. Чтобы улучшить результаты трассировки: 

 Использованием Auto Place Grid установки Grid/Draw закладки Setup диалогового окна, опре-
делить так чтобы все выводы располагались в подходящей сетке. Убедиться, что выбранная сетка 
использовалась при создании компонентов, особенно SMD. Сетка авто трассировки может быть 
только между 5 и 100 mils. 

 Выбрать пункт Netlist > Optimize Nets до авто трассировки. Это скорректирует внутренний спи-
сок связей более прямыми путями трассировки. 

 Сохранить плату после размещения компонентов, но до трассировки. Если результаты трассиров-
ки будут не благоприятные, можно возвратить не разведённую плату, изменить установки, затем 
развести снова. 

 Запуск Smoothing проходов должен быть отделён от проходов трассировки. Это позволит возвра-
титься к прежним результатам разводки. 

 По возможности минимизировать расстояния связанных компонентов. Видимость линий связан-
ностей выбором пункта Netlist > Show Nets > All Nets даёт хорошую возможность в оптимизации 



позиций компонентов. Выбором пункта Help > Get Info можно проверить общую длину связей 
после перемещения компонентов. Более низкая общая длина связей улучшит трассировку. 

 
Пример авто трассировки платы 
Программа включает несколько примеров использования .PCB файлов, которые могут быть разведены 

использованием авто трассировщика. Эти платы могут быть успешно разведены, но каждая требует различных 
установок для успешного завершения. Для этого используются Memory, Line Probe и Basic опции. Maze фай-
лы .PCB требуют использования профессионального издания, Maze трассировка и предварительное сглажи-
вание используются для успешного завершения. Установка предпочтений включает .INI файлы, которые 
должны загружаться до разводки платы. Чтобы успешно развести одну из плат примера: 

1. Открыть .PCB файл примера. 
2. Выбрать пункт File > Preferences. 
3. Нажать Load Preferences кнопку и открыть .INI файл, который имеет то же имя как .PCB файл. 
4. Выбрать Route > Board. Большинство примеров разводится со 100% завершением. 
 
Оптимизация списка цепей 
Возможно, что будут получены не желательные результаты после авто трассировки платы. Если так, то 

можно сделать выбор другой оптимизации.  Можно использовать один из трех методов оптимизации, это для 
всех цепей на плате, только цепей подключенных к выбранному компоненту, или только выбранных цепей. 
Необходимо оптимизировать список цепей перед прогоном авто трассировки, если были изменения на плате. 
Цепи оптимизируются автоматически при загрузке. Каждая цепь проверяется, чтобы определить самый корот-
кий путь между различными узлами. Чтобы оптимизировать список цепей: 

1. Выбрать пункт Netlist > Optimize Nets > Select Net. 
2. Выбрать имя цепи из списка, нажать OK, выбрать метод оптимизации, затем выбрать OK. 
или 

Выбрать пункт Nets On Selected Components, выбрать метод оптимизации, нажать OK, затем вы-
брать компонент. 

или 
   Выбрать пункт All Nets, выбрать метод оптимизации, затем нажать OK. 
Shortest Path Оптимизация списка цепей для достижения самого короткого общего расстояния свя-

зей. 
X Bias Оптимизация соединений выводов для достижения самого короткого расстояния связей 

вдоль оси X. 
Y Bias Оптимизация соединений выводов для достижения самого короткого расстояния связей 

вдоль оси Y. 
 
TRAXEDIT.LOG 
TraxMaker производит текстовый файл результатов авто трассировки, включая список не разведённых 

связей. 
 
Контроль правил проекта 
Использование Design Rules Check (DRC) пункта после трассировки платы должно подтвердить, что все 

зазоры соответствуют определённым величинам, и нет очевидных нарушений проекта, как например, пропу-
щенных связей. Этот выбор позволяет проверять, что все трассы, переходы и панели установлены согласно 
назначенным инструкциям. Процесс особенно важный, если есть трассы разведённые вручную.  

Выбор DRC сначала загружает файл списка цепей, затем проверяет все узловые связи в каждой цепи. 
При обнаружении ошибок будет сгенерировано сообщение о месте ошибки. На этом этапе также проверяется 
наличие любых лишних выводов. В следующем шаге все узлы выделяются и проверяются зазоры не выделен-
ных узлах на соответствие допустимых правил. 

Чтобы выполнить Design Rules Check: 
1. Выбрать пункт Netlist > Design Rules Check. 
2. Выбрать пункты, которые необходимо проверить, как например, потеря компонентов и выводов, 

лишние выводы, разъединённые цепи или нарушения зазоров. 
3. Выбрать Save to file, затем определить имя файла с .DRC расширением, где необходимо сохранить 

результаты контроля. 



4. Если файл сохраняется то выбрать Show saved file, чтобы отобразить содержимое файла после за-
вершения контроля. 

5. Выбрать Show errors on the fly для отображения ошибок во время контроля. 
6. Определить имя файла списка цепей с .NET расширением, который будет использоваться в течение 

контроля. 
7. Нажать Run Check, чтобы начинать контроль. Если сделан Show errors on the fly выбор и DRC на-

ходит ошибку, цепь будет выделена и курсор будет установлен в позицию ошибки. Прочитать ин-
формацию, затем выбрать Continue, чтобы продолжить контроль. Выбрать Cancel, чтобы закончить 
контроль. 

 
Сообщения об ошибках 
Сообщения об ошибках будут представлены в .DRC файле, которые будут обнаружены в течение Design 

Rules Check. 
Component Missing Один или более компонентов определенных в списках цепей не обнаружены на 

плате. 
Pin Missing Один или более выводов определенных в списках цепей не обнаружены на пла-

те. 
Extra Pin   Цепь подключена к выводу устройства не определённому в списке цепей. 
Broken Net Цепь разъединена на две части. 
Clearance Violations Зазоры не соответствуют определённым величинам.  
 
8. Печать  
TraxMaker обеспечивает большим разнообразием выборов печати и вычерчивания для создания кон-

трольных отпечатков или графических отпечатков высокого разрешения, а также файлов фото графики Gerber 
для промышленного производства качественных печатных плат. 

 
Печать топологического чертежа платы 
Печать топологических чертежей обычно зарезервировано для контрольных отпечатков, которые позво-

ляют подтверждать содержание выходных файлов.  Использование принтера для производства простых про-
тотипов платы предусматривает ожидание довольно грубого уровня детализации. Это потребует установки 
масштаба принтера 200% или более. Линейные искажения присущие печати могут вызвать проблемы с совпа-
дением слоев и выравниванием для заполнения отверстий выводов. 

 
Установки принтера 
Чтобы установить принтер для печати плат: 
1. Выбрать пункт File > Print Setup. 
2. Сделать установки принтера, как например, выбрать имя принтера и его свойства. Определить бу-

мажный размер, её источник и ориентацию. 
3. Нажать OK. 
 
Печать платы 
Когда выбран и установлен принтер, всё готово к печати платы. Прежде чем печатать, необходимо сде-

лать некоторые установки. Чтобы печатать плату: 
1. Выбрать пункт File > Print. 
2. В Adjustments групповом окне при необходимости определить величины X, Y Scale и Offset. 
 Можно независимо назначать Scale показатель на любую из осей выходной печати. Это позволяет оп-

ределять показатель коррекции к погрешности используемого принтера. Offset выбор позволит компенсиро-
вать погрешность позиции слоя при печати. Компенсация может быть положительной, например 0,050 дюйма 
или отрицательной, например – 0,250 дюйма. 

 Если сделан Fit to Single Page выбор, масштаб и компенсация корректируется автоматически, чтобы 
плата точно поместилась на листе бумаги. 

3. В Position разделе выбор Normal позиционирует отпечатанную плату в зависимости от установок по 
умолчанию принтера, выбор Auto Center центрирует плату на бумаге в течение печати. 

4. Выбрать также Draft или Final качество печати. 
5. Нажать Print для печати платы 
или 



   Нажать Options, изменить установки в окне Print Options, выбрать OK, затем нажать Print, чтобы 
начать печать. 

 
Качественная печать на принтере 
Современные принтеры имеют разрешение от 300 до 2540 dpi или выше. Из-за высокого разрешения и 

доступности таких устройств, многие потребители могут использовать такие принтеры как дешевую альтерна-
тиву графикам Gerber. Тем не менее, есть некоторые ограничения, которые должны учитываться перед печа-
тью. Если эти принтеры очень точны по горизонтали, они не всегда достигают нужной вертикальной линейно-
сти, особенно когда основа, на которую производится печать, перемещается по печатающему механизму через 
серию роликов. 

Чтобы тестировать принтер, необходимо создать файл с вертикальными и горизонтальными трассами из-
вестной длины и тщательно измерить выходную печать на точность. Это позволит определить показатель кор-
рекции на любой оси, чтобы минимизировать ошибку. Суммарная ошибка линейности не всегда постоянна, 
она зависит от многих факторов, в том числе и от качества основы печати. При смене основы необходимо сде-
лать пробную печать для определения погрешности. 

Другой проблемой, особенно с лазерным принтером является растекание расплавленного тонера на  ос-
нове, это может создать проблемы с нарушением зазоров на печатной плате. При проектировании необходимо 
сделать несколько пробных отпечатков топологического чертежа, чтобы подобрать приемлемый зазор и ми-
нимизировать эффект. Необходимо помнить, что качество отпечатка в лазерном принтере определяется глав-
ным образом бумагой.  

 
Установки печати 
Использование Print Options диалогового окна поможет в управлении слоями и размерами при печати 

платы и другими установками. Чтобы сделать установки отпечатка: 
1. Выбрать пункт File > Print, затем нажать Options. 
2. Выбрать Check Print, чтобы печатать все активные слои одновременно для оценочных целей. Кон-

трольный отпечаток показывает все выбранные слои на единственной странице. Выбрать Mirrored, 
если необходимо напечатать зеркально. 

или 
    Выбрать Batch Print, чтобы обработать несколько отпечатков за один раз. 
3. Выбор Set All выделяет все слои для печати, Clear All отменяет выбор всех слоев, и Set Used выби-

рает только используемые слои. 
4. Выбрать слои, оверлеи или маски, которые необходимо включить в отпечаток. Выбрать Mirrored для 

любого из них, которые необходимо отобразить зеркально.   
5. В Include разделе выбрать пункты платы, которые необходимо включить в отпечаток. 

Выбор Board Layers включает все пункты сделанные в этом слое для печати. Выбор Path\Filename, 
Layer включать текст идентификации файла и слоя. Выбор Single Layer Pad Holes включает отвер-
стия сверловки в единственном слое, например панели SMD. 

6. В Other Settings разделе определяются размеры, которые используются для выборов описанных ни-
же. 

7. В Color Mode разделе Color определяет цветную печать, B&W чёрно-белую печать и B&W Negative 
определяет чёрно-белую печатать в негативе. Негативы не будут печататься в режиме Draft. 

8. Нажать OK. 
 
Pad Hole Guide Size 
Этот выбор печатает небольшие отверстия, размер которых определяется пользователем, в центре каж-

дой панели и перехода. 
 
Drill Draw Symbol Size 
Этот выбор определяет размер символов используемых в чертежах сверловки. 
 
Pwr/Gnd, Solder и Paste Mask Enlargements 
Выбор Enlargements позволяет определять повышенные зазоры в этих графических пунктах специаль-

ного назначения, которые могут потребоваться при изготовлении печатных плат. Выбор PWR/GND 
Enlargement позволяет увеличить зазор между выводами, проходящими через  Power и Ground слои. Также 



можно определить увеличение зазоров для Top и Bottom Solder или Paste mask слоев. Увеличение является 
дополнительным зазором в mils или мм вокруг каждой панели и перехода. Значение по умолчанию нулевое.  

 
 
Графика слоёв  
Здесь даётся краткое описание графики каждого слоя, которые могут быть сгенерированы в TraxMaker, 

включая некоторые важные показатели, которые нужно учитывать в каждом графике. 
Check Print Позволяет генерировать составную распечатку выбранных слоев платы. 

Она может содержать любое или все слои указанные ниже за исключе-
нием Drill Drawing и Drill Guide. Распечатка может быть цветной или 
только чёрно-белой. 

Top Layer Это графика слоя компонентной стороны. Вычерчиваются все трассы, 
дуги и заполнители, которые установлены в этом слое, а также панели, 
переходы, текстовые строки и Board Layer пункты, если сделан их вы-
бор. 

Mid Layers 1-4 Это четыре средних слоя доступные в TraxMaker. Трассы, дуги, заполни-
тели и текстовые строки могут быть установлены в каждом из этих сло-
ев. Панели, переходы и строки будут включены в графику, а также Board 
Layer пункты, если сделан их выбор. 

Bottom Layer Так называемая сторона пайки платы. Компоненты также могут устанав-
ливаться в этом слое. Вычерчиваются все трассы, дуги и заполнители, 
которые установлены в этом слое, а также панели, переходы, текстовые 
строки и Board Layer пункты, если сделан их выбор. 

Top/Bottom Overlay Также названные как шёлкотрафаретные слои, используются для разме-
щения графики корпусов компонентов и текста. 

Ground/Power Planes Это специальные средние слои состоят главным образом из сплошных 
областей меди на плате, и вычерчиваются по умолчанию в негативе. За-
полнители и трассы могут быть установлены в этом слое, которые необ-
ходимо скрывать или разделять. Например, многие изготовителей реко-
мендуют устанавливать трассы по периметру платы, чтобы очистить 
краевую часть медной области. Дополнительный зазор для прохождения 
выводов через эти области предусмотрен использованием PWR/GND 
Enlargement выбора. Этот выбор позволяет увеличивать диаметр гра-
ничного зазора вокруг каждого не связанного вывода, проходящего через 
медную область. 

Top/Bottom Solder Masks Solder Masks представляет графику всех панелей с заполненными отвер-
стиями. В этом слое не может быть текстовых строк, заполнители, дуг 
или трасс. Как Ground и Power слои, Solder Masks по умолчанию вы-
черчивается в негативе. Как панели, так и переходы должны быть вклю-
чены, чтобы отображаться в маске. Большинство изготовителей печат-
ных плат требуют, чтобы маска пайки была немного больше фактическо-
го размер панелей, чтобы гарантировать, что маска приемлемо очищает 
область панелей. Использование Solder Mask Enlargement выбора опре-
делят при необходимости дополнительный зазор в mils. 

Top/Bottom Paste Masks  Paste Masks использует графику всех панелей, чтобы защитить места 
для пайки компонентов от используемых лаковых покрытий, особенно 
SMD. В слое маски не используются текстовые строки, заполнители, ду-
ги или трассы, и слой отображается в негативе.  

Pad Master Эта графика отображает все панели и переходы на плате и показывает 
размер отверстий определённый для каждой панели. Это поможет в про-
верке размещения компонентов и может действовать как руководство 
для программирования машин сверловки. 

Keep Out Layer Keep Out запретный слой, используемый для целей авто трассировки и 
авто размещения, может включать трассы, дуги, заполнители и тексто-
вые строки.  Панели, переходы и текстовые строки будут включены в 
графику, а также Board Layer пункты, если сделан их выбор. 



Drill Drawing Это специальный слой графики, используемый как руководство для про-
граммирования оборудования сверловки. Он состоит из серии символов 
в каждой позиции отверстия и таблицы, преобразующей используемые 
символы в десятичный размер отверстия. 

Drill Guide Этот слой графики представляет собой справочник по отверстиям, кото-
рые должны быть просверлены в плате и подобен графике Pad Master. 
Все панели печатаются в их определенной форме и размере. Размер от-
верстия определенного в Pad Hole Guide Size будет показан на каждой 
панели. Если размер отверстия больше чем панель, в центре будет напе-
чатан символ плюс (+). 

 
 
 


